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(1) Introduction

The ZEISS ATLAS™ Model 9000 Corneal Topography System (ATLAS System) is a diagnostic
instrument that measures the curvature of the cornea of the eye, and produces a
topographical image. This image can be viewed on a computer and printed in color. The
information can be used for contact lens fitting, corneal pathology detection and
management, and laser vision correction screening/planning/management. 

This chapter includes the following topics:

• Intended Use and Indications for Use, page 1-1
• Purpose of This User Manual, page 1-2
• ATLAS Technology, page 1-3
• System Hardware, page 1-4
• External Device Equipment, page 1-8
• Review Software and Instrument Differences, page 1-10
• Instrument Installation, page 1-11
• Tips to Avoid Damage, page 1-12
• ATLAS Instrument Embedded Windows License, page 1-13
• Product Compliance, page 1-13
• Product Safety, page 1-13
• Electromagnetic Compatibility (EMC), page 1-15
• Symbols and Labels, page 1-19
• Instrument Disposition, page 1-22
• Disposal, page 1-22
• Using the Optional Power Table, page 1-22

Intended Use

The ZEISS ATLAS Corneal Topography System is intended to measure and analyze the
corneal curvature of the eye.

Indications for Use

The ZEISS ATLAS Corneal Topography System is an automated AC-powered
videokeratoscope indicated for measuring corneal topography and assisting in corneal
evaluation, corneal refractive surgery screening and post-operative monitoring, corneal
pathology screening and monitoring, and contact lens selection and fitting.

☞ Note: The ATLAS System instrument and ATLAS Review Software are not
intended to be used as the sole diagnostic for disease.
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Purpose of This User Manual

Carl Zeiss Meditec designed this User Manual to serve as a training, usage and reference
guide. We assume that users are clinicians or technicians with professional training or
experience in the use of ophthalmic imaging equipment, and in diagnostic interpretation
of the images generated. While we offer training in the use of the ATLAS System, we do not
offer instruction in diagnostic interpretation of the images generated. This manual does
not attempt to do so. 

ATLAS System Instrument User Manual

This User Manual is intended for the operation of the ATLAS System instrument and ATLAS
System software.

ATLAS Review Software Manual

This User Manual is also intended for operation of ATLAS Review Software. ATLAS Review
Software running on a separate computer is functionally identical to the software running
on the ATLAS instrument except for the ability to acquire images. 

Please refer to the following ATLAS Review Software sections:

• Review Software and Instrument Differences on page 1-10.
• (D) Network Configuration Guide for network configuration information.

If you are using ATLAS Review Software on a separate computer you can ignore chapter (3)
Acquire Images (Instrument Only). 

Organization of the Manual

☞ Note: Unless otherwise noted, the functions and instructions described in this manual
can be used for both the ATLAS System Instrument and ATLAS Review Software.

This introductory chapter provides a system description, installation and safety information.
Chapters (2) through (4) are organized according to the normal sequence of operation of
the ATLAS System, that is, image acquisition followed by image analysis. Chapters (5)
through (8) cover Parameters, Views, and Displays, followed by data management,
backup, and transfer functions in Chapters (9) through (11). Chapters (H), (K), and (L)
cover Routine Maintenance, instrument Specifications and Legal Notices,
respectively. Users who wish to use the ATLAS System in a networked environment should
see (D) Network Configuration Guide. 

ATLAS’s optional PathFinder™ II software is discussed in (A) PathFinder II Corneal
Analysis (Optional). The optional MasterFit™ II software is discussed in (B) MasterFit II
(Optional). The optional DICOM Gateway software is discussed in (C) DICOM Gateway
(Optional). License Registration for ATLAS Review Software and optional software features
are discussed in (I) License Registration.

See (E) Network Storage Device Configuration for NAS drive information, and (F)
Printer Configuration for printer information. For ATLAS data transfer using optical disks, see
(G) Data Transfer Using Optical Disks. The manual includes a Glossary and an Index.
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Text Conventions

• This manual means “left-click” when it says, “click,” except where “right-click” is
specified.

• Chains of menu items are indicated with the use of the “>” symbol between items. For
example, “File > Exit” directs you to select Exit in the File menu.

Access Menu Options

To access the options offered through each menu, click on the menu headings. Then click
on an option to select it. Click outside all menu options to make the options disappear.

• Some menus are fields tagged with a down-arrow (drop-down lists). To access these
menu options, click on the down-arrow. 

• Grayed-out menu options or buttons are not available.

Electronic User Manual Access

The ATLAS System User Manual in Acrobat PDF format (version 8 or later) is provided with
the instrument electronically in four ways:

1. In the ATLAS System application, press the F1 function key.
2. In the ATLAS System application, select View User Manual... on the Help menu.
3. On the ATLAS User Manual CD included in the instrument accessory kit. You can view

the user manual PDF using the ATLAS System computer or any other computer.
4. On the ATLAS Review CD included in the instrument accessory kit. You can view the

user manual PDF using the ATLAS System computer or any other computer.

☞ Note: Once the ATLAS System User Manual is opened, you can switch between the
user manual and the ATLAS application by pressing Alt+Esc or Alt+Tab.

ATLAS Technology

The ATLAS System is a Placido-disk based corneal topography system that projects a series
of concentric infrared (950 nm) light rings onto the cornea of the eye. An image of the
reflected rings is captured with a digital camera. Using patented Cone of Focus™
technology and an enhanced arc-step algorithm, the ATLAS System analyzes thousands of
data points in the image to measure the distances between rings, and their relationships
with each other, to reconstruct the corneal surface. The data points are then converted by
the software into various views of the cornea. The ATLAS System can display the image of
the cornea in a variety of ways, including curvature, elevation, and aberrations. The ATLAS
System also has the ability to capture both scotopic (without light) and photopic (with
light) pupil images.

During an examination, the patient’s chin is positioned in the chin rest assembly in front of
the projection head. The clinician administering the exam aligns the projection head and,
using a joystick, focuses on the patient’s eye and activates the system. The user presses the
joystick or spacebar to stop data acquisition. The optional SmartCapture™ Image Analysis
Technology, found only in the ATLAS Model 9000, automatically acquires images during
the alignment process and selects the highest quality image for the user. Corneal
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topography exams are stored on the instrument's computer and/or on an archive medium,
and can be quantitatively analyzed. 

The field of view of the camera system is large enough to capture the limbus boundaries of
the eye, thus allowing white-to-white (limbus-to-limbus) measurements, as well as the
determination of the geometric center of the eye for better contact lens fitting and eye
registration.

System Hardware

With the exception of the keyboard and printer, the ATLAS System integrates all hardware
components in a unit, which includes the image acquisition optics, the system computer
and flat panel display screen. Carl Zeiss Meditec offers an optional motorized power table
(Figure 1-5 and Figure 1-12), which accommodates elevation adjustment to each
patient's height. The illustration below (Figure 1-1) labels hardware elements. System
specifications are in (K) Specifications.

Figure 1-1 ATLAS System Hardware
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Projection Head Assembly and Joystick

The projection head houses the illumination source, Placido disk, and video camera that
project and capture an image.

The joystick moves the base of the unit from side to side and back and forth for
positioning. The base can also be locked in place when you move the unit by turning the
joystick counter-clockwise until it clicks and stops.

The joystick is also used to focus the image. The button on top of the joystick (or the spacebar
on the keyboard) activates the camera and completes the image acquisition process.

Chin Rest Assembly

The chin rest assembly (Figure 1-2) cradles the patient’s chin and forehead during an
examination. The chin rest can be adjusted vertically to align the patient’s eye with the
camera using control knobs on the left and right (see Figure 1-1 and Figure 1-2). You
can raise or lower the chin rest to align the canthus (corner of the eye) with the canthus
marks on the chin rest assembly. This special dual chin rest minimizes any nose shadow
during an exam.

Figure 1-2 Chin Rest Assembly

Right Vertical

Control
Knob

Alignment

Forehead Rest

Chin Rest

Canthus Mark



Introduction

ATLAS User Manual 2660021135270 B

1-6

The left chin rest is positioned at an angle for the right eye, and the right chin rest is angled
for the left eye.

The chin rest (from the patient’s perspective) is labeled with arrows to indicate the chin
location, and therefore the head orientation while capturing images for the right (blue
arrow) and left (white arrow) eye. The patient should be instructed to place their chin in the
appropriate side depending on which eye is being examined. The infrared sensors in the
chin rest automatically detect OD/OS.

Keyboard and Touchpad

The keyboard is used to type in information, such as names, birth dates, and examination
remarks. Some keys can also be used for other functions, such as activating the camera
with the spacebar.

By touching the touchpad (see Figure 1-3) integrated into the keyboard, a pointer is
moved around the screen. Selections are made by quickly tapping and releasing “clicking”
the touchpad, or by pressing the left touchpad button. An external USB or PS/2 mouse can
also be used.

Figure 1-3 Keyboard with Integrated Touchpad and Buttons

Side Connectors

On the right side of the ATLAS are various computer ports as shown below.

Figure 1-4 Side Connectors 

Left and Right 
Touchpad buttons

Touchpad

Ethernet (network) (3)Serial USB (2)

PS/2 Mouse

Printer 

KeyboardVGA Video 
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ATLAS Instrument Software

Carl Zeiss Meditec pre-installs all software necessary to operate the ATLAS System
instrument. Software updates with installation instructions may be provided on CD or on
our website.

Data Storage

Storage of ATLAS exam data is designed to occur in a network environment. We recommend
archiving data to a network file server or an network attached storage device (also known as
a network hard drive), which operates just as a network file server. For more information, see
(10) Archive Management and (D) Network Configuration Guide.

For non-networked environments, an external USB hard drive can be used. 

☞ Note: An isolation transformer may be required when connecting USB hard drives or
printers that are plugged into electrical outlets. See External Device Equipment
on page 1-8.

Figure 1-5 ATLAS System on Optional Power Table (with isolation transformer)

Printer

 
Power Table
(Optional)
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External Device Equipment

WARNING: To maintain patient safety, an isolation transformer is required
when connecting externally powered peripheral devices (i.e., printer, USB
drive, etc.) within 1.5 meters (4.9 feet) from the patient. In addition, an
isolation transformer is required for all externally powered peripheral devices
outside this distance unless these devices are (1) connected to the ATLAS
using an Unshielded Twisted Pair (UTP) network cable (CZMI recommends
using a least a CAT 5 UTP network cable), (2) plugged into a different power
outlet than the ATLAS, and (3) qualified by CZM for use with the ATLAS.
Failure to observe this warning could result in electrical shock to the patient
and/or examiner.

WARNING: To directly connect a printer to the ATLAS System only use a UTP
cable. Use of a shielded Ethernet connector will ground the printer through
the ATLAS System, which could result in electrical shock to the patient and/or
examiner. It could also invalidate the system safety approval.

WARNING: Accessory equipment connected to the analog and digital
interfaces must be certified according to the respective IEC standards (e.g.,
IEC 60950 for data processing equipment and IEC 60601-1 for medical
equipment). Furthermore, all configurations shall comply with the system
standard IEC 60601-1-1. Any person who connects additional equipment to
the signal input part or signal output part configures a medical system, and is
therefore responsible for ensuring that the system complies with the
requirements of the system standard IEC 60601-1-1. If in doubt, consult the
technical service department or your local representative.

NAS Drives

See (E) Network Storage Device Configuration for more information.

Printers

See (F) Printer Configuration for more information.

Isolation Transformer

Any isolation transformer used must be approved for medical use and must have a
minimum rating that is sufficient for the device(s) being powered. CZM highly recommends
contacting your CZM representative for an isolation transformer that has been formally
qualified for the ATLAS.

☞ Note: Technical support is not provided for accessory devices that have not been
qualified by CZM.



ATLAS User Manual 2660021135270 B

Introduction 1-9

USB Drives (Flash and Hard Drives)

☞ Do not install any optional software. Drive must be formatted in NTFS format. ATLAS data
is compatible only with NTFS.

Using an External Monitor on the ATLAS Instrument

You can connect an external monitor to the VGA Video port of the ATLAS instrument (i.e.,
for presentations, larger monitor). To set up an external monitor follow these steps:

1. Right-Click on the Windows Desktop and select Properties from the pop-up menu.
2. The Display Properties dialog opens. Click the Settings tab (Figure 1-6) and

enter your preferred settings for the external monitor.

Figure 1-6 Display Properties Tab

☞ Note: ATLAS Review does not support a display resolution of 1024 x 768 with Large
size (120 DPI) DPI setting.
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Review Software and Instrument Differences

ATLAS Review Software has the following differences compared to the ATLAS instrument:

• Capture Image is not shown on the PATIENT SELECTION SCREEN (Find Existing Patient,
page 3-2).

• Always use current Parameter Set for acquisition option in Options > Preferences on
General tab is not displayed (Figure 3-1, page 3-2).

• Menu Tools > Calibration Check... is not displayed (Calibration Check, page H-4).
• Exams dialog on the EDIT PARAMETERS SCREEN only displays the OcuLign® option

(Exams, page 8-9).
• Auto print after acquisition and Auto export after acquisition options in Printing /

DICOM Export Options dialog on the EDIT PARAMETERS SCREEN are not displayed
(Printing / DICOM Export Options, page 8-11).

• Add New Patient tab and File > Add New Patient are not displayed (Add New
Patient (Instrument Only), page 3-3).

• Importing from Worklists is not displayed (Importing from Worklists
(Instrument Only), page 11-20).

• Camera Status and Instrument Status indicators on Status Bar are not displayed
(Status Bar Information, page 2-13).

• Instrument check on System Check during startup is not displayed (System Check
During Start, page 2-2).

• PATIENT SELECTION SCREEN is in standard Windows XP window with minimize and
maximize buttons.

• ANALYSIS SCREEN is in standard Windows XP window with minimize and maximize
buttons, and the Title Bar is displayed.

WARNING: User Changes to Software or Hardware

The ATLAS System is a medical device. The software and hardware have been
designed in accordance with U.S., European and other international medical
device standards designed to protect clinicians, users and patients from
potential harm caused by mechanical, diagnostic or therapeutic failures.
Unauthorized modification of ATLAS software or hardware (including
peripherals) can jeopardize the safety of operators and patients, the
performance of the instrument, and the integrity of patient data; it also voids
the instrument warranty.
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Approved Software

Use of software supplied or approved by Carl Zeiss Meditec for the ATLAS System is
authorized. Please refer to the ATLAS System Technical Support section of our website
(www.meditec.zeiss.com/atlas) for the current list of approved software.

☞ Note: Carl Zeiss Meditec does not provide technical support for the use of
unapproved third party software.

Instrument Installation

The ATLAS System is user-installable without assistance from a Carl Zeiss Meditec service
representative, except when used in conjunction with the CRS-Master workstation, which
may require a Carl Zeiss Meditec technician.

However, it is recommended that an authorized Carl Zeiss Meditec service representative
install the ATLAS System. In consultation with the buyer, Carl Zeiss Meditec schedules one
free on-site installation appointment after instrument delivery. System installation and
operator training require approximately one-half business day.

If you choose to install the ATLAS System yourself, follow these steps:

CAUTION: To prevent injury or damage to the instrument and yourself, two
people should lift the instrument out of the box, bending the knees and
keeping the back straight.

1. Open the shipping box by carefully cutting the stripping cords.
2. Remove the top lid of the box and the accessory kit box.
3. Remove the cardboard box sleeve surrounding the instrument.
4. Remove the top foam piece on the instrument.
5. Pull the bottom foam away from the instrument, and lift the instrument out of the

bottom foam by grasping firmly on the forehead rest and under the front end of the
instrument (under joystick area). Do NOT lift under the chin rest! 

6. Set the instrument on a flat, stable surface.
7. Remove the plastic bag from the instrument.
8. Remove the shipping band around the instrument.
9. Remove the keyboard and power cord from the accessory box.

☞ IMPORTANT: Retain the shipping materials (box and packaging) in the event of
shipping damage or for return, if necessary, to an authorized Carl Zeiss Meditec
service center. To prevent damage, the instrument must be transported in its original
shipping package.

10.Plug the approved hospital grade power cord provided with the instrument into the
power input receptacle (see Figure 1-1). Plug the other end of the power cord into a
dedicated grounded power outlet.

11.Plug in the keyboard cable into the instrument’s purple keyboard port (see Figure
1-4).

http://www.meditec.zeiss.com/atlas
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12.Verify ALL connections are fully seated and that the instrument feet are not on top of
any cables.

13.Turn on the ATLAS instrument by pressing the system power switch, found on the
front of the instrument facing the operator (see Figure 1-1).

14.To become familiar with the ATLAS System see (2) Operational Overview.

Care in Handling

Use extreme care when handling and transporting the ATLAS System shipping boxes and
instrument. The instrument contains fragile optics that have been precisely aligned at the
factory.

Installation Requirements

• The ATLAS System should operate on a dedicated power outlet. Based on your
specification, we configure your ATLAS at the factory to use either 100V, 115V, or
230V line voltage.

• When using the optional power table, the instrument must be powered through the
table (see Power the Instrument Through the Table on page 1-24).

• An isolation transformer is required when connecting peripheral devices (i.e., printer,
USB drive, etc.) to the USB port that are plugged into electrical outlets (see External
Device Equipment on page 1-8).

Tips to Avoid Damage

☞ Note: Users are not authorized to dismantle or modify the ATLAS System hardware.
To transport the instrument outside the office, you must consult with a Carl Zeiss
Meditec service technician. Failure to do so voids all warranties offered with the
ATLAS System.

• Only Carl Zeiss Meditec authorized technicians should disassemble or service this
instrument. In the case of malfunction, error messages or operational problems, call
Carl Zeiss Meditec customer service: In the U.S., call 800-341-6968. Outside the U.S.,
contact your local CZM distributor.

• This instrument has no special measures to protect against harmful ingress of water or
other liquids (classified IPXO—ordinary equipment). Do not place containers of liquid
on or near the instrument, nor use aerosols on or near it.

• The optional power table has an IP21 classification, which provides the specified
degree of protection against harmful ingress of water. Still, do not place containers
of liquid on or near the table where spillage onto the instrument or table could
occur, to avoid damage to the instrument or the table. 

• In case of emergency related to the instrument, unplug the power cord from the wall
outlet and call for service immediately.
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• With the exception of the main power fuses and keyboard, there are no
user-replaceable parts in the instrument. For the replacement of any component,
accessory, or peripheral, except fuses or the keyboard, call Carl Zeiss Meditec
customer service: In the U.S., call 800-341-6968. Outside the U.S., contact your local
CZM distributor.

• Although this instrument is designed for continuous operation, it should be turned off
when not in use for an extended period.

• This instrument operates according to specifications under standard indoor office
(fluorescent) lighting conditions, without exposure to any direct sunlight.

ATLAS Instrument Embedded Windows License

Each ATLAS instrument is issued with an embedded Windows® XP operating system
license located on the bottom of the instrument.

Product Compliance

Complies with 93/42/EEC Medical Device Directive. 

Complies with US and Canadian medical electrical system safety requirements.

Complies with ANSI Z80.23-2008, American National Standard for Ophthalmics – Corneal
Topography Systems – Standard Terminology, Requirements, Type A.

Complies with ISO 19980:2005, International Standard – Ophthalmic instruments –
Corneal Topographers, Type A.

Product Safety

• IEC 60601-1
• UL 60601-1 
• CSA C22.2 No. 601.1-M90

This instrument is classified as follows:

• Class I Equipment – Protection against electrical shock.
• Type B – Degree of protection against electric shock of applied part (chin and

forehead rests).
• Ordinary Equipment (IPX0)– Degree of protection against ingress of liquids (none).
• Continuous Operation – Mode of operation.

WARNING: To prevent electric shock, the instrument must be plugged into an
earthed ground outlet. Do not remove or disable the ground pin. Only an
authorized Carl Zeiss Meditec service representative may install the
instrument.

  0297
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WARNING: Do not use the printer or the instrument or the optional power
table with an extension cord or a power strip (multiple portable socket
outlet). For additional safety, do not plug the printer and the instrument (or
the optional power table) into the same wall outlet. Failure to observe this
warning could result in electrical shock to the patient and/or examiner.

WARNING: Do not open the instrument covers. Opening the instrument
covers could expose you to electrical and optical hazards.

WARNING: To maintain patient safety, an isolation transformer is required
when connecting externally powered peripheral devices (i.e., printer, USB
drive, etc.) within 1.5 meters (4.9 feet) from the patient. In addition, an
isolation transformer is required for all externally powered peripheral devices
outside this distance unless these devices are (1) connected to the ATLAS
using an Unshielded Twisted Pair (UTP) network cable (CZMI recommends
using a least a CAT 5 UTP network cable), (2) plugged into a different power
outlet than the ATLAS, and (3) qualified by CZM for use with the ATLAS.
Failure to observe this warning could result in electrical shock to the patient
and/or examiner.

☞ Note: The optional ATLAS Power Table is safe to use within the patient environment
when the instrument is powered through it as instructed herein.

WARNING: Do not reconfigure system components on the table, nor add
non-system devices or components to the table, nor replace original system
components with substitutes not approved by Carl Zeiss Meditec. Such
actions could result in failure of the table height adjustment mechanism,
instability of the table, tipping and damage to the instrument, and injury to
operator and patient.

WARNING: This instrument may cause ignition of flammable gases or vapors.
Do NOT use in the presence of flammable anesthetics such as nitrous oxide,
or in the presence of pure oxygen.

WARNING: Avoid tipping. Do not use the instrument on an uneven or sloped
surface. Also, do not roll the table in deep pile carpet or over objects on the
floor such as power cords. Failure to observe these precautions could result in
tipping of the instrument and/or table and resulting injury to operator or
patient and damage to the instrument.
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Electromagnetic Compatibility (EMC)

• EN 60601-1-2

☞ Note: The ATLAS System needs special precautions regarding EMC and needs to be
installed and put into service according to the EMC information provided herein.

☞ Note: Portable and mobile RF communications equipment can affect medical
electrical equipment.

WARNING: The use of accessories, transducers and cables other than those
specified may result in increased emissions or decreased immunity of the
equipment.

WARNING: The ATLAS System should not be used adjacent to or stacked with
other equipment. If adjacent or stacked use is necessary, the equipment or
system should be observed to verify normal operation in the configuration in
which it will be used.

Guidance and manufacturer’s declaration – electromagnetic emissions

The ATLAS System is intended for use in the electromagnetic environment specified below. The customer or user of the ATLAS 
System should assure that it is used in such an environment.

Emissions Test Compliance Electromagnetic environment - guidance

RF emissions
CISPR 11

Group 1
The ATLAS System uses RF energy only 
for its internal function. Therefore, its RF 
emissions are very low and are not likely 
to cause any interference in nearby 
electronic equipment.

RF emissions
CISPR 11

Class B
The ATLAS System is suitable for use in 
all establishments, including domestic 
establishments and those directly 
connected to the public low-voltage 
power supply network that supplies 
buildings used for domestic purposes.

Harmonic emissions
IEC 61000-3-2

Complies

Voltage fluctuations/
flicker emissions
IEC 61000-3-3

Complies
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Guidance and manufacturer’s declaration – electromagnetic immunity

The ATLAS System is intended for use in the electromagnetic environment specified below. The customer or user of the ATLAS 
System should assure that it is used in such an environment.

Immunity Test IEC 60601 test level Compliance level Electromagnetic environment - guidance

Electrostatic Discharge 
(ESD) IEC 61000-4-2

± 6 kV contact
± 8 kV air

± 6 kV contact
± 8 kV air

Floors should be wood, concrete, or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%.

Electrical fast 
transient/burst 
IEC 61000-4-4

± 2 kV for power supply 
lines

± 1 kV for input/output 
lines

± 2 kV for power supply 
lines

± 1 kV for input/output 
lines

Mains power quality should be that of a 
typical commercial or hospital environment.

Surge IEC 61000-4-5 ± 1 kV differential mode
± 2 kV common mode

± 1 kV differential mode
± 2 kV common mode

Mains power quality should be that of a 
typical commercial or hospital environment.

Voltage dips, short 
interruptions, and 

voltage variations on 
power supply input 

lines. IEC 61000-4-11

<5% UT (>95% dip in 

UT) for 0,5 cycle

40% UT (60% dip in UT) 

for 5 cycles
70% UT (30% dip in UT) 

for 25 cycles
<5% UT (95% dip in UT) 

for 5 sec 

<5% UT (>95% dip in 

UT) for 0,5 cycle

40% UT (60% dip in UT) 

for 5 cycles
70% UT (30% dip in UT) 

for 25 cycles
<5% UT (95% dip in UT) 

for 5 sec 

Mains power quality should be that of a 
typical commercial or hospital environment. If 
the user of the ATLAS System requires 
continued operation during power mains 
interruptions, it is recommended that the 
ATLAS System be powered from an 
uninterruptible source.

Note: UT is the a.c. mains voltage prior to application of the test level.
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Guidance and manufacturer’s declaration – electromagnetic immunity

The ATLAS System is intended for use in the electromagnetic environment specified below. The customer or user of the ATLAS 
System should assure that it is used in such an environment.

Immunity Test IEC 60601 test level Compliance level Electromagnetic environment – guidance

Conducted RF 
IEC 61000-4-6

3 Vrms
150 kHz to 80 MHz

3 V

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the ATLAS System, including cables, 
than the recommended separation distance 
calculated from the equation applicable to the 
frequency of the transmitter.

Recommended separation distance

 80 MHz to 800 MHz

 800 MHz to 2,5 GHz

where P is the maximum output power rating 
of the transmitter in watts (W) according to 
the transmitter manufacturer and d is the 
recommended separation distance in metres 
(m).
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site 

survey,a should be less than the compliance 

level in each frequency range.b Interference 
may occur in the vicinity of equipment marked 
with the following symbol:

Radiated RF
IEC 61000-4-3

3 V/m
80 MHz to 2,5 GHz

3 V/m

Note 1: At 80 MHz and 800 MHz, the higher frequency applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection 
from structures, objects and people.

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, 
amateur radio, AM and FM broadcast, cannot be predicted theoretically with accuracy. To assess the electromagnetic 
environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength 
in the location in which the ATLAS System is used exceeds the applicable RF compliance level above, the ATLAS System should 
be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as 
reorienting or relocating the ATLAS System.
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

d 1.17 P=

d 1.17 P=

d 2.33 P=
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Recommended separation distances between portable and mobile RF communications equipment 
and the ATLAS System

The ATLAS System is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The 
customer or the user of the ATLAS System can help prevent electromagnetic interference by maintaining a minimum distance 
between portable and mobile RF communications equipment (transmitters) and the ATLAS System as recommended below, 
according to the maximum output power of the communications equipment.

Rated maximum output 
power of transmitter

W

Separation distance according to frequency of transmitter

m

150 kHz to 80 MHz 80 MHz to 800 MHz 800 MHz to 2,5 GHz

d = 1.17 d = 1.17 d = 2.33 

0,01 0.117 0.117 0.233

0,1 0.370 0.370 0.737

1 1.170 1.170 2.330

10 3.700 3.700 7.368

100 11.700 11.700 23.300

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres (m) 
can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power 
rating of the transmitter in watts (W) according to the transmitter manufacturer.

Note 1: At 80 MHz and 800 MHz, the higher frequency applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection 
from structures, objects and people.

P P P
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Symbols and Labels

Caution, consult accompanying documents. Note: There are important operating and
maintenance instructions found in the manual.

Presence of electrical shock hazard. Note: Indicates risk of electrical shock due to the
presence of uninsulated high voltage inside the instrument. Do not remove the instrument
cover or parts.

Fuse

Type B applied parts

Manufacturer

Authorized European Community Representative

Serial number

Catalog number / part number

European Conformity

Model

Patent

Type A

  0297
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Protective Packing Symbols

The protective packing symbols specify the handling requirements and the transport and
storage conditions.

Handling Requirements

Fragile, Handle with Care

Keep Dry

This end up

Transport and Storage Conditions

Relative Humidity (10% to 100%, including condensation)

Temperature (-40 to +70 deg. C)

Atmospheric Pressure Limits (500 hPa to 1060 hPa)
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Product Labels and Serial Number Location

On the right side above the connectors and on the bottom of the instrument is the product
label:

Figure 1-7 Product Label on Exterior, Right Side

On the right side to the left of the connectors is the label showing the serial number:

Figure 1-8 Product Label with Blank Serial Number

Another label above the connectors and on the bottom of the instrument identifies the
manufacturer and authorized EC representative:

Figure 1-9 Label Identifying Manufacturer and EC Representative

A power and fuse label is to the right of the connectors:

Figure 1-10 Power and Fuse Label

A small Manufactured month and year label is on the bottom of the instrument:

Figure 1-11 Manufactured Month and Year Label
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Instrument Disposition

When it comes time to upgrade the ATLAS System, please contact Carl Zeiss Meditec to
inquire about trade-in or upgrade values we may offer. Should you not wish to trade in the
instrument, please see the Disposal section below.

Disposal

This product contains electronic components. At the end of its lifetime, the product should
be disposed of in accordance with the relevant national regulations.

Disposal of the Product within the EU

In accordance with applicable EU guidelines at the time at which the product was brought
onto the market, the product specified on the consignment note is not to be disposed of
via the domestic waste disposal system or communal waste disposal facilities.

For further information on disposal of this product, please contact your local dealer or the
manufacturer or its legal successor company. Please read the latest internet information
provided by the manufacturer.

Where the product or its components are resold, the seller must inform the buyer that the
product must be disposed of in accordance with the currently applicable national
regulations.

Using the Optional Power Table

WARNING: Do not use the optional power table with an extension cord or a
power strip (multiple portable socket outlet). For additional safety, do not
plug the printer and the power table into the same wall outlet. Failure to
observe this warning could result in electrical shock to the patient and/or
examiner.

WARNING: When using the optional power table, the instrument must be
powered through the table. 
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Install the Power Table

Place the instrument on the power table so that the monitor faces the operator side. See
Figure 1-5 for a photo example.

Figure 1-12 Power Table From Above

Table power
cord plugs in
here

Other end to

Power input label
with table fuse
type and rating
fuses here, 
above power inlet

Table up/down switch

wall outlet

under here
Instrument power
cord plugs in under table here

Patient side of table
Operator side of table
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Power the Instrument Through the Table

The instrument power cord must be plugged into the power table under the left side, as
shown in Figure 1-12 and Figure 1-13. The table power cord plugs into the table at its
base as indicated in Figure 1-12. The other end must be plugged directly into a dedicated
wall power outlet. Do not use a power strip (multiple portable socket outlet) or extension
cord.

Figure 1-13 Power Table From Below

Operating the Power Table Lift

The up/down switch is on the left side, mounted under the table (Figure 1-14). To raise
the power table, press the up arrow button; to lower it, press the down arrow button.

Figure 1-14 Table Up/Down Switch

☞ Note: Your power table may look different than what is shown in this User Manual.

Instrument power cord plugs in here

Table up/down switch
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(2) Operational Overview

Chapter Overview

This chapter provides an overview of how to operate the ATLAS System. It explains basic
operations like startup and shutdown, and initial system setup tasks. It introduces common
features like the toolbar and menu system. It also provides an overview of the typical
workflow and introduces the windows you will use in these contexts. Topics include:

• System Start and Login, page 2-1
• System Check During Start, page 2-2
• User Login, page 2-4
• Logout Locks the System, page 2-5
• Change Language, page 2-6

• Initial System Setup, page 2-9
• The admin User Account, page 2-12
• Create User Accounts (admin only), page 2-9
• Archive/Synchronize Preferences, page 2-11
• Create Institution Name (admin only), page 2-12

• Operational Modes and Windows, page 2-12
• Sequence of Operation, page 2-12

• Status Bar Information, page 2-13
• Title Bar and Menus, page 2-15
• Analysis Screen Toolbar, page 2-18
• Power Down the System, page 2-19

System Start and Login

Starting the ATLAS System Instrument

To activate power, press the system power switch, found on the front of the instrument
facing the operator (see Figure 1-1 ATLAS System Hardware on page 1-4). It takes
approximately two minutes to start the ATLAS instrument and load the ATLAS System
software.

Starting ATLAS Review Software Running on a PC

To start ATLAS Review Software on a PC, double-click the ATLAS Review Software icon
(shown on the left) on your computer desktop. Alternatively, you can select Start > 
All Programs > Carl Zeiss Meditec > ATLAS Review Software.
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☞ Note: Only one instance of the ATLAS Review Software can be running at the same
time on the same computer. If you have more than one Windows User Account, you
must disable “Fast User Switching” to ensure a successful database connection. In
Windows XP, select Start > Control Panel > User Accounts > Change the way
users log on or off > Uncheck Use Fast User Switching and select Apply
Options. In Windows Vista™, select Start > Run. Type gpedit.msc and select OK.
Select Administrative Templates > System > Logon > Hide entry points for
Fast User Switching. Select the Enable radio button and select OK. Select
Always use Classic logon. Select the Enable radio button and select OK.

☞ Note: It takes approximately 15 to 60 seconds to load the ATLAS Review Software,
depending on the speed of your computer.

System Check During Start

ATLAS System software loads automatically and performs a system check before you can log in.

Figure 2-1 System Check at Startup

During system start, ATLAS checks the following items displayed on screen:

• Database – Checks accessibility and integrity of the database. If this check fails, you
will not be able to log in and use the software.

• HD (Hard Drive) Test – Checks accessibility and free space of the hard drive. If free
space is critically low, you may be required to clear archived exams before you acquire
new images, import, or synchronize.
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• Archive – Checks accessibility of the current archive location and for adequate free
space there to archive new images. You may continue without passing this check, but
archiving may not be available. Under the default settings, you will be prompted upon
shutdown to archive unarchived exams.

• Installation Integrity – Checks that critical system software files are present and have
not been altered. If this check fails, you will not be able to log in and use the
instrument.

• Instrument (Instrument only) – Checks the connectivity of the instrument hardware
with the system computer. If this check reports a camera check failure, you will not be
able to log in and use the instrument. Other instrument check failures will only stop
you from taking new exams.

Overall Pass or Fail: Below this list of items, the overall system check reports Pass or Fail. If
the system passes, it will automatically advance to user login. If it fails, the system check
will remain on screen. If this occurs, call Carl Zeiss Meditec customer service: In the U.S.,
call 800-341-6968. Outside the U.S., contact your local CZM distributor. Be prepared to
communicate the system check details, which are accessible by clicking the Details button.

Possible Interbase Login when starting ATLAS Review Software

When starting ATLAS Review Software, it is possible a Database Login dialog (Figure
2-2) will be displayed during system check if you have installed another application using
Interbase 2007 SP3 prior to installing ATLAS Review Software. 

Figure 2-2 Interbase Database Login

ATLAS uses the default Interbase User Name (sysdba) and Password (masterkey), but a
previously installed application using Interbase 2007 SP3 may be using a different user
name and password. If ATLAS Review Software is installed after the other application, it
will not change the Interbase user name and password of the other application. If this is
the case and a Database Login dialog is displayed, you will need to enter the user name
and password from the other previously installed application. Please contact your IT
administrator for the user name and password if you do not know it. After entering in the
other application’s user name and password, ATLAS Review Software will run, and you will
not need to enter this information again.
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User Login

ATLAS optionally requires users to log in to access the ATLAS System functions. To require
user login, select Require User Identification (Login) in the General tab of the
Preferences dialog on the Options Menu (Figure 2-3).

Figure 2-3 Preferences – General Tab

If checked, the User Login dialog appears automatically when the instruments passes the
system check upon startup (and each time a user logs out of the system software).

Figure 2-4 User Login Dialog

Select a user name from the drop-down list and enter the corresponding password to
access the system software. Note that passwords are case-sensitive.

• At startup of the sample data (and with a new database), a default user name (ATLAS
Operator, blank password) appears in the drop-down list. 

☞ Note: We strongly recommend that you create individual user accounts for each staff
member who acquires or analyzes images, and that staff members routinely log out to
secure the instrument. (To create user accounts, see Initial System Setup on page 2-9.) 

If you enter an invalid user name or password, a message will prompt you to try again.

Figure 2-5 Invalid Login—Prompts You To Try Again
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Patient Selection Window

When you log in successfully upon system start, the PATIENT SELECTION WINDOW appears
with the default Find Existing Patient tab selected as shown in Figure 2-6.

Figure 2-6 ATLAS Instrument Patient Selection Window – Find Existing Patient

See Identify a Patient on page 3-1 to use the PATIENT SELECTION WINDOW.

Logout Locks the System

To prevent unauthorized access, you can lock the ATLAS System software at any time by
selecting File > Logout. When you lock the ATLAS System, it reverts to the User Login
dialog, enabling you to log in again. Upon successful login, the system always returns to
the PATIENT SELECTION WINDOW.
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Change Language

To change the language for the ATLAS instrument you need to change the Windows
regional (date and time format, number format, etc.) setting and language (operating
system text) setting (see ATLAS Instrument Windows Regional and Language
Settings on page 2-6), and the ATLAS application language (ATLAS specific text) (see
ATLAS Language Setting (admin only) on page 2-7).

For ATLAS Review, your Windows regional and language settings should already be set to
those of your country. You only need to change the ATLAS application language.

ATLAS Instrument Windows Regional and Language Settings

To change Windows XP on the ATLAS instrument to your country’s regional and language
settings (date and time format, number format, operating system text, etc.), select Start >
Control Panel > Regional and Language Options to display the Regional and
Language Options window (Figure 2-7).

Figure 2-7 Regional and Language Options Window – Regional Options Tab
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On the Regional Options tab, select your country from the drop-down menu in the
“Standards and formats” section (Figure 2-7).

Figure 2-8 Regional and Language Options Window – Languages Tab

On the Languages tab, select your country from the drop-down menu in the “Languages
used in menus and dialogs” section (Figure 2-8). Select OK to save your settings. A
dialog will be displayed informing you that you will need to log off and log on for the
settings to take effect. Select Start > Log Off to log out of Windows. See User Login on
page 2-4 to log on.

ATLAS Language Setting (admin only) 

☞ To access the ATLAS Language function, you must be logged in as the admin user
(See The admin User on page 9-1).

The ATLAS Choose Language function changes the language for the ATLAS application text
only. For the ATLAS instrument, see ATLAS Instrument Windows Regional and
Language Settings on page 2-6 to change the Windows regional (date and time
format, number format, etc.) setting and language (operating system text) setting.
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To choose your language, select Options > Language... to display the Choose
Language dialog (Figure 2-3).

Figure 2-9 Choose Language Dialog

Select your language by clicking on it and then click the OK button to change the
language, or click the Cancel button to keep the current language. If you click OK, a
message will be displayed telling you that you must exit and restart the ATLAS application
for the new language to take effect (Figure 2-10).

Figure 2-10 Exit and Restart Message

Click the OK button, and then exit and restart the ATLAS application to run ATLAS in the
new language (see Power Down Through Software on page 2-19).



ATLAS User Manual 2660021135270 B

Operational Overview 2-9

Initial System Setup

Upon initial system start, one item requires your attention.

1. Create user accounts (strongly recommended): We also strongly recommend that you
create password-protected user accounts to prevent unauthorized access.

Several other initial setup items are optional but also are worthy of consideration, and are
explained in this section.

• The admin User Account, below
• Create User Accounts (admin only), page 2-9
• Archive/Synchronize Preferences, page 2-11
• Create Institution Name (admin only), page 2-12

This section explains how to perform both the required and optional initial setup tasks, but
to do so requires that we first introduce the special admin user account.

The admin User Account

To manage administrative functions, ATLAS dedicates a special user account with the user
name admin. Only the admin user can create and edit the institution name, user accounts
and staff (see The admin User on page 9-1 for details).

The admin account never appears in the drop-down list of user names on the login screen.
You must type it in. The admin account accepts any password or none. The admin user
cannot acquire or analyze images.

Create User Accounts (admin only)

At startup of the sample data (and with a new database), a default user name (ATLAS
Operator, blank password) appears in the drop-down list. 

This section explains how to create user accounts.

☞ Note: We strongly recommend that you create individual user accounts for each staff
member who acquires or analyzes images, and that staff members routinely log out
to secure the instrument. Following these procedures helps prevent unauthorized
access to ATLAS data and functions, and enables accurate record-keeping (an
operator is saved with each acquired image). 
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Register (Create) Staff (admin only)

☞ To access the Staff function, you must be logged in as the admin user (See The
admin User on page 9-1).

1. Click Options > Staff.... The Staff Registration dialog appears.
2. In the Staff Registration dialog, click New. The New Staff dialog opens.

Figure 2-11 New Staff Dialog

3. Edit the staff registration fields as desired. A staff record must have either a last name
or first name or both; other fields are optional.

4. Select Doctor or Operator, or both. Only a user defined as an operator can log onto
the ATLAS System. At exam acquisition, you can specify a doctor and operator used for
an exam, and their names will be displayed on Analysis Screen Views and reports.

5. When finished with your changes, click Save.

• To discard the changes before saving, click Cancel. A dialog prompts you to confirm
your choice.

☞ Note: If the password field is left blank, that user must leave the password field
blank to log in. User names are not case-sensitive, but passwords are.

☞ Note: Once logged in, any user can change his or her own password by selecting
Options > Change My Password... and completing the Password Change dialog.
The admin user may take advantage of this feature by creating new user accounts
with a temporary password he provides to the user, and asking the user to change
the password.

☞ Note: If a user forgets their password, you can log in as Admin and change their
password.
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Archive/Synchronize Preferences

Select Options > Preferences... and then click the Archive/Synchronize tab.

Figure 2-12 Preferences – Archive/Synchronize Tab

To have ATLAS automatically archive new and imported exams, select Auto in the Archive
section. ATLAS will check every 10 seconds for new completed and imported exams. Once
a new or imported exam is detected it will be automatically archived in the background—
no progress dialogs will be displayed. You can enable ATLAS to automatically synchronize
networked archive databases by selecting Auto in the Synchronize section. ATLAS will
check every 10 seconds for databases that are not synchronized. Once detected,
synchronization will be performed automatically in the background—no progress dialogs
will be displayed.

ATLAS also gives you a way to control the automated behavior for archive alerts. It is
possible to select one, neither or both Start up and Shutdown. 

See Preferences: Archive/Synchronize on page 10-5 for information on automatic
archiving/synchronization and alerts. You can archive manually at any time by selecting
Archive > Archive Now. To manually synchronize at any time, select Archive > Synchronize.

Figure 2-12 displays the default settings...all options are disabled.

When finished selecting your archive preferences, click OK to save your changes and exit,
or click Cancel to exit without saving.

☞ Note: For network archive locations, the ATLAS System will archive exams only to
the current archive location (for more information on the current archive location,
see Set Current Archive on page 10-20). If no current archive is selected, the
system will not archive. If an error occurs that prevents a successful archive, the
ATLAS System will notify you.
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Create Institution Name (admin only)

☞ To access the Institution function, you must be logged in as the admin user 
(See The admin User on page 9-1).

Use the Institution Edit dialog to customize your system with the name of your
institution. The institution name will appear on all analysis printouts.

Follow the steps below to create the institution name:

1. Click Options > Institution.... The Institution Edit dialog opens.

Figure 2-13 Institution Edit Dialog

2. In the Name field, type the name of your institution. The field requires at least one
character and accepts up to 64 characters, including spaces—it cannot be empty.

Operational Modes and Windows

ATLAS operates in four modes, three of which are associated with a primary window:

Sequence of Operation

The flow chart below illustrates the sequence of operation and the relationship of the
operational modes. 

Figure 2-14 Sequence of Operation

Table 2-1 Operational Modes and Windows

Operational Mode Primary Associated Window

Patient Selection Mode Patient Selection Window

Data Management Mode Menu bar of Patient Selection Window

Exam Acquisition Mode Exam Acquisition Screen

Analysis Mode Analysis Screen

Patient Selection

Analysis

System Start

User Login

Image Acquisition

Data Management, e.g.:
•Patient Management

•Archive / Retrieve
•Import / Export

•User / Password Management
•Disk Space Monitor
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Patient selection mode is the default mode when you log in to ATLAS. It is the launch point
for the clinical functions of ATLAS: image acquisition and analysis. You must identify a
patient before you can either acquire or analyze exam data; and when you finish image
acquisition you can go to analysis, or return to patient selection mode. Other windows and
dialogs are regularly used within each mode, as a subset of the primary function or as an
adjunct, like printing analysis output. 

Data management mode operates independently and has no primary window; it operates
in various windows, which you access via menu options. Data management functions
critical for data preservation, like archive and backup, operate automatically, by default. 

This manual will introduce each window and dialog in relevant sections that explain its use.

Status Bar Information

The status bar along the bottom of the screen at lower right presents current status
information using text and signal light graphics. The status bar only appears in Patient
Selection Mode.

Figure 2-15 Status Bar Information

Auto Archive State

The Auto Archive (On/Off) state indicates if Auto Archive is enabled or disabled. When
Auto Archive On is displayed, Auto Archive is enabled. To enable/disable Auto Archive,
select Options > Preferences > Archive/Synchronize when in Patient Selection Mode (see
Preferences: Archive/Synchronize on page 10-5).

Auto Synchronize State

The Auto Sync (On/Off) state indicates if Auto Synchronize is enabled or disabled. When
Auto Sync On is displayed, Auto Synchronize is enabled. To enable/disable Auto
Synchronize, select Options > Preferences > Archive/Synchronize when in Patient Selection
Mode (see Preferences: Archive/Synchronize on page 10-5). 

Current User

The name of the current user appears in the status bar to the left of the signal lights in all
software modes. See User Login on page 2-4.

Instrument Hard Disk
Current user StatusStatus

Archive
Status

Camera
StatusAuto Synchronize stateAuto Archive state

Synchronize
Status
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Camera Status Indicator (Instrument Only)

The first signal light on the left indicates whether or not the camera is ready to acquire new images.

• The red circle with a white “X” indicates the camera is not available.
• Yellow: A yellow light indicates the camera is ready to acquire images.
• Off: A light off means the camera is not ready. A light off indicator results from a

system malfunction. If the latter occurs, we suggest you cycle power (power off and
then power on the instrument). If the problem persists, contact CZM customer service.

Instrument Status Indicator (Instrument Only)

The second signal light on the left indicates whether or not the instrument hardware is in
communication with the system computer, and therefore capable of acquiring new images.

• The red circle with a white “X” indicates the instrument is not available.
• Yellow: A yellow light indicates readiness to acquire images.
• Off: A light off means you cannot acquire new images. A light off indicator results

from a system malfunction. If the latter, we suggest you power down the ATLAS
instrument (see Power Down the System on page 2-19) and then turn it back on.
If the problem persists, contact CZM customer service.

Hard Disk Status Indicator

This signal indicates available hard disk space status as follows. Mouse over the indicator
for details.

• Green: More than 500 MB available hard disk space.
• Yellow: Between 200 MB and 500 MB available hard disk space. When hard disk

space is low, you must acknowledge it by clicking OK before continuing to the login
screen. Also, the system begins to automatically clear archived exam data.

• Red: Less than 200 MB available hard disk space. When hard disk space is critically
low, both capturing and analysis are disabled. You must clear a sufficient amount of
hard disk space by clearing archived exams to continue. If there are insufficient
archived exams to be cleared, you must first archive exams and then clear them. You
cannot clear unarchived exams.

Archive Status Indicator

This archive volume space indicator reports status as shown below. Mouse over the
indicator for details.

• The red circle with a white “X” indicates that the current archive location is not accessible.
• Green: More than 1000 MB available network archive disk space.
• Yellow: Between 200 MB and 1000 MB available network archive disk space. When

archive disk space is low, you will be prompted to change the archive location, but you
can continue using the same archive location for now.

• Red: Less than 200 MB available network archive disk space. When the red indicator
shows, the software will stop archiving to this location. You must change to a new
archive location to re-start archiving.
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Synchronize Status Indicator

The Synchronize indicator reports synchronization status in terms of connectivity as shown
below. Mouse over the indicator for details.

• The red circle with a white “X” indicates that no synchronization volumes are enabled.
• Green: All enabled synchronization volumes are connected.
• Yellow: At least one enabled synchronization volume is connected, and at least one

enabled synchronization volume is disconnected.
• Red: All enabled synchronization volumes are disconnected. When the red indicator

shows, you must connect at least one enabled synchronization volume before
synchronization can occur.

☞ Note: The Hard Disk / Archive status indicators are refreshed every five minutes. To
manually refresh them, select Tools > Refresh Disk Monitor.

☞ Note: Each ATLAS exam will take approximately 1.5 mb of hard disk space. If you
also take photopic and scotopic images with the exam, the size will be
approximately 4 mb.

Title Bar and Menus

Note that the Title bar, menu bar, and menus only appear in Patient Selection Mode on the
ATLAS instrument.

Title Bar

The title bar atop the screen contains:

• at left, the ATLAS name
• in the center, the currently selected patient’s name (first, last), date of birth, 

and ID number.
• at right, the close button , to exit the system software.
• On ATLAS Review Software only, a Minimize and Maximize window button are also

displayed.

Figure 2-16 Title Bar Information

Menu Bar and Menus

The menu bar appears below the title bar and contains the File, Edit, Archive, Tools,
Options and Help menus. Click to select menus and menu items. Note the following
general characteristics of the menus.

• Disabled menu items appear in gray. They are not available in the current context.
• Items with “...” following indicate the menu item launches a dialog giving you further

options before the command is executed.

ATLAS name

Selected patient’s name, DOB, ID number Minimize window

Maximize window

Close/Exit button
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The table below identifies and describes the items in each menu. Note the keyboard
shortcuts to the right of applicable menu items.

Menu Items Description
• Find Existing Patient Displays the Find Existing Patient tab of the PATIENT 

SELECTION WINDOW.

• View Today’s Patients Displays the View Today’s Patients tab of the PATIENT 
SELECTION WINDOW.

• Add New Patient 

(Instrument Only)
Displays the Add New Patient tab of the PATIENT 
SELECTION WINDOW.

• Import > Imports patient data & exams from the following media:
• From ATLAS 9000 Series Export Media...
• From ATLAS 900 Series...

• Export > Exports patient data & exams to the following media:
• To ATLAS 9000 Series Export Media...

• To DICOM...

• For Research

• Log Out... Logs out the user, locks the system software, invokes the 
User Login dialog.

• Exit Exits the system software.

• Edit Patient... Opens the selected patient for editing.

• Delete Patient Deletes the selected patient.

• Merge Two Patients... Opens the Patient Merge dialog, where you can select 
two patients to merge.

• Delete Exam Deletes the selected exam.

• Archive Management... Opens the Archive Locations dialog, where you can 
create and manage archives.

• Synchronize Management... Opens the Archive Locations to Synchronize 
dialog, where you can add and delete archives for 
synchronization.

• Archive Now Initiates archive of all unarchived exams.

• Clear Archived Exams Clears (deletes) archived exams from the ATLAS System 
hard drive.

• Synchronize Manually synchronizes patient and exams between the 
ATLAS System hard drive and network archive locations.

• Retrieve Archived Exams Enables you to retrieve data from an archive location.

File Menu

Edit Menu

Archive Menu
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• Back Up Configuration Files When logged in as admin, enables you back up ATLAS 
Configuration Files to an archive location.

• Retrieve Configuration Files When logged in as admin user, enables you retrieve 
ATLAS Configuration Files from an archive location.

• Refresh Disk Monitor Refreshes the Hard Disk / Archive status indicators on the 
status bar.

• Calibration Check... 

(Instrument Only)
Runs a calibration check with the test eyes.

• Run ATLAS Importer... Opens the ATLAS 900 Series Importer dialog where 
you can select, configure, and import ATLAS 900 
Instrument Databases and ATLAS 900 Export Media. 

• Database Recovery Tool... When logged in as admin user, enables you to 
synchronize from a database archive for database 
recovery.

• Preferences... Opens the Preferences dialog, where you can select 
archive, synchronization, and system preferences.

• Language... When logged in as admin user, enables you to select the 
language for the ATLAS software.

• Parameter Set... Opens the Parameter Set dialog, where you can 
create, edit, or delete Parameter Sets.

• Auto ATLAS 900 Series Importer 

Setting...
Allows you to turn on automatic importing of ATLAS 900 
data and select the rate of checking.

• Change Database... When logged in as admin user, enables you to change to 
another existing database or create a new database.

• Institution... When logged in as admin user, enables you to customize 
your ATLAS and reports generated from it by editing the 
institution name. 

• Staff... When logged in as admin user, enables you to create, 
edit or delete staff as users.

• Categories Registration... When logged in as admin user, enables you to create, 
edit or delete categories, which you can apply to patients 
and search with.

• Change My Password... Enables you to change the password for the current user.

• View User Manual... F1 Opens the ATLAS User Manual in PDF format.

• View Licenses... Displays registered software licenses.

• About... Displays the About dialog, which provides software 
version information.

Menu Items Description
Tools Menu

Options Menu

Help Menu
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Analysis Screen Toolbar

Figure 2-17 Analysis Screen Toolbar

The Analysis Screen Toolbar is only available on the ANALYSIS SCREEN. Its buttons have the
following functions:

Button Name and Function

More (F2): Displays additional windows on the ANALYSIS SCREEN which allow you to 
customize the view of the image, select different exams and views, and edit Parameter Sets.
Can be activated by pressing the F2 key on the keyboard. Not available in the Trend Analysis 
and MasterFit II Displays.

Print: Selecting Print (or Print > Print current screen) will open a standard Windows Print 
dialog where you can select print options and print the current Analysis Screen. If you 
have selected reports on the Printing / DICOM Export Options dialog of the current 
Parameter Set, selecting Print > Print report will print Reports and Views for the currently 
selected exam(s).

Export: Selecting Export (or Export > Export current screen to file) will open a save dialog 
where you can save the current exam’s analysis output screen in various file formats, 
including BMP, JPG, TIFF, and PDF. If you have enabled DICOM Data Export, selecting 
Export > Export current screen to DICOM will export the current screen to a DICOM 
system, while Export > Export report to DICOM will export the same Reports and Views as 
Print > Print report to a DICOM system.

Exit: Exits the ANALYSIS SCREEN and takes you back to the PATIENT SELECTION WINDOW where 
you can select another patient or exit the program.

Exams: Displays a pop-up list of exams for the patient. Selecting an exam on the list will 
automatically change the current View on the ANALYSIS SCREEN to the selected exam.

The View (F3) pop-up menu displays a list of exam Views. Can be activated 
by pressing the F3 key on the keyboard.
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Power Down the System

You can power down the ATLAS System Instrument through either hardware or software. In
either case, the system goes through a soft shutdown sequence. You can exit ATLAS Review
only through software.

CAUTION: You must power down the operating system safely. Not doing so
may damage the hard drive causing it to boot into safe mode, display random
errors, or cause the ATLAS application to fail to launch. If the software or
operating system is busy, you may have to wait for it to complete.

Power Down Through Software

Click File > Exit, or click the  at upper right. An Exit Dialog opens as shown on the
left.

Select Yes to close the ATLAS application and exit to the Windows operating system. To
conclude system shutdown, you must click Start > Shut Down or Turn off your computer,
and then select Shut Down or Turn off.

If an archive or synchronization alert is set to occur upon shutdown (see Preferences:
Archive/Synchronize on page 10-5), the alert dialog(s) will be displayed before the
ATLAS application closes.

Power Down Through Hardware for the ATLAS System Instrument

On the ATLAS System instrument, press the system power switch (see Figure 1-1 on page 1-4).
The system will automatically close the ATLAS application and Windows operating system
and power down the instrument.

If an archive or synchronization alert is set to occur upon shutdown (see Preferences:
Archive/Synchronize on page 10-5), the alert dialog(s) will NOT be displayed before
the ATLAS application closes.

The Display (F4) pop-up menu displays a list of available Displays. Can be 
activated by pressing the F4 key on the keyboard.

Button Name and Function
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(3) Acquire Images (Instrument Only)

Chapter Overview

This chapter explains in detail how to acquire ATLAS images. It covers the following areas:

• Prepare the Patient, page 3-1
• Identify a Patient, page 3-1
• Image Parameters Screen, page 3-5
• Exam Acquisition Screen, page 3-6
• Exam Preview/Exam Results Screen, page 3-9
• Image Quality, page 3-17

Prepare the Patient

☞ Note: The forehead and chin rests should be cleaned between each examination
with an alcohol prep swab.

The patient’s exam experience with the ATLAS System is normally brief and comfortable.
An experienced operator can acquire good images from each eye in a few minutes. An
exam usually requires the patient to look inside the imaging aperture for 1-3 minutes at a
time for each eye. The instrument acquires most images in just a few seconds. The
additional time is required to align the patient’s eye before capturing to optimize image
quality. Note that the ATLAS System is never to contact the patient's eye.

Identify a Patient

Capturing an image and image analysis are disabled until you identify a patient. Use the
PATIENT SELECTION WINDOW to identify (select or add) a patient. After system start and login,
the PATIENT SELECTION WINDOW appears by default. (From other modes, select File > Find
Existing Patient to return to the PATIENT SELECTION WINDOW.) You can identify a patient using
any of the three tabs provided. For details on using these tabs to identify a patient, see the
indicated sections.

• Find Existing Patient, below
• Add New Patient (Instrument Only), page 3-3
• View Today’s Patients, page 3-4

On any of the three tabs, once you identify the patient, click Capture Image to initiate a
new exam for that patient. The IMAGE PARAMETERS SCREEN appears. Proceed to the Image
Parameters Screen on page 3-5.



Acquire Images (Instrument Only)

ATLAS User Manual 2660021135270 B

3-2

☞ Note: If you have checked Always use current Parameter Set for acquisition
(Instrument Only) on the General tab of the Preferences dialog (Figure 3-1), then you
will go directly to the EXAM ACQUISITION SCREEN using the current Parameter Set, and will not
be able to select a Parameter Set. Proceed to the Exam Acquisition Screen on page 3-6.

Figure 3-1 Always Use Current Parameter Set for Acquisition (Instrument Only)

Find Existing Patient

On the default Find Existing Patient tab (Figure 3-2), select a patient from the patient
list displayed.

Figure 3-2 Patient Selection Window – Find Existing Patient

 Check this to use the 

and bypass the IMAGE

PARAMETERS SCREEN during
image acquisition 

current Parameter Set

 Click Capture Image

to begin image acquisition
(or double-click the patient) 
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To search the patient list:

• To search for patients by Name or Patient ID, type in the corresponding fields and click
Search. You can search using partial information, and you can use one or both fields.

• Click Advanced Search if you want to search using additional parameters—see
Advanced Search on page 9-6 for details.

• The search returns all patients that match all defined parameters, sorted
alphabetically.

• When you search by Name, the search applies to last name, first name, middle
name, prefix and suffix, and returns all patients that match from the beginning of any
of these fields.

• In the Results list, you can select only one patient at a time. When you select a
patient, the Capture Image button becomes active (on the ATLAS instrument only). 
If the patient has saved exams, the Analysis button also becomes active.

When you click Capture Image (or double-click the patient), the IMAGE PARAMETERS SCREEN

appears. Proceed to the Image Parameters Screen on page 3-5.

☞ Note: If you have checked Always use current Parameter Set for acquisition
(Instrument Only) on the General tab of the Preferences dialog (Figure 3-1), then you
will go directly to the EXAM ACQUISITION SCREEN using the current Parameter Set, and will not
be able to select a Parameter Set. Proceed to the Exam Acquisition Screen on page 3-6.

Add New Patient (Instrument Only)

To add a new patient, click the Add New Patient tab (Figure 3-3) and fill in at least
the required fields, which are indicated by the red asterisk (*). Since a Patient ID is required
for DICOM-compliant import and export of patient data, if you do not enter a Patient ID,
the system will create a unique ID automatically for this patient. 

Figure 3-3 Add New Patient Tab of the Patient Selection Window
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If you want to select one or more categories for this patient, check the categories from the
Add Categories list on the right.

When you click Save, the new patient information is saved to the database and to the list
of today’s patients. If data is missing from required fields, you will be prompted to
complete these fields before you can save.

When you click Capture Image, the IMAGE PARAMETERS SCREEN appears. Proceed to the
Image Parameters Screen on page 3-5.

☞ Note: If you have checked Always use current Parameter Set for acquisition
(Instrument Only) on the General tab of the Preferences dialog (Figure 3-1), then you
will go directly to the EXAM ACQUISITION SCREEN using the current Parameter Set, and will not
be able to select a Parameter Set. Proceed to the Exam Acquisition Screen on page 3-6.

View Today’s Patients

To select a patient from the list of today’s patients, select the View Today’s Patients tab
(Figure 3-4).

Figure 3-4 View Today’s Patients Tab of the Patient Selection Window

How the Today’s Patients List is Populated

Today’s patients list is populated automatically with new patients added today (manually,
imported from ATLAS 9000/ATLAS 900 Series data, or imported by worklist if you have
licensed the optional DICOM Gateway software (see (C) DICOM Gateway (Optional))),
and patients with new exams completed today. The list is sorted alphabetically by last name.
If you have licensed DICOM Gateway, select Refresh Patient List to refresh the patient list. If
you have licensed the optional MasterFit II software (see (B) MasterFit II (Optional)),
patients with MasterFit II data saved today will also appear in the Today’s patients list.
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Click to select the desired patient and then click Capture Image (or double-click the
patient). The IMAGE PARAMETERS SCREEN appears. Proceed to the Image Parameters
Screen on page 3-5.

☞ Note: If you have checked Always use current Parameter Set for acquisition
(Instrument Only) on the General tab of the Preferences dialog (Figure 3-1), then you
will go directly to the EXAM ACQUISITION SCREEN using the current Parameter Set, and will not
be able to select a Parameter Set. Proceed to the Exam Acquisition Screen on page 3-6.

Image Parameters Screen

The IMAGE PARAMETERS SCREEN (Figure 3-5) allows you to select a Parameter Set for the
current image. Details of the Parameter Set are also displayed.

Figure 3-5 Image Parameters Screen

At the top of the screen, move the mouse over the currently defined Parameter Set buttons.
As the mouse is over a Parameter Set button, details of the Parameter Set are shown
below. You can see a list of reports and images that will print out at the end of the exam,
Photopic and/or Scotopic image capture options, Exam Preview and Smart Capture
options, and the default Display and View(s). See Editing Parameter Sets on page 8-1
for more information on Parameter Sets. 

☞ Note: In a Parameter Set, the Exams dialog on the EDIT PARAMETERS SCREEN allows you
to set default exam settings for image acquisition (Instrument Only). You can select
whether you capture Photopic and/or Scotopic images, show the Exam Preview
Screen, select a default doctor and operator, and other settings. See Exams on page
8-9 for more information on the Exams dialog.
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To acquire the image, click on one of the ten Parameter Set buttons, or click on the Use
[Parameter Set] button in the lower right to use the currently selected Parameter Set. The
EXAM ACQUISITION SCREEN appears. Proceed to the Exam Acquisition Screen below.

Exam Acquisition Screen

After you select a Parameter Set, the EXAM ACQUISITION SCREEN is displayed (Figure 3-6).

Figure 3-6 Exam Acquisition Screen – Good Focus and Alignment

A live video image of the subject’s eye appears with white crosshairs, and white Placido
rings over the pupil and iris. Proper alignment is required in three dimensions, X, Y
(transverse) and Z (axial). ATLAS provides alignment controls using the joystick and vertical
alignment knobs on either side of the chin rest.

☞ Note: If you have not captured the image in 100 seconds, ATLAS stops the live video
and displays the message, “Exam time out. Press any key to continue with exam.” 
To continue with the exam, press any key on the keyboard.

Position the Patient

During an examination, the patient places his/her chin on the chinrest and forehead on the
forehead rest. The patient looks into the imaging aperture and sees a small orange fixation
light against a dark background. When an image is taken, the patient will see a brighter
red illumination light flash for a split second. If a photopic image is also taken, then the red
illumination light will remain on for a couple seconds. During this time, the patient’s pupil
constricts to its photopic size. 
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1. Seat the patient facing the projection head. Position the patient’s chin on the chinrest.
Use the vertical adjustment knobs to move the chin rest up or down to fit the patient.
The patient’s mouth should be closed and the eyes should be in line with the canthus
marks just below the forehead rest. See photo on the left.

2. Make sure the patient’s head is aligned properly at approximately 45° angle in the
chinrest (aligned with the arrows on the chin rest), with the chin centered in the proper
position. The chin should be pressed firmly down in the chinrest. See photo on the left.

3. Be sure the patient’s forehead is pressed against the forehead rest. See photo on the left.
4. Ask the patient to look at the orange fixation light and remain as still as possible while

you align the projection head.

Align the Projection Head and Focus the Image

Follow these steps to bring the eye into the center of the image and capture the image:

1. Check to see that the joystick is unlocked. The projection head should move forward,
backward, and from side to side easily.

☞ Note: Check the lock at the base of the projection head by turning the joystick
counter-clockwise to loosen. This lock should be tightened only when the instrument
is being moved. During normal operation, leave the lock completely loosened.

2. Position the projection head by moving the base until the live image of the eye
appears on the screen. Use the joystick to bring the cornea into view in the display.
Push away from you to move eye closer to the imaging aperture. Move the joystick
towards you to increase the distance between they eye and imaging aperture.

3. Adjust the height of the instrument by rotating the joystick handle until the rings
appear. Rotate clockwise to move the crosshairs up, and counter-clockwise to move
the crosshairs down.

4. Center the crosshairs anywhere inside the smallest white ring of the live image.
5. Move the joystick forward and back to focus. The intent is to achieve the clearest

image of all the rings. See Figure 3-6 for an example of good focus and alignment.
If you want to cancel out of image acquisition, press the Cancel button.

How to Get the Best Images

• Ask the patient to blink “naturally” (quick blink) just before you capture the image.
This causes the tear film to be distributed evenly over the cornea. A “slow” blink
usually does not work as well as a “quick” one.

• If the patient has ptosis, have an assistant stand to the side of the instrument and
hold the patient’s eyelid up, being careful not to block the optical path of the
instrument and not to press on the patients eye.

• If the patient has dry eyes and the reflected image appears very faint, or the reflected
rings are too broken or irregular to process accurately, you may need to apply
non-viscous artificial tears to the patient’s eye.

• Ask the patient to open both eyes as wide as possible just before you capture the image.

Canthus Mark



Acquire Images (Instrument Only)

ATLAS User Manual 2660021135270 B

3-8

Figure 3-7 shows an image out of alignment. Note that the crosshairs are not centered
inside the smallest white circle.

Figure 3-7 Exam Acquisition Screen – Out of Alignment

Figure 3-8 shows an image out of focus and alignment. The image is out focus—all the
white rings are not clear. The crosshairs are not centered inside the smallest white circle. 

Figure 3-8 Exam Acquisition Screen – Out of Focus and Alignment
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Capture the Image

The ATLAS SmartCapture Image Analysis technology captures images at a rate of 15 images
per second before you actually press the joystick button/spacebar. When the
joystick/spacebar is pressed, the ATLAS System stops collecting images. If the Use
SmartCapture™ option is on (see Use SmartCapture™ (Instrument Only) on page
8-10), SmartCapture analyzes these images and uses the best acceptable image for image
processing on the EXAM RESULTS SCREEN (or best four images for the EXAM PREVIEW SCREEN).

When the crosshairs are centered on the live video image and it is in clear focus, ask the
patient to blink naturally and then open their eyes wide. Quickly make any minor
corrections to the focus. Then press the button on the top of the joystick (or press the
spacebar) to capture the image.

☞ Note: If the chin rest sensors were not able to determine which eye was imaged, the
software will prompt you to select an eye. This is most often caused by patient
movement, or incorrect positioning in the chinrest.

After pressing the joystick button/spacebar, the image(s) is presented on the EXAM RESULTS

or EXAM PREVIEW SCREEN, where you can save/edit the image(s) and/or capture an image for
another eye. To proceed, see Exam Preview/Exam Results Screen below.

☞ Note: If Exam Preview is not enabled and the image captured is of Low quality, the
software may not be able to process the image. You will be notified to try again, or
continue to the EXAM RESULTS SCREEN, saving only the Rings image.

Exam Preview/Exam Results Screen

After you capture an image, the EXAM PREVIEW SCREEN (Figure 3-9) or EXAM RESULTS SCREEN

(Figure 3-10) will be displayed, depending on the Parameter Set’s Exam Preview setting.
The EXAM PREVIEW SCREEN (Figure 3-9) will only be displayed if the current Parameter Set
has the Exam Preview option checked (see Exam Preview (Instrument Only) on page
8-10). Otherwise, the EXAM RESULTS SCREEN (Figure 3-10) will be displayed.

Both the EXAM PREVIEW SCREEN and the EXAM RESULTS SCREEN allow you to evaluate image
quality, re-capture or save images, acquire additional images, edit pupil and limbus
contours, select the doctor and operator for the exam, and add remarks. While the EXAM

RESULTS SCREEN displays only the last image (or best image if the Use SmartCapture™ option
is on), the EXAM PREVIEW SCREEN displays the last four images (displayed in chronological
order, left to right) in the image frame buffer (or best four images if the Use
SmartCapture™ option is on). On the EXAM PREVIEW SCREEN, you need to click the Save
button below the image(s), or the checkmark(s) in the Save column of the Data
Parameters Table, for the images(s) you want to save or view. A green checkmark ( )
indicates the image will be saved or viewed. Click again to display a red X ( )
indicating the image will not be saved or viewed. Unlike the EXAM RESULTS SCREEN, the EXAM

PREVIEW SCREEN has a Data Parameters Table, and selectable Views for the images by using
the Views menu (see View Image/Views on page 3-12). The View name is displayed
below the images. 
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Figure 3-9 Exam Preview Screen – Rings Image

On the EXAM RESULTS SCREEN, a Rings View and a rendered Axial Curvature View along with
color scale (Auto Color Scale) is displayed for the captured image.

Figure 3-10 Exam Results Screen – Rings Image

☞ Note: The units (mm or Diopters) for the Views and Data Parameters Table are set in
the Views menu for the selected Parameter Set. See Views on page 8-7.

Image Acquisition Date & TIme,

Enter exam remarks in this field 
for the image you are saving.

Edit Pupil
and Limbus button

Data Parameters Table

Patient Name,
 ID & Date of Birth

Click Save to display the green 

you want to save/view.
checkmark for the image(s)

Eye (OD or OS) 

Patient Name,
ID & Date of Birth 

Exam quality

Eye (OD or OS),
Image Acquisition Date & TIme

Edit Pupil
and Limbus button
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Data Parameters Table (Exam Preview Screen only)

A Data Parameters Table displays the Image Quality and a PathFinder II Eligible field. See
Exam Quality below.

Parameter values for Eccentricity, Shape Factor, Flat and Steep Sim K’s, HVID, and Pupil
Diameter are shown for each image. The mean and standard deviation values for these
parameters are also displayed for the images. See Data on page 7-7 for more information
on these image parameters. A green checkmark ( ) indicates the image will be saved or
viewed; a red X ( ) indicates the image will not be saved or viewed.

Oculign®

The word “OcuLign®” is displayed if the current Parameter Set has this option selected.
See OcuLign® on page 8-9. Also, an “OcuLign® OK” or “OcuLign® not OK” message
will be displayed below the image. If “OcuLign® not OK” is displayed, an error code with
error description will also be displayed (see Table 3-1 below).

Exam Quality

An exam quality indicator (shown in the bottom left corner of the EXAM RESULTS SCREEN, and
in the Data Parameters Table on the EXAM PREVIEW SCREEN) displays High, Medium, or Low.
Medium is acceptable for image analysis. Low is a poor quality image and attempts should
be made to acquire or select a better image. If the captured image is of Low quality, the
text “Unable to display” will be displayed instead of the Axial Curvature View on the EXAM

RESULTS SCREEN, and the Axial, Tangential, and Elevation Views of the EXAM PREVIEW SCREEN.

☞ Note: Low quality images can be saved but not analyzed with PathFinder II.

☞ Note: If the image cannot be used by PathFinder II, the message “Insufficient data
for PathFinder II analysis” will be displayed on the EXAM RESULTS SCREEN, and
“FAIL” in the PathFinder II Eligible field on the EXAM PREVIEW SCREEN.

See Image Quality on page 3-17 for a discussion of image quality problems.

Table 3-1 OcuLign® Error Code Descriptions

Limbus coverage too high in photopic image. Failed to detect scotopic limbus.

Eye not centered in photopic image. Failed to detect scotopic pupil.

Limbus coverage too high in scotopic image. No suitable iris structure.

Eye not centered in scotopic image. OcuLign check failed.

Displacement between scotopic and photopic image. Ring image file not found.

Failed to detect photopic limbus. Photopic file not found.

Failed to detect photopic pupil. Missing ring image or photopic image data.
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View Image/Views

Rings / Rings Image

On the EXAM PREVIEW SCREEN, Select Rings image to view the captured Rings image (Figure
3-9). On the EXAM RESULTS SCREEN, Select Rings to view the captured Rings image (Figure
3-10). 

The Rings image shows the captured image with white Placido rings in the background.
The detected ring edges are shown with red overlays if Show Rings is checked. Uncheck
Show Rings to turn off the red rings overlay. The pupil contour can be shown with green
overlays if Show Pupil is checked, and the limbus contour can be shown with green
overlays if Show Limbus is checked.   

On the EXAM PREVIEW SCREEN, the Rings Image default display settings are set in the current
Parameter Set’s Single View setting (see Default Views on page 8-5).

Photopic Pupil

Select Photopic Pupil (if captured) to view the Photopic Pupil image (with light) (Figure
3-11).

Figure 3-11 Exam Results Screen – Photopic Pupil Image
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Scotopic Pupil

Select Scotopic Pupil (if captured) to view the Scotopic Pupil image (no light) (Figure
3-12).

Figure 3-12 Exam Results Screen – Scotopic Pupil Image

Axial / Tangential / Elevation (Exam Preview Screen only)

Select Axial to view the captured images with the Axial Curvature View (see Axial
Curvature on page 6-2). Select Tangential to view the captured images with the
Tangential Curvature View (see Tangential Curvature on page 6-4). Select Elevation to
view the captured images with the Elevation View (see Elevation on page 6-6). The View
name is displayed below the images.

The default display settings are set in the current Parameter Set’s Single View setting (see
Default Views on page 8-5). The pupil contour can be shown with green overlays if
Show Pupil is checked, and the limbus contour can be shown with green overlays if Show
Limbus is checked.   
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Doctor

The Doctor pop-up menu displays a list of previously defined doctors where you can select
one to be associated with this exam. 

A default doctor’s name can be set for the current Parameter Set and will be displayed
here. See Exams on page 8-9.

Once an exam is saved, the doctor’s name cannot be changed.

Operator

The Operator pop-up menu displays a list of previously defined operators where you can
select one to be associated with this exam.

A default operator’s name can be set for the current Parameter Set and will be displayed
here. See Exams on page 8-9.

Once an exam is saved, the operator’s name cannot be changed.

Remarks

Enter any comments or remarks you want to include with the exam (50 characters max).
This text will be displayed in exam images, reports, and in the Comment field for the
patient’s exam on the PATIENT SELECTION WINDOW. Once an exam is saved, the remarks
cannot be changed.

Cancel

Click Cancel to delete the current image on the EXAM RESULTS SCREEN, or images on the
EXAM PREVIEW SCREEN (the image(s) will not be saved, even if checked for saving), and
return to the EXAM ACQUISITION SCREEN to re-capture an image.

This is recommended in case that the rings were not detected properly due to a
pathological condition, or if the image quality is poor due to operator or subject error (see
Image Quality on page 3-17).

Acquire Another

Click Acquire Another to return to the EXAM ACQUISITION SCREEN to capture additional
images. The current image (or selected images marked for saving) will be saved. On the
EXAM PREVIEW SCREEN, you need to click the Save button below the image(s) you want to
save before you can click Acquire Another. A green checkmark ( ) indicates the image
will be saved; a red X ( ) indicates the image will not be saved.

Done

Click Done to save the acquired image on the EXAM RESULTS SCREEN and return to the
PATIENT SELECTION WINDOW. On the EXAM PREVIEW SCREEN, you need to click the Save button
below the image(s) you want to save before you can click Done to save the image(s) and
return to the PATIENT SELECTION WINDOW. A green checkmark ( ) indicates the image will
be saved; a red X ( ) indicates the image will not be saved.
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If you have Auto print after acquisition checked in the Printing / DICOM Export Options
dialog of your current Parameter Set (see Printing / DICOM Export Options on page
8-11), then the selected reports and Views (in the Printing / DICOM Export Options dialog)
will be printed for each eye when you select Done. If Auto export after acquisition is
checked, then the selected reports and Views will be exported to a DICOM system
automatically at the end of image acquisition (when you click the Done button). See Done
on page 3-14. See Report Options on page 8-12 for selecting Views included in the
Reports. See (6) Views for information on Views. See Exporting Data to DICOM
Systems on page 11-25. 

Figure 3-13 Edit Parameters – Printing Options

☞ Note: If multiple exams have been selected or acquired for one eye before you select
the Done button, only the reports and Views for the last exam will be printed.

Views

Click Views to go to the ANALYSIS SCREEN for exam analysis. On the EXAM PREVIEW SCREEN,
you need to click the Save button below the image(s) you want to view/save before you can
click Views. A green checkmark ( ) indicates the image will be viewed/saved; a red X ( )
indicates the image will not be viewed/saved. See (4) Image Analysis for more
information. When you exit the ANALYSIS SCREEN you will be returned to the EXAM PREVIEW or
EXAM RESULTS SCREEN. All selected images that were viewed/saved are now marked with a
grey checkmark ( ) indicating that they have been saved.

Click Acquire Another to capture additional images. 

 

If Auto export after acquisition is
checked, then selected reports
will be exported to a DICOM
system when you click Done.

If Auto print after acquisition is
checked, then selected reports
will print when you click Done.
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Edit Pupil and Limbus—Exam Edit Screen

☞ Note: Once an exam is saved, you will not be able to edit the pupil and limbus
diameters.

Selecting the Edit Pupil and Limbus button will display the EXAM EDIT SCREEN (Figure
3-14). The EXAM EDIT SCREEN allows you to edit the pupil and limbus contours for more
accurate diameter measurements.

Figure 3-14 Exam Edit Screen – Pupil Selected

The pupil contour is displayed as a circle overlay. The limbus contour is displayed as two
vertical contour arc overlays—an arc on the left and an arc on the right. 

On the bottom of the image, the diameters of the pupil and limbus (also known as HVID)
are displayed in mm rounded to the nearest 0.1 mm. 

Changing the Pupil or Limbus Contours

Select Pupil or Limbus to edit or delete the pupil or limbus contours, respectively. 

Select Edit to move or change the size of the selected contour. The selected contour will be
green, and the non-selected contour is shown in red in the image display area. Use the
movement buttons (Up, Down, Left, Right) or CTRL + arrows keys on the keyboard to move
the contours. Use the size buttons (Larger, Smaller) or Page Up/Down keys on the keyboard
to change the size of the contour. The selected contour will move or change in size in the
image display area as you press a button or key.

☞ Note: The largest pupil diameter allowed is 11.0 mm, and the smallest pupil
diameter allowed is 0.5 mm. The largest limbus diameter allowed is 15.0 mm, and
the smallest limbus diameter allowed is 10.0 mm.

Green Pupil

Pupil and Limbus 
Contour buttons

Contour Circle

Red Limbus
Contour Arcs 

(Pupil is selected) 
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Select Delete to delete the contour.

Select Normal to display the original displayed contour determined at image acquisition.

When your finished, click OK to save your changes and return to the EXAM RESULTS SCREEN.
The Rings Image will reflect your changes. Click Cancel to return to the EXAM RESULTS

SCREEN without making any changes.

Image Quality

Image quality can be poor due to operator or subject error. Things to look for on the EXAM

PREVIEW or EXAM RESULTS SCREEN include:

• Red ring overlay should be consistent with white Placido ring display1

• Red ring overlay and Placido rings should extend outside Cone of Focus ring (ring #8) 
• Color map view should not be distorted by tear film artifact

Example: Dry Eye/Tear Film Artifact

In this example (Figure 3-15) of a typical cornea, there is a tear film artifact. Although the
ring overlay is good, there are black spots on the map. This is normally caused by a dry eye.
The patient may need to apply drops to the eye.

Figure 3-15 Image Quality Problem – Example

1.  Due to the projected nature of the patented Cone of Focus, the red ring overlay may not match the
corresponding visible ring mire for the Cone of Focus ring.
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(4) Image Analysis

Chapter Overview

This chapter discusses the ways you can analyze previously acquired ATLAS images. 
Topics covered in this chapter include:

• Analyze Images, page 4-1
• Find an Existing Patient, page 4-1
• View Today’s Patients Tab, page 4-2
• Analysis Screen, page 4-3
• Cursor Location Point, page 4-4
• Analysis Screen Toolbar, page 4-5
• Selecting Exams and Views, page 4-9
• Display Options, page 4-9

Analyze Images

Use the PATIENT SELECTION WINDOW to identify a patient whose exams you wish to analyze.
Analysis is disabled until you identify a patient. A patient must also have completed exams
for analysis to be enabled. For analysis purposes, you can identify a patient using two of
the three tabs provided.

Find an Existing Patient

On the default Find Existing Patient tab (Figure 4-1), select a patient from the patient
list displayed.

Figure 4-1 Patient Selection Window – Find Existing Patient
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• To search for a patient by first or last Name or Patient ID, type in the corresponding
fields and click Search. You can search using partial information, and you can use one
or both search fields. The patient list will return all matching patients, sorted
alphabetically.

• Click Advanced Search if you want to search using additional parameters.
• Once you have selected a patient, click Analyze to view the patient’s latest saved

image, or select an exam from the patient’s exam list and click Analyze (or
double-click on the exam). The ANALYSIS SCREEN will be displayed. Proceed to the
Analysis Screen on page 4-3. 

☞ Note: When in the ANALYSIS SCREEN, you can select any exam for the selected patient
without exiting to the PATIENT SELECTION WINDOW. However, to select another patient
you must exit the ANALYSIS SCREEN and return to the PATIENT SELECTION WINDOW. 

View Today’s Patients Tab

To select a patient from the list of today’s patients, select the View Today’s Patients tab
(Figure 4-2). For more information on using this tab, see View Today’s Patients on
page 3-4.

Figure 4-2 Patient Selection Window – View Today’s Patients

• Click to select the desired patient and then click Analyze to view the patient’s latest
saved image, or select an exam from the patient’s exam list and click Analyze (or
double-click on the exam). The ANALYSIS SCREEN will be displayed. Proceed to the
Analysis Screen on page 4-3. 
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Analysis Screen

The ANALYSIS SCREEN (Figure 4-3) enables you to view the captured image in many
different ways. Once you have initiated analysis from the PATIENT SELECTION WINDOW, or from
the Views button on the EXAM RESULTS SCREEN after acquiring a image, the ANALYSIS SCREEN

appears.

Figure 4-3 Analysis Screen

The colors of the corneal display shown in the middle of the ANALYSIS SCREEN correspond to
the values shown on the scale at the left of the screen. Each color represents a different
value, in either diopters or millimeters.

For curvature Views, in the Standard Color Palette and Standard Color Scale (ANSI Z80.23),
red, orange, and yellow are “hot” colors and show the steeper areas of the cornea. Green
is an “intermediate” color. Light and dark blue are “cool” colors and show the flatter areas.

☞ Note: The scale and colors of the screen can be changed with the Color Scale and
Color Palette options in the View Editor. You can also click on the Color Scale in the
ANALYSIS SCREEN to select another scale.

Patient Name,
 ID & Date of Birth

Analysis Screen Toolbar

Institution Name

 Doctor, Operator

Display (F4) Pop-Up Menu

 Color Palette 
 & Color Scale

 

 

Image

Data
Table

Display 

Remarks
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another scale

Exams Pop-Up List 
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The ANALYSIS SCREEN can be customized in many ways. You can select from multiple Displays
and data Views, all of which can be customized with optional display and parameter
settings. The default View is generated based upon the currently active Parameter Set. See
(8) Parameter Sets for more information on creating and editing Parameter Sets. The
ANALYSIS SCREEN may include:

• The selected patient’s name, ID number, and date of birth
• The institution, doctor and operator name
• Remarks entered during image acquisition
• Exam date and time
• Instrument (if not ATLAS 9000)
• OcuLign® Not OK

Cursor Location Point

You can move the mouse pointer arrow to any part of the cornea display and click the left
mouse button. The large crosshair on the View denotes the point at which you clicked the
mouse button and are located on the corneal display (Figure 4-4). The Cursor table on
the bottom right of the ANALYSIS SCREEN displays the data value at the location point and its
distance from the corneal vertex (mm) in both cartesian and polar coordinates. Right-click
the mouse button to remove the Cursor table and location point. 

Figure 4-4 Analysis Screen after Mouse Click in Cornea Display

☞ Note: On multi-view Displays, such as Overview, the location point can be set to
track at the same location on each View simultaneously or set independently for
each View. See Track Views on the Options tab of the ANALYSIS SCREEN (page 4-9). 

 Location point

 

 

Cursor
 table
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Analysis Screen Toolbar

The ANALYSIS SCREEN Toolbar (see Analysis Screen Toolbar on page 2-18) displays the
following buttons:

More (F2)

Checking the More (F2) checkbox (or pressing the F2 function key on the keyboard) will
display additional windows (Figure 4-5) which allow you to customize the display, select
different exams and alternate views, and edit Parameter Sets. Uncheck or press F2 again to
return the display to the single window view.

View Editor – See (7) View Editor for more information on the View Editor and its
parameters.

Display Options – See Display Options on page 4-9 for more information on the Display
Options window.

Exams/Views – See Selecting Exams and Views on page 4-9 for more information. 

Figure 4-5 Analysis Screen with the More (F2) Button Enabled

Print

Selecting Print (or Print > Print current screen) will open a standard Windows Print dialog
where you can select print options and print the current ANALYSIS SCREEN.

View Editor

 

Display

Exams/ 

Options

Views
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If you have selected reports on the Printing / DICOM Export Options dialog of the current
Parameter Set, selecting Print > Print report will print Reports and Views for the currently
selected exam(s). See Printing / DICOM Export Options on page 8-11 and Report
Options on page 8-12 for selecting the Views and Reports. A standard Windows Print
dialog will open where you can select print options and print the report.

Export

Export (or Export > Export current screen to file) will open a save dialog where you can
save the current exam’s analysis output screen in various file formats, including BMP, JPG,
TIFF, and PDF. 

If you have enabled DICOM Data Export (see Enable and Configure DICOM Data
Export and Worklist Import on page 11-26), selecting Export > Export current screen
to DICOM will export the current screen to a DICOM system, while Export > Export report
to DICOM will export the same Reports and Views as Print > Print report to a DICOM
system. See Printing / DICOM Export Options on page 8-11 and Report Options
on page 8-12 for selecting the Views and Reports. You can select PDF or TIFF as the image
file format. See Exporting Data to DICOM Systems on page 11-25 for more
information.

Exit

Selecting the Exit button will exit the ANALYSIS SCREEN and return you to the PATIENT

SELECTION WINDOW or the EXAMS RESULTS SCREEN (if you just acquired an image).

Exams List

Selecting the Exams button displays a list of exams for the patient, including exam
comments. For all Displays except Trend with Time and Trend Analysis, an exams pop-up
list will be displayed (Figure 4-6). This exams list displays the current View with an amber
checkbox. Selecting another exam on the list with the mouse will automatically change the
current View on the ANALYSIS SCREEN to the selected exam. 

Figure 4-6 Exams Button Pop-Up List

 Current View
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All exams for the patient can be selected. However, for some Displays, the list will show
only exams for one eye. Select the Switch Eye button on the bottom of the Exams list to
display exams for the other eye.

For the Trend with Time and Trend Analysis Displays, a pop-up SELECT EXAM window will be
displayed (Figure 4-7) when you select the Exams button. This window displays all exams
for one eye. You can select up to four exams. Click the checkbox next to an exam to select
or deselect it—a green checkmark means it is selected. If all four exams are selected, you
must first deselect an exam to select another. Select the Switch Eye button to display exams
for the other eye.

Figure 4-7 Select Exam Pop-Up Window

Select OK to close the window with your exam selections, or Cancel to keep the previous
exam selections.
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View (F3) Pop-Up Menu

Clicking the View (F3) pop-up menu button (or pressing the F3 function key on the
keyboard) displays a list of Views. See (6) Views for a description of each View.

Display (F4) Pop-Up Menu

Clicking the Display (F4) pop-up menu button (or pressing the F4 function key on the
keyboard) displays a list of Displays. Some choices may be unavailable for a selected
patient because of a lack of exam data. See (5) Displays for a description of each Display.
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Selecting Exams and Views

The EXAMS/VIEWS window allows you to select the exam(s) and View for the ANALYSIS SCREEN

display when the More (F2) checkbox on the ANALYSIS SCREEN is selected.

Exams

Clicking the Exams tab on the EXAMS/VIEWS window allows you to select the exam(s) to
include in the current View for the ANALYSIS SCREEN display. Once you click on an exam, you
can scroll through the list of exams by using the Up and Down Arrow keys on the keyboard.
The content of the Exam window depends on the current View. See (6) Views for more
information. 

You can also click the Exams pop-up list button on the ANALYSIS SCREEN to select exams
when the More (F2) checkbox is not selected (see Exams List on page 4-6).

Views

Clicking the Views tab on the EXAMS/VIEWS window allows you to select the View for the
ANALYSIS SCREEN display. See (6) Views for more information.

Display Options

The DISPLAY OPTIONS window on the ANALYSIS SCREEN controls display options and allows you
to select and edit Parameter Sets.

☞ Note: The More (F2) checkbox on the ANALYSIS SCREEN must be selected to show the
DISPLAY OPTIONS window.

Options

The Options tab controls display options on the ANALYSIS SCREEN and allows you to edit
and save current parameters, and select and edit Parameter Sets.

Figure 4-8 Display Options – Options Tab

Reverse colors – Check this button to reverse the colors of the ANALYSIS SCREEN from black
to white.

Track Views – Check this button to enable tracking of the location point—location points
will be updated simultaneously for each View in a multi-view Display (such as Overview).
Uncheck this field so each View can have a different location point. See Cursor Location
Point on page 4-4 for more information.

Parameter Sets buttons – Click the PARAMETER SET drop-down menu to select a Parameter
Set. It displays the current Parameter Set being used. Click the Save current parameters



Image Analysis

ATLAS User Manual 2660021135270 B

4-10

button to save the current parameters and settings to the current set. Click the Edit
Parameter Sets button to display the EDIT PARAMETERS SCREEN to change, create, or edit
Parameter Sets. See (8) Parameter Sets for more information on Parameter Sets.

☞ Note: When you change Parameter Sets, all settings that have not been saved from
the previous Parameter Set will be lost. If you changed the current settings and want
to keep them, be sure to click Save current parameters (or create a new
Parameter Set by clicking Edit Parameter Sets) before you select another
Parameter Set. Also when you change Parameter Sets, your current Display and
View will change to the Parameter Set’s default Display and View.

Text

The Text tab controls the display of text items on the ANALYSIS SCREEN. See Display Text
on page 8-6 for more information.

Figure 4-9 Display Options – Text Tab

Patient

The Patient tab controls the display of the patient’s name, ID, and birthday on the
ANALYSIS SCREEN. See Display Text on page 8-6 for more information.

Figure 4-10 Display Options – Patient Tab
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(5) Displays

Chapter Overview

The ATLAS Software lets you select different types of displays for the exam data captured by
the instrument. You can select a single-image display or compare more than one exam—or
more than one view of the same exam or different exams—on the same display. 

• Overview, page 5-2
• Single View, page 5-3
• OD/OS Compare, page 5-4
• 2-Difference, page 5-6
• 3-Difference, page 5-8
• Trend with Time, page 5-10
• Trend Analysis, page 5-12
• Custom, page 5-14
• PathFinder II (Optional), page 5-16
• MasterFit II (Optional), page 5-16

Selecting Views and Exams for Displays

You can select Views and Exams for Displays in two ways (for multi-View Displays, click on
a View to select it (a green border indicates the selected View)): 

• click the View (F3) and Exams pop-ups (see View (F3) Pop-Up Menu on page 4-8
and Exams List on page 4-6).

• click the View(s) or Exams tab on the EXAMS/VIEWS window when More (F2) is checked
(see Analysis Screen with the More (F2) Button Enabled on page 4-5).

☞ Note: If an image is of Low quality, the text “Unable to display” will be displayed
instead of the exam image for all Views except the Rings Image View. See Exam
Quality on page 3-11.

View Tracking

A location point and crosshair can be set on the corneal image for some Views by
left-clicking the mouse. For multi-View Displays, all Views can be set to the same location
point by turning on the Track Views option. See Track Views on the Options tab of the
ANALYSIS SCREEN (page 4-9). Turn off tracking so that each View has a different location
point. A Cursor table will be displayed showing the value for that location. Right-clicking
will remove the crosshair and Cursor table. See Cursor Location Point on page 4-4.

Display (F4) pop-up menu

The Display (F4) pop-up menu (or pressing the F4 function key on the keyboard) displays a
list of Displays. Some choices may be unavailable for a selected patient because of a lack
of exam data or licenses. For multi-View Displays, the selected View (a green border
indicates the selected View) will be displayed when you select the Single View Display.
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Overview

The Overview Display shows four different Views of the same exam for the selected patient.

You can select the exam and Views for the Overview Display in two ways:

1. Select an exam from the Exams pop-up list (see Exams List on page 4-6).
2. Select a View by clicking on it (a green border indicates the selected View).
3. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEWS window.
2. Select the Exams tab from the EXAMS/VIEWS window.
3. In the Exams tab window, select the exam you want to view from the list of available

exams by clicking on it—the display updates automatically. All exams for the selected
patient are shown in the list.

4. Select a View tab (View 1, View 2, View 3, View 4) from the EXAMS/VIEWS window by
clicking on the tab or clicking on the View in the window. View 1 is displayed at top
left, View 2 at top right, View 3 at bottom left, and View 4 at bottom right. A green
border indicates the selected View.

5. For each selected View tab (View 1, View 2, View 3, View 4), select the View you want
in the View tab window from the list by clicking on it—the display updates
automatically.

See Default Views on page 8-5 to set the default Views of the Overview Display for the current
Parameter Set. Figure 5-1 shows an Overview Display with View 1 selected (green border).

Figure 5-1 Overview Display (View 1 Selected – Green Border)

☞Note: Double-clicking a View
on the Overview Display will open
that View in Single View Display.
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Single View

The Single View Display shows a single View of a single exam for the selected patient. 

You can select the exam and View for the Single View Display in two ways:

1. From the View (F3) and Exams pop-ups (see View (F3) Pop-Up Menu on page
4-8 and Exams List on page 4-6).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEWS window.
2. Select the Exams tab from the EXAMS/VIEWS window.
3. In the Exams tab window, select the exam you want to view from the list of available

exams by clicking on it—the display updates automatically. All exams for the selected
patient are shown in the list.

4. Select the Views tab from the EXAMS/VIEWs window.
5. In the Views tab window, select the View you want from the list by clicking on it—the

display updates automatically.

See Default Views on page 8-5 to set the default View of the Single View Display for the
current Parameter Set.

Figure 5-2 shows a Single View Display.

Figure 5-2 Single View Display

☞ Note: For multi-View Displays, the selected View (a green border indicates the
selected View) will be displayed when you select the Single View Display.



Displays

ATLAS User Manual 2660021135270 B

5-4

OD/OS Compare

The OD/OS Compare Display shows two different Views of left and right eye exams for the
same patient on the same display. Two Views on the left side of the display are for the right
eye (OD) exam, and the same Views for the left eye (OS) are on the right side. ATLAS
automatically selects the closest other eye (based on exam date).

You can select the exams to include in the OD/OS Compare Display in two ways:

1. Select an OD and OS exam from the Exams pop-up list (see Exams List on page
4-6).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEWS window.
2. Select the Exam tab from the EXAMS/VIEWS window.
3. In the Choose OS Exam list, select the exam you want to view for the left eye from the

list of available exams by clicking on it—the display updates automatically. All OS
exams for the selected patient are shown in the list.

4. In the Choose OD Exam list, select the exam you want to view for the right eye from
the list of available exams by clicking on it—the display updates automatically. All OD
exams for the selected patient are shown in the list.

You can select the Views for the OD/OS Compare Display in two ways:

1. Select the Top or Bottom View by clicking on it (a green border indicates the selected
View).

2. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).
or 

1. Select the More (F2) checkbox to show the EXAMS/VIEWS window.
2. Select the Top View tab from the EXAMS/VIEWS window to select the View you want for

the eyes on the top of the display by clicking in the list—the display updates
automatically.

3. Select the Bottom View tab from the EXAMS/VIEWS window to select the View you want
for the eyes on the bottom of the display by clicking in the list—the display updates
automatically.

See Default Views on page 8-5 to set the default Views of the OD/OS Compare Display
for the current Parameter Set. 
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Figure 5-3 shows an OD/OS Compare Display with the Bottom View selected (green
border).

Figure 5-3 OD/OS Compare Display (Bottom View Selected – Green Border)
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2-Difference

The 2-Difference Display shows two exams for the same eye and the difference between
them. The top exam (Exam 1) is subtracted from the bottom exam (Exam 2).

You can select the exams to include in the 2-Difference Display in two ways:

1. Select an exam by clicking on it (a green border indicates the selected View).
2. Select an exam from the Exams pop-up list (see Exams List on page 4-6).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEW window.
2. Select the Exams tab from the EXAMS/VIEW window.
3. In the Exams tab window, select the eye you want to display by clicking the OD (Right)

or OS (Left) radio button. All exams for the selected eye are shown in the Exams 1 or 2
lists. Select an exam in both lists by clicking on it.

☞ Note: If you change an exam that would make the Display out of chronological order
(latest shown on the bottom), the software will move the exams into chronological
order on the Display.

You can select the View for the 2-Difference Display in two ways:

1. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).
or

1. Select the More (F2) checkbox to show the EXAMS/VIEW window.
2. Select the View tab from the EXAMS/VIEWS window.
3. In the View tab window, select the View you want from the list by clicking on it—the

display updates automatically.

The following Views are available for the 2-Difference Display: Axial, Tangential, Refractive,
Mean, and Corneal Wavefront. See Default Views on page 8-5 to set the default View
of the 2-Difference Display for the current Parameter Set.



ATLAS User Manual 2660021135270 B

Displays 5-7

Figure 5-4 shows a 2-Difference Display with Exam 1 selected (green border). Note that a
location point has been clicked on the top exam and the difference value at that location
point is displayed on the right.

Figure 5-4 2-Difference Display (Exam 1 Selected – Green Border)

☞ Note: The difference value calculated may be slightly different than the difference
value when calculated on the displayed two decimal value, because the difference
value is calculated using a higher number of decimal places, and then rounded.

☞ Note: If an image is of Low quality, the text “Unable to display” will be displayed
instead of the exam image and the difference map. See Exam Quality on page
3-11.
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3-Difference

The 3-Difference five-map Display provides information regarding changes between
multiple exams; for example, to monitor the surgical and healing changes that take place
on the eye after corneal surgery. It is also useful to follow contact lens induced change over
time, to determine the effect that the lens is having on the cornea. Three exams for the
same eye are selected and two differences are calculated. 

Exam 1, Exam 2, and Exam 3 are shown respectively left to right on the top of the display.
Exam 1 will be subtracted from Exam 2 and a difference map will be calculated and
displayed on the lower left. Exam 2 will be subtracted from Exam 3 and a difference map
will be calculated and displayed on the lower right.

You can select the exams to include in the 3-Difference Display in two ways:

1. Select an exam by clicking on it (a green border indicates the selected View).
2. Select an exam from the Exams pop-up list (see Exams List on page 4-6).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEW window.
2. Select the Exams tab from the EXAMS/VIEW window.
3. In the Exams tab window, select the eye you want to display by clicking the OD (Right)

or OS (Left) radio button. All exams for the selected eye are shown in the three Exams
lists. Select an exam in each list by clicking on it.

☞ Note: If you change an exam that would make the Display out of chronological order
(left to right), the software will move the exams into chronological order on the
Display.

You can select the View for the 3-Difference Display in two ways:

1. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).
or

1. Select the More (F2) checkbox to show the EXAMS/VIEW window.
2. Select the View tab from the EXAMS/VIEWS window.
3. In the View tab window, select the View you want from the list by clicking on it—the

display updates automatically.

The following Views are available for the 3-Difference Display: Axial, Tangential, Refractive,
Mean, and Corneal Wavefront. See Default Views on page 8-5 to set the default View
of the 3-Difference Display for the current Parameter Set.
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Figure 5-5 shows a 3-Difference Display with Exam 1 selected (green border). Note that a
location point has been clicked on the top exams and the difference values at that location
point are displayed on the bottom exams.

Figure 5-5 3-Difference Display (Exam 1 Selected – Green Border)

☞ Note: The difference values calculated may be slightly different than the difference
values when calculated on the displayed two decimal values, because the difference
values are calculated using a higher number of decimal places, and then rounded.

☞ Note: If an image is of Low quality, the text “Unable to display” will be displayed
instead of the exam image and the difference map calculated from it. See Exam
Quality on page 3-11.
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Trend with Time

The Trend with Time Display shows the currently active exam and up to three previous
exams for the same eye. The exams are always displayed in chronological order (left to
right, top to bottom).

You can select the exams to include in the Trend with Time Display in two ways:

1. Select an exam from the Exams pop-up SELECT EXAM window (see Exams List on page
4-6).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEW window.
2. Select the Exams tab from the EXAMS/VIEW window.
3. In the Exams tab window, select the eye you want to display by clicking the OD (Right)

or OS (Left) radio button. All exams for the selected eye are shown in the Available
Exams or Selected Exams list. The Selected Exams list shows exams that are included
in the Trend with Time Display. The Available Exams list shows exams that are
available, but not currently selected to be included in the Trend with Time Display.

4. To add an exam to the Trend with Time Display, click on an exam in the Available
Exams list to move it to the Selected Exams list—the display updates automatically. 
If the Selected Exams list has 4 exams, you will need to remove an exam from the list
before you can add another exam.

5. To remove an exam in the Trend with Time Display, click on an exam in the Selected
Exams list to move it to the Available Exams list—the display updates automatically.

☞ Note: If you add or change an exam that would make the Display out of
chronological order (left to right, top to bottom), the software will move the exams
into chronological order on the Display.

You can select the View for the Trend with Time Display in two ways:

1. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).
or

1. Select the More (F2) checkbox to show the EXAMS/VIEW window.
2. Select the View tab from the EXAMS/VIEW window.
3. In the View tab window, select the View you want from the list by clicking on it—the

display updates automatically.

See Default Views on page 8-5 to set the default View of the Trend with Time Display
for the current Parameter Set.
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Figure 5-6 shows a Trend with Time Display with View 1 selected (green border).

Figure 5-6 Trend with Time Display (View 1 Selected – Green Border)
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Trend Analysis

The Trend Analysis Display (Figure 5-7) shows up to four exams for the same eye, along
with a table of data analysis parameters. By default, only the current day’s exams for the
same eye are displayed, if possible. However, you can select any four exams to include in
the Trend Analysis Display by selecting them from the Exams pop-up SELECT EXAM window
(see Exams List on page 4-6). The exams are always displayed in chronological order
(left to right).

☞ Note: If you add or change an exam that would make the Display out of
chronological order (left to right, top to bottom), the software will move the exams
into chronological order on the Display.

You can select certain Views for the Trend Analysis Display by selecting the View from the
View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8). Only color maps can be
viewed. The default display settings are set in the current Parameter Set’s Single View
setting (see Default Views on page 8-5). The units (mm or Diopters) for the Views are
set in the Views menu for the selected Parameter Set. See Views on page 8-7.

Figure 5-7 Trend Analysis Display

Data Parameters Table

The Trend Analysis Data Parameters Table displays Apical radius (Ro) (along meridian),
Sagittal height (along meridian), Eccentricity (along meridian), Flat and Steep Sim K’s, HVID,
and Pupil Diameter values for each image. The mean and standard deviation values for these
parameters are also displayed for the images. See Data on page 7-7 for more information.
The blue data line corresponds to the currently selected exam image (green border).

Data Parameters Table

Display Options
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Apical radius (Ro)

Apical radius of curvature, also known as Ro, or apical curvature, is the radius of curvature
of the unique ellipse calculated along a certain meridian (see Figure 5-8).

Figure 5-8 Trend Analysis Data Diagram 

Sagittal height

The Sagittal height (micrometers) is the height of the cornea measured from the geometric
center of the cornea to the specified chord along the selected meridian (see Figure 5-8).

Display Options

Meridian

Select a meridian (Flat, Steep, or Custom (0-180 degrees)) for the Data Parameters Table
analysis. The default is Flat. The meridian is shown as a white line on each image. Apical
radius (Ro), Sagittal height, and Eccentricity values will change for all images.

Chord length

The Chord length is the diameter of the section along which the corneal data is calculated. This
can be selected from 2 to HVID in 0.05 mm increments in the drop-down menu (default is 8.0
mm). The smaller the value, the closer to the corneal apex the section is (see Figure 5-8).

Color Scale

Color Scale parameters for the images can be set here. These are global parameters. If you
change any parameter, it will be changed in all other Views that have these parameters
after you save the Parameter Set in another Display. See Color Scale on page 7-5. If your
current Color Scale is Auto, it will change to Uniform for all images in the Trend Analysis
Display for better comparison (if more than one image, and the View supports it).
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Custom

The Custom Display can show four different Views for the selected patient. Any
combination of exams and Views can be selected. This differs from the Overview Display
where all Views are for the same exam.

You can select the exams and Views for the Custom Display in two ways:

1. Select a View by clicking on it (a green border indicates the selected View).
2. Select an exam from the Exams pop-up list (see Exams List on page 4-6).
3. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).

or

1. Select the More (F2) checkbox to show the EXAMS/VIEWS window.
2. Select a View tab (View 1, View 2, View 3, View 4) from the EXAMS/VIEWS window by

clicking on the tab or clicking on the View in the window. View 1 is displayed at top
left, View 2 at top right, View 3 at bottom left, and View 4 at bottom right. A green
border indicates the selected View.

3. For each selected View tab (View 1, View 2, View 3, View 4), select the View you want
in the View tab window from the list by clicking on it—the display updates
automatically.

4. Select an Exam tab (Exam 1, Exam 2, Exam 3, Exam 4) from the EXAMS/VIEWS window
by clicking on the tab. Exam 1 is for View 1, Exam 2 is for View 2, etc.

5. For each selected Exam tab (Exam 1, Exam 2, Exam 3, Exam 4) from the EXAMS/VIEWS

window, select the exam you want to view from the list of available exams by clicking
on it—the display updates automatically. All exams for the selected patient are shown
in the list.

See Default Views on page 8-5 to set the default Views of the Custom Display for the
current Parameter Set. 
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Figure 5-9 shows a Custom Display with View 4 selected (green border).

Figure 5-9 Custom Display (View 4 Selected – Green Border)
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PathFinder II (Optional)

PathFinder II is an optional software feature for the ATLAS System designed to assist in
identifying abnormal, pathologic, and normal corneas using anterior corneal topography.
Please see (A) PathFinder II Corneal Analysis (Optional) for a complete discussion
of the PathFinder II software.

☞ Note: PathFinder II corneal analysis is only available for ATLAS 9000 exams.
PathFinder II will be greyed out and not selectable for ATLAS 900 Series exams.

MasterFit II (Optional)

MasterFit II is an optional software feature for the ATLAS System that incorporates contact
lens fitting capabilities. Please see (B) MasterFit II (Optional) for a complete discussion
of the MasterFit II software.
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(6) Views

Chapter Overview

ATLAS supports thirteen different types of Views of the exam image. Views can be
customized by using the View Editor on the bottom of the ANALYSIS SCREEN (see (7) View
Editor). Default View Editor parameters for each View are set in the current Parameter Set
(see Editing Parameter Sets on page 8-1).

The thirteen Views are described in the following sections of this chapter:

• Axial Curvature, page 6-2
• Tangential Curvature, page 6-4
• Elevation, page 6-6
• Irregularity, page 6-9
• Rings Image, page 6-13
• Keratometry, page 6-16
• Refractive Power, page 6-17
• Mean Curvature, page 6-19
• Corneal Wavefront, page 6-21
• Image Simulation, page 6-24
• PSF (Point Spread Function), page 6-26
• MTF (Modulation Transfer Function), page 6-28
• PathFinder II (Optional), page 6-30

Selecting Views and Exams for Displays

From the ANALYSIS SCREEN you can select Views and Exams in Displays in two ways (for
multi-View Displays, click on a View to select it (a green border indicates the selected
View)): 

• click the View (F3) and Exams pop-ups (see View (F3) Pop-Up Menu on page 4-8
and Exams List on page 4-6).

• click the View or Exams tab on the EXAMS/VIEWS window when the More (F2)
checkbox is checked (see Analysis Screen with the More (F2) Button Enabled
on page 4-5).

For more information on the ANALYSIS SCREEN and selecting a patient, see Analysis
Screen on page 4-3.

☞ Note: If an image is of Low quality, the text “Unable to display” will be displayed
instead of the exam image for all Views except the Rings Image View. See Exam
Quality on page 3-11.
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Axial Curvature

The Axial View (Figure 6-2) displays the axial curvature of the cornea as a topographical
view, using 23 colors to represent dioptric power or mm radius. The Axial View is a simple
way of describing the overall shape of the cornea, and even though the values can be
displayed as diopters, the Axial View is actually a calculation of curvature, instead of “true”
refractive power, when displayed as diopters (keratometric diopters). The color-coded
display visually corresponds to the “flat” and “steep” axes well known to keratometry
users. 

Axial Views naturally incur more smoothing when measuring the corneal surface towards
the periphery, and may not be able to show more subtle changes, as can the Tangential
View. Because it shows a “perfect sphere” as flat, the Axial View is unable to take into
account the phenomenon known as spherical aberration. 

The Axial View treats every single data point as if the whole cornea would be a sphere that
matches the local slope and position of every data point. The Axial View has been
established in the field, but it does not really represent the local curvature. Use the
Tangential View for a better representation of true local curvature.

The distance (R) from the point of interest on the corneal surface to the optical axis defines
the axial radius of curvature (Figure 6-1).

Figure 6-1 Axial Curvature / Power
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Figure 6-2 Axial View – Color View

All parameters for the Axial View Editor are discussed in (7) View Editor. 
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Tangential Curvature

The Tangential View (Figure 6-4) displays the cornea as a topographical view, but bases
the calculation on the local curvature of a given meridian, and thus shows more detail than
the Axial View.

The Tangential View bases its calculation on a different mathematical approach or
algorithm and is also known as instantaneous or local curvature. This algorithm is more
accurate at calculating the periphery of the cornea. The Tangential View may also
recognize sharp transitions in power more easily, and eliminates the “smoothing”
appearance of the topographical view as seen in the axial or sagittal view. This is often
useful in following healing trends after surgery or in viewing pathologic eyes. The
Tangential View is helpful for locating the size, shape, and position of specific features on
the corneal surface, such as the apex of corneal steepening in keratoconus, boundaries of
a treatment zone after corneal refraction surgery, pterygia, and corneal scarring.

The Tangential View does not force the center of curvature of the best-fit sphere to lie
along the optical axis. The location of the center of curvature for each point is calculated
by a best-fit sphere to the local neighborhood at the point of interest on the corneal
surface. The distance (R) from the point of interest to the center of the locally best-fit
sphere represents the tangential (or instantaneous) curvature (Figure 6-3). 

Figure 6-3 Tangential Curvature
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Figure 6-4 Tangential View – Color View

All parameters for the Tangential View Editor are discussed in (7) View Editor.
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Elevation

The Elevation View (Figure 6-5) displays the difference in height or elevation of the
cornea, in micrometers (μm), from a reference sphere. ATLAS then fits, or superimposes,
this reference sphere onto the corneal surface, measuring the difference between the
reference and the real corneal surface. Elevation is measured as differences in height from
the reference sphere as positive and negative micrometers. The reason for this is that the
corneal surface can fall above (positive, red color in the Standard Colors) or below
(negative, blue color in the Standard Colors) the best-fit reference sphere. 

The reference sphere can either be automatically computed or with parameters entered by
the user.

It is important to keep in mind that the measurement is in micrometers, not diopters, and
that Axial and Elevation Views cannot be directly compared. The value of measuring the
corneal surface in micrometers is that small elevations or depressions on the corneal
surface created by surgery or pathology can be carefully documented in micrometers of
measurement, giving a level of detail not possible using the curvature views.

Because the shape of the normal cornea is aspheric (ellipsoidal) rather than spherical, it is
sometimes still hard to single out subtle deviations in elevation maps. Besides the problem
of the non-spherical shape of the normal cornea, which makes it difficult to identify subtle
pathological variants in the Elevation View, non-pathologic corneal shape changes, like
astigmatism, can also wash out subtle shape abnormalities.

Figure 6-5 Elevation View – Color View
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The Elevation View can also be viewed as a Surface (Figure 6-6) or Zernike table (Figure
6-7) by selecting those views in the View As... section on the General tab.

Figure 6-6 Elevation View Editor – Surface View

Figure 6-7 Elevation View Editor – Zernike Table View

The Zernike table view displays the names (up to order 4) and values of the Zernike
coefficients, along with horizontal bar graphs of the Zernike coefficients values (note that
bars for orders 1 and 2 are graphed on a larger scale than the other order coefficients).
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Data

The Data tab on the Elevation View Editor (Figure 6-8) contains one surface data
parameter that can be displayed:

RMS fit

Checking this will display the RMS fit parameter value. The Root Mean Square (RMS) fit
value, measured in micrometers, determines how much the actual corneal surface varies
from the smooth-fitted spherical surface. The higher the RMS fit value, the higher the
variation. RMS fit only uses image data set by the Fit Zone parameter (see below). 
.

Figure 6-8 Elevation View Editor – Data Tab

Surface Fit

Figure 6-9 Elevation View Editor – Surface Fit Tab

Fit Zone

The Fit Zone defines the diameter of the zone used to fit the sphere to the surface.

Select Automatic to let the software determine the Fit Zone (the fit is over all data in the
exam). To define a zone, select Custom and click on the pop-up menu to select a number
(mm diameter of zone, centered on corneal vertex).

Reference Sphere Radius

The Reference Sphere Radius defines the radius of the sphere used to fit the sphere to the
surface.

Select Automatic to let the software determine the radius (the fit is over all data in the
exam). To define the radius, select Custom and enter a reference sphere radius in mm in the
Radius field. Press the Enter or Tab key to update the display.

Other parameters for the Elevation View Editor are discussed in (7) View Editor. 
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Irregularity

The Irregularity View takes the best-fit surface methodology of the Elevation View further
by using non-spherical surfaces as the reference object. The Irregularity View shows the
amount of surface irregularity on the cornea—which areas are divots or depressions and
which areas are elevations or islands. A best-fit toric ellipsoid surface is subtracted from
the corneal elevation data to yield the irregularity that cannot be described by a reference
ellipsoid that accounts for the asphericity and toricity of the cornea.

Figure 6-10 Irregularity View – Color View

Use the Irregularity View to show how different the cornea is from a normal eye. It has
been shown that normal eyes can be represented very well by a general ellipsoid1 (see
Figure 6-11) or a mid-order Zernike fit. The Irregularity View shows the elevation
difference between the “normal” best-fit ellipsoid surface and the actual measured corneal
surface.

☞ Note: A “general ellipsoid” is a sphere that is scaled in x, y, z, moved (translated)
anywhere in x, y, z, and rotated arbitrarily along its principal meridians (pitch, yaw, tilt).

1.  Optics of the average normal cornea from general and canonical representations of its surface 
topography. J Opt Soc Am A Opt Image Sci Vis. 2006 Feb; 23(2):219-32.
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Figure 6-11 3-D Model with General Ellipsoid as Corneal Surface

The Irregularity View can also be viewed as a Surface (Figure 6-6) by selecting it in the
View As... section on the General tab.

Figure 6-12 Irregularity View Editor – Surface View
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Data

The Data tab on the Irregularity View Editor (Figure 6-13) contains one surface data
parameter that can be displayed:

RMS fit

Checking this will display the RMS fit parameter value. The Root Mean Square (RMS) fit
values, measured in micrometers, determines how much the actual corneal surface varies
from the smooth-fitted non-spherical surface. The higher the RMS fit value, the higher the
variation. RMS fit only uses image data set by the Surface Fit parameters (see below).
.

Figure 6-13 Irregularity View Editor – Data Tab

Surface Fit

Surface Fit parameters specify the surface used to compute the difference between it and
the elevation data. You can select the reference surface to be a General Ellipsoid (Quadric)
or a Zernike polynomial expansion. The reference surface can either be automatically
computed or with parameters entered by the user. For the Zernike expansion fit, both
number of coefficients (Order) and Fit Zone can be specified by the user. The Zernike
coefficients are computed automatically and can be displayed. 

The Surface Fit tab displays the parameters shown in Figure 6-14 below.

Figure 6-14 View Editor – Surface Fit Tab

Fit Zone

The Fit Zone defines the diameter of the zone used to fit the model to the surface.

Select Automatic to let the software determine the Fit Zone (the fit is over all data in the
exam). To define a zone select Custom and click on the pop-up menu to select a number
(mm diameter of zone, centered on the corneal vertex).
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Surface Fit Type

The Surface Fit Type selects the surface used in the Irregularity View.

Select General Ellipsoid (Quadric) to select this ellipsoid, or Zernike for a Zernike polynomial
expansion. 

If you select Surface fit on the Data tab for the General Ellipsoid, ellipsoid parameters will
be displayed (see Table 6-1 below).

When selecting Zernike, also select the number of coefficients from the Order pop-up
menu. If you select Surface fit on the Data tab for the Zernike Surface Fit Type, the number
of coefficients and Order number will be displayed.

All other parameters for the Irregularity View Editor are discussed in (7) View Editor.

Table 6-1 General Ellipsoid (Quadric) Parameters

Parameter Description

R1 / R2 Apical radius in mm for principal meridians of ellipsoid

D1 / D2 Apical diopters for principal meridians of ellipsoid

Flat meridian Angle of the flat principal meridian

SF1 / SF2 Shape Factors at principal meridians of ellipsoid
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Rings Image

The Rings Image View (Figure 6-15) or “Photokeratoscoptic Image” displays the actual
captured image of the eye with the reflected rings. Captured Scotopic (no light, large pupil)
and Photopic (with light, small pupil) images may also be displayed if captured. 

Figure 6-15 Rings Image View – Rings Image

A Scotopic pupil (Figure 6-16) or Photopic pupil (Figure 6-17) image can be displayed
by selecting those views in View As... on the General tab (Figure 6-18) of the View
Editor.

Figure 6-16 Rings View Editor – Scotopic Pupil View
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Figure 6-17 Rings View Editor – Photopic Pupil View

The View Editor tabs for the Rings Image View are shown below.

General

Figure 6-18 Rings Image View Editor – General Tab

In addition to the Rings image, the Rings Image View can also display a Scotopic pupil or
Photopic pupil image if you have taken those images at image acquisition. See Exams on
page 8-9 to turn on/off the capture of Scotopic and/or Photopic images for a Parameter Set. 

Overlay

Figure 6-19 Rings Image View Editor – Overlay Tab
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Zoom rings image – Check this to display a zoomed in rings image to 10mm. Only available
for ATLAS 9000 exam. Does not work for Photopic, Scotopic, or low quality image. 

Figure 6-20 Rings Image View – Rings Image (Zoomed In, with Rings)

Limbus contour – Check this to turn on the green display marking the location and size of
the limbus contour.

Geometric center – Check this to display a crosshair enclosed by a circle denotes the point
on the cornea corresponding to the center of the limbus contour.

Rings – Check this to display the red rings overlay (detected ring edges).

All other Overlay parameters for the Rings View Editor are discussed in (7) View Editor.
See Overlay on page 7-6.

Data

Figure 6-21 Rings Image View Editor – Data Tab

Scotopic pupil diameter – The scotopic pupil diameter in mm can be displayed.

Photopic pupil diameter – The photopic pupil diameter in mm can be displayed.

Geometric center offset – The geometric center offset in mm can be displayed.

Other Data parameters for the Rings View Editor are discussed in (7) View Editor. 
See Data on page 7-7.
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Keratometry

The Keratometry View (Figure 6-22) provides information simulating the data obtained
using a Keratometer. This view also provides readings for each semi-meridian in three
zones:

• Central (0-3 mm)
• Midperiphery (3-6 mm)
• Periphery (6-9 mm)

The steepest semi-meridians in each zone are displayed in red diopter values; the flattest
meridian in blue diopter values.

The data is listed by semi-meridian and zone on the left of the screen. The simulated
Keratometer values at the top left of the display are computed in a similar way to the
computations performed by Keratometers commonly used to measure the central 3 mm,
assuming the principal axes have a 90 degree shift.

Eccentricity values are also displayed for meridians at 0, 10, 15, 25, and 30 degrees. 

Figure 6-22 Keratometry View

The Keratometry View has only one parameter to edit in the View Editor:

Show Eccentricities – Check this to display the table of meridians and eccentricities.
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Refractive Power

The Refractive Power View (Figure 6-24) shows the power of the eye in its refractive
state, measured only in diopters. Sometimes called a “Snell’s Law Map”, this view
measures the refraction of light rays, using Snell’s Law, as they pass through the corneal
surface. Taking into account spherical aberration, the Refractive Power View more closely
illustrates how light rays behave as they strike an aspheric surface, such as the human
cornea. Figure 6-23 shows an example corneal surface which has increasing refractive
power from the center to the periphery, demonstrating spherical aberration. Parallel light
rays (A, B, C) striking the corneal surface are refracted. Ray C has the greatest refractive
power since it crosses the optical axis at the shortest focal distance, c. Rays B and A have
larger focal lengths, respectively, (b and a), and therefore have the least refractive power.

Figure 6-23 Refractive Light Geometry

Refractive Power Views may differ from Axial Views in their readings of power and radius
for the same exam. The biggest difference can be seen in the periphery and on eyes that
have unusual or abnormal shapes. This is due to the spherical aberration effect that
Refractive Power Views take into account.

Optical 
  Axis
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Figure 6-24 Refractive Power View – Color View

All parameters for the Refractive Power View Editor are discussed in (7) View Editor.
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Mean Curvature

The Mean View (Figure 6-25) is the average curvature of the two principal curvatures for
any given point on the cornea. Whereas Axial and Tangential Views are defined along
individual meridians (or slices of the cornea), the Mean View contains curvature
information along both the radial and azimuthal directions of every single data point. The
Mean curvature is the average curvature in all directions around the data point, whereas
Axial and Tangential curvature is only along the semi-meridian. As a result, the Mean View
suppresses corneal astigmatism and is insensitive to patient fixation. The advantage of the
Mean View is that it may better detect subtle shape abnormalities, since it is a more
faithful description of three-dimensional shape and has the ability to suppress some
non-pathological features (such as corneal astigmatism) while preserving pathological
features such as keratoconus. 

Figure 6-25 Mean View – Color View

Figure 6-26 shows an OD/OS Display comparison of a normal WTR astigmatism patient
with an Axial Curvature View on the top and a Mean Curvature View on the bottom. Notice
the normal WTR pattern on the Axial Curvature View. However, the Mean Curvature View
eliminates the corneal astigmatism from the map through local averaging, which is
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independent of a reference axis, unlike the Axial Curvature View, which is meridian specific
and whose reference is the vertex, or center of the map.

Figure 6-26 OD/OS Comparison of Axial and Mean Curvature Views

Compared to the Axial Curvature View, the Mean Curvature View is not dependent on the
location of a central axis, less sensitive to patient fixation, suppresses some
non-pathological features (such as corneal astigmatism), and is a more faithful description
of a three-dimensional shape. 

All parameters for the Mean View Editor are discussed in (7) View Editor.
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Corneal Wavefront

The Corneal Wavefront View (Figure 6-27) displays corneal wavefront aberrations.
Corneal wavefront is the part of the total aberrations of the eye contributed by the cornea.

Corneal Wavefront (CW)= Ocular Wavefront (OW) - Internal Wavefront (IW)

The corneal wavefront is calculated from corneal topography by using an algorithm that
incorporates the shape of the cornea using ray tracing technology to trace light rays from
the fovea out of the eye. Wavefront aberration is measured as the difference from a plane
surface, at the entrance pupil. This optical path difference, the basis of corneal wavefront
theories, is the difference between the corneal wavefront and an ideal wavefront.

Total aberration of the eye as measured by wavefront aberrometers depend on:

1. Size of pupil – If the pupil opens only 5 mm, then the map generated is only 5 mm.
2. Effect of Accommodation – Introduces another factor into ocular wavefront (i.e the

effect of the lens on the wavefront). As the lens changes shape to accommodate, it
itself induces aberrations.

Corneal wavefront aberrations are:

1. Relatively stable over time and serial measurements.
2. Can be evaluated for different pupil diameters.
3. Not affected by accommodation.
4. Does not provide any information about the refractive error of the eye (no spectacle

lens prescriptions possible!)

You can use the Wavefront View Editor (Wavefront on page 7-14) to select coefficients to
remove. You can also enable or disable the use of a Stiles-Crawford weighting (see
Stiles-Crawford effect on page 7-14) in the calculation of the aberrations.
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Figure 6-27 Corneal Wavefront View – Color View

The Corneal Wavefront View can also be viewed as a Surface (Figure 6-28) or Zernike
table (Figure 6-29) by selecting those views in View As... on the General tab of the
View Editor.

Figure 6-28 Corneal Wavefront View Editor – Surface View

If any Wavefront coefficients 
are masked in the 
View Editor, Coeff edit
will display Yes.

If you check Stiles-Crawford effect,
SC Weight will display Yes.
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Figure 6-29 Corneal Wavefront View Editor – Zernike Table View

The Zernike table view displays the names (up to order 4) and values of the Zernike
coefficients, along with horizontal bar graphs of the Zernike coefficients values (note that
bars for orders 1 and 2 are graphed on a larger scale than the other order coefficients).

Other Corneal Wavefront parameters are discussed in (7) View Editor.
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Image Simulation

The Image Simulation View displays a corneal focal plane image simulation based upon
the corneal PSF (Point Spread Function). Images available for use in the simulation include
an “E” image (Figure 6-30), an eye chart (Figure 6-32), and a beach scene image
(Figure 6-33). 

Figure 6-30 Image Simulation View – “E” Image

The View Editor for the Image Simulation View is shown in Figure 6-31 below.

Figure 6-31 Image Simulation View Editor – General Tab

Image source

E – Select this for an “E” image.

Eye Chart – Select this for an eye chart image (Figure 6-32).

Custom image – Select this to use a custom beach scene image (Figure 6-33).

Overlays – Scale graphic

Check this to display a 20.0 arcmin graphic scale and approximate Snellen values (Figure
6-30 and Figure 6-32).

Graphic Scale enabled
(arcmin = arc minutes, 
Snellen value) 
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Other parameters for the Image Simulation View Editor are discussed in (7) View Editor.
 

Figure 6-32 Image Simulation View – Eye Chart Image

Figure 6-33 Image Simulation View – Beach Scene Image
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PSF (Point Spread Function) 

The PSF (Point Spread Function) View is a monochrome display representing the point
spread function arising from the Corneal Wavefront. The PSF shows the distribution of light
on the focal plane of the anterior cornea, not including the effects of diffraction. The PSF
(Point Spread Function) View – Image view is shown in Figure 6-34 below. 

Figure 6-34 PSF View – Image View

The PSF View can also be viewed as a Surface (Figure 6-35) or Profile (Figure 6-36) by
selecting those views in the View As... section on the General tab of the View Editor.

Figure 6-35 PSF View Editor – Surface View

Graphic Scale enabled
(arcmin = arc minutes) 
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Figure 6-36 PSF View Editor – Profile View

Overlays

Figure 6-37 PSF View Editor – Overlay Tab

Scale graphic – Check this button to display a 20.0 arcmin graphic scale (Figure 6-34).

Airy Disk – Check this to turn on the display of the Airy disk.

Other parameters for the PSF View Editor are discussed in (7) View Editor.
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MTF (Modulation Transfer Function)

The MTF (Modulation Transfer Function) View is a monochrome display representing the
modulation transfer function arising from the Corneal Wavefront. The MTF (Modulation
Transfer) View – Profile view is shown in Figure 6-38 below. 

Figure 6-38 MTF (Modulation Transfer) View – Profile View

The MTF View can also be viewed as a Surface (Figure 6-39) or Image (Figure 6-40) by
selecting those views in the View As... section on the General tab of the View Editor.

Figure 6-39 MTF View Editor – Surface View
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Figure 6-40 MTF View Editor – Image View

Overlays

Figure 6-41 MTF View Editor – Overlay Tab

Scale graphic – Check this button to display a 20.0 cpd (cycles per degree) graphic scale
(Figure 6-38).

Other parameters for the MTF View Editor are discussed in (7) View Editor.

Graphic Scale enabled
(cpd = cycles per degree) 
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PathFinder II (Optional)

PathFinder II is an optional software feature for the ATLAS System designed to assist in
identifying abnormal, pathologic, and normal corneas using anterior corneal topography.
Please see (A) PathFinder II Corneal Analysis (Optional) for a complete discussion
of the PathFinder II software.

PathFinder II can be selected as a View in Single View and multi-View Displays. Only the
Probability View will be displayed for multi-View Displays.

☞ Note: PathFinder II Corneal Analysis is only available for ATLAS 9000 exams.
PathFinder II will be greyed out and not selectable for ATLAS 900 Series exams.
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(7) View Editor

Chapter Overview

The VIEW EDITOR window on the ANALYSIS SCREEN allows you to edit some parameters of the
selected View. Default View Editor parameters for each View are set in the current
Parameter Set (see (8) Parameter Sets).

☞ Note: The More (F2) checkbox on the ANALYSIS SCREEN must be selected to show the
VIEW EDITOR window. Pressing the F2 function key in the ANALYSIS SCREEN toggles the
More (F2) checkbox on and off to allow for easier switching between the View and
View parameters. See Figure 4-5 on page 4-5.

View Editor parameters are global for all Views except the following parameters which can
be set differently for each View:

• General tab – Map diameter (Auto, Fixed diameter (mm))
• General tab – View as... (Color, Number, Profile)
• Data tab – All parameters

If you change any global parameter in one View, it will be changed in all other Views that
have these parameters after you save the Parameter Set. 

The View Editor parameters discussed in this chapter are those used by many Views. Some
Views have additional View Editor parameters specific to their View. These are discussed
separately for each View in (6) Views.

By default, the Color Tab is selected when you enter the View Editor. Each View Editor tab
has its own section:

• General, page 7-1
• Color, page 7-5
• Overlay, page 7-6
• Data, page 7-7
• Wavefront, page 7-14

View Editor Tabs

General

The General tab displays the parameters shown in Figure 7-1 below.

Figure 7-1 View Editor – General Tab
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Units

Units can be displayed in either millimeters (mm) or Diopters. This option will effect all
scale and measurement values shown on the active view of the display.

☞ Note: Diopters and millimeters are numerically inverse-related—higher diopter
values correspond to lower millimeter values and vice-versa.

☞ Note: Changing units will change the color map display because Diopter and mm
values do not necessarily map to the same color for any Color Scale.

Map diameter

Map diameter can be set to Auto or to a fixed value. 

Auto – Sets the map diameter based upon values in the map. 

Fixed diameter (mm) – Select a mm value in the pop-up menu to set the map to a fixed
value. The allowable diameter values are 3.0 to 10.0 mm in 0.5 mm steps.

View as...

The cornea image can be viewed in three main modes:

Color – The Color view displays the data as colors which correspond to the scale shown on
the left. The colors represent the flatness or steepness of the cornea. The Color view can be
rendered as Contour or Smooth (see Rendering on page 7-4).

Number – The Number view displays diopter or mm values as numbers for the curvature of
the cornea. The color of the numbers represents the flatness or steepness of the cornea
and corresponds to the scale shown on the left (see Figure 7-2).

Figure 7-2 Number View
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Profile – The Profile view mode (Figure 7-3) graphs data values across two full meridians
of the cornea and the difference between them.

In the top portion of the screen, the Profile view plots the curvature of the cornea (diopters
or mm) for two meridians along the corneal surface (distance from corneal apex in mm).
The initial view plots the steepest (shown in red) and flattest (shown in blue) meridians.

The circle on the right displays a graphical view of the two meridians degree angles, and
the numbers below it display the numerical view of the meridians in degrees. Inside the
circle the color view of the cornea for the current View is displayed. The red meridian (the
red line on the circle and red number) plots the red graph, and the blue meridian (blue line
on the circle and blue number) plots the blue graph. 

The bottom part of the screen (green graph) plots the difference (diopters or mm) between
the two meridians along the corneal surface shown in the top part of the screen.

The grey areas in the center of the two graphs show the pupil area.

To plot other meridians, click on the red or blue arrows and drag up or down to change the
meridian degree values. The steep and flat meridians are always 90 degrees apart. 

Click the Reset button to reset the meridians to the initial steepest (red) and flattest (blue)
degrees.

Figure 7-3 Profile View

☞ Note: For Profile views in 2-Difference and 3-Difference Displays, the initial
meridians are plotted at 0 and 90 degrees, and the Reset button resets all Profile
view meridians in the display to these initial values.

Click and drag 
the arrows
to change the 
meridian values 

Color view

 
 

inside circle 

Reset button
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Rendering

When the Color view is displayed, select Contour on the Rendering radio button to see
contours on the color map (See Figure 7-4). 

Figure 7-4 Color View with Contour Rendering

When the Color view is displayed, select Smooth on the Rendering radio button to see a
smooth gradation in color on the map (See Figure 7-5).

Figure 7-5 Color View with Smooth Rendering
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Color

The Color tab (Figure 7-6) allows you to select the Color Scale and Color Palette used in
the display. 

Figure 7-6 View Editor – Color Tab

Color Scale

When you change the scale, the display changes to show the new diopter/mm values. The
Color Scale can also be selected by clicking (left or right click) on the scale on the ANALYSIS

SCREEN.

Standard (ANSI Z80.23) – A fixed standard center and step size is used as defined by the
ANSI Standard for corneal topography (ANSI Z80.23). The Standard scale ranges from 38.5
to 49.5 diopters in 0.50 diopter increments, and 9.1 to 6.9 mm in 0.1 mm increments.

☞ Note: All Color Scale values of 38.5 diopters (9.1 mm) and below are shown in the
same blue color, and all values of 49.5 diopters (6.9 mm) and above are shown in
the same red color.

Auto – The center and step size is calculated based upon the values in the map. Auto uses
the statistical distribution of the readings from the map to set the minimum and maximum
values of the scale in diopter increments as small as 0.25 diopters. These values are unique
to any given map. Auto typically provides the most detail, but colors cannot be directly
compared across exams or patients. Note that the scale range is a minimum of 6 diopters.
Thus, on a map where the data varies by less than 6 diopters, the minimum and maximum
values on the Auto scale won’t match the minimum and maximum values of the map data.

Custom – Custom allows you to specify the center and step size in either diopters or
millimeters.

☞ Note: Changing units will change the color map display because Diopter and mm
values do not necessarily map to the same color for any Color Scale.

Uniform – All Axial, Tangential, Mean, and Refractive Power Views in a multi-View Display
are automatically adjusted to the same Color Scale. Uniform behaves the same as Auto if
only one of the above Views is displayed in a multi-View Display.

Color Palette

Color Palettes contain the set of colors used to render a color map or numeric view. The
colors of the corneal display correspond to the values shown on the scale at the left of the
screen. Each color represents a different value in either diopters or millimeters. Red,

 Click to Select Color Scale
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orange, and yellow are “hot” colors and show the steeper areas of the cornea. Green is an
“intermediate” color. Light and dark blue are “cool” colors and show the flattest areas. You
can select from two color palettes:

Standard (ANSI Z80.23) – This is the default palette with 23 color steps, going from red to
blue, as defined by the ANSI Standard for corneal topography (ANSI Z80.23).

Expanded – This option sets the display to the Expanded color palette. This palette
contains a wider color spectrum with 25 color steps. Instead of red to blue in the Standard
color palette, the Expanded color palette goes from white to blue. 

Overlay

The Overlay tab (Figure 7-7) on the View Editor allows you to select which data overlays
display on the corneal view. A checkmark means the selected data overlay will be displayed. 

Figure 7-7 View Editor – Overlay Tab

Grid (1-mm spacing)

Displays a 1-mm square grid on the corneal view.

Zones

Displays up to 3 concentric circles that represent different zones on the cornea: 3, 6, and 9
mm from the center of the pupil.

Pupil contour

The green pupil contour marker locates and determines the size of the pupil.

Pupil center

The smaller crosshair enclosed by a circle denotes the center of the pupil, or “optical
center” of the eye. 

Corneal apex

The triangle identifies the apex of the cornea defined by the intersection of the axis of the
best-fit ellipsoid with the corneal surface.

Corneal vertex

A small white cross indicates the corneal vertex location defined by the intersection of the
visual axis with the corneal surface.

Display diameter

Displays the current map diameter in mm at the bottom of the corneal view. 
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Angle overlay

Displays a 360 degree angle overlay.

Sim K values

Displays a crosshair enclosed in a circle and the Sim K values on the corneal view.

Data

The Data tab (Figure 7-8) on the View Editor allows you to select what data is displayed
in the data table (Figure 7-9) to the right of the corneal view on the ANALYSIS SCREEN. A
checkmark means the selected data will be displayed. If there are more data values than
can fit in the table, you will see an ellipse (...) symbol at the bottom of the data table.
Different Views may show different data parameters on the Data tab. In the data table,
diopters are displayed with a “D” next to the value, millimeters are displayed as “mm.”

Figure 7-8 View Editor – Data Tab (Axial View)

 

Figure 7-9 Analysis Screen – Data Table Example (Axial View)

Cornea Shape Measures

Normal corneal shape is aspheric, steeper centrally, and flatter progressively toward the
limbus. There are several descriptors to describe corneal aspheric shape. Vision scientists
often assume the corneal profile in any meridian to be conic section. A conic section can
be fully described using two parameters—the apical radius and the eccentricity (e ). The
apical zone is the area around the corneal apex where the refractive power variation is
little, approximately 4mm in diameter. The eccentricity indicates the departure of the
peripheral curvature from the apical radius and so defines the degree of asphericity. There
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are other descriptors such as Shape Factor (SF), p-value (p), and Q that also describe a
conic section (see Table 7-1 and Table 7-2). A conic section can be a circle, and ellipse,
a parabola, or a hyperbola (Figure 7-10). A normal cornea is a prolate conic section. That
means that the curvature flattens from the apex to the periphery and 0 < SF < 1. This is
called positive asphericity.

 

Figure 7-10 Conic Sections

Table 7-1 Conic Sections and the Corresponding Values of SF, p and Q

Conic Section Shape Factor (SF) p Q 

Hyperbola > 1 < 0 < –1

Parabola 1 0 –1

Prolate Ellipse
(normal eye)

0 < SF < 1 0 < p < 1 –1 < Q < 0

Circle 0 1 0

Oblate Ellipse < 0 > 1 > 0

Table 7-2 Corneal Shape Measures Equations

Q SF–=
SF Q–=

p 1 SF–=
SF 1 p–=

SF 0
Q 0

e SF=
e Q–=

e2 SF=
e2 Q–=

SF 0
Q 0

e SF–  1 SF– =
e Q  1 Q+ =

e2 SF–  1 SF– =
e2 Q  1 Q+ =

hyperbola

parabola

prolate ellipse

circle

oblate ellipse
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Eccentricity

Eccentricity is a measure determined by the shape of the cornea. The eccentricity indicates
the departure of the peripheral curvature from the apical radius and so defines the degree
of asphericity.

Shape Factor (SF)

Shape Factor is a measure of the asphericity of the cornea. Shape Factor gives a measure
of the flattening or steepening of the cornea along its flattest meridian. In the PathFinder II
multi-clinical sample data, the average normal cornea has a Shape Factor of 0.37. The
Shape Factor should be used in conjunction with the CIM value to gain the most
information about the cornea. Shape Factor can be used to determine whether the cornea
is more oval or elliptical shaped. 

Shape factors are unique and different from eccentricity in that it is possible to calculate a
negative, or oblate shape, as well as a positive, or prolate shape. Negative Shape factors
imply an oblate cornea (flatter in the center, steeper in the periphery). Positive Shape
factors imply a prolate cornea (steeper in the center, flatter in the periphery). 

Shape Factor is useful in contact lens fitting and in identifying unusual or pathological
corneal shapes. Shape Factor is based on a best-fit general ellipsoid to the corneal surface.
This takes into account the effects of astigmatism, and the tip and tilt of the corneal
symmetry axis.

The value of both the CIM and Shape Factor measurements can be seen with serial
topography over time. Judging whether these statistical indices are increasing or
decreasing over time may indicate a worsening pathology or a healing trend. 

The probability distribution of Shape Factor for normal diagnosed eyes in the PathFinder II
multi-clinical sample data is shown in Figure 7-11. The multi-clinical sample data set
covers 95% of the normal eye population with a 95% confidence. For example, Figure
7-11 shows a 32% probability that the Shape Factor for normal eyes falls between 0.2 and
0.3. The mean value is 0.37 and 90% of the population falls between 0.20 and 0.64. See
Table A-1, “PathFinder II Color-Coded Parameter Classification (Normal Eyes,
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based on Multi-Center Clinical Study),” on page A-2) for Shape Factor range
values.

Figure 7-11 Shape Factor Probability Distribution (Normal Eyes, PathFinder II Clinical Study)

Q

Q is a measure of the shape of the cornea. It is defined as the inverse (or negative) of the
Shape Factor (see Shape Factor (SF) on page 7-9). Q is an index of asphericity; Q
indicates how much the curvature changes upon movement from the center to the
periphery of the cornea. A normal cornea is prolate (i.e., becomes flatter toward the
periphery). In the PathFinder II multi-clinical sample data, the average value of Q is –0.37.
A prolate surface has negative Q values and positive oblate surface values. Most myopic
laser vision corrections change the anterior corneal surface from prolate to oblate.

CIM

CIM (Corneal Irregularity Measurement) is a statistical measurement which uses
topographic data from the central area of the cornea and compares it to the best-fit
surface found. It determines the regularity or irregularity of the corneal surface used for
vision. The CIM measurement determines how much the actual corneal surface varies from
a smooth fitted ellipsoidal toric surface as Root Mean Square (RMS) error in micrometers
(μm). The fitted surface includes any regular astigmatism which may be present.

The higher the irregularity index, the more uncorrectable or uneven the surface is optically,
thereby highlighting irregular astigmatism that often results in visual distortions. CIM uses
the thousands of data points within the first fourteen rings of the corneal topography data
to determine the difference in “height” or elevation between the patients cornea and the

Shape Factor

Pr
ob

ab
ili

ty



ATLAS User Manual 2660021135270 B

View Editor 7-11

best matching, perfect model ellipsoidal toric cornea. The area covered by the fourteen
rings (approximately 50 degrees) has proven to provide excellent corneal coverage while
neglecting the expected “non-normal” transition zone from cornea to limbus. The
difference between the perfect model and the actual cornea is measured in micrometers
and the standard deviation is taken. This is defined as CIM. Higher CIM values, then,
would tend to indicate a worsening pathology such as keratoconus, due to the inherent
corneal thinning and “wrinkling” of the corneal surface that the pathology causes. High
CIM indices can also be observed in post refractive surgery corneas due to the irregularity
that the surgical procedure and subsequent healing process cause. CIM also measures the
type of irregular astigmatism which cannot be corrected with spectacle lenses.

CIM normal values range from 0.42 to 4.05 micrometers, and the higher the number
becomes, the more abnormal it is. The probability distribution of CIM for normal diagnosed
eyes in the PathFinder II multi-clinical sample data is shown in Figure 7-12. The
multi-clinical sample data set covers 95% of the normal eye population with a 95%
confidence. For example, Figure 7-12 shows a 72% probability that CIM for normal eyes
falls between 0.5 and 1.0. The mean value of CIM is 0.91 micrometers and 90% of the
population falls between 0.49 and 1.68. See Table A-1, “PathFinder II Color-Coded
Parameter Classification (Normal Eyes, based on Multi-Center Clinical
Study),” on page A-2) for CIM range values.

Figure 7-12 Probability Distribution of CIM (Normal Eyes, PathFinder II Clinical Study)

CIM
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TKM

TKM (Toric Keratometric Mean) is the average corneal curvature at the apex. The apical
position is the intersection of the “symmetry axis” of the best-fit ellipsoidal toric with the
cornea. Two principal curvatures are calculated at the apex for the flattest and steepest
meridian and their mean is determined. This is described as the mean value of the apical
curvature.

The probability distribution of TKM for normal diagnosed eyes in the PathFinder II
multi-clinical sample data is shown in Figure 7-13. The multi-clinical sample data set
covers 95% of the normal eye population with a 95% confidence. For example, Figure
7-13 shows a 28% probability that TKM for normal eyes falls between 44.0 and 45.0 D. The
mean value of TKM is 44.68 D and 90% of the population falls between 42.19 and 47.26 D.
See Table A-1, “PathFinder II Color-Coded Parameter Classification (Normal
Eyes, based on Multi-Center Clinical Study),” on page A-2) for TKM range values.

Figure 7-13 Probability Distribution of TKM (Normal Eyes, PathFinder II Clinical Study)

Sim K’s

The simulated K readings are a measurement which simulate the readings of a standard
Keratometer. These readings may vary slightly from automated or manual Keratometer
readings depending on the Placido rings location on the corneal surface. 

Astigmatism

Astigmatism is the difference between the Steep and Flat K values displayed as a positive
value. Astigmatism is only displayed when Sim K’s are displayed.

TKM
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HVID (ATLAS 9000 data only)

The HVID (Horizontal Visible Iris Diameter) value in mm can be displayed. This is the same
as the Horizontal limbus diameter or white-to-white diameter. This is only measured on an
ATLAS 9000 instrument.

Pupil diameter

The pupil diameter in mm can be displayed.

Axial I-S (Axial View only)

Axial I-S is a value proposed by Rabinowitz1, which quantifies inferior-superior dioptric
asymmetry. It is calculated by first taking the nearest curvature value 3 mm from the
corneal vertex on five Inferior meridians (210, 240, 270, 300, and 330 degrees) and five
Superior meridians (30, 60, 90, 120, and 150 degrees). The five Superior curvature values
are then averaged and subtracted from the average of the five Inferior values to create the
value. A positive Axial I-S value indicates steeper Inferior curvature for the cornea; a
negative value indicates steeper Superior curvature.

RMS (Corneal Wavefront, Image Simulation, PSF, and MTF Views only)

The Root Mean Square (RMS) value of the Zernike coefficients determines how much wavefront
error the anterior cornea has. The higher the RMS value, the larger the amount of wavefront error.
RMS is a quadratic sum of the Zernike coefficients, measured in micrometers, that give the
power of the aberrations for the terms that have been summed. For example, higher order RMS is
the total of all the higher order aberrations. Total RMS is the overall magnitude of all the eye’s
refractive errors. RMS only uses image data set by the Zernike Wavefront parameters (see
Wavefront on page 7-14). Low (2nd order aberrations only), High (3rd order aberrations and
greater only), and Total (Low + High) RMS values (μm), and their “equivalent defocus” values
(diopters only) are displayed, as shown on the left. 

Equivalent defocus is the amount of defocus needed to produce the same RMS wavefront
error produced by one or more higher-order aberrations. The diopters of equivalent defocus
depends on the ratio of RMS error to pupil area. One diopter of a higher-order aberration
does not have exactly the same visual effect as one diopter of defocus, and one diopter of
astigmatism does not have exactly the same effect as one diopter of defocus, but the use
of a common metric helps judge their relative importance. Equivalent defocus allows us to
compare the order of magnitude of different kinds of aberrations and judge their clinical
significance.

Averages

Select the Zone radio button for the average curvature in diopter or millimeter values for up
to 8 circular areas or zones on the cornea. All data within the zone is used to calculate the
average. Then select any or all of the mm buttons from 0 mm to 8 mm (diameter of zone,
centered on corneal vertex) for the zone(s) you want values displayed.

1.  Rabinowitz, YS. Videokeratographic indices to aid in screening for keratoconus. J Refract Swg 1995;
11:371-379.
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Select the Ring radio button for the average curvature in diopter or millimeter values for up
to 8 circular rings on the cornea. Only data taken along the ring points is used to calculate
the average. Then select any or all of the mm buttons from 0 mm to 8 mm (diameter of
ring, centered on corneal vertex) for the ring(s) you want values displayed.

Wavefront

The Wavefront tab is used in the calculation and display of the Corneal Wavefront View,
PSF View, MTF View, and Image Simulation View. It displays the parameters shown in
Figure 7-14 below.

Figure 7-14 View Editor – Wavefront Tab

Stiles-Crawford effect

The Stiles-Crawford weighting compensates for the directional sensitivity of the photo
receptors. Click this box to enable (checked) or disable (unchecked) the use of the
Stiles-Crawford function weighting in the calculation of the aberrations. 

Zernike order (pop-up number)

Enter a Zernike order number (number of coefficients) in the pop-up menu to set the order
of the Zernike fit.

Aperture

Aperture sets the maximum diameter or opening (simulated pupil diameter) to use in
computing the Corneal Wavefront. 

Table 7-3 Examples of Ring and Zone Averages

Rings Zones

1 mm 1 mm

2 mm 2 mm

3 mm 3 mm
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Select Automatic (All data) to let the software automatically set the aperture. To manually
set the value, select Custom diameter and then select the value (mm) in the pop-up menu. 

Select coefficients to mask

Each Zernike coefficient represents a specific wavefront error, or optical aberration, and
these are used to describe both lower and higher order aberrations of the eye. You can
mask off (set to zero) a given Zernike term to see the effect of removing that aberration
from the cornea. The software uses the double-index notation method for the Zernike
Polynomial functions. The Zernike coefficient is designated by the form:

Z (n, m)

where n is a positive integer representing the radial index of the function, and m is a
signed integer representing the meridional index of the function. See Table 7-4 for a list
of common names for the Zernike Polynomial functions. 

In the “2,” to “7,” button column (radial index, n), you can mask (or unmask) a Zernike
Order number (a row of coefficients) by clicking on a number. In the number pyramid
(meridional index, m), you can mask aberration coefficients by clicking in the box next to
the number to select it. A row of coefficients (m) align with their row number (n). For
example, to mask the Z (5, -1) coefficient, click the “-1” in the “5,” row to select it. 

Table 7-4  Common Names of Zernike Polynomial Functions

Zernike Function Common Name

Z (0,0) Piston

Z (1, –1) Vertical tilt

Z (1,1) Horizontal tilt

Z (2, –2) Oblique astigmatism

Z (2,0) Myopic defocus (positive value)
Hyperopic defocus (negative value)

Z (2,2) Against the rule astigmatism (positive value)
With the rule astigmatism (negative value)

Z (3, –3) Oblique trefoil

Z (3, –1) Vertical coma – superior steeping (positive value)
Vertical coma – inferior steeping (negative value)

Z (3, 1) Horizontal coma

Z (3,3) Horizontal trefoil

Z (4, –4) Oblique quatrefoil

Z (4, –2) Oblique secondary astigmatism

Z (4, 0) Spherical aberration
Positive – pupil periphery more myopic than center
Negative – pupil periphery more hyperopic than center

Z (4,2) With/against the rule secondary astigmatism

Z (4, 4) Quatrefoil
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Z (5, –1) Secondary vertical coma

Z (5, 1) Secondary horizontal coma

Table 7-4  Common Names of Zernike Polynomial Functions

Zernike Function Common Name
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(8) Parameter Sets

Chapter Overview

You can customize exam acquisition, printing preferences, and the way data is displayed
using Parameter Sets. ATLAS Software allows you to create up to ten different Parameter
Sets for customized exam acquisition, analysis, and reporting options. The following topics
are discussed in this chapter:

• Editing Parameter Sets, page 8-1
• Displays, page 8-5
• Views, page 8-7
• Exams, page 8-9
• Printing / DICOM Export Options, page 8-11
• Report Options, page 8-12

Editing Parameter Sets

To create/edit Parameter Sets and to set the current Parameter Set:

• From the PATIENT SELECTION WINDOW: select Parameter Set... on the Options menu.
• From the ANALYSIS SCREEN, when the More (F2) checkbox is selected: select Edit

Parameter Sets from the Options tab in the DISPLAY OPTIONS window (see Options
on page 4-9).

 The EDIT PARAMETERS SCREEN (Figure 8-1) is displayed.

Figure 8-1 Edit Parameters Screen
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Default Parameter Sets

ATLAS ships with six default parameter sets. Table 8-1, “Default Parameter Sets,”
shows these default parameter sets and some of their parameter settings. 

Table 8-1  Default Parameter Sets

Parameter Sets

Pathology Cataracts Contact Lens Fitting Refractive Surgery Screening Screening
(Expanded)

Capture 
Scotopic

No Yes Yes Yes No No

Capture 
Photopic

No Yes Yes Yes No No

Color 
Palette

Standard Standard Standard Standard Standard Expanded

Color Scale
(Curvature)

Standard Standard Standard Standard Standard Custom
Center: 49.0 D
1.5 D interval

(31 to 67 D range)

Default 
Display

Overview Overview Overview Overview OD/OS OD/OS

Overview 
Views

Rings
Axial

Tangential
Elevation

Axial
Keratometry

Corneal Wavefront
Image Simulation

Axial
Keratometry
Tangential

Image Simulation

Axial
Mean

Elevation
Irregularity

Axial
Tangential

Mean
Image Simulation

Axial
Tangential

Mean
Image Simulation

Single View 
Data

Axial
Sim Ks

Eccentricity
SF
Q
-
-
-

Pupil Diam.
HVID

-
-
-
-
-

Axial
Sim Ks

-
SF
Q
-
-
-

Pupil Diam.
-

0 mm ring
1 mm ring
2 mm ring
3 mm ring
4 mm ring

Axial
Sim Ks

Eccentricity
SF
-
-

CIM
TKM

Pupil Diam.
HVID

-
-
-
-
-

Axial
Sim Ks

-
SF
Q

Axial I-S
-
-

Pupil Diam.
-
-
-
-
-
-

Axial
Sim Ks

Eccentricity
SF
Q
-

CIM
TKM

Pupil Diam.
HVID

-
-
-
-
-

Axial
Sim Ks

Eccentricity
SF
Q
-

CIM
TKM

Pupil Diam.
HVID

-
-
-
-
-

OD/OS 
Display

Axial
Tangential

Axial
Keratometry

Axial
Keratometry

Axial
Mean

Axial
Keratometry

Axial
Keratometry

Auto Print 
after 
Acquisition?

No Yes No Yes Yes Yes

Report 
Printouts

- Overview Display - Overview Display OD/OS Display OD/OS Display
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Setting the Current Parameter Set

To set the current Parameter Set, click the Current Parameter Set drop-down menu to
select the Parameter Set you want to make current, and then click the OK button on the
bottom of the EDIT PARAMETERS screen. Click Cancel to keep the previous setting.

Figure 8-2 Setting the Current Parameter Set

☞ Note: When you change Parameter Sets, all settings that have not been saved from
the previous Parameter Set will be lost.

Setting a Parameter Set to Default Settings

To set a Parameter Set to default settings shipped with the software, click in the Current
Parameter Set drop-down menu to select the Parameter Set you want to set to default
settings. Click the Defaults button. An Attention dialog is displayed.

Figure 8-3 Setting a Parameter Set to Default Settings

Click the Yes button to set the selected Parameter Set to factory default settings. Click No to
keep the current setting. Click the OK button on the bottom of the EDIT PARAMETERS screen
to complete the change.

☞ Note: The Defaults button will set new Parameter Sets you have created to the
default settings of the Parameter Set it was copied from.

☞ Note: If you have created new Parameter Sets or renamed them in prior versions of
ATLAS, you will be prompted to select the Parameter Set to default to. 
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Creating a New Parameter Set

To create a new Parameter Set, click the New button.

Figure 8-4 Creating a New Parameter Set

Select a Parameter Set in the drop-down menu to set the initial parameter values. Type in a
new name for the Parameter Set and then press Enter or click the OK button. Click the OK
button on the bottom of the EDIT PARAMETERS screen to save the new set.

Renaming a Parameter Set

To rename a Parameter Set, click in the Current Parameter Set drop-down menu to
select the Parameter Set you want to rename. Click the Rename button.

Figure 8-5 Renaming a Parameter Set

Type in a new name for the Parameter Set and then press Enter or click the OK button. Click
the OK button on the bottom of the EDIT PARAMETERS screen to save the new name.

Deleting a Parameter Set

To delete a Parameter Set, click in the Current Parameter Set drop-down menu to
select the Parameter Set you want to delete. Click the Delete button. An Attention dialog
is displayed.

Figure 8-6 Deleting a Parameter Set

Click the Yes button to delete the Parameter Set. Click No to cancel the deletion. Click the
OK button on the bottom of the EDIT PARAMETERS screen to complete the change.
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Displays

Default Views

The Default Views dialog (Figure 8-7) sets default views for the selected Parameter Set.
This function allows you to select the default Display when the ANALYSIS SCREEN is first
displayed for a patient. In addition, default Views for the Displays can also be specified.
When a Display is selected, the default View set here will be displayed.

Figure 8-7 Default Views Dialog

The Default display drop-down menu sets the default Display when the ANALYSIS SCREEN

is displayed. See (5) Displays for more information on Displays.

All other drop-down menus set the default Views for the Displays shown. Note that OD/OS
has 2 default Views to select, Overview has 4 default Views to select, and Custom also has
4 default Views to select. See (6) Views for more information on Views.

Click the OK button to save your changes. Click Cancel to keep the previous setting.
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Display Text

The Display Text dialog (Figure 8-8) allows you to set the default display of text items
on the ANALYSIS SCREEN for the selected Parameter Set.

Figure 8-8 Display Text Dialog

The text items checked will be shown on the ANALYSIS SCREEN. Click to uncheck a text item
and keep it from being displayed on the ANALYSIS SCREEN. Figure 8-9 shows the location
of all Display text items on the ANALYSIS SCREEN.

The Show/hide patient info button allows you to easily turn on/off the display of Patient
Name, Patient ID, and Patient birthday with one click.

Click the OK button to save your changes. Click Cancel to keep the previous setting.
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Figure 8-9 Display Text Items Shown on the Analysis Screen

Views

The Views menu on the EDIT PARAMETERS SCREEN allows you to set default parameters for all
Views for the selected Parameter Set. Selecting a View from the menu, displays the View
Editor for that View. See (6) Views for more information on Views. See (7) View Editor
for more information on the View Editor’s parameters. 

View Editor parameters are global for all Views except the following parameters which can
be set differently for each View:

• General tab – Map diameter (Auto, Fixed diameter (mm))
• General tab – View as... (Color, Number, Profile)
• Data tab – All parameters

If you change any global parameter in one View, it will be changed in all other Views that
have these parameters after you save the Parameter Set.

Patient Name,
 ID & Birthday

Institution Name

 Doctor, Operator

 Nasal/Temporal 

 

 

Exam

Eye (OD/OS)

comment

Exam date
& time

Names
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For example, Figure 8-10 shows the Axial dialog which allows you to set default View
Editor parameters for the Axial View. 

Figure 8-10 Views – Axial Dialog

Click the OK button to save your changes. Click Cancel to keep the previous setting.
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Exams

The Exams dialog on the EDIT PARAMETERS SCREEN allows you to set default exam settings for
image acquisition. See (3) Acquire Images (Instrument Only) for more information
on the image acquisition screens. 

Figure 8-11 Exams Dialog on ATLAS Instrument

OcuLign®

Check this to enable OcuLign® mode. This mode enables capturing an image that is
compatible with the Carl Zeiss Meditec CRS-Master Software. This feature is used when
capturing the photopic image so you can use the exam for corneal guided ablation with
the CRS-Master Software. 

When OcuLign® is selected on the ATLAS instrument the version number is also displayed
and Capture photopic is selected by default—it is greyed out, you cannot deselect it. In
addition, you have the option to select the Photopic delay (sec.) from a drop-down menu
(Figure 8-12). 

Figure 8-12 OcuLign® Mode Selected on ATLAS Instrument
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When OcuLign® mode is enabled, an OcuLign column is displayed in the patient exam
list of the Find Existing Patient tab and View Today’s Patients tab (Figure 8-13). 

Figure 8-13 OcuLign® Column in Patient’s Exam List

On the ATLAS instrument, if OcuLign® mode is enabled at the time of exam acquisition,
the OcuLign® field in the patient’s exam list will display “OcuLign® OK” or “OcuLign®
not OK” for the exam in terms of iris image quality or obstruction. If “OcuLign® not OK” is
displayed, the EXAM PREVIEW or EXAM RESULTS SCREEN at exam acquisition will display an
error code (see Table 3-1, “OcuLign® Error Code Descriptions,” on page 3-11).

Capture scotopic (Instrument Only)

Check this to capture a scotopic image at image acquisition. This setting will be displayed
on the IMAGE PARAMETERS SCREEN. See the Image Parameters Screen on page 3-5.

Capture photopic (Instrument Only)

Check this to capture a photopic image at image acquisition. This setting will be displayed
on the IMAGE PARAMETERS SCREEN. See the Image Parameters Screen on page 3-5.

Exam Preview (Instrument Only)

Check this to display the EXAM PREVIEW SCREEN after image acquisition (Figure 3-9). The
EXAM PREVIEW SCREEN displays the last four images in the image frame buffer (or best four
images if the Use SmartCapture™ option is on), has a Data Parameters Table for each
exam, mean and standard deviation values for the four images displayed, and
selectable/customizable Views for the images. If not checked, the EXAM RESULTS SCREEN will
be displayed (Figure 3-10) which displays only the last image (or best image if the Use
SmartCapture™ option is on). This setting will be displayed on the IMAGE PARAMETERS

SCREEN. See the Image Parameters Screen on page 3-5.

Use SmartCapture™ (Instrument Only)

Check this to enable ATLAS SmartCapture image acquisition mode. SmartCapture Image
Analysis Technology automatically acquires images during the alignment process and
selects the highest quality image (or images if Exam Preview is enabled). This setting will
be displayed on the IMAGE PARAMETERS SCREEN. See the Image Parameters Screen on
page 3-5.
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Default doctor’s name (Instrument Only)

Select a default doctor from the drop-down menu. This name will appear on the EXAM PREVIEW

or EXAM RESULTS SCREEN. See the Exam Preview/Exam Results Screen on page 3-9. 

Default operator’s name (Instrument Only)

Select a default operator from the drop-down menu. This name will appear on the EXAM PREVIEW

or EXAM RESULTS SCREEN. See the Exam Preview/Exam Results Screen on page 3-9. 

Click the OK button to save your changes. Click Cancel to keep the previous setting.

Printing / DICOM Export Options

The Printing /DICOM Export Options dialog (Figure 8-14) on the EDIT PARAMETERS SCREEN

allows you to select the reports, Displays, and Views printed/exported at the end of image
acquisition, and with the Print/Export button on the ANALYSIS SCREEN. 

Figure 8-14 Printing / DICOM Export Options Dialog on ATLAS Instrument

In the Report Printout Selection area, select the reports and Views you want printed by
clicking on them and displaying a checkmark. Click again to deselect and remove
checkmark. See Report Options on page 8-12 for selecting Views included in the
Reports. See (6) Views for information on Views. The selected reports will be printed
when you select Print > Print report on the ANALYSIS SCREEN. Selecting Export > Export
report to DICOM will export the selected reports to a DICOM system.
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☞ Note: For the OD/OS Display and Reports, the software automatically selects the
closest other eye (based on exam date).

If Auto print after acquisition is checked (ATLAS instrument only), then the selected reports
and Views will be printed automatically at the end of image acquisition (when you click the
Done button). If Auto export after acquisition is checked (ATLAS instrument only), then the
selected reports and Views will be exported to a DICOM system automatically at the end of
image acquisition (when you click the Done button). See Done on page 3-14. See
Exporting Data to DICOM Systems on page 11-25.

☞ Note: If multiple exams have been selected or acquired for one eye before you select
the Done button, only the reports and Views for the last exam will be printed.

Click the OK button to save your changes. Click Cancel to keep the previous setting.

Report Options

The Report Options dialog on the EDIT PARAMETERS SCREEN allows you to select the Views
included in OVERVIEW REPORTS (Figure 8-15) and OD/OS REPORTS (Figure 8-16). 

Figure 8-15 Report Options – Overview Reports
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Figure 8-16 Report Options – OD/OS Reports

Six Views are included per Overview report (see Figure 8-17 for an example Overview
report), and three Views for each OD/OS report (see Figure 8-18 for an example OD/OS
report). Select the Views you want from the drop-down or pop-up menus by clicking on it.
See (6) Views for more information.
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Click the OK button to save your changes. Click Cancel to keep the previous setting. 

Figure 8-17 Example Overview Report
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Figure 8-18 Example OD/OS Report
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(9) Data Management

Chapter Overview

This chapter explains how to manage data with the ATLAS System. Topics covered in this
chapter include:

• The admin User, page 9-1
• Create Institution Name (admin only), page 9-2
• Staff Registration (admin only), page 9-2

• Patient Search, page 9-5
• Advanced Search, page 9-6

• Create, Edit and Delete Patients, page 9-8
• Merge Patients, page 9-11
• Categorize Patients, page 9-13
• Change Database / Create New Database (admin only), page 9-16
• Back Up/Restore Configuration Files (admin only), page 9-20

This manual treats the archive/retrieve and export/import transfer functions in separate
chapters:

• (10) Archive Management
• (11) Export and Import

The admin User

To manage administrative functions, ATLAS dedicates a special user account with the user
name admin. Only the admin user can create and edit the institution name, user accounts
and staff.

The admin account never appears in the drop-down list of user names on the login screen.
You must type it in. The admin account accepts any password or none. The admin user
cannot acquire or analyze images. When the admin user is logged in, the only available
menu functions are:

• File > Log Out
• File > Exit
• Tools > Back Up Configuration Files...
• Tools > Retrieve Configuration Files...
• Tools > Database Recovery Tool...
• Options > Language... (change to another language)
• Options > Change Database...(change to another ATLAS database)
• Options > Institution... (edit institution information)
• Options > Staff... (register or edit staff)
• Options > Category Registration... (create or edit categories)
• Help > View User Manual... F1
• Help > View Licenses...
• Help > About (view software version information)
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Only the admin user can access the Language, Change Database, Institution,
Staff, and Category Registration dialogs on the Options menu. Also, only the admin
user can access the Back Up/Retrieve Configuration Files dialogs on the Tools menu.

Create Institution Name (admin only)

Use the Institution Edit dialog to customize your system with your institution’s name.
The institution name will appear on all analysis printouts.

To access the Institution Edit dialog, you must be logged in as the admin user.

A default Institution name (Advance Eye Clinic) has been created in the sample data.
Follow the steps below to customize your system:

1. Click Options > Institution.... The INSTITUTION EDIT dialog opens.

Figure 9-1 Institution Edit Dialog

2. In the Name field, type the name of your institution. The field requires at least one
character and accepts up to 64 characters, including spaces. The name field cannot
be empty.

3. Click Save to save your changes and exit the dialog, or click Close to exit the dialog
without saving.

Staff Registration (admin only)

Using the Staff Registration dialog, the admin user can create (register) medical staff
and assign a user name and password to users. 

User Accounts

ATLAS user accounts offer two types of users, Operator and Doctor. Only a user defined as
an operator can log onto the ATLAS System. At exam acquisition, you can specify a doctor
and operator used for an exam, and their names will be displayed on Analysis Screen Views
and reports. A user can be defined as both an operator and doctor.

At first-time startup of the sample data (and with a new database), a default user name
(ATLAS Operator, blank password) appears in the drop-down list. 

Register (Create), Edit and Delete Staff

To register, edit or delete staff, use the Staff Registration dialog. To access this dialog, you
must be logged in as the admin user.



ATLAS User Manual 2660021135270 B

Data Management 9-3

Select Options > Staff.... The Staff Registration dialog opens.

Figure 9-2 Staff Registration Dialog

All registered staff appear in the list, sorted alphabetically by last name. None is selected
by default.

Register (Create) Staff

1. In the Staff Registration dialog, click New. The New Staff dialog opens.

Figure 9-3 New Staff Dialog

2. Edit the staff registration fields as desired. A staff record must have either a last name
or first name or both; other fields are optional. 

3. Select Doctor or Operator, or both.
4. When finished with your changes, click Save.

• To discard the changes before saving, click Cancel. A dialog prompts you to confirm
your choice.



Data Management

ATLAS User Manual 2660021135270 B

9-4

☞ Note: If the password field is left blank, that user must leave the password field
blank to log in. User names are not case-sensitive, but passwords are.

☞ Note: Once logged in, any user can change his or her own password by selecting
Options > Change My Password... and completing the Password Change
dialog. The admin user may take advantage of this feature by creating new user
accounts with a temporary password he provides to the user, and asking the user to
change the password.

Edit Staff

To edit medical staff, follow these steps:

1. In the Staff Registration dialog, select a staff record and click Edit. The Staff Edit
dialog opens. It resembles Figure 9-3 above except that the name of the selected
staff appears in the title bar. Edit the staff registration fields as desired and then click
Save. A staff record must have either a Last Name or First Name; other fields
are optional.

• To discard the changes before saving, click Cancel. A dialog prompts you to confirm
your choice.

☞ CAUTION: If you edit a doctor or operator that has been referenced in exams, then
your edited changes will be displayed with the exams.

Delete Staff

To delete medical staff, follow these steps:

1. In the Staff Registration dialog, select a staff record and click Delete. A dialog will
ask you to confirm your choice.

Figure 9-4 Confirm Staff Deletion Dialog

2. Click OK to confirm deletion, or click Cancel to cancel deletion.

You cannot delete a staff record if there are any references to it in exam data. If you try to
delete it, the following dialog appears.

Figure 9-5 Cannot Delete Staff Referenced in Exam Data
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Patient Search

Search functionality is incorporated into several dialogs within the ATLAS System software.
In each instance, the software provides basic search functionality on the dialog itself and
an Advanced Search link. With advanced search, you can search using all possible
parameters. The advanced search, no matter where initiated, always uses a common
dialog (see Advanced Search on page 9-6). Dialogs that include basic search
sometimes provide different sets of search parameters. This section presents basic search
using the most common example: the PATIENT SELECTION WINDOW.

Basic Search

1. To search for patients, use the Find Existing Patient tab of the PATIENT SELECTION

WINDOW (Figure 9-6), which appears automatically after login.

From other modes, click the Find Existing Patient button or select File > Find Existing
Patient to return to the PATIENT SELECTION WINDOW.

Figure 9-6 Patient Selection Window—Default Tab: Find Existing Patient

Click and drag the
mouse between
the Patient and

Exam lists to
resize the list

boxes.
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2. Click Search to return all patients in the index database. To search for patients by first
or last Name or Patient ID, type in the corresponding fields and click Search.

• You can search using partial information, and you can use one or both fields.
• Click Advanced Search if you want to search using additional parameters—see

Advanced Search on page 9-6 for details.
• The search returns all patients that match all defined parameters, sorted

alphabetically.
• When you search by Name, the search applies to last name, first name, middle

name, prefix and suffix, and returns all patients that match any of these fields.
• In this list, you can select only one patient at a time. When you select a patient, the

Capture Image button becomes active for an ATLAS instrument. If the patient has
saved exams, the Analyze button becomes active.

Advanced Search

1. Click Advanced Search if you want to search for patients using additional parameters. 
The Advanced Search dialog appears.

Figure 9-7 Advanced Search Dialog

2. Using the available fields, enter or select search parameters and click Search. Search
parameters you type in are not case-sensitive. 

☞ Note: If you have licensed the optional MasterFit II software (see (B) MasterFit II
(Optional)), you can search for patients that have saved MasterFit II data by
selecting MasterFit II Patient Data in the Exam Protocol drop-down menu.
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3. The Search Preview dialog returns all matching patients, sorted alphabetically by
last name.

Figure 9-8 Search Preview Dialog

☞ Note: The search returns only the patients that match all search parameters used. If
your search does not return all patients desired, you may want to broaden your
search by using fewer parameters or partial information. Clicking Search without
using any parameters returns all patients in the ATLAS System index database.

4. In the Search Preview dialog, select the patients you wish to populate the patient
list where your search originated.

• Click to select one patient; Ctrl-click to select multiple patients; Shift-click on two
patients to select all intervening patients; Ctrl-Shift-click to select all intervening
patients plus those already selected.

• Click Select All to select all patients in the Search Preview list; the button then
toggles to Deselect All, in case you wish to start selecting again.

• Click Back to return to the Advanced Search dialog.
• Click Cancel to return to the PATIENT SELECTION WINDOW.

5. After you select patients, click OK. The selected patients will appear in the patient list
where you started.
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Create, Edit and Delete Patients

To manage patients, start in the PATIENT SELECTION WINDOW, which appears automatically
after login. From other modes, select File > Find Existing Patient or click the Find Existing
Patient button to return to the PATIENT SELECTION WINDOW.

Add a New Patient (Instrument Only)

To add a new patient, click the Add New Patient tab and fill in at least the required
fields, which are indicated with red asterisk (*). Since a Patient ID is required for
DICOM-compliant import and export of patient data, if you do not enter a Patient ID, the
system will create a unique ID automatically for this patient. 

Figure 9-9 Add New Patient Tab of the Patient Selection Window

• When you click Save, the new patient information is saved to the database and to the
list of today’s patients. If data is missing from required fields, you will be prompted to
complete these fields before you can save.

• Click Clear to clear the fields and start over, before or after saving. This is useful to add
multiple new patients in succession, because when you click Save, the patient is saved
but the Add a New Patient tab remains open.

• When you click Capture Image (Instrument only), ATLAS saves the new patient
information and initiates a new exam for that patient. See Add New Patient
(Instrument Only) on page 3-3.
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Edit Patient...

1. Select a patient from the Find Existing Patients tab or from the View Today’s
Patients tab of the PATIENT SELECTION WINDOW. (To populate the patient list, see
Patient Search on page 9-5.)

2. Click Edit > Edit Patient... (This menu option is available only if you are in patient
selection mode and one patient is selected). The Patient Edit dialog appears with
the name of the selected patient appearing in the title bar (Figure 9-10).

Figure 9-10 Patient Edit Dialog

3. Edit the desired fields and click Update and then OK to save the changes. Click Cancel
and then OK to cancel the changes and return to the PATIENT SELECTION WINDOW.

Obscured Patients

Patient information can be hidden (as for a clinical trial) when exporting ATLAS 9000 Series
data. To hide patient information so that they are obscured, see Patient Identifier Omit
Options on page 11-22. If the patient identifying data is obscured, you will not be able
to edit patient information. 

Add/Remove Categories Tab

Use this tab to assign categories to and remove them from the patient. For details, see
Add Categories to Patient on page 9-15.
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Delete Patient

To delete a patient:

1. Select a patient from the Find Existing Patient (see page 3-2) tab or from the
View Today’s Patients (see page 3-4) tab of the PATIENT SELECTION WINDOW. If
necessary, perform a Patient Search (see page 9-5) to access the desired patient.

2. Click Edit > Delete Patient. This option is available only if you are in patient selection
mode and have selected one patient.

• You can also click the Delete button from any tab of the Patient Edit dialog (see
Figure 9-10 on page 9-9).

• If the patient has no exam data, the following dialog will be displayed:

• The following notice will appear if you try to delete a patient that has exam data
that has not been archived:

When you try to delete a patient that has saved exams that have been archived a dia-
log prompts you to confirm your choice:

3. Click Continue to delete the patient, or click Cancel to cancel deletion.

WARNING: Deleting a patient is permanent to the instrument/computer you
delete from. However, if you have already archived the patient before
deletion, the patient and his/her exams remain on the archive volume, and
can be recovered by using the Database Recovery Tool (see Database
Recovery Tool on page 10-25).
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Merge Patients

In ATLAS, every patient has a unique Patient ID number. It is possible that two or more
patients may exist for the same patient because this information was entered differently on
separate occasions. To correct such errors, it is possible to merge two patients. To merge
two patients, follow these steps:

1. Select Edit > Merge Two Patients.... The Patient Merge dialog opens.

Figure 9-11 Patient Merge Dialog

To populate the patient list with the patients you wish to merge, either click Search to 
return all patients, or specify search parameters in the fields provided and then click 
Search. You can also click Advanced Search to search with more parameters.

☞ Note: Patients imported with omitted patient identifiers cannot be merged and will
not be displayed in the Patient Merge dialog. See Exporting to ATLAS 9000
Series Media on page 11-21.
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1. Select the two patients you wish to merge. You must hold down the Ctrl key while
clicking (Ctrl-click) the second patient. The Merge Patients button will not be active
unless exactly two patients are selected (Figure 9-12).

Figure 9-12 Patient Merge – Two Patients Selected

WARNING: Be certain that you select the correct patients to merge. If you
have not archived the two patients, then only the merged patient will be
available for later archive, and there is no way to separate the combined
records of the erroneously merged patients. If you have already archived the
two patients, both patients will remain on the archive location, and can be
recovered by using the Database Recovery Tool (see Database Recovery
Tool on page 10-25).

2. Click Merge Patients. A dialog informs you that after merging, all exams, analyses,
and categories from both patient records will belong to the patient record you select.

Figure 9-13 Patient Merge – Warning Dialog
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3. A dialog prompts you to select the correct patient, that is, the patient whose
information you wish to retain for the newly merged record. Select the desired patient
and click Merge Patients.

Figure 9-14 Patient Merge – Select the Correct Patient

☞ Note: Note that merging is not reversible if you have not already archived the
patients.

4. A dialog prompts you to confirm the merge, as shown below. Click OK to proceed with
merging. 

Figure 9-15 Confirm Patient Merge

When complete, you will return to the Patient Merge dialog, where you will observe just
one record for the patient in the patient list. If you wish to merge additional patients,
repeat the steps above. When finished merging, click Cancel or  to close the dialog.

Categorize Patients

You can create your own categories and place patients in them. This enables you to search
for groups of patients by category. In general, the advantage of the categories function is
that it provides you the ability to create groups of your own design for any reason, and to
directly control their membership. All other search criteria arise from objective data.

Create, Edit and Delete Categories (admin only)

To create, edit and delete categories, use the Category Registration dialog. To access
this dialog, you must be logged in as the admin user.
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To access the Category Registration dialog:

1. Select Options > Category Registration.... The Category Registration dialog
opens.

Figure 9-16 Category Registration Dialog

All registered categories appear in the list, sorted alphabetically. None is selected by
default.

Create (Register) Categories

1. In the Category Registration dialog, click New. The New Category dialog appears.

Figure 9-17 New Category Dialog

2. In the Name field, type in a name for the new category, up to 64 characters,
including spaces. You may enter an optional description.

3. Click Save. The new category now will be available to place patients in it.

• Click Cancel at any time to cancel changes and exit the dialog.

Edit Categories

☞ Note: You cannot edit categories created at another institution.

1. In the Category Registration dialog, select a category and click Edit. 
The Category Edit dialog appears (Figure 9-17).

2. In the Name and Description fields, edit the category as desired.
3. Click Save to save your changes.

• Click Cancel at any time to cancel changes and exit the dialog.
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Delete Categories

1. In the Category Registration dialog, select a category and click Delete. A dialog
will ask you to confirm your choice.

2. Click OK to confirm deletion, or click Cancel to cancel deletion.

☞ Note: Categories cannot be deleted if they are associated with at least one patient.

Apply Categories to Patients: Add or Remove

You can apply categories to new patients when you add a new patient by selecting a
category from the list (see Figure 9-9). To add or remove categories to patients after
adding a patient, follow these steps:

1. Select a patient and click Edit > Edit Patient.... The Patient Edit dialog appears (see
Figure 9-10 on page 9-9). The name of the selected patient appears in the title bar
of the dialog.

2. Select the Add/Remove Categories tab. Available Categories are displayed on the
left and Patient Categories on the right.

Figure 9-18 Add/Remove Categories Tab of the Patient Edit... Dialog

☞ Note: The Delete button applies to the patient itself, not to categories. Click the
Delete button only if you want to delete the patient. For details, see Delete Patient
on page 9-10.

Add Categories to Patient

1. Select the desired categories to apply to this patient from the Available Categories list
on the left. Ctrl-click to select multiple categories.

2. Click Add to associate the selected categories with the patient. The selected
categories will now appear in the Patient Categories list on the right.
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3. Click Update and then OK to save your changes and close the Patient Edit dialog, or
click Cancel and then OK to exit the dialog without saving.

Remove Categories from Patient

1. From the Patient Categories list on the right, select the desired categories to remove
from this patient. Ctrl-click to select multiple categories.

2. Click Remove to remove the selected categories from the list of Patient Categories on
the right. The newly removed categories will now appear in the list of Available
Categories on the left.

3. Click Update and then OK to save your changes and close the Patient Edit dialog, or
click Cancel and then OK to exit the dialog without saving.

Change Database / Create New Database (admin only)

You can change your current database to a different patient database and create a new
blank database at a new location. The new database location must be on your local hard
drive or a USB mass storage device.

☞ Note: To access the Change Database function, you must be logged in as the
admin user (see The admin User on page 9-1).

☞ Note: When you change databases, only the staff of doctors and operators
associated with the new database will be available.

☞ Note: An ATLAS 9000 Version 1.0 database will undergo a conversion upon loading.
If any patients exist without a Patient ID, a Patient ID will be created for them using
the first and last name (e.g. Patient ID = johnadams).

☞ Note: ATLAS data is not encrypted. To protect confidentiality of your ATLAS data, the
use of disk encryption is recommended and is the responsibility of the user, using
third-party encryption software.

☞ Note: The default sample database that comes with the ATLAS System and ATLAS
Review is located at “C:\Documents and Settings\All Users\Application Data\Carl
Zeiss Meditec\ATLAS\Database” for Windows XP; for Windows Vista the path is
“C:\Program Data\Carl Zeiss Meditec\ATLAS\Database.”
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Change Database

To change the database to another database file, follow these steps.

1. Click Options > Change Database.... The Database Path dialog appears with the
Change Database tab selected (Figure 9-19).

Figure 9-19 Change Database – Change Database Tab 

2. In the Database file and path field, you can type in the exact path to the new
database file, if you know it, or click the Path button (...) to find and select the new
database file. 
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A Select ATLAS database file dialog (Figure 9-20) appears, enabling you to 
browse to the new database file.

Figure 9-20 Select ATLAS Database File Dialog

3. When you have selected the new database file, click Open to enter the path into the
Select ATLAS database file dialog box. 

4. Click OK to change the database file. A Change Database (Figure 9-21) dialog
will be displayed. 

Figure 9-21 Change Database Dialog

5. For the database change to take effect, click OK to close the ATLAS application. 

6. Restart the ATLAS application to load the new database.
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Create New Database

To create a new database file, follow these steps.

1. Click Options > Change Database.... The Database Path dialog appears with the
Change Database tab selected. Click the Create new database tab (Figure
9-22).

Figure 9-22 Change Database – Create New Database Tab

2. In the Folder to put new database field, you can type in the exact path to the
new database folder, if you know it, or click the Path button (...) to find and select (or
create) the new database folder. A Browse For Folder dialog (Figure 9-23)
appears, enabling you to browse to the new database folder location.

Figure 9-23 Browse For Folder Dialog
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3. In the New database name field, type in a name for the new database.

4. Click Create new blank database to create the new database. The system notifies you
when the new database has been created.

5. In order to use the new database you just created, you need to change to the new
database by using the Change Database function (see Change Database on page
9-17) and specify the new database location.

☞ Note: At first-time startup of a new database, the Institution Edit dialog will be
displayed where you must enter a name for your institution (see Create Institution
Name (admin only) on page 9-2). A default user name (ATLAS Operator, blank
password) will be created for the new database (see Register (Create), Edit and
Delete Staff on page 9-2 to create your staff user accounts). 

Back Up/Restore Configuration Files (admin only)

ATLAS allows you to back up certain configuration files. This is useful for transferring the
current ATLAS configuration to another ATLAS, and as a backup in case of file corruption.
The files backed up are the Parameter Sets and preference settings. 

☞ Note: To access Back Up/Restore Configuration, you must be logged in as the
admin user (see The admin User on page 9-1).

Back Up Configuration Files

To back up configuration files to an archived location, follow these steps.

1. Make sure that the back up location is accessible. For network locations, your system
must be connected to the network back up location.

2. Click Tools > Back Up Configuration Files. The Back Up Configuration Files dialog
appears. 

Figure 9-24 Back Up Configuration Files Dialog

3. In the Path field, you can type in the exact path to the back up folder, if you know it,
or click the Path button (...) to find and select (or make) the new archive folder. 
A Browse for Folder dialog appears, enabling you to browse anywhere in a local or
network path that is accessible.
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.

Figure 9-25 Browse for Folder Dialog

4. When you have selected or created the new archive folder, click OK to enter the path
into the Back Up Configuration Files dialog box. Click OK to proceed with the
back up. 

5. When the back up is complete, the system notifies you.

Restore Configuration Files

To restore configuration files from an archived location, follow these steps.

1. Make sure that the restore location is accessible. For network locations, your system
must be connected to the network restore location.

2. Click Tools > Restore Configuration Files.... The Restore Configuration Files
dialog appears. 

Figure 9-26 The Restore Configuration Files Dialog
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3. In the Path field, you can type in the exact path to the restore folder, if you know it, or
click the Path button (...) to find the restore folder. A Browse for Folder dialog
appears, enabling you to browse anywhere in a local or network path that is
accessible.

Figure 9-27 Browse for Folder Dialog

4. When you have found the path of the restore folder, click OK to enter the path into the
Restore Configuration Files dialog box. Click OK to proceed. You will receive the
following warning: 

Figure 9-28 Warning on Replacing Current Setting 

WARNING: Make sure you have already backed up the current configuration
files before you restore another set, since restoring replaces your current
setting.

5. Click Yes to proceed with the restore, or No to cancel.
6. When you click Yes, the restore process begins. If the program cannot find any

configuration files, a dialog will be displayed. Click OK to continue. 
7. When the restore is complete, the system notifies you.
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(10) Archive Management

Chapter Overview

ATLAS provides the archive function to preserve your exam data, and the retrieve function
to access archived exam data, or restore it in case of computer malfunction. This chapter
explains how to perform these functions. Topics covered include:

• The Patient Database, below
• Data Maintenance Requirements, page 10-2
• Clear Exam Data, page 10-3
• Archive/Synchronize Recommendations, page 10-4
• Archive/Synchronize Management, page 10-8
• Manual Archive, page 10-21
• Retrieve Archived Exams, page 10-22
• Database Recovery Tool, page 10-25

Advisory: We strongly recommend that you archive daily to a network archive
location (a network file server or network attached storage device) or to a
USB Hard Drive. If you do not archive at all, paper records are the only way to
retain patient information in case of system hard drive malfunction.

☞ Note: ATLAS data is not encrypted. To protect confidentiality of your ATLAS data, the
use of disk encryption is recommended and is the responsibility of the user, using
third-party encryption software.

The Patient Database

To enable excellent database performance along with long-term data protection, the
patient database separates data-intensive exam data from the index database. Thus, the
ATLAS patient database contains two kinds of stored data:

1. The index database identifies each saved exam and analysis by patient, date and type
of image or analysis, and records where its associated bulk exam data can be
found—on the local hard drive or which archive location.

2. Exam data or bulk data includes the images generated during an examination, along
with the associated patient, exam, image and analysis data.

1

Index Database

• Index of exam data:

  identity and location

2

Exam Data
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Data Maintenance Requirements

The complete index database always remains on the ATLAS System computer hard drive
(unless you delete individual patient data). Exam data, because it includes image files,
eventually must be cleared from the system hard drive to make space to save new images.
Two actions must occur to protect your data against loss in case of computer malfunction:

1. Backup: Occurs Automatically

Upon startup, the system automatically backs up the index database to the current archive
location to protect it from a system malfunction that could render it inaccessible. 

☞ Note: A current archive location must be set in order to back up the index database
(See Set Current Archive on page 10-20).

Backup is an important data protection function, but since it is automatic, you need not be
concerned with it unless the current archive location is inaccessible. In that case, a dialog
will notify you, and the recommended course is to restore access to the current archive
location or to change the current archive location. See Archive/Synchronize
Management on page 10-8 for details.

Archive: Automatic or User-Initiated

Archiving of exam data can be set to occur automatically or manually by user intervention.
Exam data remains on the instrument hard drive until the hard disk reaches capacity, or
until automatically or manually removed. The ATLAS instrument can be set to automatically
archive exam data (see Automatic Archiving on page 10-5) or you can initiate archive
manually (see Manual Archive on page 10-21). The system can also be set to prompt
you to archive unarchived exams, either at startup or shutdown, but the user must initiate
the archive option when offered (see Archive Alerts on page 10-6). 

By copying exam data to another location, archiving protects data from loss due to system
malfunction. But archiving has the secondary purpose of enabling you to clear archived
exams and thereby maintain adequate hard disk space to save more images. Because
exam data has unique and persistent identifiers that link it to the index database, it can be
safely removed from the system hard drive. You can readily access or retrieve archived exam
data when the ATLAS System has access to the correct archive location. If the current
archive location is inaccessible, a dialog will notify you, and the recommended course is to
restore access to the current archive location or to change the current archive location. See
Archive/Synchronize Management on page 10-8 for details.

1

Index Database

Backup

2

Exam Data

Archive
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Clear Exam Data

Data maintenance eventually requires the clearance (deletion) of exam data on the ATLAS
System that has previously been archived.

☞ Note: ATLAS never clears unarchived exam data.

Only when the hard drive gets too full must you clear enough hard disk space to allow you
to save more exams. With a new instrument, it takes many months up to a few years,
depending on its usage rate, before the ATLAS System prompts you to clear archived
exams.

Automatic Clearance

When the hard disk status becomes yellow, the system automatically initiates clearance of
archived exams upon startup. Also, before synchronizing, retrieving, and importing, the
software calculates the size required for the data. If there is not enough free space in the
ATLAS hard drive, then the clearing process is automatically started. However, if the
amount of archived exams available for clearance is insufficient for the data being
imported, or to return the status to green, you will be notified as in Figure 10-2 below. In
this case, you must archive exams and then clear again.

☞ Note: If you do not clear archived exams when prompted, eventually the hard disk
status will reach red, whereupon capturing and analysis are disabled. At that point,
you must archive and clear exam data to restore use of these primary functions.

Manual Clearance

To manually clear archived exams:

While in patient selection mode, select Archive > Clear Archived Exams to initiate
clearance.

Clearance Behavior

☞ Note: The clearance function, whether automatic or manual, has the same
characteristics.

The system searches on the ATLAS hard drive for exams that have been archived. If it finds
any, it begins to clear archived data immediately. The Clear Progress dialog reports
progress.

Figure 10-1 Clear Progress Dialog

• If there is no data to clear, a dialog reports it, as at left.
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• When clearing completes successfully, a dialog reports it.
• If clearing completes, but insufficient space has been cleared on the hard drive to

return the hard drive status to green, the following message appears:

Figure 10-2 Insufficient Data Cleared

If this occurs, you must archive exams to make additional exam data available for 
clearance from the hard drive, and then clear again.

Which Exams Are Cleared

• The ATLAS System clears only enough exams to forestall the reappearance of the
yellow or red Hard Disk Status indicator (see Hard Disk Status Indicator on page
2-14) for several weeks or months, depending on the acquisition rate of new exams.
Once initiated, the clearing target space is 25% above the green/yellow Hard Disk
Status indicator border.

• It does not clear exams that have not been archived. 
• Archived exams are cleared oldest first, based on the last viewed date. 
• Exams acquired, imported or retrieved in the last month are not cleared.
• It does not clear an archived exam if its archive location is disabled (see Disable an

Archive Location on page 10-19.

Archive/Synchronize Recommendations

WARNING: It is the user’s responsibility to protect exam data from loss.
Unarchived data is at risk of permanent loss in case of computer malfunction.
We recommend that you archive daily, as described in this section. The
archived data also needs to be backed up regularly.

The ATLAS System makes it possible to archive to a network location, which includes to a
network attached storage device (also known as a network hard drive). Once installed, a
network attached storage device operates just as a network archive location and offers the
same advantages.

☞ Note: For archive to a network file server, configuring the server and the instrument
should be attempted only by a network administrator or system administrator.
Instructions for network administrators to set up network archive are found in 
(D) Network Configuration Guide. Users are responsible for network setup,
backup, and maintenance. Carl Zeiss Meditec Technical Support is limited to testing
network connectivity of the ATLAS System. Technical Support cannot troubleshoot or
repair problems with network connectivity. 
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Advantages of Network Archiving

Archiving to a network location offers the following advantages:

• Protects your high value exam data: Server hardware and software are engineered for
better long-term data security and preservation.

• Ease of use: Plug the ATLAS System into your existing office network (or plug a
network attached storage device into the instrument), create an archive location, and
you are ready to archive with little or no ongoing intervention. 

Preferences: Archive/Synchronize

Select Options > Preferences... to access the Preferences dialog and then click the
Archive/Synchronize tab (Figure 10-3).

Figure 10-3 Preferences – Archive/Synchronize Tab

The Archive/Synchronize preferences are described below. When finished selecting your
preferences, click OK to save your changes and exit, or click Cancel to exit without saving.

Automatic Archiving

To have ATLAS automatically archive new and imported exams, select Auto in the Archive
section. ATLAS will check every 10 seconds for new completed and imported exams. Once
a new or imported exam is detected it will be automatically archived in the background—
no progress dialogs will be displayed. At the end of image acquisition, a new exam is
detected once a new completed exam is created—when you select Done on the Exam
Results screen (see Done on page 3-14). For imported exams, if auto archiving is on
and exams are imported (ATLAS 1 or 2), they will be automatically archived.
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☞ IMPORTANT: The ATLAS System will archive exams only to the current archive
location. (For details, see Set Current Archive on page 10-20.) If no current
archive is selected, the system will not automatically archive.

☞ Note: If you have a large database of unarchived exams, it is recommended to
manually archive (Archive > Archive Now) the database first before you turn on
automatic archiving. In this case, archiving could take a long time, and manual
archiving allows you to see the archive progress.

☞ Note: Since auto archiving occurs in the background with no progress indicators, it
is possible that you may shut down the ATLAS System during the archive progress. If
this happens, archiving will stop at shutdown and automatically resume at the next
ATLAS System startup.

Archive Alerts

ATLAS gives you a way to control the automated behavior for archive alerts. It is possible to
select one, neither or both Start up and Shutdown. If you select neither option, it is
possible for unarchived exams to accumulate without your knowledge because the system
will not prompt you to archive. However, when the hard disk status turns yellow, you may
have to archive exams in order to then clear enough archived exams to return the status to
green. At that time, archiving may take several hours. You must archive if the hard disk
status turns red and you cannot clear enough space to enable capturing and analysis.

Figure 10-3 displays the default settings. If Shutdown is checked, the system alerts you to
the presence of unarchived exams upon shutdown. If any are found, the software acts just
like you have selected to archive manually—the Archive Now function will be displayed
where you can initiate an archive by selecting the Archive button (see Manual Archive
on page 10-21). 

You can archive manually at any time by selecting Archive > Archive Now (see Manual
Archive on page 10-21).

☞ IMPORTANT: The ATLAS System will archive exams only to the current archive
location. (For details, see Set Current Archive on page 10-20.) If no current
archive is selected, the system will not alert you to unarchived exams.

☞ Note: The archived data also needs to be backed up regularly. If the archive “dies”,
there is no way to retrieve exams that have cleared on the instrument. Also, all
exams will link to an archive that is “dead” and still cannot be removed. It is
important that you have a multiple back up procedure in place on the archived
volumes (RAID, off-site storage, etc.).

☞ IMPORTANT: The archive’s location hard drive must be formatted in NTFS format.
ATLAS data is compatible only with NTFS.
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Automatic Synchronization

You can enable ATLAS to automatically synchronize networked archive databases by
selecting Auto in the Synchronize section. ATLAS will check every 10 seconds for databases
that are not synchronized. Once detected, synchronization will be performed automatically
in the background—no progress dialogs will be displayed. Only archives listed on the
Archive Locations to Synchronize screen (Archive > Synchronization Management...)
will be synchronized.

☞ Note: Since auto synchronization occurs in the background with no progress
indicators, it is possible that you may shut down the ATLAS System during the
synchronization progress. If this happens, synchronization will stop at shutdown
and automatically resume at the next ATLAS System startup.

Synchronize Alerts

ATLAS gives you a way to control the automated behavior for synchronization alerts. It is
possible to select one, neither or both Start up and Shutdown.

Figure 10-3 displays the default settings. If Start up is checked, the system alerts you to
the presence unsynchronized exams on startup. If any are found, the software acts just like
you have selected to synchronize manually (Archive > Synchronize). A dialog appears
asking if you are sure you want to synchronize (Figure 10-4).

Figure 10-4 Synchronization Dialog 

Click Yes to proceed, or No to not synchronize.

If you proceed with synchronization, a dialog will be displayed showing the progress of the
synchronization (Figure 10-5). Click Stop if you want to cancel. ATLAS notifies you when
the synchronization is complete. 

Figure 10-5 Synchronizing Archive Volume Dialog 

If you want to be alerted at computer shutdown, select Shutdown. You can manually
synchronize at any time by selecting Archive > Synchronize. See Synchronizing
Databases on ATLAS Instruments/Computers on page 10-11 and
Synchronization on page 10-18.



Archive Management

ATLAS User Manual 2660021135270 B

10-8

Archive/Synchronize Management

Archive locations or volumes are directories on a network server, network attached storage
device (NAS device), or connected USB hard drive (see Figure 10-6 and Figure 10-7).

Figure 10-6 Archive Network Diagram

Figure 10-7 USB Hard Drive Archive Diagram

When you create a new archive or add a pre-existing archive, it is registered on your ATLAS
System, which can then access the archive location.

☞ Note: “Register” is a useful term that means to add an archive to your system’s list
of available archives.
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Archive/Synchronize management includes the following functions:

• Create a New Archive Location, page 10-9
• Synchronizing Databases on ATLAS Instruments/Computers, page 10-11
• Add Network Archive(s) for Synchronization, p. 10-15
• Disable/Enable an Archive Location for Synchronization, p. 10-16
• Delete an Archive Location for Synchronization, p. 10-17
• Synchronization, page 10-18
• Edit an Archive Location, page 10-19
• Disable an Archive Location, page 10-19
• Set Current Archive, page 10-20
• Delete Archive Locations, page 10-20

To access archive management:

1. While in patient selection mode, click Archive > Archive Management.... The Archive
Locations dialog appears.

Figure 10-8 Archive Locations Dialog

It shows all archive locations, sorted alphabetically by label. The current archive is
indicated on the left with a green checkmark. Any disabled archives will have a gray
background.

Create a New Archive Location

☞ Note: To create a new network archive location, an information technology
specialist must first configure the network file server and the ATLAS System to
communicate. See (D) Network Configuration Guide. 

☞ Note: You cannot write to an archive created on another ATLAS System.
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To create a new archive location:

1. In the Archive Locations dialog, click New. The New Archive Location dialog
appears.

Figure 10-9 New Archive Location Dialog

The Label field is generated automatically and will be unique. You cannot edit it. This 
field is composed of the model number, serial number and archive sequence number.

2. If you wish, you can enter up to about 85 characters in the Description field to
describe the archive.

3. In the Path field, you can type in the exact path, if you know it, but usually users will
click Browse to find and select (or make) the new archive folder. A Browse for
Folder dialog appears, enabling you to browse anywhere in a local or network path
that is accessible.

Figure 10-10 Browse for Folder Dialog

4. When you have found the path where the new archive will reside, select the desired
archive folder, or click Make New Folder to create a new archive folder.

☞ Note: The system prevents you from creating an archive volume on the instrument
hard drive.
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5. When you have selected (or created) the new archive folder, click OK to save your
selection and return to the New Archive Location dialog. The archive path will
appear in the Path field, and the Drive Mapping field will also be completed
automatically.

6. If you wish to archive to this archive location, select the Mark as Current Location
checkbox. You can also select the current archive in the Archive Locations dialog.

7. Click Save to save your changes, or Cancel to cancel changes without saving. When
you click Save, the archive will appear in the list of Archive Locations.

Synchronizing Databases on ATLAS Instruments/Computers

It is possible to synchronize databases from multiple ATLAS 9000 instruments or Review
Stations with each other—either automatically or manually. If archive volumes created on
different ATLAS instruments exist on the same network file server, any other ATLAS 9000
instrument or computer running the ATLAS Review Software can access the images from
the archive volumes. This process, called synchronization, ensures that each ATLAS 9000
instrument or Review Station synchronized has the same database after synchronization. 

Figure 10-11 Synchronization Diagram for One ATLAS 9000
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Synchronization consists of moving data from two or more instruments/computers into
separate archive volumes on a network server. Each instrument/computer creates a
separate archive volume that other instruments/computers cannot write to. This function is
known as “archiving.” Once data has been archived for each instrument/computer, it can
be read by any other instrument/computer during the synchronization process so that each
instrument/computer contains the same data as all the others.

Figure 10-11 shows a synchronization diagram for one ATLAS 9000 instrument and three
Review Station computers. The ATLAS 9000 creates an archive folder on the Network
Server that the Review Stations can synchronize from.

Figure 10-12 Synchronization Diagram for an ATLAS 9000 and ATLAS 993/995

Figure 10-12 shows a synchronization diagram for one ATLAS 9000, one ATLAS 993/995,
and three Review Station computers. The ATLAS 9000 is configured to auto import ATLAS
993/995 exams (see Importing from ATLAS 900 Series Instrument Databases on
page 11-5). The ATLAS 9000 creates an archive folder on the Network Server that the
Review Stations can synchronize from.
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Figure 10-13 shows a synchronization diagram for one ATLAS 993/995, and four Review
Station computers. A Review Station is configured to auto import ATLAS 993/995 exams
(see Importing from ATLAS 900 Series Instrument Databases on page 11-5).
The Review Station creates an archive folder on the Network Server that the other Review
Stations can synchronize from. This is the recommended configuration when you have
three or more Review Stations. This will prevent possible file lockup errors when multiple
Review Stations try to import exams at approximately the same time. When you have one
or two Review Stations you can just auto-import ATLAS 993/995 exams into the Review
Stations (see Figure 11-18 on page Figure 11-18) without synchronization. 

Figure 10-13 Synchronization Diagram for an ATLAS 993/995
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Figure 10-14 shows a synchronization diagram for two ATLAS 9000 instruments and
three Review Station computers. Each ATLAS 9000 creates its own archive folder on the
Network Server that the Review Stations can synchronize from. 

Figure 10-14 Synchronization Diagram for Two ATLAS 9000s

The first archiving that is performed will archive the entire database from an ATLAS
instrument hard disk to its archive volume. This should be done for each ATLAS in the
network. Subsequent archiving operations will archive only new data that has been
collected since the last archiving was completed.

Archiving can occur automatically or by manual selection (see Manual Archive on page
10-21 and Automatic Archiving on page 10-5), and you can set alerts at start up and
shut down (see Archive Alerts on page 10-6). 

Synchronization can be done manually or automatically, and alerts can also be set (see
Automatic Synchronization on page 10-7, Synchronize Alerts on page 10-7, and
Synchronization on page 10-18).
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As an example, a networked office with three ATLAS 9000 instruments and one Review
Station PC has exams done on all three instruments in one day—10 patients on ATLAS #1,
12 patients on ATLAS #2, and 8 patients on ATLAS #3. If the three ATLAS 9000 instrument
archive volumes are registered on the Review Station PC (see Add Network Archive(s)
for Synchronization on page 10-15) and all instruments have been archived at the end
of the day, then after the Review Station PC performs synchronization it will have all the
new test data from all 30 patients in its database. This allows you to run an exam from any
ATLAS 9000 instrument, for instance, and analyze the results on a Review Station PC at a
different location in the office.

Add Network Archive(s) for Synchronization

For synchronization to occur, you must first add or register the network archive(s) locations
of other instruments to the list on the Archived Locations to Synchronize screen.

To add a new archive location for synchronization:

1. While in patient selection mode, click Archive > Synchronization Management.... The
Archive Locations to Synchronize dialog appears.

Figure 10-15 Archive Locations to Synchronize Screen

1. Click Add. An Open dialog appears (Figure 10-6).

Figure 10-16 Open Archive Locations Dialog
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2. Only archive volume files (Archive.xml) on the network file server can be selected in
the dialog. Find and select the desired archive volume. Click Open.

3. A dialog will be displayed asking if you want to register (add) the archive volume
(Figure 10-17). Select Yes to add the archive volume.

Figure 10-17 Register Archive Volume Dialog

4. The newly added network archive volume will be displayed in the Archive
Locations to Synchronize screen (Figure 10-18).

Figure 10-18 Archive Volume on Archive Locations to Synchronize Screen

5.The archive location is automatically enabled for synchronization. You can now access

image data from the network archive volume you just registered, when you

synchronize. See Synchronization on page 10-18.

Disable/Enable an Archive Location for Synchronization

An archive location is automatically enabled for synchronization when you add it to the
Archive Locations to Synchronize list. You can disable an archive location to prevent
database synchronization to and from an archive location. To disable/enable an archive
location for synchronization:

1. While in patient selection mode, click Archive > Synchronization Management.... The
Archive Locations to Synchronize screen appears.



ATLAS User Manual 2660021135270 B

Archive Management 10-17

2. Select the desired archive and click the Disable or Enable button.

Figure 10-19 Disable Archive Location for Synchronization

3. If you selected the Disable button, it will change to an Enable button. If you selected
the Enable button, it will change to a Disable button. 

4. Click Close to exit the Archive Locations to Synchronize screen.

Delete an Archive Location for Synchronization

☞ Note: ATLAS permits deletion of an archive location for synchronization only if you
have never synchronized from that archive location, or have deleted all patients that
were ever synchronized from that archive location. 

To delete an archive location for synchronization:

1. While in patient selection mode, click Archive > Synchronization Management.... The
Archive Locations to Synchronize screen appears.

2. Select the desired archive and click the Delete button.

Figure 10-20 Delete Archive Location for Synchronization

3. Click OK to confirm deletion, or click Cancel to cancel deletion.
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Synchronization

Once you have registered the desired network archives on your ATLAS Instrument or ATLAS
Review Computer (see Add Network Archive(s) for Synchronization on page
10-15), you can access the images saved in those archives, after you synchronize. The
process of synchronization copies patient index data from registered enabled
synchronization archive volumes to the local ATLAS database. Synchronization can be done
manually or automatically. See Automatic Synchronization on page 10-7 to set
automatic synchronization. To manually synchronize follow the steps below:

1. From the PATIENT SELECTION WINDOW, click Archive > Synchronize. 
2. A dialog appears asking if you are sure you want to synchronize (Figure 10-21).

Figure 10-21 Synchronization Dialog

3. Click Yes to continue with synchronize, No to cancel.
4. A dialog is displayed showing the progress of the synchronization (Figure 10-22).

Click Stop if you want to cancel.

Figure 10-22 Synchronizing Archive Volume Dialog

5. ATLAS notifies you when manual synchronization is complete. All index database
references from all registered and available network archives are added to your
current system database. You will see the names of new patients appear in the PATIENT

SELECTION WINDOW. You can now access their exams as if they were created at your
computer, when the source archive is available. To make the exams available for
viewing and analysis without further connection to the archive location, use the
Retrieve Archived Exams (see Retrieve Archived Exams on page 10-22) function
to copy the exams from the archive location to your ATLAS System hard drive.

☞ Note: A patient must have at least one exam to be synchronized.

☞ Note: Synchronization is not allowed to an archive volume created by the same
instrument/computer. If your ATLAS instrument hard drive fails and you need to
install a new hard drive, you can recover your database by using the Database
Recovery Tool (see Database Recovery Tool on page 10-25).
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☞ Note: ATLAS 9000 Version 1.0 data will undergo a conversion upon synchronization.
If any patients exist without a Patient ID, a Patient ID will be created for them.

Edit an Archive Location

Among the things you can do while editing an archive location are:

• remove or select the current archive designation
• disable the archive—see the effects of this below
• change the description of an archive
• change the path of archive location

To edit an archive location:

1. In the Archive Locations dialog, select the desired archive and click Edit. The Edit
Archive Location dialog appears.

Figure 10-23 Edit Archive Location Dialog

2. Edit the fields as desired. You can select and deselect the checkboxes for Mark as
Current Location and for Disable Location, the functions of which are described
below.

3. When you are finished editing, click Save to save your changes, or click Cancel to
cancel changes without saving.

Disable an Archive Location

Disabling an archive location has only one function—it disables or prevents archiving to
that archive location during the archive process.

To disable an archive location:

1. In the Archive Locations dialog, select the desired archive and click Edit. The Edit
Archive Location dialog appears, as in Figure 10-23.

2. Select the Disable Location checkbox.
3. Click Save to save your changes, or click Cancel to cancel changes without saving.

☞ Note: The Disable Location checkbox is not available if you are editing the current
archive location. It does not appear when you are creating a new archive.
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Set Current Archive

The current archive is the one to which new images will be archived (assuming the archive
location is accessible), and is marked with a green checkmark to the left of the label.

☞ Note: If no current archive is selected, the system cannot archive the database.

If you wish to change the network archive location to which new images will be archived,
follow these instructions:

1. In the Archive Locations dialog, click the archive you want to make current and
then click Mark as Current. The archive selected will be marked as the current archive.

• You can also select the Mark as Current Location checkbox in the Edit Archive
Location dialog.

2. Click Close or the  at upper right to exit the Archive Locations dialog.

Delete Archive Locations

☞ Note: ATLAS permits deletion of an archive location only if the archive location
contains no patient data. Also, you cannot delete the current archive location.

To delete an archive location:

1. In the Archive Locations dialog, click on the archive you want and then click
Delete. A dialog prompts you to confirm your choice.

2. Click OK to confirm deletion, or click Cancel to cancel deletion.

Move Archive Volume

Follow these steps to move an archive volume to another server or USB hard drive (e.g.,
when drive becomes full):

1. Find the path of the current archive location by selecting the current archive in the
Archive Locations dialog, selecting Edit, and noting the location in the Path field.

2. Launch Windows Explorer and copy the current archive folder (location in the Path
field) to a folder on the new drive (you may want to create a new folder).

3. In the Archive Locations dialog, select the current archive and click Edit.
4. Click the Browse button to find and select the location of the new archive (you need to

open the archive folder and select the Archive.xml file).
5. Click the Save button to save the archive at the new location.
6. Click Close or the  at upper right to exit the Archive Locations dialog.

☞ Note: If you are just replacing drives so the drive letter and archive folder location
name are the same, then you don’t need to do anything, since the new archive
location is exactly the same as the old location.
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Manual Archive

You can archive exam data manually at any time.

☞ Note: It does not affect the instrument or its performance to leave it running
overnight while archiving.

☞ IMPORTANT: The ATLAS System will archive exams only to the current archive
location. (For details, see Set Current Archive on page 10-20.) If no current
archive is selected, the system will not be able to archive.

1. Select Archive > Archive Now. A dialog appears showing the current archive location:

Figure 10-24 Archive Now Function

Select Change Archive Location to display the Archive Locations dialog and select
another archive location. Select Archive to begin the archive. Click Close to exit the
Archive Now function.

2. When you click Archive, a dialog is displayed showing the number of patients that
have not been archived and asking if you want to archive them:

Figure 10-25 Archiving Dialog

3. When you click OK, archiving begins immediately with a progress dialog:

Figure 10-26 Archive Progress Dialog
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Archive Behavior

• All unarchived exams will be archived, unless you click Stop. If you click Stop,
archiving will stop after the system completes archiving all data of the current patient.
Data already archived will not be erased from the archive location.

• It can take several seconds to several minutes for the ATLAS System to finish writing to
the archive location, depending on the number of unarchived exams. When complete,
a message reports a successful archive, or if some exams were not archived
successfully, a summary dialog reports information about exams not archived
successfully.

• The system does not overwrite previously archived data.

Accessing Archived Exams

You can view and analyze any archived image as usual if the system is connected to the
necessary archive location. If not, a dialog will inform you that the archive is not accessible,
identifying which archive is needed. Establish a connection with the necessary archive to
continue.

☞ Note: The system automatically retrieves archived data, if necessary to access the
data, for example, when analyzing cleared archive data. After retrieval, the data will
be available for clearance again, according to the usual parameters for clearing (see
Which Exams Are Cleared on page 10-4 for details).

Retrieve Archived Exams

To retrieve archived exams is to copy it from an archive location to the ATLAS hard drive,
thereby making it available for viewing and analysis without further connection to the
archive location.

To retrieve exam data, follow these steps.

1. Make sure that the archive location is accessible. Network archives must be registered
on the list of archives, and your system must be connected to the network archive
location.
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2. While in patient selection mode, click Archive > Retrieve Archived Exams. The
Retrieve dialog appears. Use this dialog to search for and then retrieve the exams
you want. 

Figure 10-27 The Retrieve Dialog

3. Enter search parameters in the fields provided and click Search, or click Advanced
Search to use additional search parameters (see Advanced Search on page 9-6 for
details). The search returns all matching patients, sorted alphabetically by last name. 

• If there are no exams to retrieve, a dialog reports it, as shown at left.
4. Select the desired patients in the Results list: Click to select one patient; Ctrl-click to

select multiple patients; Shift-click on two patients to select all intervening patients;
Ctrl-Shift-click to select all intervening patients plus those already selected; click and
drag to the right of the last name to select all adjacent patients. Click Select All to
select all patients in the Results list.
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5. When you have made your selections, click Retrieve (Figure 10-28). 

Figure 10-28 The Retrieve Dialog with Selected Patients

6. The software checks in which archive location(s) the matching exams are stored, and
starts the retrieval process one archive at a time (Figure 10-29). 

Figure 10-29 Retrieving Exams
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7. The dialog box shows the retrieval progress. It can take several seconds to several
minutes for the software to finish retrieving the exams to the hard drive, depending on
the number of exams.

8. At any time, you can click the Stop button to abort the retrieval. The retrieval process
will stop after the current whole exam has been retrieved. Already retrieved exams will
not be removed. A dialog will then be displayed (Figure 10-30).

Figure 10-30 Stop Retrieval Dialog

Select OK to close the dialog and return to the Retrieve dialog. Select Close to close 
the Retrieve dialog.

• If the hard drive is too full to retrieve all selected exams, the system will initiate
clearance of archived exams automatically, making space available before retrieval
continues.

9. When a successful retrieval is complete, the system notifies you (Figure 10-31).

Figure 10-31 Successful Retrieval Dialog

Select OK to close the dialog and return to the Retrieve dialog. Select Close to close 
the Retrieve dialog.

• If any exam data is not retrieved, a summary report appears with information about
all exams that were not retrieved.

Database Recovery Tool

When logged in as admin user, the Database Recovery Tool (Tools > Database Recovery
Tool) enables you to synchronize from a system’s own database archive for database
recovery. The Database Recovery Tool should only be used with assistance from a Carl Zeiss
Meditec authorized technical support technician. Please call Carl Zeiss Meditec customer
service for assistance: In the U.S., call 800-341-6968. Outside the U.S., contact your local
CZM distributor.
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(11) Export and Import

Chapter Overview

ATLAS offers the capability of exporting data for viewing and analysis to another ATLAS
instrument, a computer running ATLAS Review Software, or to a DICOM system. 

ATLAS has the ability to selectively import and export individual and multiple patients using
various media. This chapter explains how to export and import ATLAS data and to ensure
patient privacy and data integrity. The topics covered in this chapter include:

• Privacy and Data Integrity Features, page 11-1
• Importing/Exporting Patient Data and Exams, page 11-2
• Importing from ATLAS 9000 Series Export Media, page 11-3
• Importing from ATLAS 900 Series Instrument Databases, page 11-5
• Importing from ATLAS 900 Series Export Media, page 11-19
• Importing from Worklists (Instrument Only), page 11-20
• Exporting to ATLAS 9000 Series Media, page 11-21
• Exporting Data to DICOM Systems, page 11-25
• Exporting for Research, page 11-29

☞ Note: ATLAS data is not encrypted. To protect confidentiality of your ATLAS data, the
use of disk encryption is recommended and is the responsibility of the user, using
third-party encryption software.

Privacy and Data Integrity Features

It is the user’s responsibility to observe applicable privacy restrictions and to maintain data
integrity. ATLAS incorporates options in its data transfer functions that enable the user to
do this.

Patient Privacy

ATLAS gives you the choice to export exam data without information that could identify the
patient. When you choose to export data in this way, ATLAS does export the following
clinically relevant patient data: gender, assigned patient categories and comments. You
have the further option to export a complete date of birth, the month and day of birth only,
or no date of birth. The patient name is not exported and neither is the Patient ID. Instead,
anonymous patients include a 17 character Unique Patient ID number in the First Name
and Patient ID fields, and the originating clinic Institution name in the Last Name field. See
Table 11-2, “Patient Identifier Omit Options.
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Data Integrity

Cannot Edit Identifying Information

ATLAS applies a permanent electronic tag to patients that are imported without patient
identifying information and treats them as a protected category of data. For these patients,
you cannot edit or merge their information. You can analyze, archive and re-export the
data. Data that is imported with identifying patient information can be edited without
restriction.

Updating ATLAS 9000 Series Imported Patients

For all ATLAS 9000 imported patients, it is possible to import new image data and update
patient data. 

In the case of patients imported without patient identifying information, the Patient ID
enables updating of the patient. If during import ATLAS encounters information associated
with a Patient ID already imported, ATLAS does the following:

• imports all image data (exams) not previously imported, but never deletes nor
overwrites any image data already imported;

• updates patient data only if it was created on a later date than the data already
imported. This prevents overwriting of newer patient data with older.

Importing/Exporting Patient Data and Exams

The Import/Export options in ATLAS let you export, or copy patient data and exams from
the internal ATLAS hard drive to a network hard drive location, USB drive, or optical disk.
You can export patient data and exams from the ATLAS System hard drive to ATLAS 9000
Series media format, DICOM systems, and for research in XML or CSV formats.

You can also import, or add, patient data and exams to the ATLAS instrument. You can
import patient data to the ATLAS System hard drive from ATLAS 900 Series Instruments
(databases) and Export media, and ATLAS 9000 Series Export media. Patient information
can also be imported from worklists. Unlike archiving, exporting does not remove the exam
data from the ATLAS hard drive. Exporting and importing are used to transfer patient data
and exams from one ATLAS instrument (or computer running ATLAS Review Software) to
another, or to and from a DICOM system.

☞ Note: When patients are imported, all doctors and operators associated with the
patient’s imported exams are saved with the exams and can be viewed on the
ANALYSIS SCREEN, but they are not imported into the current staff database, and
therefore, cannot be modified or deleted. Also, an imported exam’s institution name
is not imported into the current instrument and is not displayed with the exam. The
current institution name will be displayed for all imported exams.
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Import

ATLAS provides four different import functions as described below:

Importing from ATLAS 9000 Series Export Media

To import data from ATLAS 9000 Series Export media, follow these steps.

1. Make sure that the import location is accessible. Your system must be connected to
the network for network import locations. If you are importing from an optical disk,
insert the optical disk containing the export data into its drive.

2. While in patient selection mode, click File > Import > From ATLAS 9000 Series Export
Media.... An Import dialog appears (Figure 11-1). 

Figure 11-1 Import Dialog

3. If the ATLAS 9000 data has been compressed to a Zip file during export (see Exporting
to ATLAS 9000 Series Media on page 11-21) select Import from Zip Format.

4. Click the Browse button to find the import folder or Zip file. A Browse for Folder
dialog appears, enabling you to browse anywhere in a local or network path that is
accessible. The Path field cannot be empty.

5. When you have selected the import folder or Zip file, click Import to begin the import.
6. If you have selected an export Zip file, the export volume will be extracted before

importation. 

☞ Note: It will take extra time to extract the export volume from the Zip file. 

☞ Note: ATLAS 9000 Version 1.0 data will undergo a conversion upon importation. If
any patients exist without a Patient ID, a Patient ID will be created for them.

☞ Note: You must import all the exams in the selected import folder or Zip file; you
cannot import exams selectively.

7. An Import dialog appears asking if you are sure you want to import patient data
from this export volume (Figure 11-2). Click OK to begin import or Cancel to cancel
the importation.

Figure 11-2 Import Confirm Dialog
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8. A progress dialog appears (Figure 11-3) and importation begins.

Figure 11-3 Import Progress Dialog

The progress dialog box shows import progress. It can take several seconds to several
minutes for the software to finish importing to the hard drive, depending on the
number of exams in the export database.
• At any time, you can click the Stop button to abort import. The import process will

stop after the next whole patient has been imported. Already imported patients will
not be removed.

When finished, a dialog notifies you of successful completion, or a summary dialog
appears to report information about data that failed to be imported. It reports the number
of duplicate exam records that were found and not imported and the number of exams
that failed to be imported due to errors.

• The imported records will now be available when you search.

Import Behavior

• Before importing, the system checks for sufficient available space on the system hard
drive and if insufficient space is available, initiates clearance of archived exams
automatically, making space available before import continues.

• ATLAS displays obscured imported patients in the patient list with the originating
institution name as the last name, and a unique Patient ID as the first name and
Patient ID. See Table 11-2, “Patient Identifier Omit Options.

• When exam data is imported, its last modified date and time are changed to the
current system date and time. This makes it unavailable for clearance until sufficient
time passes.

• Imported data does not overwrite already existing records in the ATLAS database. It
associates new exam data based on patient identification.
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Importing from ATLAS 900 Series Instrument Databases

WARNING/CAUTION: Initial import of ATLAS 900 series databases could take
several hours depending on the size of the database. Do not use the ATLAS
9000/Review Station during that time.

To enable importing of ATLAS 900 series instrument databases you must first:

• Configure your ATLAS instrument for networking and ATLAS file sharing (see
Network Configuration and File Sharing for ATLAS Model 993/995
Instruments on page 11-5).

• Configure import settings with ATLAS 900 Series Importer (see Configure Import
Settings with ATLAS 900 Series Importer on page 11-8).

See Begin Exam Import on page 11-13 to perform a database import and for details on the
importation process. Importing of ATLAS 900 series instrument databases can be done
automatically or manually (see Automatic and Manual Exam Importing on page 11-16). 

Network Configuration and File Sharing for ATLAS Model 993/995 Instruments

ATLAS Model 993/995 instruments run on the Windows 98 operating system. The
instruments are equipped with a 10/100 Base-T Ethernet adapter and a 10/100 Base-T
RJ-45 connector.

The drivers for the Ethernet adapter are preloaded on all new systems. A client for
Microsoft Networking is also preloaded. It is the end user's responsibility to setup the
required networking clients and protocols for their networking environment. Due to the
numerous types of networking setups, it is impossible to create a generic procedure that
describes the changes necessary in the Network program. All of the necessary changes
should be a simple task for someone familiar with the details of their network environment.
The Windows 98 CAB files are preloaded on the instruments’ hard drives. Once the
necessary networking setups have been completed, ATLAS 993/995 instruments can access
and share resources on the network just like any other PC in the network. 

You will need your local network administrator person to set up the network (see
Configuration for Export via Preexisting Office Network on page D-6). Make
sure the following steps have been completed to set up your ATLAS 993/995 instrument for
networking:

1. Exit the MASTERVUE MAIN MENU screen by double-clicking on the word Main in green in
the top right-hand corner. This will take you to the Windows desktop.

2. Click Start > Settings > Control Panel.
3. Double-click on Network. 
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4. To enable file sharing, select File and Print Sharing... from the Configuration tab
(Figure 11-4).

Figure 11-4 Windows 98 Network Control Panel

5. Check I want to be able to give others access to my files and then select OK 
(Figure 11-5).

Figure 11-5 File and Print Sharing Dialog

6. Restart your computer at the prompt to turn on file sharing.

☞ Note: You may want to rename your ATLAS 993/995 instrument(s) for easy
identification on the network. From the Network control panel, select the
Identification tab. In the Computer name field enter a name you can easily
identify for the ATLAS instrument.

Select File and Print Sharing...
to enable file sharing 
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7. The default exams database resides in the C:\EXAMS directory. Double-Click My
Computer, Right-Click on the Exams directory and select Sharing (Figure 11-6).

Figure 11-6 Windows 98 Exams Folder Properties

8. Select Full as the Access Type.
9. Click OK to save the settings. Your ATLAS 993/995 should now be network accessible

for automatic database import using the ATLAS 900 Series Importer.

☞ Note: It is possible to move the default EXAMS directory anywhere in the network as
long as a drive letter is mapped on the ATLAS 993/995 to that location. Once the
drive letter has been mapped, appropriate changes must also be made to the
directory statements in the C:\CTS\CTS.INI file. The CTS.INI file has several path
statements (under DATABASEPATH), which direct the system to the default C:\EXAMS
directory. If the EXAMS directory and its subdirectories are moved to a new location,
those statements must be changed to reflect the new location. If changed, the
topographer will no longer save patient tests to the local hard drive. 

10.To map a drive letter to an ATLAS 993/995 database on a Review Station see Map a
Drive Letter to a Shared Folder in Windows XP on page D-14, and Using
the Mapped Drive for Import and Export on page D-18. The drive letter will
then be available to select for database import using the ATLAS 900 Series Importer.
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Configure Import Settings with ATLAS 900 Series Importer

1. While in patient selection mode, click Tools > Run Atlas Importer to display the
ATLAS 900 Series Importer dialog (Figure 11-7). 

Figure 11-7 ATLAS 900 Series Importer Dialog

The current ATLAS 9000 Series database is selected in the Destination field.

Select the Match data from patients with same name without birth date or ID based
upon name only checkbox to match patients without ID or birth date as same patient
if their names match. If this option is checked, two patients that have identical names,
and no other information is available to help identify them (such as ID, birth date), will
be considered the same patient and their data will be merged together as a single
patient. If not checked, the patient will not be imported and the program will flag this
as a “Duplicate patient name” error.

To leave the ATLAS 900 Series Importer click Exit to return to the PATIENT SELECTION

WINDOW. 
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2. Click the Database button to display the Select ATLAS 900 Series Database
dialog (Figure 11-8). 

Figure 11-8 Select ATLAS 900 Series Database Dialog
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3. You can add up to 5 different ATLAS 900 Series databases. To add an ATLAS 900
Series Instrument database, click an Add button to display the Add / Edit ATLAS
900 Series Database dialog (Figure 11-9). 

Figure 11-9 Add / Edit ATLAS 900 Series Database Dialog

4. In the Name field, type in a name for the ATLAS 900 Series Instrument.
5. In the Location field, you can type in the exact path to the database folder, if you

know it, or click the browse (...) button to find and select the folder. A Choose file
with name Corneal.mdb dialog appears, enabling you to browse anywhere in a
local or network path that is accessible. If you mapped an ATLAS 993/995 database
folder to a drive letter, you can enter it here.

☞ Note: If you are using a USB flash drive or USB floppy drive to add a database, the
USB flash drive or floppy disk must not be write-protected or you will get an error
message.

6. In the Import Option field, select All (for all exams), None (for no exams), or New
(for new exams since last import).

7. Click the Add button to add the database. Click Cancel to cancel adding the database.
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8. After clicking Add, the Select ATLAS 900 Series Database dialog will be
displayed showing the database you have just added (Figure 11-10). Double-click
the database to edit it and return to the Add / Edit ATLAS 900 Series Database
dialog. If you want to remove the database, click the Remove button. A dialog will
appear asking you if you really want to remove the database. Click Yes to remove, or
No to cancel removal.

Figure 11-10 Select ATLAS 900 Series Database Dialog with Added Database

9. Check the Skip Archived checkbox if you do not want to import previously archived
exams. Leave unchecked to import archived exams. This only applies if you begin the
import process by clicking Start Import on this screen—auto and manual import will
ALWAYS skip all archived exams even if you have enabled the option to skip
archived exams here (see Automatic and Manual Exam Importing on page
11-16).

10.To import the exams from the ATLAS 900 Series Instrument database now, click Start
Import. Skip to Step  on page 13. 

11.To import the exams later (either automatically or manually), click the <Back button
to return to the ATLAS 900 Series Importer dialog.

☞ Note: If you have automatic importing turned on (see Automatic and Manual
Exam Importing on page 11-16) and exit the ATLAS 900 Series Importer, exams
may be automatically imported depending on your import settings.
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12.To select only certain exams to import, click Exam Selection. The Select Exams
dialog (Figure 11-11) will be displayed showing a list of all exams from the
database(s). 

Initially, all exams are highlighted in light blue and are selected for import. A light
blue exam and a checkmark in the exam’s Selected checkbox means it is selected for
import. Double-click an exam (or click the exams’s Selected checkbox) to change it
to white and make it unselected for import. Double-click the same exam again (or
click the exams’s Selected checkbox) to make it light blue and selected for import. 

The De-Select All button will unselect all exams, making it easy to select just a few
exams. After clicking the De-Select All button, the button will change to a Select All
button, which when clicked will select all exams, making it easy to unselect just a few
exams. 

If an exam has been archived, the archive source label is shown in the Archive
column; i.e., ARC1-03-07-08.

The number of exams selected for import is shown to the right of the Selected: field.

Figure 11-11 Select Exams Dialog

13.To import the selected exams, click the Import Selected button. If you click the < Back
button the selected exams will not be retained and you will be returned to the ATLAS
900 Series Importer dialog. 

Currently selected

Checked (light blue)
exams selected

exam (dark blue) 

Un-checked (white)
exams NOT selected
for import 

Number of exams
selected for import 
 

for import 



ATLAS User Manual 2660021135270 B

Export and Import 11-13

Begin Exam Import
14.If you clicked the Import Selected button or the Start Import button, the exam import

process begins and the Import Exam Status dialog will be displayed (Figure
11-12). The progress bar at the bottom of the screen indicates the importation
progress. The dialog also shows the import and export database locations and
number of exams selected for import.

Figure 11-12 Import Exam Status Dialog

A running exam number is also displayed during importation for the following:

• Total – Total number of exams imported so far.
• Success – Exams successfully imported.
• Error – Exams not imported because an error occurred during import. 
• Duplicate – Exams not imported because they already exist in database. Exams are

considered the same if they have same patient, same exam date, and same exam eye.
• Archived – Archived exams not imported.
• Incomplete – Exams not imported because the Rings image is not found. 

See Table 11-1, “Exam Import Error Codes on page 11-16 for a complete list of
error codes.
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If you have left the Skip Archived checkbox unchecked, and the archive volume is not
connected or cannot be found, a Search Archive dialog will be displayed during the
import process (Figure 11-13).

Figure 11-13 Search Archive Dialog

☞ Note: If the archive volume is on an external drive, you will need to connect it and
install any software drivers needed.

You can enter the archive location directly, or select the Change Location button to
display a Browse for Folder dialog enabling you to browse anywhere in a local or
network path that is accessible where you can select the archive location. Select
Import to continue with the import, or select Cancel to skip importing this exam.
Select Skip volume to skip all exams from this archive volume. Select the Skip Archived
checkbox if you do not want to import any archived exams from all archive volumes.

At any time, you can click the Stop button to abort import. The import process will
stop after the next whole patient has been imported. Already imported patients will
not be removed. A dialog will be displayed to confirm stopping the import. Select Yes
to stop the import or select No to continue with import. If you select Yes, the Import
Exam Status dialog will be displayed (Figure 11-14). 

☞ Note: The import process will stop if the target's drive has less than 10 MB of free
space or an undetermined error occurs.
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At the end of exam importation, the Import Exam Status dialog (Figure 11-14)
displays the number of exams successfully imported and a list of exams not imported,
including the reason they were not imported. See Table 11-1, “Exam Import Error
Codes on page 11-16 for a complete list of error codes.

Figure 11-14 Import Exam Status Dialog at End of Importation

15.Click the Print button to print a report of exams that were not imported and their
Exam Import Error Codes. Click the Save Report to file button to save the report as a
text file. See Table 11-1, “Exam Import Error Codes on page 11-16 for a
complete list of error codes.

16.Click the Main Menu button to return to the ATLAS 900 Series Importer dialog
or click the Exit Importer button to return to the PATIENT SELECTION window.

☞ Note: A Summary.log text file is created at the end of the import summarizing the
import process. An Import.log text file is created at the end of the import containing
data source information and a list of exams that have problems associated with the
importation process. If there is already a file with the same name in the folder, the
existing file will be renamed by adding its creation date to the file name. These log
files are located in “C:\Documents and Settings\All Users\Application Data\Carl Zeiss
Meditec\ATLAS\Log” for Windows XP; for Windows Vista the path is “C:\Program
Data\Carl Zeiss Meditec\ATLAS\Log.”
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☞ Note: When a patient from an ATLAS 900 series instrument does not have a birth
date, the software will assign a fake birth date (1/1/1000) to the patient. This fake
birth date will not be shown in patient lists and print outs; however, it will be
displayed on the Analysis Screen, the Export to DICOM function, and in Export For
Research text files. After import, you should check for patients without a date of
birth, and enter a date of birth for them.

☞ Note: When a patient from an ATLAS 900 series instrument does not have a Patient
ID, a Patient ID will be created for them using the patient’s first and last name (e.g.,
Patient ID = johnadams). If a patient exists in the database with the same name, the
Patient ID will be incremented with a dash. Subsequent patient name conflicts will
add another dash.

Automatic and Manual Exam Importing

ATLAS can be set to automatically import exams from ATLAS 900 Series Instrument
databases. This feature instructs the software to check for exams performed on 900 series
instruments since the last one imported. Once set for automatic import, you can still
perform a manual import at any time if you want. Configuration of automatic and manual
exam importation is performed in the ATLAS 900 Series Importer (see Configure Import
Settings with ATLAS 900 Series Importer on page 11-8). 

Table 11-1 Exam Import Error Codes

Category Code Description Impact on Import

Incomplete Rings image is missing Exam is still imported but Rings image is not found. Exam imported

Duplicate Duplicate exam found Exam already exists in target database. Exam skipped

Error Duplicate patient ID found Failed to save patient because patient in target database already uses the 
same patient ID.

Exam skipped

Error Incomplete data found Imported exam does not have critical data to be imported. Exam skipped

Error Duplicate patient name found Failed to save patient because patient in target database already uses same 
patient name.

Exam skipped

Error Error saving patient data Failed to save patient to target database. Exam skipped

Error Patient data file missing Cannot find MVU file. Exam skipped

Error Unable to read patient data file Problem reading data from MVU file. File may be corrupt or Disk I/O Error. Exam skipped

Error Integrity check failed Exam index data and MVU are mismatch. Exam skipped

Error Error saving exam Cannot save new exam to target database. Exam skipped

Archived Archived exam not accessible Imported exam has been archived and archived media is not accessible 
during import.

Exam skipped

Archived Archived exam not selected for import Imported exam has been archived and operator chose to skip archived 
exams.

Exam skipped

Error Unknown error An error occurs that cannot be determined. This will stop the import 
process.

Import stopped

Error Out of disk space There is not enough disk space in the target drive to continue import. This 
will stop the import process.

Import stopped
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To turn on automatic importing:

1. While in patient selection mode, click Options > Auto ATLAS 900 Series Importer Setting.
The Auto ATLAS 900 Series Importer Setting dialog appears (Figure 11-15). 

Figure 11-15 Auto 900 Series Importer Setting Dialog

2. Check Turn on Auto ATLAS 900 Series Importer to turn on automatic importing.
Uncheck to turn off.

3. In the Setting field, enter the number of seconds for how often you want the
software to check for new exams. Setting this less than 30 seconds could generate file
lockup errors when you have more than one Review Station set for automatic import.

4. Click the OK button to save your changes. Click Cancel to keep the previous setting.
5. When new exams are found they will be automatically imported into your current

database. A dialog will be displayed showing the import progress (Figure 11-16).

Figure 11-16 ATLAS Auto Importer Dialog
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The auto import will create a summary log file at the end of import. You can select the
View Today’s Patients tab on the PATIENT SELECTION WINDOW to view today’s
automatically imported patients.

6. You can perform a manual import at any time by using the ATLAS 900 Series Importer
(see Begin Exam Import on page 11-13) or selecting File > Import > From ATLAS
900 Series... (if already configured the way you want). When selecting File > Import >
From ATLAS 900 Series... you will see the Atlas Auto Importer dialog (Figure
11-16) if there are exams to be imported. The manual import will create a summary
log file at the end of the import. If there are no exams to be imported you will see a
dialog reporting this (Figure 11-17).

Figure 11-17 Check New Exam Dialog

☞ Note: Auto and manual import will ALWAYS skip all archived exams even if you have
enabled the option to skip archived exams (see page 11-11).

Figure 11-18 shows a network diagram for one ATLAS 993/995 and two Review Station
computers. The Review Stations are configured to auto import exams from the ATLAS
993/995. Synchronization cannot be performed on an ATLAS 993/995. This is the
recommended configuration when you have one or two Review Stations. When you have
three or more Review Stations you should auto-import ATLAS 993/995 exams into one of
the Review Stations which then archives to a Network Server that the other Review Stations
can synchronize from (see Figure 10-13 on page 10-13). This will prevent possible file
lockup errors when multiple Review Stations try to import exams at approximately the
same time. 

Figure 11-18 Network Diagram for One ATLAS 993/995
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Importing from ATLAS 900 Series Export Media

Importing of ATLAS 900 Series Export Media is done with the ATLAS 900 Series Importer as
shown in the following steps:

1. While in patient selection mode, click Tools > Run Atlas Importer... to display the
ATLAS 900 Series Importer dialog (Figure 11-19).

Figure 11-19 ATLAS 900 Series Importer Dialog

The current ATLAS 9000 Series database is selected in the Destination field.

Select the Match data from patients with same name without birth date or ID based
upon name only checkbox to match patients without ID or birth date as same patient
if their names match. If this option is checked, two patients that have identical names,
and no other information is available to help identify them (such as ID, birth date), will
be considered the same patient and their data will be merged together as a single
patient. If not checked, the patient will not be imported and the program will flag this
as a “Duplicate patient name found” error.

To leave the ATLAS 900 Series Importer click Exit to return to the PATIENT SELECTION

window. 
2. To import ATLAS 900 Series Export Media, click the Export Media button to find and

select an ATLAS 900 Series Export Media file with name Cornealx.mdb. A Choose
file with name Cornealx.mdb dialog appears, enabling you to browse anywhere
in a local or network path that is accessible.

3. When you open a Cornealx.mdb file the Select Exams dialog will be displayed to
allow you to select exams from the export file. Go to Step 12. on page 12 of the
Importing from ATLAS 900 Series Instrument Databases steps to complete
import of ATLAS 900 Series Export Media.
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Use Extrapolated Data for ATLAS 900 Series Exams

After importing ATLAS 900 series exams with ATLAS Importer, either by database or export
media, you can choose to view ATLAS 900 series exams with extrapolated data. When this
option is turned on, ATLAS tries to fill in missing data by extrapolation. Select Options >
Preferences... and then click the General tab (Figure 11-20).

Figure 11-20 Preferences – General Tab

Check Use Extrapolated data for Atlas 900 Series exams and then select OK if you
want to display ATLAS Series 900 exams with extrapolated data. 

Importing from Worklists (Instrument Only)

The ATLAS instrument allows you to import patient information (name, date of birth,
patient ID, etc.) from an Electronic Medical Records (EMR) system or Patient Management
System (PMS) (CZM-XML or DICOM (Digital Imaging and Communications in Medicine)
compliant). Obtaining patient information from worklists avoids the need to enter patient
information multiple times, and prevents typing mistakes. Once the ATLAS instrument is
licensed, enabled and configured, patients scheduled for exams today from a worklist can
be viewed on the ATLAS instrument.

☞ Note: You should check with your EMR/PMS/DICOM vendor to determine the
compatibility of their system with the ATLAS System, before purchasing an
EMR/PMS/DICOM system.

☞ Note: Make sure that the DICOM system is accessible. Your system must be
connected to the network for network import processes.

Enable and Configure Worklist Import

While in patient selection mode, select Options > Preferences... and then click the
DICOM Export Configuration tab (Figure 11-25) to enable and configure the ATLAS
for worklist import. See Enable and Configure DICOM Data Export and Worklist
Import on page 11-26 for more information.
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Import Worklists

To import a worklist into the ATLAS instrument, follow this step:

1. While in patient selection mode, select the View Today’s Patients tab (see View
Today’s Patients on page 3-4). Any patients scheduled for today on a worklist are
automatically imported into the ATLAS instrument. The patients can be new or existing
ATLAS patients. Select Refresh Patient List to refresh the patient list.

☞ Note: If any patients exist without a Patient ID on the worklist, a Patient ID will be
created for them using the current date and time.

Export

ATLAS provides three different export functions as described below:

Exporting to ATLAS 9000 Series Media

To export data to ATLAS 9000 Series formatted media, follow these steps.

1. While in patient selection mode, click File > Export > To Atlas 9000 Series Export
Media.... The Export Options dialog appears (Figure 11-21). 

Figure 11-21 Export Options Dialog

2. In the Path field, you can type in the exact path to the export folder, if you know it, or
click the Browse button to find and select (or make) the new export folder. A Browse
for Folder dialog appears, enabling you to browse anywhere in a local or network
path that is accessible. You can export data to an optical disk, to any location in a
network path, or to a USB hard disk or flash drive. The Path field cannot be empty.
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3. If you want to export all the selected data into one compressed file using the Zip
compression format, check Export to Zip Format. The export volume will be
compressed into one Zip file inside the export folder. The name of the Zip file will be
the Label of the export volume. You do not need to uncompress the Zip file before
importing—just select the Zip file for import and all data will be imported (see
Importing from ATLAS 9000 Series Export Media on page 11-3).

☞ Note: ATLAS will incrementally write export data to a location or optical disk that
already contains the same export volume name.

☞ Note: We do not recommend export to the system hard drive. If you export to the
system hard drive, please be aware that it is possible to fill the hard disk, at which
point you will be unable to acquire an exam or analyze.

☞ Note: It is recommended to always create a new folder when exporting Zip files. If
you select Export to Zip Format and the export folder already contains patients
exported to the same folder without using the Zip format, a Zip file will be created
that contains the currently selected patients and the previously exported patients.
Any existing Zip files in the folder will not be included.

☞ Note: It will take extra time to compress the export volume.

4. Patient information can be hidden (as for a clinical trial). Click the Omit Patient
Identifiers checkbox if you want to omit any patient identifiers in the resulting
exported exams. Select the radio button to one of three possible identifier omit
options as described in the table below.

☞ Note: You cannot edit or merge patient information for patients imported with
omitted patient identifiers.

5. Enter search parameters in the fields provided (Name, Patient ID, Category, Exam
Date) and click Search, or click Advanced Search to use additional search parameters.
(See Advanced Search on page 9-6 for details.) The search returns all matching
patients, sorted alphabetically by last name. The search returns patients that match all
parameters used. Clicking Search without using any parameters returns all
patients in the ATLAS index database.

Table 11-2 Patient Identifier Omit Options

Option Description

Omit Patient Name This option inserts the Institution name in the patient’s Last 
Name field and a 17 character Unique Patient ID number in the 
First Name and Patient ID fields (e.g., 20070609081320226, 
the date and time of patient creation to a thousandth of a 
second).

Omit Patient Name and 
day of birth

In addition to above, 1 will be used for day of birth.

Omit Patient Name, day 
and month of birth

In addition to above, 1 will be used for the birth month. For 
patient over 80 years old, the birth year will be 80 years in the 
past from the current year.
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6. Select the desired patients in the Results list: Click to select one patient; Ctrl-click to
select multiple patients (Figure 11-22); Shift-click on two patients to select all
intervening patients; Ctrl-Shift-click to select all intervening patients plus those already
selected; click and drag to the right of the last name to select all adjacent patients.
Click Select All to select all patients in the Results list.

Figure 11-22 Export Options Dialog

7. If you want to select only certain exams for a patient, rather than all exams, select the
patient or patients, and then select the Select Exams button. The Select Exams
dialog appears. Select the desired exams: Click to select one exam; Ctrl-click to select
multiple exams (Figure 11-23). Click Select All to select all exams. Select OK when
you’re done. 

Figure 11-23 Select Exams Dialog
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8. When you have made your selections, click Export to begin the export process. A Progress
dialog appears on the bottom of the Export Options dialog (Figure 11-24). 

Figure 11-24 Export Options Dialog During Export

• At any time, you can click Stop to stop export. If you do, the system completes
exporting all data from the same patient being exported when you clicked Stop. No
data already exported is removed from the export database.

When finished, a dialog notifies you of successful completion, or a summary log appears to
report information about data that failed to be exported.

Export Behavior
• Before exporting, the system checks the export destination for sufficient available

space and returns an error message if insufficient space is available.
• If exporting to an optical disk, you must re-select patient records for export,

choosing patients whose total amount of data does not exceed the capacity of the
export destination.

• If exporting to a network path, you must select another network path.
• The system attempts to export cleared archive data.

• If the cleared data is on an available network archive, the data will be exported
automatically. If the file server is not connected, you will be prompted to connect
with it. If you cannot connect, you can skip it and continue exporting.
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• If the cleared data is on a removable drive or flash drive, you will be prompted to
insert the archive by its label. If you do not have the required drive, you can skip it
and continue exporting. If more than one archive drive is required, you must attend
the instrument during export and insert the indicated archive drive(s) when
prompted.

• You can export imported patient data. If an imported patient was obscured, it will be
re-exported as is, that is, it will retain its original Patient Export ID and institution
name.

• If the export options are the same, you can export to the same export database. The
system will not overwrite previously exported data. It will supplement previously
exported patient records with new exam data. It associates exam data based on
patient identification.
• You cannot export to a network export database created by another ATLAS system.

• You cannot export to a network path that contains an archive database.
• The system does not allow concurrent export to the same network path. If another

application is currently exporting to the selected path, a dialog will inform you.

Exporting Data to DICOM Systems

ATLAS allows you to export patient information (name, date of birth, patient ID, etc.) and
data (exam images, screens, and reports) to a qualified DICOM 3.0 Ophthalmic Compatible
Electronic Medical Records (EMR) system, Patient Management System (PMS), or DICOM
archive that supports EPDF or Secondary Capture. You can select PDF or TIFF as the image
file format.

☞ Note: Before purchasing a DICOM system you should check with your DICOM vendor
to determine the compatibility of their system with the ATLAS System.

☞ Note: Make sure that the DICOM system is accessible. Your system must be
connected to the network for network export processes.

☞ Note: ATLAS assigns a fake birth date (1/1/1000) to patients imported from an ATLAS
900 series instrument that do not have a birth date. This fake birth date will not be
shown in patient lists and print outs; however, it will be displayed on the Analysis
Screen, the Export report to DICOM function, and in Export For Research text files.
After import, you should check for patients without a date of birth, and enter a date
of birth for them. Some DICOM systems require a date of birth, and though the
Export report to DICOM function will work, patients without a date of birth (the fake
birth date is not a valid date of birth) will not be imported into those DICOM systems
that require a date of birth. If you wish to export patients without a date of birth to
all DICOM systems, you must first enter a date of birth for them.
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After enabling and configuring DICOM Data Export (see Enable and Configure
DICOM Data Export and Worklist Import on page 11-26), a DICOM data export
can be performed in four ways:

1. Export report on the Analysis Screen (see Export Current Screen or Report to
DICOM on page 11-27).

2. Export current screen on the Analysis Screen (see Export Current Screen or
Report to DICOM on page 11-27).

3. Export Data for All Exams of Patient(s) (see Export Data for All Exams of
Patient(s) to DICOM on page 11-28).

4. Automatic export at end of exam acquisition (see Printing / DICOM Export
Options on page 8-11).

Enable and Configure DICOM Data Export and Worklist Import

To enable and configure the ATLAS for DICOM data export and worklist import, Select
Options > Preferences... and then click the DICOM Export Configuration tab (Figure
11-25).

Figure 11-25 Preferences – DICOM Export Configuration Tab

Select the Enable DICOM Data Export and Worklist Import button to enable DICOM data
export and worklist import. Worklist import functionality is disabled for ATLAS Review.

Time Out (seconds): Select from 1 to 30 seconds for the Worklist import and Data Export
time-out. This is the time allowed for the DICOM system to respond to the request before
an alert message is displayed (“Server not responding”).

Select Connection Test to send a test request to the DICOM system.
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DICOM Gateway is a an optional software feature that manages the communication
between the ATLAS instrument and a DICOM System. The Configure DICOM Gateway and
Restart DICOM Gateway buttons can be used to configure and restart the DICOM Gateway
software, respectively (Note: These buttons are not displayed on Windows Vista Review
Stations). See (C) DICOM Gateway (Optional) for installation and configuration of the
DICOM Gateway software.

To use an EMR/PMS system that has been custom configured to use CZM-XML data
transfer, fill in the following fields:

Folder: Enter or Browse to the shared folder for EMR/PMS data export and worklist import.

Application Entity Title: Enter a unique application name for this ATLAS instrument. 

Destination AET: Enter the application name for the EMR/PMS system.

Image Type: Images can be exported in multi-page PDF or TIFF files. Select PDF or TIFF. 

Export Current Screen or Report to DICOM

You can export the current screen (Export > Export current screen to DICOM) or selected
reports (Export > Export report to DICOM) to a DICOM system (see Export on page 4-6
for more information).

To export report data for a patient to a DICOM system, follow these steps:

1. In patient selection mode, select the patient and the exam you want to export. Select
Analyze to go to the Analysis mode.

2. On any View or Display, click the Export button and select Export report to DICOM.

Figure 11-26 Select Export report to DICOM on Export Button
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3. A DICOM Export Progress dialog will be displayed showing the export progress
(Figure 11-27). 

Figure 11-27 DICOM Export Progress Dialog

4. After completing the export, the DICOM Export Progress dialog will close.

Export Data for All Exams of Patient(s) to DICOM

To export data from all exams of one or more patients to a DICOM system, follow these
steps:

1. While in patient selection mode, click File > Export > To DICOM.... The Advanced
Search dialog appears (Figure 11-28). 

Figure 11-28 Advanced Search Dialog

2. Search and select one or more patients for export. See Advanced Search on page
9-6 for information on using the Advanced Search dialog.
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3. Select OK on the Search Preview screen to begin the export process. A DICOM
Export Progress dialog will be displayed showing the export progress (Figure
11-29).

Figure 11-29 DICOM Export Progress Dialog

4. After completing the export, the DICOM Export Progress dialog will close. Select
Cancel to cancel the export before completion. If you have selected many patients or
have many exams for the selected patient(s), it may take some time to complete. 

Exporting for Research

To export a single exam in .CSV format for research purposes, follow these steps.

1. While in patient selection mode, select the patient and exam you want to export and
click File > Export > For Research. The Exam Export Option dialog appears
(Figure 11-30). 

Figure 11-30 Exam Export Option Dialog
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2. In the Output Folder field, you can type in the exact path to the export folder, if you
know it, or click the Browse button to find and select (or make) the new export folder.
A Browse for Folder dialog appears, enabling you to browse anywhere in a local or
network path that is accessible.

3. In the Output File name field, you can enter a name for the exported file. ATLAS
enters in a default file name based on the selected patient.

4. If you want to hide patient information in the exported exams, click the Hide patient
Information checkbox. If checked, you can also enter a name in the Alternate
Patient Identification field, other than the default Patient name.

5. Select the file format you want in the Output File Format radio button (CSV Comma
delimited, or CSV Semicolon delimited)

6. If you want to include images (if available) with the exported exam, select the
image(s) you want in the Include Images field (Photokeratoscope, Photopic, and
Scotopic). Click the All checkbox to include all images.

7. Click Start Export to begin the export process. The exam is exported to the selected
output folder without any notification.
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(A) PathFinder II Corneal Analysis 
(Optional)

Chapter Overview

PathFinder II Corneal Analysis is an optional software feature for the ATLAS System
designed to assist with the identification of abnormal, pathologic, and normal corneas
using anterior corneal topography. Topics covered in this chapter include:

• Introduction, page A-1
• Accessing PathFinder II, page A-3
• Using PathFinder II, page A-4
• User-Selectable View, page A-5
• Probability View, page A-6
• Parameters View, page A-8
• Mean Curvature View, page A-10
• PathFinder II Examples, page A-12

☞ Note: PathFinder II is an optional software feature that is separately licensed. You
must activate the software for it to function on your ATLAS. You can register a Trial
(30-Day) or Full license. Note that a Trial License is not available for Windows Vista.
To activate, go to www.meditec.zeiss.com/register. You may also contact Carl Zeiss
Meditec:
In the U.S.: Call Carl Zeiss Meditec at 1-800-341-6968.
Outside the U.S.: Contact your local Carl Zeiss Meditec distributor.
E-mail: z.customersupport@meditec.zeiss.com.
You can activate a Trial or Full license using the procedure that is provided in 
(I) License Registration.

Introduction

PathFinder II Corneal Analysis Software is based solely on anterior corneal topography.
PathFinder II uses statistical parameters derived from anterior corneal topography for its
analysis. PathFinder II analyzes twelve different corneal parameters for a particular exam
and compares them to a comprehensive clinical database that contains parameter
reference values for the following conditions and pathologies (see Probability View on
page A-6):

• Normal
• KCN Pattern
• Myopic LVC
• Hyperopic LVC
• Other

☞ Note: The ATLAS System instrument and ATLAS Review Software are not
intended to be used as the sole diagnostic for disease.
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The clinical data makes it possible to compare findings in an individual patient to expected
findings from different populations of individuals with eyes that have various known
conditions or pathologies. Using a trained Support Vector Machine (SVM) algorithm,
PathFinder II displays the probability (from 0 to 99%) that the corneal topography matches
each of the categories established in the PathFinder II clinical study database.

Of the twelve corneal parameters analyzed, three evaluate the irregularity (CIM), mean
apical curvature (TKM), and shape of the cornea (Shape Factor) (see Parameters View
on page A-8). The remaining nine parameters are derived from the Mean Curvature View
(see Mean Curvature View on page A-10). 

PathFinder II incorporates a Support Vector Machine algorithm that performs classification
by constructing multi-dimensional hyperplanes that optimally separate the clinical (or
training) data into specific categories using the analyzed parameters. Support Vector
Machines (SVM) are considered to be one of the most successful classification algorithms
in the data mining field. For each topography exam, the PathFinder II SVM algorithm
assigns a percent probability of the exam to match the trained categories. 

Each corneal parameter used by PathFinder II is color-coded to indicate the degree to
which it matches the values established for the normal population, based on a multi-center
clinical study. The multi-clinical sample data set covers 95% of the normal eye population
with a 95% confidence. The statistical parameters (CIM, TKM, and Shape Factor) are
displayed in bar plot format with color-coding shown in the bar plot itself. The nine other
parameters based on the Mean Curvature View are displayed in the Mean Curvature View
Data Box and the values themselves are color-coded. The color-coding scheme is
implemented as shown in Table A-1 below:

Table A-1 PathFinder II Color-Codeda Parameter Classificationb (Normal Eyes, based on Multi-Center Clinical Study)

Parameter Green (Normal) Yellow (Borderline) Red (Abnormal)

% of Population 90% 8% 2%

CIM (μm) 0.49 to 1.68 0.43 to 0.48, 1.69 to 3.01 0 to 0.42, 3.02 to 5.33

TKM
42.19 to 47.26 D
8.00 to 7.14 mm

41.21 to 42.18, 47.27 to 48.38 D
8.19 to 8.01, 7.15 to 6.98 mm

38.51 to 41.20, 48.39 to 56.28 D
8.76 to 8.20, 6.97 to 6.00 mm

SF 0.20 to 0.64 0.16 to 0.19, 0.65 to 0.85 -0.79 to 0.15, 0.86 to 0.89

Max Mean Curvature
41.97 to 47.36 D
8.04 to 7.13 mm

41.08 to 41.96, 47.37 to 48.77 D
8.22 to 8.05, 7.14 to 6.92 mm

40.50 to 41.07, 48.78 to 63.65 D
8.33 to 8.23, 6.91 to 5.30 mm

Max Mean Curvature X mm -1.39 to 1.27 -2.13 to -1.40, 1.28 to 1.73 -3.09 to -2.14, 1.74 to 2.68

Max Mean Curvature Y mm -2.42 to 0.72 -3.79 to -2.43, 0.73 to 1.18 -3.99 to -3.80, 1.19 to 1.38

Centroid X mm -0.72 to 0.71 -1.03 to -0.73, 0.72 to 1.00 -1.18 to -1.04, 1.01 to 1.76

Centroid Y mm -1.24 to 0.31 -1.79 to -1.25, 0.32 to 0.53 -2.98 to -1.79, 0.54 to 0.72

Convexity 0.777 to 0.981 0.600 to 0.778, 0.982 0.411 to 0.599, 0.983 to 1.000

Mean I - S -0.78 to 1.77 D -1.28 to -0.79, 1.78 to 2.32 D -3.14 to -1.29, 2.33 to 9.35 D

Mean IN - ST -1.00 to 1.20 D -1.44 to -1.01, 1.21 to 1.67 D -3.98 to -1.45, 1.68 to 6.52 D

Mean IT - SN -0.51 to 1.45 D -1.02 to -0.52, 1.46 to 1.79 D -2.99 to -1.03, 1.80 to 10.35 D
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☞ Note: PathFinder II Corneal Analysis is only available for ATLAS 9000 exams. 

Accessing PathFinder II

PathFinder II performs data analysis on a single patient exam. From the ANALYSIS SCREEN,
PathFinder II can be accessed three ways:

• Select PathFinder II from the Display (F4) pop-up menu to access the full PathFinder II
software display.

• In the Single View Display, select PathFinder II from the View (F3) pop-up menu to
access the full PathFinder II software display.

• Select PathFinder II from the View (F3) pop-up menu for a selected View (a green
border indicates the selected View) in a multi-View Display to display only the
Probability View (see Probability View on page A-6) of PathFinder II.

Figure A-1 Display (F4) and View (F3) Pop-Up Menus

For more information on the ANALYSIS SCREEN and selecting a patient, see Analysis
Screen on page 4-3.

☞ Note: PathFinder II Corneal Analysis is only available for ATLAS 9000 exams.
PathFinder II will be greyed out and not selectable for ATLAS 900 Series exams.

☞ Note: During image acquisition, if the image acquired cannot be used by PathFinder
II, the message “Insufficient data for PathFinder II analysis” will be displayed
on the EXAMS RESULTS SCREEN (see Exam Preview/Exam Results Screen on page
3-9).

a. Green represents the “normal range” (between the 5th and 95th percentile of the normal population). Yellow is a transitional or borderline range 
(between the 1st and 99th percentile), and red is beyond the normal range or abnormal.

b. Classification Analysis. Three images were taken for each study eye. The best image determined by the study investigator was used in calculating 
the reference values for the parameters. Each parameter was tested for normal distribution using the Shapiro-Wilk test. For consistency, all data was 
transformed using Box-Cox data transformation. The same percentiles were derived for the transformed data based on normal assumptions, and all 
derived percentiles except Convexity were converted back to the original scale. Due to extreme skewness, the Convexity percentiles were derived using 
a non-parametric approach based on an empirical distribution.
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After selecting PathFinder II from the Display (F4) pop-up menu, or from the View (F3)
pop-up menu in the Single View Display, the full PathFinder II display will be displayed
(Figure A-2).

Figure A-2 PathFinder II Display

Using PathFinder II

The PathFinder II display shows four Views (see Figure A-2):

• Probability View – displays five categories with blue color bars representing the two
highest probabilities. See Probability View on page A-6.

• Parameters View – bar graphs of statistical data parameters (CIM, TKM, Shape
Factor). See Parameters View on page A-8. 

• User-Selectable View – the default is Axial Curvature View. See User-Selectable
View on page A-5.

• Mean Curvature View – a special Mean Curvature View with nine additional
parameters. The Mean Curvature View cannot be changed. See Mean Curvature
View on page A-10.

☞ CAUTION: Decisions involving therapeutic and/or surgical procedures should be
made only after considering total clinical information, and not on the basis of a
single index measurement or analysis.

User-Selectable
View (Axial is
default View) 

Probability
View

Parameters Mean Curvature
View (cannot
be changed) View
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User-Selectable View

You can select the exam and View for the PathFinder II display in two ways:

1. Select an exam from the Exams pop-up list (see Exams List on page 4-6).
2. Select a View from the View (F3) pop-up (see View (F3) Pop-Up Menu on page 4-8).

or
1. Select the More (F2) checkbox to show the EXAMS/VIEWS window (Figure A-3).

Figure A-3 PathFinder II Screen View Editor 

2. Select the Exams tab from the EXAMS/VIEWS window.
3. In the Exams tab window, select the exam you want to view from the list of available

exams by clicking on it—the display updates automatically. All exams for the selected
patient are shown in the list.

4. For the user-selectable View (upper right display), select the View 1 tab from the
EXAMS/VIEW 1 window.

5. In the Views tab window, select a View (Mean and PathFinder II Views cannot be
selected) by clicking on it—the display updates automatically.

6. The View Editor parameters correspond to the selected View.
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Cursor Tracking

A cursor location and cross hair can be set on the User-Selectable and Mean Curvature
Views by left-clicking the mouse. Both Views can be set to the same cursor location by
turning on the Track Views option. See Track Views on the Options tab of the ANALYSIS

SCREEN (page 4-9). A Cursor table will be displayed on each View showing the power value
for that location. Right-clicking will remove the cross hair and Cursor table. See Cursor
Location Point on page 4-4.

Probability View

The Probability View (shown in Figure A-2) displays the result of the PathFinder II
analysis. 

PathFinder II uses an advanced support vector machine (SVM) learning algorithm to
classify corneal data into five categories (pathologies or conditions). The two highest
categories and their respective probabilities are shown with blue bar graphs. If the second
highest probability is less than the user-selectable Category Display Threshold value, then it
will not be displayed. The currently selected Category Display Threshold is displayed in the
Probability View. To change the threshold value, select the More (F2) checkbox to display
the View Editor for the Probability View (Figure A-4). Select a percentage (5 to 25%) for
the Category Display Threshold from the drop-down menu. The PathFinder II display
updates automatically.

Figure A-4 Category Display Threshold

☞ Note: If the View Editor for the Axial or Mean Curvature View is displayed when you
select the More (F2) checkbox, click on the Probability View to display the View
Editor for the Probability View.

The five categories established in the PathFinder II multi-center clinical study are defined
below:

Normal

The normal cornea is typically aspherical in shape with TKM, CIM, and Shape Factor in the
normal range (see Table A-1, “PathFinder II Color-Coded Parameter
Classification (Normal Eyes, based on Multi-Center Clinical Study),” on
page A-2). No abnormal or asymmetric topography patterns, such as inferior steepening,
abnormal elevation, or curvature can be seen in the Mean Curvature View. PathFinder II's
clinical database for the Normal category includes normal topography corneas with no
corneal pathologies, and no history of refractive surgery or other ocular surgery. These
corneas were screened with other modalities (e.g., corneal pachymetry) and were
determined to be good candidates for laser vision correction. See Normal Example on
page A-12 for an example of a Normal category result.
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KCN Pattern

This PathFinder II clinical database for the KCN Pattern category includes established
keratoconus, suspect keratoconus (sub-clinical keratoconus), and pellucid marginal
degeneration. Keratoconus is defined as the true pathological condition, which causes
thinning and wrinkling of the cornea, along with a cone-like protrusion of the cornea in its
later stages. Keratoconus can also produce high regular astigmatism, irregular
astigmatism, and inferior steepening topographical patterns. Abnormal corneal findings
observed under biomicroscopy to confirm a true keratoconus diagnosis may include but are
not limited to: Vogt's striae, Munson's sign, Fleischer's ring, corneal ectasia, stromal
thinning, and superficial scars in Descemet's membrane.

Sub-clinical keratoconus (also known as forme fruste keratoconus) is usually
distinguishable with the typical inferior steepening topographical pattern, but the cornea
does not yet exhibit slit lamp findings typical of keratoconus. The steepening is noticeable
on topography but can be well under 50 diopters at the apex of the cone. Often there is
history of the disease in the family, or the refractive history is unstable with a measurable
increase in both myopia and astigmatism over the past several years. There may also be an
inability to wear contact lenses, along with visual symptoms (reduced VA, ghosting, light
sensitivity).

Pellucid marginal degeneration is a bilateral, non inflammatory, peripheral corneal
thinning disorder characterized by a peripheral band of thinning of the inferior cornea. The
cornea in and adjacent to the thinned area is ectatic. The topographic pattern has a classic
butterfly appearance. Slit lamp examination shows a peripheral band of thinning of the
inferior cornea from the 4-o'clock position to the 8-o'clock position. This thinning is
accompanied by 1-2 mm of normal cornea between the limbus and the area of thinning.

PathFinder II's clinical database for keratoconus includes corneas with the following:
• An irregular cornea determined by distorted keratometry mires, distortion of the

retinoscopic, or ophthalmoscopic red reflex (or a combination of these).
• At least one of the following biomicroscopic signs: Vogt's striae, Fleischer's ring of 

> 2 mm arc, or corneal scarring consistent with keratoconus.

PathFinder II's clinical database for suspect keratoconus includes corneas with one or more
of the following:

• Fellow eyes of subjects with established keratoconus on one eye with keratoconus-like
topographical changes but with no biomicroscopic signs of keratoconus.

• Fellow eyes of subjects that underwent penetrating keratoplasty or INTACS
implantation for keratoconus on one eye with keratoconus-like topographical changes
but with no biomicroscopic signs of keratoconus.

• An irregular cornea determined by distorted keratometry mires, distortion of the
retinoscopic, or ophthalmoscopic red reflex (or a combination of these).

• An area of inferior or central steepening on corneal topography.
• An area of corneal thinning shown by pachymetry that corresponds to the area of steepening. 
• Decreased best-corrected visual acuity.
• History of poor contact lens tolerance.
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PathFinder II's clinical database for pellucid marginal degeneration includes corneas with
the following:

• Topographic pattern of inferior corneal steepening radiating in from the inferior
oblique meridians with an area of flattening down the center of the cornea.

• Inferior peripheral thinning of the cornea.
• Slit lamp finding of peripheral band of thinning with protrusion (“beer belly” contour)

of the inferior cornea, typically from the 4-o'clock to the 8 o'clock position,
accompanied by 1 to 2 mm of relatively normal cornea between the limbus and the
area of thinning.

See Clinically Diagnosed Keratoconus Example on page A-13, and Diagnosed Suspect
Keratoconus Example on page A-14 for examples of KCN Pattern category results.

Myopic LVC (Laser Vision Correction)

PathFinder II's clinical database for the Myopic LVC category include corneas that have
undergone myopic laser vision correction (LASIK, PRK, or LASEK). See Myopic LASIK
Example on page A-16 for an example of a Myopic LVC category result.

Hyperopic LVC (Laser Vision Correction)

PathFinder II's clinical database for the Hyperopic LVC category include corneas that have
undergone hyperopic laser vision correction (LASIK, PRK, or LASEK). See Hyperopic
LASIK Example on page A-17 for an example of a Hyperopic LVC category result.

Other 

PathFinder II's clinical database for the Other category include corneal conditions
(diseases/pathologies/surgeries) that can potentially affect the corneal surface (e.g.,
postoperative corneal transplant, intra-corneal ring segments, radial keratotomy, post
LASIK ectasia, corneal scars, etc.). See Other Category Example on page A-18 for an
example of an Other category result. 

Parameters View

The Parameters View (shown in Figure A-2) displays three specific parameters (CIM, TKM,
and Shape Factor) as values on color-coded bar graphs. The values are rounded to the
nearest tenth of decimal point. The colors indicate PathFinder II’s classification (see
Table A-1, “PathFinder II Color-Coded Parameter Classification (Normal Eyes,
based on Multi-Center Clinical Study),” on page A-2). 

• See CIM on page 7-10 for a discussion of CIM.
• See TKM on page 7-12 for a discussion of TKM.
• See Shape Factor (SF) on page 7-9 for a discussion of Shape Factor.

Parameters Information Window

Placing the mouse pointer on any of the color-coded bar graphs of a parameter turns the
mouse pointer into an arrow with question mark ( ). Clicking once with this question
mark mouse pointer (Figure A-5) will open an Information window (Figure A-6)
displaying a normal population probability distribution for the parameter from PathFinder
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II’s clinical study, and a short explanation of the parameter, including the parameter’s 90%
range for normal corneas from the PathFinder clinical study. This window remains the same
for every patient. It can be used as a reference to the user to show where a particular
patient falls in the normal population distribution. It also serves to help educate both the
user and patient as to the meaning of the parameter.

Figure A-5 Question Mark Mouse Pointer 

Figure A-6 Parameter Information Window 

Once the Parameter Information window is opened, you can click on a parameter tab at
the top of the window to select another parameter’s information display. A Mean
Information window is also included. Click the Cancel or Close  button to close the
window and return to the PathFinder II Display.

Question Mark 

 
Mouse Pointer

Parameter Tabs 
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Mean Curvature View

PathFinder II software includes a special Mean Curvature View (shown in Figure A-2)
with nine new parameters. You cannot change the Mean Curvature View to another View.
You can change some View Editor parameters when the Mean Curvature View is selected
(green border); however, the Data table parameters cannot be changed.

The Mean Curvature View parameter values are color-coded just like the Parameter View
bar graphs (see Table A-1, “PathFinder II Color-Coded Parameter Classification
(Normal Eyes, based on Multi-Center Clinical Study),” on page A-2). 

The Mean Curvature View displays the local average curvature in all directions from every
data point on the cornea, independent of a reference axis. The Mean Curvature View finds
the local average curvature by finding the maximum and minimum principal curvatures at
each point and taking the average. The usefulness is that it removes regular astigmatism,
and potentially exposes underlying local changes in curvature, such as pathology like
keratoconus. See Mean Curvature on page 6-19 for more information on the Mean
Curvature View.

The nine new parameters derived from the Mean Curvature View are:

Max Mean Curvature

The maximum curvature value of the Mean Curvature View. The search for the maximum
excludes potential artifacts at the edges of the Mean Curvature View.

Max Mean Curvature X and Max Curvature Power Y

X and Y coordinates of the maximum mean curvature power value, in mm from the Vertex.

Centroid X and Centroid Y

X and Y coordinates of the center of gravity of the convex hull (see Convexity below), in
mm from the Vertex.

Convexity

Convexity describes the shape of the curvature contour around the highest point in the
Mean Curvature View. The range is 0.0 to 1.0. The more “convex” the contour, the higher
the value; the less convex, the lower. 

Convexity is defined as the ratio of the area of the “convex hull” of the contour line,
compared to the area inside the contour. The convex hull can be thought of as a virtual
rubber band that gets wrapped around the contour line. Any “concave” section around the
contour will lose “touch” to the rubber band/convex hull. 

For example, a U-like shape will have a convexity below one, compared to a sphere or
ellipse with convexity of 1.0. Normal and keratoconus eyes tend to have high convexity,
while post-myopic vision correction, or Ortho-K lenses tend to leave the eye with a lower
convexity value.
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Mean I-S

Difference between an Inferior (I) and Superior (S) region of mean curvature data (Mean
Curvature Inferior minus Superior). See Figure A-7. The average value in the region is
taken, where the region in each area is 1.5 mm wide x 1.5 mm high, centered radially 2 mm
away from the corneal vertex at 270 and 90 degrees.

Mean IN-ST

Difference between an Inferior-Nasal (IN) and a Superior-Temporal (ST) region of mean
curvature data around the Vertex (Mean Curvature Inferior-Nasal minus
Superior-Temporal). See Figure A-7. The average value in the region is taken, where the
region in each area is 1.5 mm wide x 1.5 mm high, centered radially 2 mm away from the
corneal vertex at 225 and 45 degrees.

Mean IT-SN

Difference between an Inferior-Temporal (IT) and a Superior-Nasal (SN) region of mean
curvature data around the Vertex (Mean Curvature Inferior-Temporal minus
Superior-Nasal). See Figure A-7. The average value in the region is taken, where the
region in each area is 1.5 mm wide x 1.5 mm high, centered radially 2 mm away from the
corneal vertex at 315 and 135 degrees.

Figure A-7 Mean Curvature Regions for an OS Eye

☞ Note: A mean value is not calculated if the number of image pixels is less than 5% in
a Mean Curvature region used in the calculation of the mean value.
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PathFinder II Examples

There are five different Probability View categories that can be displayed when using
PathFinder II software (see Probability View on page A-6). The following examples
show these five categories.

Normal Example

Figure A-8 shows a PathFinder II display showing a 83% probability to the Normal
category.

Figure A-8 PathFinder II Normal Category
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Clinically Diagnosed Keratoconus Example

Figure A-9 shows a diagnosed Keratoconus patient’s PathFinder II display showing a
84% probability to the KCN Pattern category.

Figure A-9 PathFinder II KCN Pattern Category – Diagnosed KCN 
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Diagnosed Suspect Keratoconus Example

Figure A-10 shows a diagnosed suspect Keratoconus patient’s PathFinder II display
showing a 90% probability to the KCN Pattern category.

Figure A-10 PathFinder II KCN Pattern Category – Diagnosed Suspect KCN
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Irregular Astigmatism/Forme Fruste (2 Category) Example

Figure A-11 shows a PathFinder II display showing a 85% probability to the KCN Pattern
category, and a 11% probability to the Other category, with a Threshold of 10%.

Figure A-11 PathFinder II KCN Pattern and Other Category
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Myopic LASIK Example

Figure A-12 shows a PathFinder II display showing a 87% probability to the Myopic LVC
category.

Figure A-12 PathFinder II Myopic Category 
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Hyperopic LASIK Example

Figure A-13 shows a PathFinder II display showing a 75% probability to the Hyperopic
LVC category.

Figure A-13 PathFinder II Hyperopic Category
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Other Category Example

Figure A-14 shows a Penetrating Keratoplasty patient’s PathFinder II display showing a
95% probability to the Other category.

Figure A-14 PathFinder II Other Category
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(B) MasterFit II (Optional)

Chapter Overview

The optional MasterFit II Contact Lens Software enables the user to design gas permeable
(GP) contact lenses and to simulate the resulting fluorescein pattern on the cornea.
MasterFit II features both topographic or keratometric-based lens fitting methods. Based
on customizable fitting preferences, MasterFit II will recommend the most appropriate lens
type (including spherical, aspheric, front toric, back toric, and bi-toric designs) and will
design a custom lens that best achieves the desired fitting preferences. MasterFit II also
features region-specific databases of stock (finished) lenses that may be used as an
alternative to creating custom lens designs. 

The user may create multiple lens designs per topography exam to simulate the effect of
adjusting the available lens parameters on the fluorescein pattern. After finalizing the lens
design, the user may print the lens design using the order form templates provided, or the
order form may be saved as a PDF and sent by email to the preferred laboratory.

Topics covered in this chapter include:

• Accessing MasterFit II, page B-2
• Patient Refraction, page B-2
• MasterFit II Display, page B-3
• The Toolbar, page B-4
• Fluorescein Map, page B-6
• Tear Film Thickness Profile Graphs, page B-7
• Data Table, page B-8
• Lens Design Thumbnails, page B-11
• Design Lens, page B-13
• Map View, page B-15
• Change Rx, page B-16
• Options, page B-17
• Order, page B-26

☞ Note: MasterFit II is an optional software feature that is separately licensed. You
must activate the software for it to function on your ATLAS. You can register a Trial
(30-Day) or Full license. Note that a Trial License is not available for Windows Vista.
To activate, go to www.meditec.zeiss.com/register. You may also contact Carl Zeiss
Meditec:
In the U.S.: Call Carl Zeiss Meditec at 1-800-341-6968.
Outside the U.S.: Contact your local Carl Zeiss Meditec distributor.
E-mail: z.customersupport@meditec.zeiss.com.
You can activate a Trial or Full license using the procedure that is provided in
(I) License Registration. 
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Accessing MasterFit II

MasterFit II can be selected from the Display pop-up menu on the ANALYSIS SCREEN for a
selected patient (see Display (F4) pop-up menu on page 5-1).

Patient Refraction

If the selected patient doesn’t have any saved lens designs, the PATIENT REFRACTION SCREEN

is displayed first as shown in Figure B-1 below.

You can enter the patient’s refraction data on this screen or later on the CHANGE RX SCREEN

(see Change Rx on page B-16). Select the Vertex Distance (mm) and Cylinder Type. Enter
the patient’s Distance Rx correction data for each eye. Correction corneal plane values will
be calculated by the software.

If you select Use trial lens, you can also enter in Trial lens and Over refraction data.

Figure B-1 Patient Refraction Screen

Clicking Next displays the MasterFit II Display (Figure B-2) and a recommended lens
design will be created for each eye.If you click Exit, the Patient Refraction dialog will
close and the MasterFit II Display will not be displayed.
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MasterFit II Display

The MasterFit II Display contains the Fluorescein Map, Contact Lens Design thumbnails, Tear Film
Thickness Profile Graphs, Data Table, Lens Parameters, Design/Map View, Change Rx button,
Change Lens button, Option button, Order button, and Toolbar as shown in Figure B-2 below.

Figure B-2 MasterFit II Display

Fluorescein Map 

Patient Name,
ID & Date of Birth

White Profile and 180º Meridian Tear Film Thickness Profile Graphs 

Toolbar 

Data Table

Recommended Lens Design

 

Contact Lens Design
 Thumbnail buttons 

Lens Parameters

90º Tear Film Thickness Profile Graph 

Toolbar

Current Selected Lens 

Adjustable White 
Profile Meridian

Thickness Table 
for mouse tracking

Exam Eye, 

Map Scale

Date, & Time
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The Toolbar

Print

Selecting Print will open a standard Windows Print dialog where you can select print
options and print a MasterFit II report for the selected patient (Figure B-3). 

Figure B-3 MasterFit II Report
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Export

Export (or Export > Export current screen to file) will open a save dialog where you can
save the MasterFit II Display in various file formats (BMP, JPG, TIFF, and PDF). The file
format you select will be saved for subsequent exports.

If you have enabled DICOM Data Export (see Enable and Configure DICOM Data
Export and Worklist Import on page 11-26), selecting Export > Export current screen
to DICOM will export the current screen to a DICOM system. See Exporting Data to
DICOM Systems on page 11-25 for more information.

Exit

Selecting the Exit button will exit the MasterFit II Display and return you to the PATIENT

SELECTION WINDOW or the EXAM PREVIEW/EXAMS RESULTS SCREEN (if you just acquired an
image). If you have made any changes to a contact lens design, a dialog will be displayed
(Figure B-4). Select Yes to save your changes. Select No to discard your changes.

Figure B-4 Save Design Dialog

Exams Pop-Up List

Selecting the Exams pop-up list button displays a list of exams for the patient, including
exam comments. The current exam is shown with an amber checkbox. Selecting an exam
on the list with the mouse will automatically change to the selected exam (Figure B-5). 

Figure B-5 Exams Button Pop-Up List

All exams for the patient can be selected.
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Display (F4) Pop-Up Menu

Clicking the Display (F4) pop-up menu button (or pressing the F4 function key on the
keyboard) displays a list of Displays. Some choices may be unavailable for a selected
patient because of a lack of exam data or licenses. See (5) Displays for a description of
each Display.

Fluorescein Map

The Fluorescein Map (Figure B-6) is a green color map of simulated fluorescein tear film
layer thickness (between the back surface of the contact lens and the cornea) for the
current selected lens design shown over the Ring image of the eye. The shades of green
correspond to the values (μm) shown on the scale at the left of the screen—darker green
areas have small tear film thicknesses while brighter greens areas have larger tear film
thicknesses. The software will initially place the lens at the geometric center of the cornea
(or the corneal vertex if the geometric center location is not available). You can manually
move the lens by clicking inside the lens and dragging up/down and/or left/right.

Figure B-6 Fluorescein Map (Sim Ks Displayed)

☞ Note: For some non-ATLAS 9000 exams the Rings Image will not be displayed.

☞ Note: For certain irregular corneas, the Fluorescein Map cannot be generated, and
the message “Unable to display” will be displayed.

 Click and drag the white solid circle at end of the white Profile Meridian 
d horizontallywith left mouse button to rotate it (Profile Meridian enabled).

 

Fluorescein (tear film thickness) map
d horizontally

Blue Flat meridian (Sim K displayed)
d horizontally

Adjustable White Profile Meridian
d horizontally

Red Steep meridian (Sim K displayed)
d horizontally

Optical Zone
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☞ Note: A highly irregular cornea may result in a poor simulation fit. The clinician may
observe the tear film profile trending by changing the lens type, the lens
parameters, and the lens position. It may be impossible to avoid large tear film
thickness due to large disparities between the corneal shape and the contact lens. In
some cases, it may be possible for the contact lens to “settle” in one of many
positions.

☞ Note: Large tear film profile differences may be observed when moving the contact
lens far away from the central position where the contact lens parameters were
originally chosen.

The steepest meridian is shown with a red line, and the flattest meridian with a blue line
(only shown when Sim K is selected on the DISPLAY PREFERENCES SCREEN or pop-up Overlay
Display Options menu; see Display Preferences on page B-9). The steep and flat
meridians are always 90 degrees apart. 

Thickness Mouse Tracking

Hover the mouse over any point on the Fluorescein Map to see the tear film thickness value
(micrometers) calculated at that point and the location (mm away from the corneal vertex)
in x, y coordinates in the lower left of the MasterFit II display (shown on the left).

Tear Film Thickness Profile Graphs

To the right of the Fluorescein Map is the Vertical (90º) Tear Film Thickness Profile Graph
(shown on the left) which plots the tear layer thickness (μm) (solid green area) along the
corneal surface (distance from corneal apex in mm) for the 90º meridian on the Fluorescein
Map.

Below the Fluorescein Map are the Horizontal (180º) and white Profile Meridian Tear Film
Thickness Profile Graphs which plot the tear layer thickness (μm) along the corneal surface
(distance from corneal apex in mm) for the 180º meridian (solid green area) and white
Profile Meridian (white graph) on the Fluorescein Map (Figure B-7).

Figure B-7 White Profile and 180º Meridian Tear Film Thickness Profile Graphs 

White Tear Film Thickness Profile Graph (μm)
for white Profile Meridian (Profile Meridian enabled) 
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The white Profile Meridian and white Tear Film Thickness Profile Graph are only displayed
when Profile Meridian is enabled for display (see Overlay on page B-9). The default white
Profile Meridian is the flat axis value (note that it initially covers the display of the flat blue
meridian if Sim Ks are displayed). The white Profile Meridian can be rotated to any angle (0
– 360 degrees) by clicking on the white circle at the end with the left mouse button and
dragging (Figure B-6). The profile graph and meridian values are updated automatically.
This allows the doctor to judge the fit of the chosen lens based on the simulated
fluorescein pattern in any meridian (axis) that is desired. The rotated meridian value is not
saved when saving lens.

Data Table

The Data table (Figure B-8) displays the lens power (Diopters and mm, steep and flat
axis), steep and flat axis meridian values, astigmatism, steep and flat Shape
Factor/Eccentricity, and HVID value that were calculated for the currently selected lens
design.

Figure B-8 Data Table

Astig. (Astigmatism)

Astigmatism is the difference between the Steep and Flat K values displayed as a positive value.

Shape Factor (SF)

See Shape Factor (SF) on page 7-9 for more information.

Eccentricity (Ecc)

See Eccentricity on page 7-9.

HVID (ATLAS 9000 data only)

The HVID (Horizontal Visible Iris Diameter) value (mm) is the same as the Horizontal limbus
diameter or white-to-white diameter. This is only measured on an ATLAS 9000 instrument.
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Display Preferences

Display preferences for the Fluorescein Map View can be set by selecting the Options button
in the lower left of the MasterFit II Display. On the Options screen select the Display
Preferences tab (Figure B-9). Some display options can also be set by right-clicking on the
Fluorescein Map Display to pop up Display Options menus (as shown on the left). 

Figure B-9 Options – Display Preferences

Overlay

The Overlay section allows you to select which overlays display on the Fluorescein Map. A
checkmark means the selected overlay will be displayed. See Overlay on page 7-6 for
information. Sim K toggles the display of the red steep meridian and blue flat meridian,
and their values. Profile Meridian (or Show Profile Meridian on pop-up display options)
toggles the display of the white Profile Meridian on the Fluorescein map (see Fluorescein
Map on page B-6). The Optical Zone is the central portion of the contact lens calculated
from the base curve, and typically comprises from 65% to 80% of the lens diameter
(displayed as a dark blue circle) (see Figure B-6 and Figure B-10). Beyond the Optical
Zone are the peripheral curves (Peripheral Curves (Custom Lens only) on page
B-15). Tear Layer Thickness displays the tear film layer thickness (μm) just inside the optical
zone boundary at both ends of the steep and flat meridians.
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Opacity

Select the opacity of the Fluorescein Map: 100% is completely opaque and covers up the
Rings Image, while 0% is completely transparent. Setting to something in between allows
display of the green Fluorescein Map and the Rings Image.

Width

Select the width of image to display in millimeters.

Rendering

Image rendering can be either Contour (default) or Smooth. The Contour option displays
the color image with color contours, while the Smooth option displays the color image with
a smooth color gradation. See Rendering on page 7-4 for examples.

Fluorescein Map Scale

Right-clicking on the map scale (see Figure B-6) to the left of the Fluorescein Map will
pop up a scale menu where you can select the scale for the green Fluorescein Map tear
film layer thickness. The shades of green that correspond to the values (μm) shown on the
scale will change on the Fluorescein Map. 
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Lens Design Thumbnails

MasterFit II allows you to have up to six lens designs for each eye. The left of the MasterFit
II Display (Figure B-2) contains thumbnail buttons (shown on the left) where you can add
and edit up to five user lens designs. The first lens design is always the Recommended lens
design automatically calculated by the software and named Recommended. It cannot be
deleted or renamed. 

The Recommended lens design is calculated by the software based upon acquired eye
image information, refractive data (see Change Rx on page B-16), lens fitting rules (see
Fitting Rules on page B-17), and your preferred lenses (see Lenses on page B-22). The
Recommended lens design will change if you edit the refractive data, fitting rules, or
preferred lenses. 

Mousing over a lens design thumbnail will display a pop-up information box (shown on the
left) containing lens design parameters, and for user designs, the design modification date
and time.

The currently selected lens design is displayed with a red border (Lens Design 2 shown on
the left). You can click on a design thumbnail to make it the selected lens design. The
Fluorescein Map will be automatically updated (see Fluorescein Map on page B-6).

Lens Design Parameters

Base Curve (BC) is the curvature of the central portion of the back surface of the lens
Figure B-10 displays a bicurve lens design which has one base curve and one secondary
peripheral curve. Most rigid corneal lenses used today are either bicurve or tricurve. The
back vertex power is the effective power of the lens measured from the back surface.

Figure B-10 Spherical Bicurve Lens Design Diagram

Spherical lenses have one base curve. All toric lens except the front toric have two base
curves, a steep base curve and flat base curve, perpendicular to each other. Aspheric
lenses have a varying base curve defined by the back optic zone eccentricity.
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Add a New Lens Design

To add a new lens design, click on the empty thumbnail labeled “Click here to add new
design.” A new lens design thumbnail will be created and selected with the currently
selected thumbnail’s design parameters. The first lens design is named “1” with
subsequent designs named “2, 3, etc.” You can rename the lens designs using the Rename
button (see Rename below).

☞ Note: You can also add a new design by changing the lens or lens design parameters
of the Recommended lens design.

Rename

Click the Rename button to rename the currently selected lens design (thumbnail). 
A Change Name dialog will be displayed (Figure B-11). You can also click on the name
of the design on the bottom of the thumbnail to bring up the Change Name dialog.

Figure B-11 Contact Lens Design – Change Name Dialog

Enter the new name in the New Name field and select OK to save your new name. A dialog
will be displayed confirming your request for a new name. Select Yes to rename the design
or No to cancel the renaming.

☞ Note: You cannot rename the Recommended lens design.

Delete

Click the Delete button to delete the currently selected lens design (thumbnail). A dialog
will be displayed confirming your request for deletion. Select Yes to delete the design or No
to cancel the deletion.

☞ Note: You cannot delete the Recommended lens design.
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Design Lens

The Design tab (Figure B-12) displays the recommended lens parameters.

Figure B-12 Design Tab

The software determines a Fitting Method, Lens Type, and other lens parameters based
upon acquired eye image information, refractive data (see Change Rx on page B-16),
lens fitting rules (see Fitting Rules on page B-17), and your preferred lenses (see Lenses
on page B-22). The Flat base curve value display units can be set to mm or Diopters (see
Units on page 7-2). 

Change Lens

The Change Lens button displays the LENS BROWSER SCREEN (Figure B-13) which allows you
change the currently selected lens. To select a new lens, follow these steps:

1. Select a lens type from the Select Lens Type drop-down menu. 
2. In the left column, select a lens manufacturer by clicking on it.
3. In the right column, select a lens name from the list by clicking on it.
4. The selected lens’s design parameters are shown below the two columns.
5. Click OK to select the lens.
6. The selected lens will be displayed in the field above the Change Lens button (shown

on the left) and the Fluorescein Map Display will be updated.

Lens Types

• Spherical – This is the most frequently fitted lens; it has spherical curves on both the
front and back surfaces.

• Front toric – This lens has a spherical back surface with cylinder ground into the front
surface.; it is used to correct residual astigmatism on relatively spherical corneas.

• Back toric – The cylinder is on the back surface only; this lens is used to fit highly
cylindric WTR or ATR corneas, combined with residual astigmatism, when lens flexure
or rotation is a problem.

• Bi-Toric – This lens has a minus cylinder curve on the posterior surface and a plus
cylinder on the anterior curve; it is used for high WTR or ATR corneal toricity with
residual astigmatism.
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• Aspheric – The back surface of this lens has a continuous elliptic or parabolic shape
that is steeper in the center and flattens toward the periphery; it is used to match the
anterior surface of an aspheric cornea with a Shape Factor between 0.50 and 0.70.

Figure B-13 Lens Browser Screen

☞ Note: If you change the lens of the Recommended lens design, a new design will
automatically be added to the Lens Design Thumbnails.

Lens Parameters

The LENS PARAMETERS SCREEN (Figure B-14) displays lens design parameters which can be
edited by selecting different values in the drop-down menus for each parameter. If you
have the Recommended lens design selected, a new lens design thumbnail will
automatically be created.

Figure B-14 Lens Parameters Screens
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Peripheral Curves (Custom Lens only)

For Custom lens, checking Peripheral Curves adds Secondary and Third Curve Radius and
Width to edit. Peripheral Curves, which typically encompass the outer 15 to 25% of the
lens, surround the optical zone of the lens. See Figure B-10. 

If Auto Update is checked (default), the Peripheral Curves will change by the same amount
as any change to the Flat base curve value.

☞ Note: Set the Secondary and Third Curves to the same values to create a bi-curve
design.

Residual Astigmatism

When the contact lens is placed on the cornea, the tear lens corrects the astigmatism on
the cornea but not the astigmatism due to the other components of the eye—Residual
Astigmatism is the remaining astigmatism or refractive error that is still present. Residual
astigmatism is calculated only from a spherical lens fit.

Map View

The Map tab (Figure B-15) displays a corneal topography map for the currently selected
exam. You can select Axial, Elevation, Tangential, or Mean from the drop-down menu. 

Figure B-15 Map Tab

Axial is selected as the default View. See Axial Curvature on page 6-2 for more
information on the Axial Curvature View. See Elevation on page 6-6 for more information
on the Elevation View. See Tangential Curvature on page 6-4 for more information on
the Tangential Curvature View. See Mean Curvature on page 6-19 for more information
on the Mean Curvature View. The maps use the same settings as in the Single View Display.
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Change Rx

The Change Rx button displays the CHANGE RX SCREEN (Figure B-16) which allows you to
enter and edit the patient’s refraction data.

Figure B-16 Change Rx Screen

Vertex Distance (mm) – Select the corneal vertex distance (mm) from the drop-down menu.

Use trial lens – Select this to use a trial lens. If selected, enter in Trial lens and Over
refraction data for the Sphere, Cylinder, and Axis.

Cylinder Type – Select the radio button for your cylinder convention (Minus cylinder or Plus
cylinder).

Distance Rx – Enter in the Sphere, Cylinder, and Axis values for the distance correction.

Correction corneal plane, Tear lens, and Back vertex power will be calculated by the
software for the Sphere, Cylinder, and Axis.
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Options

The Options button on the lower left of the MasterFit II Display displays the OPTIONS SCREEN

which allows you to select and edit your preferred lenses, define lens fitting rules, and set
your display preferences for the Fluorescein Map View. In addition, a Lens Material list can
be defined and edited.

Some units will be displayed in mm or Diopters depending on your global unit setting (see
Units on page 7-2).

Click the Default values button to return all edited parameter values back to the default
values of the software.

Select OK to save your changes on all Tab screens of the OPTIONS SCREEN. All changes are
saved globally. Select Cancel to discard your changes and close the OPTIONS SCREEN. 

Fitting Rules

Selecting the Options button and then selecting the Fitting Rules tab displays the
Options – Fitting Rules dialog (Figure B-17).

Figure B-17 Options – Fitting Rules Tab
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Fit Type
• If the Use Topographic Fit radio button is checked, MasterFit II's topography-based

fitting rules is used to determine the recommended contact lens type. See
Topographic on page B-19 for the Topographic Fitting Rules.

• If the Use Keratometric Fit radio button is checked, then the software determines the
recommended contact lens type using the Keratometric Fitting Rules. See
Keratometric on page B-20 for the Keratometric Fitting Rules.

Spherical / Front Toric Residual Astigmatism Rule
• Use Front Toric if residual astigmatism is > – Enter an astigmatism value to determine

if a Front Toric lens will be used.

Back Toric /Bi-Toric Residual Astigmatism Rule
• Use Back Toric/Bi-Toric if residual astigmatism is > – Enter an astigmatism value to

determine if a Bi-Toric lens will be used.

Spherical / Aspheric Override
• Use Spherical / Aspheric if Shape Factor is > – If checked, enter a Shape Factor value

and select either Spherical or Aspheric to determine if a Spherical/Aspheric lens will be
used.

Lens Diameter

Select one of the two radio buttons:
• Subtract from HVID (mm) – The initial lens diameter will be calculated by subtracting

this value from the HVID value. This lens diameter will be used in selecting an
available lens diameter, based upon the lens diameter available for the recommended
lens from the catalog.

• If HVID < 10.5 mm use 9.0 mm, If HVID > 10.5 mm and < 11.5 mm use 9.4 mm, If
HVID > 11.5 mm use 9.8 mm – Select this to select the lens diameter based upon the
HVID value as follows:
• Set Lens diameter to 9 mm if HVID < 10.5 mm
• Set Lens diameter to 9.4 mm if HVID > 10.5 mm and < 11.5 mm
• Set Lens diameter to 9.8 mm if HVID > 11.5 mm

Note that ATLAS 900 series exams use an HVID of 11.5 mm.
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Topographic

Selecting the Options button and then selecting the Topographic tab displays the
Options – Topographic dialog (Figure B-18).

Figure B-18 Options – Topographic Tab

If the Use Topographic Fit Fit Type radio button is checked in the Fitting Rules tab (Figure
B-17), MasterFit II's topography-based fitting optimizes the tear film clearance using the
following methodology:

1. The center of the lens should clear the central cornea by approximately 20 μm.
2. There should be a mid-peripheral contact point along the horizontal meridian.
3. The lens should maintain unobstructed movement along the vertical meridian of

approximately 40 μm.

The topographic fitting algorithm attempts to create a contact lens design which will
provide the selected tear lens thickness (TLT) for the following:

Topographical Fitting Tear Lens Thicknesses (μm) 

• Central Clearance – This is the TLT in the central 0.5 degree center of the eye.
• Horizontal/Vertical Mid-Peripheral Clearance – Horizontal Mid-Peripheral Clearance is the

peripheral clearance along the corneal Sim K axis closest to 180º. Vertical Mid-Peripheral
Clearance is the peripheral clearance along the corneal Sim K axis closest to 90º.
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Keratometric 

Selecting the Options button and then selecting the Keratometric tab displays the
Options – Keratometric dialog (Figure B-19).

Figure B-19 Options – Keratometric Tab

If the Use Keratometric Fit Fit Type radio button is checked in the Fitting Rules tab (Figure
B-17), then the software determines the recommended contact lens type using the
Keratometric Fitting Rules. The parameters can be edited by selecting different values in
the drop-down menus for each parameter. Keratometric Fitting Rules for Spherical, Bi-Toric,
and Front Toric lens types can be edited, along with lens diameter.

Spherical

• Spherical BC offset (mm) (add to Flat K) – Enter the mm value to add to the initial
base curve radius which is set to the flat Sim K value.

• Subtract (mm) from Flat K (Delta K < 0.75 D (0.15 mm)) – Enter the mm value to
subtract from the initial base curve value when the Delta K value is less than 0.75
Diopters (0.15 mm).
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• Subtract (mm) from Flat K (Delta K > 0.75 D (0.15 mm) and Delta K < 1.75 D (0.35
mm)) – Enter the mm value to subtract from the initial base curve value when the
Delta K value is greater than 0.75 Diopters (0.15 mm) but less than 1.75 Diopters (0.35
mm).

• Subtract (mm) from Flat K (Delta K > 1.75 D (0.35 mm)) – Enter the mm value to
subtract from the initial base curve value when the Delta K value is greater than 1.75
Diopters (0.35 mm).

Back Toric / Bi-Toric

• WTR Delta K Cutoff between spherical and toric – If the corneal astigmatism is WTR
(With The Rule) and greater than this value, then a spherical design will be changed to
a toric design.

• ATR Delta K Cutoff between spherical and toric – If the corneal astigmatism is ATR
(Against The Rule) and greater than this value, then a Spherical design will be
changed to a Toric design.

• Use Mandell-Moore Bi-Toric Fitting Guide – Check this to use the Mandell-Moore
Bi-Toric Fitting Guide. See http://www.gpli.info for more information.

• Toric steep K offset (mm) – If the Mandell-Moore Bitoric Fitting Guide is not checked,
enter the mm to add to the steep K value for the steep base curve value.

• Toric flat K offset (mm) – If the Mandell-Moore Bitoric Fitting Guide is not checked,
enter the mm to add to the flat K value for the flat base curve value.

http://www.gpli.info
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Lenses

Selecting the Options button and then selecting the Lenses tab displays the Option –
Lenses dialog (Figure B-20).

Figure B-20 Options – Lenses Tab
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Lens Catalogs

The List of selected catalogs table shows the current list of contact lens catalogs.
MasterFit II comes with two catalogs: a North American Contact Lens catalog
(NA_CONTACT_LENS.CAT) and a European Union Catalog (EU_CONTACT_LENS.CAT)
which are located in “C:\Documents and Settings\All Users\Application Data\Carl Zeiss
Meditec\ATLAS\contactlens” for Windows XP; for Windows Vista the path is “C:\Program
Data\Carl Zeiss Meditec\ATLAS\contactlens.” Additional and updated contact lens catalogs
may be available for download on the ATLAS System Technical Support section of our
website (www.meditec.zeiss.com/atlas).

To add or update the list, select the Add new catalog to list / Update existing catalog in list
button to open a standard Open dialog where you can find and open a Catalog File in the
CAT format. If a catalog with same name already exists, it will be replaced.

If you want to remove a lens catalog from the list, first select a catalog file from the list
with your mouse and then select the Remove selected catalog from list button to remove it.
If a preferred lens belongs to the removed catalog, a generic lens of appropriate type will
be set to the preferred lens.

Preferred Lenses

Use the Preferred Lenses fields to set the preferred lens for each type of lens (Aspheric,
Spherical, Back toric, Front toric, Bi-Toric). When the software calculates the recommended
lens type, it will use the preferred lenses entered here for that type. The software displays
the Recommended lens on the Recommended tab (see Design Lens on page B-13).

☞ Note: If you do not select a preferred lens for a lens type, a custom lens for that type
will be selected by default.

http://www.meditec.zeiss.com/atlas
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Click the corresponding Browse button for each lens type to select a preferred lens from the
Contact Lens Select Form (Figure B-21).

Figure B-21 Contact Lens Select Form

Select a lens and then select OK to return to the Option – Lenses dialog.

Display Preferences

Selecting the Options button and then selecting the Display Preferences tab displays
the Options – Display Preferences dialog (Figure B-9). See Display Preferences
on page B-9 for information on the Options – Display Preferences dialog.
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Lens Material

Selecting the Options button and then selecting the Lens Material tab displays the
Options – Lens Material dialog (Figure B-17).

Figure B-22 Options – Lens Material Tab

The Lens Material dialog displays a list of lens materials. You can select a lens material
to be used on the Contact Lens order form (see Order on page B-26 for more
information).

The current lens material is shown in the Current Selection field and will be the default
material on the Contact Lens order form. Select Remove Entry to delete this material.

To add a new lens material to the list, enter the description (< 30 characters) in the text
field to the right of the Add Entry button, and then select Add Entry.

Select Replace List to open a standard Open dialog and locate and open a MasterFit Lens
Material File(*.txt). The current Lens Material List will be replaced and overwritten.
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Order

The Order button on the lower left of the MasterFit II Display allows you to select, print,
edit, and save Order Forms. Selecting the Order button displays the Contact Lens order
form dialog (Figure B-23). When opened, it is updated with the currently selected
patient information and lens designs, replacing the current template tags with values. You
can edit the file by scrolling and clicking in the text box.

Figure B-23 Contact Lens Order Form

Browse

Click the Browse button to display a standard Open dialog where you can find and open
an Order form template file in RTF format. An Order form template file contain tags that
will be replaced with real values once it is opened. The tags allow you to customize your
order form. For a list of available tags see Table B-1, “Order Template Form Tags
and Values,” on page 27. A sample order form named “DefaultOrderForm.rtf” is the
default Order Template form and is located in “C:\Documents and Settings\All
Users\Application Data\Carl Zeiss Meditec\ATLAS\contactlens” for Windows XP; for
Windows Vista the path is “C:\Program Data\Carl Zeiss Meditec\ATLAS\contactlens.”
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Table B-1 Order Template Form Tags and Values

Tag Value

#Date Current date

#Time Current time

#Institution Institution name

#Doctor Doctor name

#PatientName Patient name

#PatientDOB Patient birth date

#PatientID Patient ID

#Eye Exam eye

#Manufacturer Lens manufacture name

#LensName Lens name

#LensType Type of lens

#LENS_COLOR Lens Color (current eye)

#RIGHT_LENS_DOTTED Right Lens Dotted (Yes/No)

#OD_LENS_COLOR Lens Color (OD)

#OS_LENS_COLOR Lens Color (OS)

#BOZR1 Base Curve

#BOZR2 Base Curve 2 (Toric)

#TD Lens diameter

#ADD ADD value

#OD_EYE Exam eye (OD)

#OD_Manufacturer Lens manufacture name (OD)

#OD_LensName Lens name (OD)

#OD_LensType Type of lens (OD)

#OD_BOZR1 Base Curve (OD)

#OD_BOZR2 Base Curve 2 (Toric) (OD)

#OD_TD Lens diameter (OD)

#OD_ADD ADD value (OD)

#OS_EYE Exam eye (OS)

#OS_Manufacturer Lens manufacture name (OS)

#OS_LensName Lens name (OS)

#OS_LensType Type of lens (OS)

#OS_BOZR1 Base Curve (OS)

#OS_BOZR2 Base Curve 2 (Toric) (OS)

#OS_TD Lens diameter (OS)

#OS_ADD ADD value (OS)
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Lens Material

Select the lens material from the Lens Material drop-down box. The currently selected
lens material on the Options – Lens Material dialog will be selected by default (see
Lens Material on page B-28).

Lens Color

Select the lens color from the Lens Color drop-down box. The default is Clear.

Right Lens Dotted

Check Right Lens Dotted to have the right lens dotted for identification. The default is
checked. 

Preview/Print

Click this button to preview/print the Order Form. This will open a standard Windows Print
Preview dialog where you can select print options and preview/print the Order Form. 

#OS_BVP2 Steep back vertex power (Toric) (OS) 

#OD_BVP2 Steep back vertex power (Toric) (OD) 

#BVP2 Steep back vertex power (Toric)

#OZD Optic zone diameter (current eye)

#OS_OZD Optic zone diameter (OS)

#OD_OZD Optic zone diameter (OD)

# SEC_RADIUS 2nd curve radius

# PER_RADIUS 3rd curve radius

#SEC_CURVE_WIDTH 2nd curve width

#PER_CURVE_WIDTH 3rd curve width

# OS_SEC_RADIUS 2nd curve radius (OS)

# OS_PER_RADIUS 3rd curve radius (OS)

# OS_SEC_CURVE_WIDTH 2nd curve width (OS)

# OS_PER_CURVE_WIDTH 3rd curve width (OS)

# OD_SEC_RADIUS 2nd curve radius (OD)

# OD_PER_RADIUS 3rd curve radius (OD)

# OD_SEC_CURVE_WIDTH 2nd curve width (OD)

# OD_PER_CURVE_WIDTH 3rd curve width (OD)

# OD_Lens_Material Lens material (OD)

# OS_Lens_Material Lens material (OS)

Table B-1 Order Template Form Tags and Values

Tag Value
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Save to file

Click this button to save the Order Form as an RTF or text file. This will open a standard
Save as dialog where you can save the Order Form with a name, type, and location of
your choice. The default file name is Patient Last name + Patient first name + Eye + Date.

Exit

Click this button to exit the Contact Lens order form dialog and return to the MasterFit
II Display.
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(C) DICOM Gateway (Optional)

Overview

The DICOM (Digital Imaging and Communications in Medicine) Gateway is an optional
software program that allows you to connect one or more ATLAS instruments to a qualified
DICOM 3.0 Ophthalmic Compatible Electronic Medical Records (EMR) system, Patient
Management System (PMS), or DICOM archive that supports EPDF or Secondary Capture,
for paperless workflow. When the DICOM Gateway is properly installed and configured on
an ATLAS, the ATLAS can display a list of patients who are scheduled for exams (“DICOM
Modality Worklist”). When a patient is selected from this list, all demographic data (e.g.,
name, patient ID, birthdate, etc.) is entered automatically into the ATLAS database. Once
the exam is performed, any report that would normally be printed can be automatically
added to the patient's electronic medical record for easy viewing and analysis. This
workflow eliminates the need to manually enter patient demographic information into the
ATLAS and dramatically increases clinic efficiency by eliminating the need to print or scan
any diagnostic reports.

☞ Note: The DICOM Gateway is an optional software program that is separately
licensed. You must activate the software for it to function on your ATLAS. 
To activate, go to www.meditec.zeiss.com/register. You may also contact Carl Zeiss
Meditec:
In the U.S.: Call Carl Zeiss Meditec at 1-800-341-6968.
Outside the U.S.: Contact your local Carl Zeiss Meditec distributor.
E-mail: z.customersupport@meditec.zeiss.com.
You can activate a license using the procedure that is provided in (I) License
Registration.

☞ Note: You should check the ATLAS DICOM Conformance Statement and with your
vendor to determine the compatibility of their system with the DICOM Gateway
before purchasing an EMR/PMS system. Your EMR/PMS must be DICOM 3.0
Ophthalmic Compliant and support EPDF.

The DICOM Gateway Version 1.0 is compatible with ATLAS’s running System Software
Version 3.0 or later. The procedures for installing and configuring the DICOM Gateway
software on an ATLAS are described in detail in this appendix. For using the DICOM
Gateway see Importing from Worklists (Instrument Only) on page 11-20, and
Exporting Data to DICOM Systems on page 11-25.

This appendix includes the following topics:

• DICOM Gateway Configuration Steps, page C-2
• Network Broker Installation, page C-3
• Network Broker Configuration, page C-6
• Launching the Configuration Tool, page C-7
• General Information, page C-8
• Network Broker Configuration Tool Steps, page C-10
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Network Broker Service

The main software component of the DICOM Gateway that runs on the ATLAS is called the
Network Broker service. The software acts as an intermediary between your ATLAS and
your DICOM Storage and Worklist Servers (Figure C-1).

Figure C-1 DICOM Gateway Setup Diagram

DICOM Gateway Configuration Steps

The setup process for your complete DICOM Gateway solution includes the following steps
that you will need to perform:

1. DICOM Server Setup: Set up your DICOM storage server and modality worklist server
to recognize the AE Title of the ATLAS that will be connected through the Network
Broker service. This is a potentially complex and time-consuming process whose
details depend on your system, and which should only be attempted by someone who
has expert knowledge of this system. 

2. Network the ATLAS: Configure your ATLAS to connect to your network. See your IT or
PACS administrator for more information.

3. License DICOM Gateway: License the DICOM Gateway on the ATLAS.
See (I) License Registration for more information.

4. Install Network Broker: Install the Network Broker service on the ATLAS. 
See Network Broker Installation on page C-3 for more information.

5. Configure Network Broker: Run the Network Broker Configuration program to
configure the Network Broker service to recognize the connected ATLAS and to
communicate with the designated Storage and Worklist servers. See Network
Broker Configuration Tool Steps on page C-10 for more information.

6. Run the Network Broker Service with new configuration: Make sure you have restarted
the ATLAS to start the Network Broker Service with the new configuration.

☞ Note: If the Network Broker service is stopped, it can be manually started by
selecting Options > Preferences > DICOM Export Configuration > Restart
Network Broker in the ATLAS software (except Windows Vista Review Stations), or
by selecting Start > All Programs > CZM > Network Broker > Start Network
Broker service from the Windows desktop.
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7. Use DICOM on your ATLAS: Query your worklist server for requested exams, perform
these exams and export the desired ATLAS reports to the patient record. See
Importing from Worklists (Instrument Only) on page 11-20, and Exporting
Data to DICOM Systems on page 11-25.

Network Broker Installation

The following instructions describe the installation of the Network Broker software. The
Network Broker installation program is found on the ATLAS Version 3.0 installation CD.

Please read all instructions before performing the installation.

Important Installation Notes

1. Plan and allow sufficient time for installation and configuration.
2. Administrator Account Required. To install or to use this software, you must be logged

in to Windows as a Computer administrator.
3. Non-public JRE Installed. The installer also installs a non-public Java Runtime

Environment (JRE) for the Network Broker. Any already existing JREs are neither used
nor modified. Upon first launch of the Network Broker a Windows Security Alert will
be displayed if you have Windows Firewall turned on (see Windows Security Alert
on page C-7).

Installation Instructions

☞ Note: If a previous version of Network Broker is installed, it needs to be uninstalled
before installing the Network Broker.

☞ Note: The screenshots shown in this document may differ slightly from the screens
displayed during installation.

1. Exit the ATLAS system software (click File > Exit or click the  at upper right) to
enter the operating system environment. The Windows desktop will appear.

2. Install the ATLAS Version 3.0 installation disk into its drive. Wait for the installation
program to start automatically.

3. Click Cancel to cancel the Version 3.0 installation.
4. Click Start > Explore to launch Windows Explorer.
5. Open the NetworkBroker folder on the Version 3.0 disk.
6. Double-click the file named “NetworkBroker_1.3.msi” to launch the Network Broker

installation program.
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7. After preparatory steps complete, the INSTALLSHIELD WIZARD WELCOME window appears:

Figure C-2 InstallShield Wizard Welcome Window

8. Click Next to begin installation.The INSTALLSHIELD WIZARD DESTINATION FOLDER window is
displayed:

Figure C-3 InstallShield Wizard Destination Folder Window

To install into the default folder, C:\Program Files\CZM\Network Broker, click Next. 
To install into a different folder, click the Change button to select another folder, and
then click Next to continue installation.
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9. An INSTALLSHIELD WIZARD READY TO INSTALL window is displayed:

Figure C-4 InstallShield Wizard Ready to Install Window

 Click Install to begin the installation.
10.An INSTALLSHIELD WIZARD STATUS window tracks progress of the installation:

Figure C-5 InstallShield Wizard Status Window
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11.AN INSTALLSHIELD WIZARD COMPLETED window is displayed when installation is
complete:

Figure C-6 InstallShield Wizard Completed Window

12.Click Finish to end the installation.

Network Broker Configuration

The Network Broker Configuration Tool helps you to configure the Network Broker. This
section describes how to configure the Network Broker Configuration Tool for use with
VISUPAC™ 4.4 (or later) or a DICOM system and an ATLAS.

After completing the configuration, you must restart Windows on the ATLAS to start the
Network Broker service with the new configuration.

1. Launch the Network Broker Configuration Tool from the ATLAS. See Launching the
Configuration Tool on page C-7.

2. Go through all 10 steps of the Configuration Tool to configure the Network Broker. See
Network Broker Configuration Tool Steps beginning on page C-10.

3. Restart Windows on the ATLAS to start the Network Broker service with the new
configuration.
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Launching the Configuration Tool

To launch the Network Broker Configuration Tool, select Options > Preferences > DICOM
Export Configuration > Configure Network Broker in the ATLAS software (except Windows
Vista Review Stations), or select the Windows key on the keyboard to see the
Windows Task Bar, and then select Start > All Programs > CZM > Network Broker >
Configuration Tool to display the WELCOME SCREEN (Figure C-7).

Figure C-7 Configuration Tool Welcome Screen

Windows Security Alert

Upon first launch of the Network Broker a Windows Security Alert will be displayed
(Figure C-8) if you have Windows Firewall turned on. You must unblock the JRE from
Windows Firewall by selecting the Unblock button.

Figure C-8 Windows Security Alert – Windows Firewall
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The Java(TM) Platform SE binary program will then be displayed on the Exceptions tab
(Figure C-8) of Windows Firewall (Start > Control Panel > Windows Firewall >
Exceptions).

Figure C-9 Windows Firewall Exceptions Tab

General Information

Configuration is done in a series of wizard steps. To navigate between configuration steps,
click the Continue  and Back buttons. 

It is not possible to move on to the next configuration step until the current configuration
step has been completed without errors. If an invalid value is entered in an entry field, this
field will be displayed in red. In addition, an exclamation mark will be displayed to the left
of the field next to the field label.

To complete the configuration, click the OK button in the final configuration
step. A message will be displayed, indicating that the configuration data has been saved
correctly. If an error occurs during configuration, an error message is displayed. 

Select Cancel at any step if you want to cancel the configuration. The
configuration will be aborted and the Configuration Tool will close. A backup of the
existing configuration will be made automatically. This ensures that the configuration can
be aborted at any time without losing the existing (old) configuration data. The existing
configuration will be restored automatically.

Version information is available by clicking on the “i”  button on the left.
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Configuration Tool Language Selection

The language for the Network Broker Configuration Tool is selected on the WELCOME SCREEN

(Figure C-7) by selecting the language from the pop-up menu. This setting is for the
Configuration Tool only and does not affect the language used by the Network Broker. The
default language depends on the current system locale.

Available languages are:

• English
• German
• French
• Italian
• Spanish

Configuration Tool Help

Help for the current step is available by clicking on the Help button  to display
the HELP SCREEN.

Figure C-10 Help Screen

You can print the help information by clicking Print. 
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Network Broker Configuration Tool Steps

☞ IMPORTANT!: The Network Broker Configuration Steps below describe how to
configure each step for VISUPAC and a non-specific DICOM System. All screenshots
show the VISUPAC Configuration, but callouts (marked with a ) show where you
would enter your DICOM specific configuration information. This specific
information should be provided for you by your PACS Administrator or IT person.

Step 1: Select Configuration Type

Clicking Continue  on the WELCOME SCREEN (Figure C-7) will display the
STEP 1 SCREEN (Figure C-11).

Figure C-11 Step 1 – Create a New Configuration

On the STEP 1 SCREEN, you can either create a new configuration using the Configuration
Tool or edit an already existing configuration. Editing an existing configuration is only
possible if there is a previously created configuration. Whether you are creating a new
configuration or editing an existing configuration, a back-up copy of the existing
configuration will be created. This allows you to abort the configuration process at any
time without losing the existing (old) configuration data.

To begin a new configuration select Create a new configuration to create a new
configuration for the ATLAS.

Click Continue  to continue to the next step.

*
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Step 2: Device Selection

Clicking Continue  on the STEP 1 SCREEN (Figure C-11) will display the STEP

2 SCREEN (Figure C-12).

Figure C-12 Step 2 – Device Selection

On the STEP 2 SCREEN, a preset device can be selected. The Preset drop-down menu
(Figure C-13) lists all the instruments that can be configured using the Configuration Tool.

Figure C-13 Preset Device List

After selecting a preset device from the list, the communication protocol for that device can
then be specified by clicking on the corresponding radio button: Socket Communication or
FEP Communication (File Export Protocol). It is also possible to simply select a protocol,
without selecting a preset device by choosing entry '…' from the list. The generic default
configuration will then be started for this protocol.

On the STEP 2 SCREEN, select Atlas from the Preset drop-down menu. FEP Communication
is automatically selected as the communication protocol—leave it selected. Click Continue

 to continue to the next step.
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Step 3: DICOM Application Entity Title

Clicking Continue  on the STEP 2 SCREEN (Figure C-12) will display the STEP

3 SCREEN (Figure C-12).

Figure C-14 Step 3 – DICOM Application Entity Title

In the DICOM Application Entity Title field, enter NB_1—the name of the Network Broker
in the DICOM environment. 

If invalid characters are entered in the name field, the name in the DICOM Application
Entity Title field will be displayed in red and an exclamation mark will be displayed to the
left of the field next to the field label.

The DICOM Application Entity Title is the name used by Network Broker in the DICOM
environment, i.e. which it uses to communicate with both the DICOM Storage Provider and
the DICOM Modality Worklist Provider. 

Click Continue  to continue to the next step.
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Step 4: DICOM Modality Worklist Provider Setup

Clicking Continue  on the STEP 3 SCREEN (Figure C-14) will display the STEP

4 SCREEN (Figure C-15).

Figure C-15 Step 4 – DICOM Modality Worklist Provider Setup

For VISUPAC, enter VISUPAC_MWL in the Application Entity Title field. 

For your DICOM system, enter the name of the DICOM Modality Worklist Provider (MWL) in
the Application Entity Title field. This is the name by which the DICOM Modality Worklist
Provider is recognized and addressed in the DICOM environment. This should be provided
for you by your PACS Administrator or IT person.

For VISUPAC and your DICOM system, enter the address and port for the DICOM Modality
Worklist Provider in the Host/IP and Port fields. The Timeout field is used to set the time
interval to be assigned to the provider—it can be left at 10 seconds.

Verify that the Modality Worklist Dialog checkbox is left unchecked. 

For a DICOM system, enter
the AET Title, Host/IP
address, and Port for the
DICOM Modality Worklist
Provider.

*
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Connection Test

After entering the Host/IP and Port number, the connection to this Host can be tested.

Ensure that you are physically connected to the host and that the application will not be
blocked by a firewall. To carry out the test, click the Connection test button. This will open
a new window, displaying the status of the connection test. During the connection test, a
socket connection to the specified host and port is established. After that, a DICOM
association is opened to test whether the peer system acts as a Modality Worklist Provider.

If the system is able to connect correctly to the address given, a message will be displayed
indicating that the connection test was successful. 

If either no socket connection could be established or the peer system isn't a DICOM
Modality Worklist provider, an error message is displayed (Figure C-16).

Figure C-16 Connection Test Failure

Once you have filled in all the fields, click Continue  to continue to the next
step, or click Back to return to the previous step.

If you do not perform a connection test, a dialog will be displayed when you click Continue
 (Figure C-17).

Figure C-17 Connect Test Dialog

Select Yes to continue to the next step, or No to remain on the STEP 4 SCREEN and then
perform a connection test.
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Step 5: DICOM Storage Provider Setup

Clicking Continue  on the STEP 4 SCREEN (Figure C-15) will display the STEP

5 SCREEN (Figure C-18).

Figure C-18 Step 5 – DICOM Storage Provider Setup

For VISUPAC, enter VISUPAC_PACS in the Application Entity Title field. 

For your DICOM system, enter the name of the DICOM Storage Provider in the Application
Entity Title field. This is the name by which the DICOM Storage Provider is recognized in the
DICOM environment. Network Broker will address the DICOM Storage Provider using this
name. This should be provided for you by your PACS Administrator or IT person.

For VISUPAC and your DICOM system, enter the address for the DICOM Storage Provider in
the Host/IP field. For VISUPAC, enter 5104 in the Port field. For your DICOM system, enter
the port for the DICOM Storage Provider in the Port field. The Timeout field is used to set
the time interval to be assigned to the provider—it can be left at 10 seconds.

For your DICOM system, in the Used DICOM IOD drop-down menu, select Encapsulated
PDF or Multi-frame True Color Secondary Capture. If you selected Multi-frame True Color
Secondary Capture, select a compression level radio button: No compression, JPEG
baseline compression, or RLE compression. For Encapsulated PDF, no compression is
available, because the compression is already done inside the PDF document. 

The scaling factor determines whether and to what degree the image saved in DICOM is to
be scaled down in comparison with the original. It is not available for PDF documents. To
activate the scaling factor, check the Activate SC scaling factor checkbox and select a
scaling factor in the entry box (from .1 to 1, where .1 is 10% and 1 is 100%).

For a DICOM system,
enter the AET Title,
Host/IP address, and Port
for the DICOM Storage
Provider.

*

For a DICOM system, 
select Encapsulated PDF 
or Multi-Frame Grayscale 
Byte Secondary Capture.

*
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For VISUPAC, select Multi-frame True Color Secondary Capture, No compression, and leave
the Activate SC scaling factor unchecked.

Connection Test

After entering the Host/IP and Port number, you can now test the connection to this Host.

Ensure that you are physically connected to the host and that the application will not be
blocked by a firewall. To run the test, click on Connection test. This will open a new
window, displaying the status of the connection test. During the test, a socket connection
to the specified host and port is established. If this is successful, a DICOM association is
opened to check if the peer system is a DICOM Storage SCP and accepts the selected
combination of DICOM IOD and compression.

If the system is able to connect correctly to the address given, a message will be displayed
indicating that the connection test was successful. 

If either no socket connection could be established, the peer system isn't a DICOM Storage
SCP, or for another reason, an error message is displayed (Figure C-19).

Figure C-19 Connection Test Failure

Common error messages coming from the peer system could be: 

• “Abstract syntax not supported” if the selected IOD is not supported by it.
• “Transfer syntax not supported” if the selected compression isn't supported.

Once you have filled in all the fields, click Continue  to continue to the next
step, or click Back to return to the previous step.

If you do not perform a connection test, a dialog will be displayed when you click Continue
 (Figure C-20).

Figure C-20 Connect Test Dialog

Select Yes to continue to the next step, or No to remain on the STEP 5 SCREEN and then
perform a connection test.
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Step 6: CZM-XML Application Entity Title

Clicking Continue  on the STEP 5 SCREEN (Figure C-18) will display the STEP

6 SCREEN (Figure C-21).

Figure C-21 Step 6 – CZM-XML Application Entity Title

Enter NB in the CZM-XML Application Entity Title field. It will be addressed by the
connected instrument using this name via CZM-XML. 

Click Continue  to continue to the next step.
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Step 7: Instrument Setup

Clicking Continue  on the STEP 6 SCREEN (Figure C-21) will display the STEP

7 SCREEN (Figure C-22).

Figure C-22 Step 7 – HFA FEP Communication 

In the FEP folder field, enter or select the path to the ATLAS DICOM Export Folder. The
default path to the ATLAS DICOM Export Folder is C:\CZM\ATLAS\FEP. 

For VISUPAC, enter the serial number of the ATLAS instrument (ATLAS-XXXXX) in the
CZM-XML Application Entity Title field. The serial number of your ATLAS can be found on
the right side of the ATLAS instrument to the left of the connectors (see Figure 1-8). For a
DICOM system, you can enter any name, but it must be unique. Click Add to add the AET
to the list of Available AETs. There is no reason to add more than one ATLAS Application
Entity Titles (AETs). Click Edit if you need to edit the ATLAS AET.

Once you have filled in all the fields, click Continue  to continue to the next
step.
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Step 8: Hotkey Setup

Clicking Continue  on the STEP 7 SCREEN (Figure C-22) will display the STEP

8 SCREEN (Figure C-23).

Figure C-23 Step 8 – Keyboard Shortcut Key Setup (Default: F12)

Select the keyboard shortcut key for activating the Network Broker window by pressing a
key or function key (or any key combination; e.g., SHIFT-F10, CTL-SHIFT 2, etc.) on the
keyboard in the Storage Dialog ‘Hotkey’ field.

The Show Storage Dialog ONLY on pressing 'HotKey' option means that the Storage
window will only be activated when the keyboard shortcut key is pressed. If this checkbox
is not checked, the Storage window will be displayed in the foreground whenever a storage
request is made.

Click Continue  to continue to the next step, or click Back to
return to the previous step.
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Step 9: Language Selection

Clicking Continue  on the STEP 8 SCREEN (Figure C-23) will display the STEP

9 SCREEN (Figure C-24).

Figure C-24 Step 9 – Language Selection

Select the language for the Network Broker application from the Network Broker language
drop-down list (Figure C-25). This setting relates only to the language used in the
Network Broker itself, and is independent of the language used during setup.

Figure C-25 Network Broker Language List

Available languages are:

• en (English)
• de (German)
• fr (French)
• it (Italian)
• es (Spanish)

Click Continue  to continue to the next step, or click Back to
return to the previous step.
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Step 10: Configuration Complete

Clicking Continue  on the STEP 9 SCREEN (Figure C-24) will display the STEP

10 SCREEN (Figure C-26).

Figure C-26 Step 10 – Finish Configuration

Click OK to save the configuration settings to the configuration file. If the
configuration has been completed correctly, the Network Broker Configuration Tool will
report a successful configuration and save your settings (Figure C-27).

Figure C-27 Configuration Completed Successfully

Click OK to close the Network Broker Configuration Tool.

☞ IMPORTANT!: Restart the ATLAS to start the Network Broker Service with the new
configuration.
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(D) Network Configuration Guide

Chapter Overview

This chapter provides configuration instructions to enable transfer of ATLAS data from an
ATLAS instrument to a personal computer (PC) running ATLAS Review Software (an ATLAS
Review Station) via network connection. Topics include:

• Network Capabilities, page D-1
• WARNING: Risks of Internet Connectivity, page D-1
• Security Recommendations, page D-2
• Approved Third Party Hardware and Software, page D-5
• Prohibited Activities, page D-5
• Using the Network File Server, page D-5
• Network File Server System Requirements, page D-6
• Configuration for Export via Preexisting Office Network, page D-6
• Configuration for Direct Network Connection, page D-19

☞ Note: Users are responsible for network setup and maintenance, including installation
and configuration of all necessary hardware and software. Carl Zeiss Meditec
Technical Support is limited to testing network connectivity of the ATLAS System.
Technical Support cannot troubleshoot or repair problems with network connectivity. 

Network Capabilities

The ATLAS System instrument and ATLAS Review Software are designed for network data
transfer. ATLAS supports the following:

• Windows and Novell networks.
• Creation of user accounts
• Networking via a local area network or intranet.
• Users can archive to and retrieve from a network file server.

WARNING: Risks of Internet Connectivity

When connected to the Internet, the ATLAS System may be vulnerable to
serious security risks, including viruses and worms that could disable your
system or adversely affect its performance. Internet connectivity enables third
party software, software drivers and updates to be downloaded to your
system, either automatically or intentionally. Installation of any unapproved
software, including drivers, could degrade the performance of the instrument
and/or lead to corrupted diagnostic or therapeutic information and may void
the instrument warranty.
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WARNING: When networking the ATLAS System, use only network cables
with an unshielded RJ-45 connector. Use of a shielded network connector in
the ATLAS System could result in electrical shock to the patient and/or
examiner.

Security Recommendations

If the ATLAS System is connected to the Internet, we recommend you use the Windows
Automatic Update feature to install all high-priority operating system patches and fixes
with the exception of driver and hardware updates. We also recommend routinely scanning
for viruses. 

Windows Automatic Update

The default (shipped) and recommended Windows Automatic Update setting and update
steps are described below. Note: If you have installed Windows XP SP3 (Service Pack 3),
the system will prompt you to turn on/off automatic updates upon reboot. Select Yes and
then follow the configuration steps below to configure Windows Automatic Update to the
recommended setting.

1. Select Start > Settings (Classic Start Menu only) > Control Panel > Automatic Updates
to display the AUTOMATIC UPDATES window.

2. Select Notify me but don’t automatically download or install them as shown in
Figure D-1 below.

Figure D-1 Automatic Updates Window (Recommended Setting)

3. Select OK to save your setting and close the window.
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4. When new updates become available, click on the text prompt shown below

or later on the yellow shield icon ( ) in the Windows Taskbar to choose the updates
to download.

5. Review the updates shown in the AUTOMATIC UPDATES window and unselect any driver
or hardware update. See Figure D-2 below where a hardware driver update has
been unselected.

WARNING: All non-high-priority updates (driver, hardware or optional
updates, etc.) should not be installed.

Figure D-2 Automatic Updates Window (Choose updates to download)

6. Select Download to begin downloading the selected updates.
7. If you unselect an update, a HIDE UPDATES window will be displayed. Click to display a

green checkmark next to Don’t notify me about these updates again as shown in
Figure D-3 below and then select OK.

Figure D-3 Hide Updates Window
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8. When the downloads are complete for the selected updates, click on the text prompt
shown below

or later on the yellow shield icon ( ) in the Windows Taskbar to install the updates.
9. An AUTOMATIC UPDATES window will be displayed prompting for an installation method

as shown in Figure D-4 below.

Figure D-4 Automatic Updates Window (How do you want to install updates?)

10.Select Express Install and then Install to install all of the downloaded updates.
11.Depending on the update(s), you may need to first accept license terms and/or restart

the ATLAS computer after installation is complete.

Anti-Virus Software

The software has been tested with McAfee Virus Scan Plus and Kaspersky Anti-Virus 2009,
but anti-virus software does not come with the ATLAS System pre-installed. We recommend
that you disable automatic scanning, because it may interfere with instrument operation.
Please refer to the ATLAS System section of our website (www.meditec.zeiss.com/atlas) for
the current list of approved anti-virus software.

☞ Note: Do not perform virus scanning while acquiring exam data.

www.meditec.zeiss.com/atlas
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Approved Third Party Hardware and Software

Please refer to the ATLAS System section of our website (www.meditec.zeiss.com/atlas) for
the current list of approved hardware and software. If you wish to use a third party device,
seek technical support from the device manufacturer. Repairs necessitated by the attempt
to use a non-approved device are not covered under warranty.

☞ Note: Carl Zeiss Meditec does not provide technical support for the use of
unapproved third party hardware or software.

Prohibited Activities

The following activities are prohibited using the ATLAS System instrument.

WARNING: Attempting to perform these prohibited activities may void your
ATLAS warranty and may result in damage to your ATLAS System. Carl Zeiss
Meditec is not responsible for software upgrades or repairs necessitated by
the attempted performance of the following prohibited activities.

• Do not relocate the ATLAS System database to a network file server.
• Do not share the ATLAS System printer on the network if the printer is connected to

the USB port.

Using the Network File Server

Using a network file server is recommended in offices that have a local area network,
especially if you have multiple ATLAS instruments. Once you have set up the instrument(s)
on the network, you can use the network file server for routine archiving.

Set Up Network Server

☞ Note: Configuring the server and the instrument for data transfer to a network file
server should be attempted only by a network administrator or system administrator. 

☞ Note: If you attempt a data transfer function when the network is down or the
server is down, the function will fail and the instrument will notify you that a
connection could not be established.

www.meditec.zeiss.com/atlas
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Network File Server System Requirements

Operating System

• Windows 2003 Server®
• Windows 2003 Small Business Server

System Requirements

If you plan to use a network file server it must meet the following minimum requirements:
• Processor: 800MHz processor or faster
• Memory: 256 MB RAM
• NTFS drive partition(s) for ATLAS data. ATLAS data is compatible only with NTFS. 
• 100GB available disk space for data storage (should be expandable) 
• Network interface card 100 or 1000 Mbps
• External Hard Drive or Tape backup unit for offsite disaster protection

☞ Note: It is the user's responsibility to protect their exam data from loss by frequent
backup of the network server. Backup media should be of archival quality, and the
media should be stored in a secure, remote location.

WARNING: Failure to backup the network file server may result in the loss of
medical exam data.

Network File Server Recommendations

In addition to the minimum requirements listed above, we recommend the following for
the network file server:

• A mirrored RAID array for data storage-strongly recommended.
• An uninterruptible power supply (UPS)-strongly recommended.
• The file server must be started prior to networked ATLAS instruments and PCs running

ATLAS Review Software, and shut down after ATLAS instruments and PCs running
ATLAS Review Software.

☞ It is strongly recommended that the file server not be used for interactive programs, such as
web browsing or word processing.

Configuration for Export via Preexisting Office Network

This section explains how to configure the ATLAS and a Review Station PC to communicate
via your pre-existing office network (a local area network or LAN). To do this, the ATLAS
and the Review Station PC each must be connected to the office network by a standard
network patch cable. It is the user’s responsibility to install the necessary cables.

Most networks use a DHCP server to automatically assign an IP address to the Review Station
PC and the ATLAS instrument. If your network uses static IP addresses, contact your network
administrator to have the device added. If no network exists, see Configuration for
Direct Network Connection on page D-19.
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Install the Network Cable

1. For both the ATLAS and the Review Station PC, plug one end of a standard network
patch cable into the computer Ethernet port. Plug the other end of the cable into the
office network outlet.

Create a Common Administrator User Account

☞ Note: If you are using a file server to transfer ATLAS data, create and use a user
account with the same username and password on all three network endpoints: the
ATLAS instrument, the network file server and the Review Station PC. Follow the
instruction below.

1. On the ATLAS, create a new administrator account for use as the default account.
2. On the Review Station (and the server), create and always use a new Computer

administrator account with the same username and password as on the ATLAS. 
To access user account settings: 

• Click Start > Control Panel > User Accounts.

☞ Note: Do not edit nor delete the Tech Support account, which is to be used only by
Carl Zeiss Meditec technical support personnel. If you change or delete this account,
CZM technical support may be unable to restore access to your system, in case you
lose the password for the Administrator account. In this case, a service call would be
required to replace the system hard drive.

Create a Shared Folder

To configure an ATLAS 9000/993/995 or Windows XP Review Station, see Create a shared
folder on a Windows XP Review Station on page D-8.

To configure a Windows Vista Review Station, see Create a shared folder on a
Windows Vista Review Station on page D-11.
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Create a shared folder on a Windows XP Review Station

1. Create a local folder on the Review Station for exported data. The new folder can be
created in any available path on the hard disk drive. In the example below, the new
folder was created by right-clicking on the Windows desktop, and then selecting 
New > Folder (Figure D-5).

Figure D-5 Right-click on Desktop, Select New > Folder

Continuing the example, the new folder created on the Windows desktop was named 
Netshare (Figure D-6).

Figure D-6 Right-click New Folder, Select Sharing and Security

2. Right click on the new folder, and then select Sharing and Security... as shown in
Figure D-6. 
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3. If you have Simple File Sharing enabled, the following Netshare Properties dialog
opens to the Sharing tab (Figure D-7).

Figure D-7 Netshare Properties (Simple File Sharing ON)

If you have Simple File Sharing disabled, the following Netshare Properties dialog
opens to the Sharing tab (Figure D-8).

Figure D-8 Netshare Properties (Simple File Sharing OFF)
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4. If you see the Netshare Properties dialog from Figure D-7, select Share this folder
on the network and Allow network users to change my files as shown in Figure D-7. 

5. If you see the Netshare Properties dialog from Figure D-8, select the Permissions
button. The Permissions for Netshare dialog opens (Figure D-9).

Figure D-9 Permissions for Netshare Dialog

Select the Allow checkbox for Full Control as shown in Figure D-9 so that all
checkboxes for Allow are checked. Click OK to save changes and close the
Permissions for Netshare dialog.

☞ Note: You can change the Share Name if desired. The default share name is the
same as the folder name. We recommended you use the default share name.

6. Click OK to save changes and close the Netshare Properties dialog.
7. The Netshare folder now displays a shared folder icon (Figure D-10).

Figure D-10 Netshare Folder Icon (Shared)
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Create a shared folder on a Windows Vista Review Station

1. Create a local folder on the Review Station for exported data. The new folder can be
created in any available path on the hard disk drive. In the example below, the new
folder was created by right-clicking on the Windows desktop, and then selecting 
New > Folder (Figure D-11).

Figure D-11 Right-click on Desktop, Select New > Folder

Continuing the example, the new folder created on the Windows desktop was named 
Netshare (Figure D-12).

Figure D-12 Right-click New Folder, Select Properties
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2. Right click on the new folder, and then select Properties as in Figure D-12. Select the
Sharing tab on the Netshare Properties dialog (Figure D-13).

Figure D-13 Netshare Properties – Sharing Tab

3. Select the Advanced Sharing... button. If you have User Account Control enabled you will
see a User Account Control – Windows needs your permission to continue dialog. Click
Continue to proceed. The Advanced Sharing dialog opens (Figure D-14).

Figure D-14 Advanced Sharing Dialog

☞ Note: You can change the Share Name if desired. The default share name is the
same as the folder name. We recommended you use the default share name.
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4. Select the Permissions button. The Permissions for Netshare dialog opens
(Figure D-15).

Figure D-15 Permissions for Netshare Dialog

5. Select the Allow checkbox for Full Control as shown in Figure D-15 so that all
checkboxes for Allow are checked.

6. Click OK to save changes and close the Permissions for Netshare dialog.
7. Click OK to close the Advanced Sharing dialog.
8. Click OK to close the Netshare Properties dialog.
9. The Netshare folder now displays a shared folder icon (Figure D-16).

Figure D-16 Netshare Folder Icon (Shared)
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Map a Drive Letter to a Shared Folder in Windows XP

The following instructions describe how to map a drive letter to a shared folder in Windows
XP. This could be used to map a drive letter on an ATLAS 9000 to a Review Station PC
shared folder for data export, or to map a drive letter on a Review Station PC to an ATLAS
993/995 shared database folder for data import. 

1. Right-click on the My Computer icon, and then select Map Network Drive... as in
Figure D-17.

Figure D-17 Right-click My Computer, Select Map Network Drive

The Map Network Drive dialog appears (Figure D-18).

Figure D-18 Map Network Drive Dialog

2. Click the down-arrow next to the Drive field, and select an unused drive letter from
the list.
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3. In the Folder field, enter the computer name and shared folder name. Use the format
“\\computer name\shared folder name” as shown below (Figure D-19). In this
example, the computer name is station1 and the shared folder name is
netshare. The names are not case-sensitive.

Figure D-19 Enter the Review Station Computer Name and Shared Folder Name

☞ Note: To find the Review Station computer name: Select Start, right-click My
Computer and select Properties. Then select Computer Name to view the
computer name.

☞ Note: To find the ATLAS 993/995 computer name: Select Start > Settings >
Control Panel > Network. Then select the Identification tab to view the
computer name.

☞ Note: You must use two backslashes before the computer name as shown in the
example.

☞ Note: You must select the Reconnect at logon checkbox to allow the system to
reconnect to the shared drive each time Windows starts.

4. Click Finish to save your changes and close the Map Network Drive dialog.
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Map a Drive Letter to a Shared Folder in Windows Vista

The following instructions describe how to map a drive letter to a shared folder in Windows
Vista. This could be used to map a drive letter on an ATLAS 9000 to a Review Station PC
shared folder for data export, or to map a drive letter on a Review Station PC to an ATLAS
993/995 shared database folder for data import. 

1. Select Start > Computer. Right-click Computer and select Map Network Drive... as
shown in Figure D-20.

Figure D-20 Right-click Computer, Select Map Network Drive

The Map Network Drive dialog appears (Figure D-21).

Figure D-21 Map Network Drive Dialog
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2. Click the down-arrow next to the Drive field, and select an unused drive letter from
the list.

3. In the Folder field, enter the computer name and shared folder name. Use the format
“\\computer name\shared folder name” as shown below (Figure D-22). In this
example, the computer name is station1 and the shared folder name is
netshare. The names are not case-sensitive.

Figure D-22 Enter the Review Station Computer Name and Shared Folder Name

☞ Note: To find the Review Station computer name: Select Start, right-click My
Computer and select Properties. Then select Computer Name to view the
computer name.

☞ Note: To find the ATLAS 993/995 computer name: Select Start > Settings >
Control Panel > Network. Then select the Identification tab to view the
computer name.

☞ Note: You must use two backslashes before the computer name as shown in the
example.

☞ Note: You must select the Reconnect at logon checkbox to allow the system to
reconnect to the shared drive each time Windows starts.

4. Click Finish to save your changes and close the Map Network Drive dialog.
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Using the Mapped Drive for Import and Export

If you mapped a Review Station shared folder to an ATLAS 9000, the new drive letter will
now be available during the export process on the ATLAS instrument. In the example in
Figure D-19, the drive letter Y: was mapped to the shared folder on the Review Station. To
export to the Review Station PC from the ATLAS instrument, select the mapped drive letter
(Y: in this case) as the export target. For more detail, refer to  Exporting to ATLAS
9000 Series Media on page 11-21.

If you mapped an ATLAS 993/995 shared database folder to a Review Station, the new
drive letter will be available to select for database import. On the Map Network Drive
dialog in Windows XP (Figure D-19), you would enter “//ATLAS1/exams” for an ATLAS
993/995 with a computer name of “ATLAS1” and a database directory of “C:/exams.” See
Importing from ATLAS 900 Series Instrument Databases on page 11-5.

Import Data from the Local Shared Folder

To have access in ATLAS Review Software to the data exported from the instrument, you
must complete the process by importing it from the local shared folder you created as
described above. 

See Importing from ATLAS 9000 Series Export Media on page 11-3 for information
on importing ATLAS 9000 Series media. To import from the local shared folder you created in
Windows XP, click Browse on the Import Options dialog to find and select the local shared
folder; in the examples described above, this is the folder named Netshare on the Windows
desktop (Figure D-6). When finished, click OK.
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Configuration for Direct Network Connection

This section explains how to configure a direct network connection between the ATLAS and
a PC running ATLAS Review Software. If you do not have a preexisting networking
infrastructure, this option provides an alternative. To do this, the sending and receiving
platforms must be connected by an unshielded RJ-45 crossover cable (or network switch
and network cable) between their respective Ethernet ports. It is the user’s responsibility to
acquire and install the necessary cable and/or switch.

In this scenario, the ATLAS instrument and the Review Station PC will each be
automatically configured with an IP address. 

☞ Note: You should use a direct connection only if no other networking infrastructure
exists, because while so configured, both the ATLAS and the Review Station PC will
be limited in the ability to communicate via other network connections.

☞ Note: A direct connection allows patient data to be transferred from the ATLAS to
the Review Station utilizing the ATLAS export functions or Review Station’s import
functions.

Direct Connection Procedure

1. Plug one end of the RJ-45 crossover cable (or network switch and network cable) into
the Ethernet port on the ATLAS. Plug the other end of the cable into the Ethernet port
on the Review Station PC.

2. The ATLAS instrument and the Review Station PC will each be automatically
configured with an IP address.

Reconnecting Review Station to a Preexisting Network

To reconnect the Review Station to a preexisting network, disconnect the cable (and/or
switch), and stop sharing the shared folder. If the data folder is shared on a preexisting
network, it may be visible to all network users and the Internet. When not connected to the
ATLAS, we strongly recommended that you disable sharing of the data folder.
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(E) Network Storage Device Configuration

Introduction

This appendix instructs you how to configure a network attached storage device (NAS device),
also known as a network drive, for use with the ATLAS System. These instructions provide
requirements and recommendations for the NAS device, but are generic with respect to
brand, the choice of which is at the discretion of the user. You can attach the NAS device
directly to one of the ATLAS System Ethernet ports, or you can connect it via your office
network (local area network or LAN). These instructions cover both scenarios.

Once installed and correctly configured for use with the ATLAS System, the NAS device serves
the same functions as a network server (primarily archiving), and the instructions for using a
network server apply to the use of the NAS device.

WARNING: We strongly recommend you use peripheral devices supplied or
approved by Carl Zeiss Meditec, when available, because they will have been
tested to work with the instrument. If you do use a peripheral device that
conforms with the requirements in this section but is not supplied by Carl
Zeiss Meditec, do not install any unapproved third-party software on the
instrument. Installation of any unapproved software, including drivers, could
degrade the performance of the instrument and/or lead to corrupted
diagnostic or therapeutic information and may void the instrument warranty.

Please refer to the ATLAS section of our website (www.meditec.zeiss.com/atlas) for the
current list of approved hardware and software. If you wish to use a third party peripheral
device, seek technical support from the device manufacturer. Repairs necessitated by the
attempt to use a non-approved peripheral device are not covered under warranty.

NAS Device Safety Warnings

WARNING: To maintain patient safety, an isolation transformer is required
when connecting externally powered peripheral devices such as a NAS device
within 1.5 meters (4.9 feet) from the patient. In addition, an isolation
transformer is required for all externally powered peripheral devices outside
this distance unless these devices are (1) connected to the ATLAS using an
Unshielded Twisted Pair (UTP) network cable (CZMI recommends using a least
a CAT 5 UTP network cable), (2) plugged into a different power outlet than the
ATLAS, and (3) qualified by CZM for use with the ATLAS. Failure to observe this
warning could result in electrical shock to the patient and/or examiner.

WARNING: To directly connect the NAS device to the ATLAS System using an
Ethernet network patch cord (UTP cable), only use an unshielded Ethernet
RJ-45 connector. Use of a shielded Ethernet connector will ground the printer
through the ATLAS System, which could result in electrical shock to the
patient and/or examiner. It could also invalidate the system safety approval.

www.meditec.zeiss.com/atlas
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WARNING: Do not use the NAS device or the instrument with an extension
cord or a power strip (multiple portable socket outlet). For additional safety,
do not plug the NAS device and the instrument into the same wall outlet.
Failure to observe this warning could result in electrical shock to the patient
and/or examiner.

NAS Device Requirements

For safety and minimally acceptable performance when used with ATLAS, the user must
select a NAS device with the following characteristics:

• 100BaseT or 1000BaseT Ethernet capable. For safety reasons, USB connection is not
permitted with ATLAS.

• Network patch cord for direct connection to ATLAS: UTP CAT5e cord with an
unshielded RJ-45 connector, at least 10 feet (3.05 meters) long to enable you to place
the NAS device outside the patient environment. See related safety warnings above.
Note that many network drives you purchase may contain patch cords that are
shielded or of insufficient length to use with ATLAS. In such cases, you must purchase
this cord separately.

• Drive media formatted using NTFS: ATLAS data is compatible only with NTFS.
• Approvals: The NAS device you select must conform with local agency requirements.

In Europe, CE approval is required. In North America, UL, CSA or equivalent approval
is required; and FCC approval is required.

NAS Device Recommendations

• Recommended storage capacity: At least as large as the ATLAS System hard drive,
currently 80 GB.

• Backup solution: To maintain redundancy of data backup, we strongly recommend you
use the backup solution of your choice for the NAS device, especially when you have
used the ATLAS System long enough for it to begin deleting archived exams
automatically. Depending on the usage rate, it may take many months up to a few
years before ATLAS begins to clear archived exams automatically.

• You can use multiple NAS devices as a backup solution, but when you use two or
more NAS devices concurrently, you must use a switch or router. The switch/router
may be directly connected to the instrument or elsewhere on the local area network.
Configuration in this scenario is the user’s responsibility.
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Install and Configure the NAS Device

You can attach the NAS device directly to one of the ATLAS System Ethernet ports, or you
can connect it via your office network (local area network or LAN). These instructions apply
to both scenarios.

1. With the ATLAS System and the NAS device turned off, use a network patch cord to
connect the NAS device either directly to the ATLAS System, or to the office network
(local area network or LAN) on which the ATLAS System resides. Refer to the
manufacturer’s instructions for details regarding installation of the NAS device.

☞ Note: For safety, observe the warnings and requirements on page E-2 that relate to
the type and length of cord.

2. Turn on the NAS device and wait for initialization to complete before you turn on the
ATLAS System. Often a color change in a light on the front of the NAS device indicates
initialization is complete, but see the manufacturer’s instructions for details on
initialization.

3. Turn on the ATLAS System. After you complete the startup process, exit the ATLAS
System software, going to the Windows desktop.

• In the system tray at lower right, you may observe a Local Area Connection notice
resulting from attachment of the NAS device. Ignore the message at this point.

4. In the ATLAS System optical drive, install the CD that accompanies the NAS device,
which will install and run the NAS device configuration program. Follow the on-screen
instructions, using the default settings. While running the NAS device configuration,
observe the following recommendations:

A.Installation Type: If you are presented with an option to choose a type of 
installation, for example a choice between “typical,” “minimal” and/or “custom” 
installation, we recommend you choose “typical” or “minimal.” Do not perform a 
“custom” installation unless you have reason to do so and the knowledge and 
experience required, which would be equivalent to that of a network or system 
administrator.

B.Record Storage Drive Name: If you are presented with the option to change the 
name of the NAS device, you can either use the default name or change it at your 
discretion, but in either case, you must write it down, because you may need it to 
complete configuration on the ATLAS System. You can use the space below:

NAS Device Name (also known as Network ID):                                                                                                                                                          
C.Workgroup Name Must Match ATLAS Workgroup Name: If you are presented with 

the option to change the workgroup name of the NAS device, you must make it 
match the workgroup name of the ATLAS System, which is “WORKGROUP” by 
default—this name is not case-sensitive on ATLAS. If the ATLAS System is 
connected to an office network as part of a different workgroup name, then you 
must use that workgroup name. 

5. When you complete NAS device configuration, exit the configuration program and
remove the CD from the ATLAS System optical drive. 
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On ATLAS, Map a Network Drive to the NAS Device

In some cases, the configuration software of the NAS device automatically maps the
correct folder of the NAS device to a drive letter on the ATLAS System. When this is the
case, configuration is complete and the NAS device is ready to use. In other cases, you
must map a drive on the ATLAS System to the proper folder of the NAS device using
Windows Explorer:

1. On the Windows desktop, open Windows Explorer: right-click on Start and select
Explore.

2. In the Explorer Address field, type two backlashes and then the NAS device name
you recorded in step 4.B. above, and press Enter.

☞ Note: If you failed to record it properly, note that you can often find the NAS device
name on a label on the back of the NAS device. The device name, for this purpose,
may be presented as the Network ID. Enter the entire network ID/device name
after the two backslashes, with no spaces.

If you have typed the device name correctly, and the NAS device is correctly configured 
and turned on, when you press Enter, Explorer should find the NAS device on the left 
and display its contents on the right, as in the Windows XP example below.

Figure E-1 Explorer Finds NAS Device and Displays Its Contents
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3. Now you must map a drive on the ATLAS System to the NAS device folder that is
accessible to all users for storage. In the example above, the folder named Public is
the correct folder. The folder name for your NAS device may be similarly indicative that
it is intended for use as the storage folder. Consult the manufacturer’s instructions to
determine which folder is intended for this purpose.

4. Click to select the correct storage folder. Click Tools > Map Network Drive. The Map
Network Drive dialog appears.

Figure E-2 Map Network Drive Dialog

5. In the Drive field, select any available network drive letter, using the down-arrow on
the right. You may, for example, choose N: for network storage device.

• In the Folder field, note that the folder name is already selected and unavailable to
be changed.

• Do not clear the Reconnect at logon check box.

6. Click Finish. You have now completed configuration. To archive to the NAS device,
register the drive letter assigned to the NAS device as an archive volume. See Create
a New Archive Location on page 10-9 for details.

Cleaning the NAS Device

Regular periodic cleaning of the NAS device is not required. However, if the device
becomes dusty, you may clean it using a soft bristle brush such as a keyboard brush. Do
not use liquid cleaners unless specifically directed by the manufacturer, since they may drip
into the device and cause it to malfunction.
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(F) Printer Configuration

Introduction

This appendix instructs you how to configure a printer for use with ATLAS System. These
instructions provide requirements and recommendations for the printer, but are generic
with respect to brand, although one may be supplied with the instrument. Specific
configuration instructions vary by printer, and users are advised to closely follow the
instructions supplied. These instructions cover two configurations for communication
between instrument and printer:

1. Network Configuration (page F-3), either via direct connection between instrument
and printer, or via connection of instrument and printer to a local area network.

2. USB Configuration (page F-3), via direct USB connection between instrument and printer.

Approved Printers

CZM recommends using a printer that has been specifically qualified for the ATLAS,
because untested drivers could interfere with instrument operation. Please contact your
CZM representative for qualified printers in your geography.

Many printers are available that are compatible with Microsoft Windows XP. Please note if
you use an unqualified printer with the ATLAS, CZM cannot guarantee technical support.
Repairs necessitated by the attempt to use a non-qualified device are not covered under
warranty. Any printer considered must meet the following criteria: 

• Windows XP compatible
• Network port or USB port (the network port must be 100, 10/100, or 10/100/1000

Base T. If a USB port is used, an isolation transformer is required). 
• Color printing
• Ability to print on 8.5 x 11 paper in the US or appropriate paper size outside the US.

WARNINGS: We strongly recommend you use peripheral devices supplied or
approved by Carl Zeiss Meditec, when available, because they will have been
tested to work with the instrument. Installation of any unapproved software,
including drivers, could degrade the performance of the instrument and/or
lead to corrupted diagnostic or therapeutic information and may void the
instrument warranty. 

Prior to installing any printer other than one qualified by CZM, please perform
an external data backup. Many printers come with optional software. Install
the required drivers only. Do not install any optional software.
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Printer Safety Warnings

WARNING: To maintain patient safety, an isolation transformer is required
when connecting externally powered peripheral devices (i.e., printer, USB
drive, etc.) within 1.5 meters (4.9 feet) from the patient. In addition, an
isolation transformer is required for all externally powered peripheral devices
outside this distance unless these devices are (1) connected to the ATLAS
using an Unshielded Twisted Pair (UTP) network cable (CZMI recommends
using a least a CAT 5 UTP network cable), (2) plugged into a different power
outlet than the ATLAS, and (3) qualified by CZM for use with the ATLAS.
Failure to observe this warning could result in electrical shock to the patient
and/or examiner.

WARNING: To directly connect a printer to the ATLAS System only use a UTP
cable. Use of a shielded Ethernet connector will ground the printer through
the ATLAS System, which could result in electrical shock to the patient and/or
examiner. It could also invalidate the system safety approval.

WARNING: Do not use the printer or the instrument with an extension cord or
a power strip (multiple portable socket outlet). For additional safety, do not
plug the printer and the instrument into the same wall outlet. Failure to
observe this warning could result in electrical shock to the patient and/or
examiner.

Installation Overview

The following three general steps are common to all configurations. These steps are
explained further in the specific sections.

1. Printer hardware setup and configuration: Refer to the instructions provided with the
printer to unpack and set up the printer hardware. Printer configuration is typically
not required.

2. Connect hardware to enable communication between instrument and printer. The
hardware used depends on the type of configuration you select: either a network
cable or a USB cable. 

3. Configure the instrument software to communicate with the printer, including
installation of printer drivers, if required. If there are no driver installation instructions
provided with the printer, then driver installation is not required.
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Network Configuration

Typically, no printer configuration is required for the network configuration. Three general
steps are required for configuration: 

1. Connect the printer to the ATLAS System via network cabling
2. Power on the printer
3. Install printer drivers on the ATLAS System. Note: If printer drivers are already

installed, open the printer configuration and modify the port by replacing the existing
printer Hostname with the actual Hostname of the printer being used. The Hostname
for the printer can be found by printing the printer’s information page (line 6).

This is the usual sequence of steps, but follow any additional instructions provided with the
printer or from Carl Zeiss Meditec. 

Using Network Cable(s) to Connect ATLAS System and Printer

To establish network communication between the ATLAS System and the printer, you can
directly connect instrument and printer with the network (Ethernet) cable, or connect both
instrument and printer to the local area network or to a network switch/router/hub
connected to the ATLAS System. 

☞ Note: Use the same kind of network cable in all cases. (If you connect instrument
and printer to the network rather than to each other, you will need two network
cables.) Do not use an RJ-45 crossover cable for direct connection between
instrument and printer.

USB Configuration

No printer configuration is required for the USB configuration. Three general steps are
required for configuration: install printer drivers on the ATLAS System if required, connect
the printer to the ATLAS System via USB, and power on the printer. This is the usual
sequence of steps, but follow any additional instructions provided with the printer from
Carl Zeiss Meditec.

WARNING: To maintain patient safety, peripheral devices connected to a USB
port (i.e., printer, USB drive, etc.) and plugged into an electrical outlet must
also be connected to an isolation transformer. In addition, the instrument
operator must not touch the patient and a peripheral device at the same time
while examining the patient. Failure to observe this warning could result in
electrical shock to the patient and/or examiner.
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(G) Data Transfer Using Optical Disks

Overview

You can transfer data between ATLAS instruments, and computers running ATLAS Review
Software with an optical drive and Roxio® Drag-to-Disc™ software installed. This appendix
explains the features and limitations of ATLAS data transfer using optical disks, and provides
instructions for data transfer.

Important Note: The Roxio Drag-to-Disc software is pre-installed on the ATLAS
instrument and specially configured for use with it. Do not re-install Roxio
Drag-to-Disc on the instrument. The Roxio Easy Media Creator CD included
with your instrument is provided to satisfy licensing requirements only.

A computer running ATLAS Review Software will need to have Roxio
Drag-to-Disc or another similar application installed in order to use optical disks
for data export. No additional license is provided for Roxio Easy Media Creator
for use with ATLAS Review Software.

Compatible Media Formats

The ATLAS instrument, or a computer running ATLAS Review Software with an optical drive,
can use the following types of disks to transfer data:

• CD-R – writable CD
• CD-RW – rewriteable CD

In addition, the ATLAS instrument or your Review Station computer, may also be able to
use the following:

• DVD±R – writable DVD
• DVD±RW – rewriteable DVD

☞ Note: Check the logo on the face of the optical drive. If the DVD-Multi logo is
present, then the ATLAS instrument can write to DVD media.

☞ Note: The optical disks you use must first be formatted, as explained in the section
Disk Formatting on page G-2.

Compatible Data Transfer Functions

Optical disks can be used for configuration restore, and all export and import functions.

☞ Note: You cannot archive to the optical drive.
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Export and Import

You can copy ATLAS 9000 Export Media data to an optical disk for transfer to another
ATLAS instrument or to a personal computer (PC) running the ATLAS Review Software.

☞ Note: On a PC, it may be possible to view and analyze ATLAS data using third party
software. Beyond the instructions here, Carl Zeiss Meditec does not support the
import of ATLAS data to a PC other than a PC running ATLAS Review Software;
neither do we specify third party software you can use on a PC to view and analyze
ATLAS data, nor support its use.

☞ Note: To successfully export from a Review Station PC, the PC must also have Roxio
Drag-to-Disc (or another similar application) installed, plus an optical drive capable
of writing to the chosen media. 

ATLAS Data Transfer Instructions

The actual data transfer functions—export and import—are done using the ATLAS
software in the usual way, except that you enter or select the optical drive as the target or
source drive for data transfer (you can also enter or select a folder on the optical drive; e.g.
E:\data export), and you insert a compatible formatted disk in the optical drive. ATLAS can
write multiple and incremental export data to a disk that already contains export data. See
the indicated sections of the user manual below for details.

• See Export on page 11-21 for instructions to export.
• See Import on page 11-3 for instructions to import.

☞ Note: You must first format the disk, as described in Disk Formatting on page G-2.

Proper Disk Care

We do not recommend that you use optical disks for long-term data storage. Use should be
limited to data transfer between systems. Take care to protect these media from damage.
We recommend you use hard plastic cases when transporting and shipping these media.
Optical disks are very susceptible to scratches that could render them unreadable.

Disk Formatting

This section explains how to format optical disks using Roxio Drag-to-Disc as it is installed
on the ATLAS instrument. To backup or export requires an optical disk formatted in the
Universal Disk Format (UDF1.5). 

Warning: Formatting permanently erases any data currently on the disk!
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General Steps

1. Install the optical disk into the ATLAS optical drive. Wait approximately 30 seconds for
the drive to recognize the media type. If you attempt the next step before the drive is
ready, you will get an error message, “There is no disk.”

2. To access the Drag-to-Disc software, you do not have to close the ATLAS software.
Select the Windows key  on the keyboard. Using your mouse, bring the screen
pointer down to the bottom of the screen. This will cause the Windows Task Bar to
appear along the bottom. Notice the icons in the System Tray at bottom right. (When
you mouse-over an icon, its name appears.) 

3. Right-click the Roxio Drag-to-Disc icon and select Format Disc from the pop-up
menu, as shown on the left. The Drag-to-Disc Format Options dialog appears.
See Disk Format Options below.

Disk Format Options

CD-R and DVD±R disks

No format options are available for CD–R or DVD±R disks (Figure G-1). 

Figure G-1 CD-R Format Options

If desired, type a name in the Volume Label field. Click OK to begin formatting. 
A Drag-to-Disc Preparation dialog appears during formatting. Formatting is brief. The
dialog disappears when it is complete. Once formatted, you cannot format CD–R or
DVD±R disks again, nor can you erase them. 
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CD–RW and DVD±RW Format Options

For a new, blank CD–RW or DVD±RW, you have only the option to perform a full format
(Figure G-2).

Figure G-2 Disk Full Format Option

A full format requires 18-29 minutes (Figure G-3.

Figure G-3 Full Format Disc Preparation
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If the CD–RW or DVD±RW was previously formatted, you can perform a quick (Figure
G-4) or full format 

Figure G-4 Disk Quick Format Option

☞ Note: Both quick and full formatting effectively erase any data currently on the disk.
Use these options with care to prevent loss of patient data.

The Advantage of Full Format

Full format has this advantage: the disk ejects immediately after writing when you eject it.
If the disk is quick formatted, it requires 15 seconds to 4 minutes for the disk to eject after
writing to it, depending on the amount of data written. 

Roxio Drag-to-Disc Software Configuration

CD-R or DVD±R Optical Disks

To successfully import ATLAS data from a CD-R or DVD±R optical disk to a Review Station
PC, the Roxio Drag-to-Disc Eject Options must be configured to finalize the disk upon
ejection (enable the disk to be read on any computer), as shown in Figure G-5. Do not
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change the configuration of the Roxio Drag-to-Disc software, particularly the eject settings.
The correct eject settings are seen in Figure G-5 below.

Figure G-5 CD-R and DVD±R Drag-to-Disc Eject Options

CD-RW or DVD±RW Optical Disks

To successfully import ATLAS data from a CD-RW or DVD±RW rewriteable optical disk to a
Review Station PC, Roxio Drag-to-Disc will prepare the disk to be read on any other
computer upon disk ejection, as shown in Figure G-6.

Figure G-6 CD-RW and DVD±RW Drag-to-Disc Preparation
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When preparation is completed, the disk will be ejected with a dialog displayed as shown in
Figure G-7.

Figure G-7 CD-RW and DVD±RW Disk Ejection Dialog

When you insert the disk into another computer that doesn’t have Roxio Drag-to-Disc
software installed, a dialog will be displayed as shown in Figure G-8.

Figure G-8 Roxio Setup Wizard Dialog

In order to read the rewriteable optical disk on this computer, select Yes to install the
EasyWrite Disc Reader software. A language dialog will be displayed. Select your language
and select Next to continue the installation as shown in Figure G-9.

Figure G-9 Roxio Setup Wizard Dialog – Select Language
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Select Install to continue the installation as shown in Figure G-10.

Figure G-10 Roxio Setup Wizard Dialog – Install

When installation completes, select YES to reboot your system as shown in Figure G-11.

Figure G-11 Roxio Setup Wizard Dialog – Reboot

After computer reboot, the disk should now be readable for ATLAS import functions.
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(H) Routine Maintenance

Chapter Overview

Carl Zeiss Meditec designed the ATLAS System (and the optional power table) to require
very little user maintenance. Most maintenance activities covered here are required only
occasionally, except for the calibration check and routine cleaning between patients. This
chapter covers the following topics:

• Fuse Replacement, page H-1
• Calibration Check, page H-4
• Handling Error Messages, page H-7
• Hard Disk Defragmentation, page H-7
• Routine Cleaning, page H-8
• List of User Replacement Accessories, page H-9

Note Regarding Warranty

☞ Note: Except for the main power fuses, the ATLAS System has no user-replaceable
parts. The user must not attempt hardware repairs, except fuse replacement, without
consulting Carl Zeiss Meditec service personnel. To do so voids the instrument
warranty. However, we may provide software updates that users can install. 

Fuse Replacement

Both the instrument and the optional power table have two fuses. Instructions to check
and replace the fuses in both the instrument and table are included below. First we offer
help in determining the source of power problems.

☞ Note: Except for fuse replacement, only authorized Carl Zeiss Meditec service
engineers may disassemble the instrument and replace parts. If fuse replacement does
not repair the problem, or if another sort of problem prevents normal operation, contact
Carl Zeiss Meditec customer service. In the U.S., call 800-341-6968. Outside the U.S.,
contact your local Carl Zeiss Meditec distributor.

Determine the Source of the Power Problem

This section assumes that the instrument will not power on. Troubleshooting your power
problem depends on whether or not you power the instrument through the optional power
table.

If Not Using the Optional Power Table

If you power the instrument directly from a wall outlet (not through the optional power
table), check the following to determine the source of the power problem, in order:

1. Is there power available everywhere in your office?
• If not, there may be a localized power outage in your office or a general power

outage in your neighborhood.
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• If so, proceed to step 2.
2. Is the instrument power cord plugged in at both ends?

• If not, plug in the cord and try to power up the instrument.
• If so, check the instrument fuses and replace them if necessary. See Check and

Replace Instrument Fuses on page H-2 for instructions.

If Using the Optional Power Table

If you are using the optional power table, the instrument is powered through it. Check the
following to determine the source of the power problem, in order: 

1. Is there power available everywhere in your office?

• If not, there may be a localized power outage in your office or a general power
outage in your neighborhood.

• If so, proceed to step 2.

2. Does the table have power (while the instrument does not)? You can test the table by
trying the lift.

• If the table has power, the power problem is within the instrument. First, check that
the instrument power cord is plugged in at the power table and at the instrument.
Next, check the instrument fuses and replace them if necessary. See Check and
Replace Instrument Fuses on page H-2 for instructions.

• If the table does not have power, the power problem is likely within the table. First,
check that the table is plugged in at both the wall outlet and at the table. Next,
check the table fuses and replace them if necessary. See Check and Replace
Table Fuses on page H-4 for instructions.

Check and Replace Instrument Fuses

Two fuses are located on the right side of the instrument just to the left of the power cord
inlet.

CAUTION: Carefully follow these instructions to safely check and replace
fuses. Always power down the instrument and unplug the power cord before
proceeding. At all times, use the minimum force necessary to accomplish
each step so as to prevent damage or injury.

1. Power down the instrument. Unplug the power cord.
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2. Using a narrow-bladed screwdriver, gently pry open the fuse holder, from the side, to
expose and remove the fuse holder.

Figure H-1 Opening instrument fuse assembly and removing fuse holder

Information about the proper replacement fuses is found adjacent to the fuse holder.

WARNING: Always replace fuses with the same type and rating. Failure to do
so may create a risk of fire.

3. Slide out the fuse holder and check the filament for breakage. Dispose of any
defective fuses.

4. Insert the new fuse in the holder. Slide the holder back into the housing until it snaps
closed.

5. Plug in the power cord at both ends.
6. Your instrument is now ready to be powered on.

With screwdriver, pry open fuse holder from the side. Remove fuse holder with fingers.

☞   Fuse type and rating for both instrument fuses: T3.15 A 250 V, Slow Blow. 
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Check and Replace Table Fuses

Two fuses are located just below the table power cord inlet, near the floor. Carefully follow
these instructions to safely check and replace fuses.

1. Power down the instrument. Unplug the table power cord at both ends, for safety and
easy access.

Figure H-2 Removing table fuses

2. The fuse holder can be removed out of the housing by grasping it while pressing down
on the center tab of the fuse holder and firmly pulling out.

3. Check the filament for breakage. Dispose of any defective fuses. Information about
the proper replacement fuses is found on a label just above the fuse holders (see
Power Table Specifications on page K-4.)

WARNING: Always replace fuses with the same type and rating. Failure to do
so may create a risk of fire.

4. Insert the new fuse in the holder. Slide the holder firmly back into the housing
securing it in place.

5. Plug in the table power cord at both ends. Your instrument is now ready to be
powered on.

Calibration Check

The Calibration Check function tests the ATLAS instrument to make sure it is providing
accurate measurements. A calibration bar with three mounted spheres is placed in the chin
rest assembly. Using the Calibration Check... function on the Tools menu, capture a series
of three sphere images that are then analyzed to see if the measurements are within the
defined ranges. The calibration test is performed by taking one image of each of the
different size spheres in the order from largest to smallest size—35.0 D (9.65 mm), 42.2 D
(8.0 mm), and 54.9 D (6.15 mm). The test is performed in diopters or mm, depending on
your current Units setting (see Units on page 7-2).

We recommend that you run the calibration option at least once a month. 

Power cord inlet fuse holder pull out tab Removing fuse holder
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Follow these steps to perform a calibration check:

1. Place the calibration bar in the two slots provided on the chin rest. Be sure the spheres
are facing the projection head (Figure H-3).

Figure H-3 Calibration Bar Inserted into Chin Rest Assembly

2. Select Tools > Calibration Check.... 
3. For the first image, focus the projection head first on the largest sphere (35.0 D or

9.65 mm) at the left end of the calibration bar (Figure H-4).

Figure H-4 Calibration Check—35.0 D Test Sphere.
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4. Align the projection head by centering the crosshairs in the smallest ring of the image
displayed.

5. When the image is aligned and focused, press the button on the joystick to capture
the image.

☞ Note: If the calibration test fails, first clean the front surface of the spheres with a
soft cloth and repeat the calibration test before calling Technical Support.

6. Continue to align, focus, and capture images for each of the other two remaining
spheres when prompted—the 42.2 D (8.00 mm) sphere in the center, and the 54.9 D
(6.15 mm) sphere on the right end of the calibration bar.

7. When you have finished capturing images for all three spheres, a dialog appears
showing the final results of the calibration test (Figure H-5). If all three spheres
report PASS then your ATLAS is providing accurate measurements. If a FAIL is reported
for at least one of the spheres, try cleaning the sphere with a soft cloth and repeating
the calibration check before calling Technical Support. 

Figure H-5 Calibration Check—Results 

8. Select Exit to exit the Calibration Check function, Print to print the results, or Save to
open a Save dialog and save the results to a text file. The default calibration file is saved
as a time-stamped calibration check file (e.g. 15253520081121CalibrationCheck.txt) in
“C:\ATLAS\CalibrationCheck.”

9. The calibration check is finished. Remove the calibration bar from the chin rest.
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Handling Error Messages

In normal instrument start-up, the User Login dialog appears. If the system fails the system
check, or if some other error prevents the system’s normal function, document the
circumstances and any associated error messages, and report it to Carl Zeiss Meditec
customer service. In the U.S., call 800-341-6968. Outside the U.S., contact your local Carl
Zeiss Meditec distributor. Often error messages can be resolved with solutions provided
over the telephone. 

Please be prepared to provide CZM the serial number of your instrument. It is located on
the label affixed to the back of the instrument, under the rear cover.

Hard Disk Defragmentation

Defragmentation of the ATLAS System computer hard disk becomes necessary when you
begin to clear archived exams regularly. The process of deleting data and then writing
again to the hard disk fragments the hard drive, which degrades database and system
performance over time. To maintain peak performance, we recommend that you check if
the hard disk requires defragmentation after each five times archived exams are cleared.
Recall that the system can initiate clearance of archived exams automatically when
necessary.

☞ Note: Since hard disk defragmentation usually requires several hours to complete,
we recommend that you start defragmentation at the end of the day and let the
process run overnight. If defragmentation is not complete in the morning, it does no
harm to stop defragmentation and continue using the instrument.

To defragment the hard drive, follow these steps:

1. Exit the ATLAS System (click File > Exit or click the  at upper right) to enter the
Windows environment.

2. Click Windows Start > All Programs > Accessories > System Tools > 
Disk Defragmenter. The Disk Defragmenter appears.

3. Select the C: drive and click Analyze to determine whether the drive requires
defragmentation. When analysis completes, a dialog will appear to inform you
whether or not the drive requires defragmentation. If it does, click Defragment. If it
does not, click Close.

Figure H-6 Sample Defragmenter Analysis Outcome
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Routine Cleaning

The forehead and chin rests, and to a lesser extent the imaging aperture, are the only parts
that require routine cleaning. Instructions are included below for occasional cleaning of
the instrument covers and optional power table.

Forehead and Chin Rests

The instrument parts that routinely contact the patient—the forehead and chin rests—
should be cleaned between each examination with an alcohol prep swab. These parts are
not removable.

The Imaging Aperture

The imaging aperture should not contact the patient's eye. Still, you should clean it
occasionally or as necessary to remove dust and oily smudges, ensuring true images. You
may use an alcohol prep swab or cotton swab dipped in isopropyl alcohol. (You may use
the Volk Precision Optical Lens Cleaner.) Wipe dry with a soft, non-linting cloth or tissue. If
the lens inadvertently contacts the patient's eye, clean it before proceeding with the
examination.

Calibration bar

The calibration bar should be cleaned with alcohol and wrapped in a soft cloth. Care
should be taken not to scratch the surface of the spheres.

Occasional Cleaning of Instrument Covers and Optional 
Power Table

WARNING: The instrument has no special measures to protect against
harmful ingress of water or other liquids (classified IPX0—ordinary
equipment). To avoid damage to the instrument and a safety hazard, cleaning
solutions, including water, must be applied sparingly, with a non-linting cloth
that is dampened only—not dripping wet! You must not use aerosols on or
near the instrument.

☞ Note: When dusting of the instrument or table is necessary, use a dry non-linting
soft cloth. Do not use aerosols, as these can penetrate the instrument covers and
damage the instrument.

☞ Note: When the instrument covers or table require cleaning or disinfecting, wipe
with a non-linting cloth or swab, dampened only—not dripping wet!—with
water or alcohol. Wipe dry with a clean and soft non-linting cloth.
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List of User Replacement Accessories

To order: In the U.S., call 800-341-6968. Outside the U.S., contact your local Carl Zeiss
Meditec distributor.

Part Number Description

2660100022511 Power Cord, 120 V

2660100022581 Power Cord, 220 V

2660021121801 Power Cord, China

2660021121716 USB Keyboard, Mini (Black)

Variable (Optional) USB/Network Printer

Variable (Optional) Instrument Power Table

2660021102326 Antiseptic Wipes (Box of 200)

0000001345415 USB Mouse (Optical)

2660100057793 Dust Cover, Instrument

2660021120470 Test Eye Kit

2660021121819 Cable, Ethernet, CAT5e (14’)

2660021116418 Cable, USB MA-MB (6’)

2660100057507 Roxio Software on Disk

2660100033594 Fuse T3.15 A 250 V (For 100-120 V and 220-240 V Systems)

2660021134314 ATLAS 3.0 Upgrade Kit/User Documentation CD

2660021135270 ATLAS 3.0 User Manual_ENG
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(I) License Registration

ATLAS Review Software and the optional software features run under license protection.
PathFinder II and MasterFit II have the option of registering a Trial (30-Day) or Full license.
They will not run until you register their corresponding license. Each ATLAS Review Station
operates under separate license protection—you will need to purchase a license for each
ATLAS Review Station. Follow the instructions below to register a software license.

☞ Note: ATLAS Review Software includes one or more software Certificate serial
numbers for your license or licenses. Each Certificate serial number you receive must
be registered separately. Additional licenses may be obtained from Carl Zeiss
Meditec at 1-800-341-6968. Outside the United States, please contact your local Carl
Zeiss Meditec distributor.

☞ Important: A license is valid only for the computer you register it to—it cannot be
transferred to another computer without purchasing another license. Be certain of
your network configuration before licensing ATLAS Review to a computer.

☞ Note: If the computer has multiple network cards you may need to register the
license again.

☞ Note: On Windows Vista computers, each user (User Account) will need to register a
license using the same Certificate Serial Number, License Key and Security Code. 

Registering ATLAS Review Software

When you first run the ATLAS Review Software without registering a license, the LICENSE

VIEW window (Figure I-1) will be displayed.

Figure I-1 License View Window
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Registering Optional Software Features

You can also register the optional software features at any time the software is running by
selecting View Licenses... on the Help menu. The LICENSE VIEW window will be displayed
(Figure I-1). If the software is not running, start the software by double-clicking the icon
on the desktop. You may need to logon with a User Name and Password.

Registering a Trial License

☞ Note: Trial Licenses are not available on Windows Vista computers.

1. Click Register under the Trial heading for the license you want to register. A dialog
will be displayed similar to the one shown below (Figure I-2).

Figure I-2 Trial License Dialog

2. Click Yes to start your 30-Day Trial license. The LICENSE VIEW window will be displayed
with the Trial license registered (Figure I-3).

Figure I-3 License View Window – PathFinder II 30-Day Trial License Registered

3. Select OK to close the LICENSE VIEW window and begin using the software.
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4. You have 30 days from the date of registering to continue using the software. The
number of days left in your Trial license is shown on the LICENSE VIEW window (Figure
I-3). Each day during the Trial period you will be notified at application startup with a
dialog such as shown in Figure I-4 below:

Figure I-4 License Notification Dialog

5. Click OK to continue using the software for your remaining trial days. At the end of
your Trial license, the license will expire and you will need to purchase a Full license to
continue using the software.

Registering a Full License

1. Click Register for the license(s) you want to register.
2. The CZM License Registration Utility dialog (Figure I-5) appears. 

Figure I-5 CZM License Registration Utility Dialog – Review Software
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3. Under FEATURE TO BE REGISTERED, confirm that the name of the feature you selected
matches the license certificate you are about to register.

4. Make a note of the unique Node ID of your system. Enter the Certificate Serial Number
provided on the software certificate, obtained from Carl Zeiss Meditec customer, or
found on a sticker affixed to the back of the CD case, including the alphabetic prefix
and the intervening dash before the number.

5. To obtain a License Key and Security Code, go to the Carl Zeiss Meditec website:
www.meditec.zeiss.com/register. If your language is other than English, select your
language under the “Other Languages:” area of the website.

☞ Note: If you have questions regarding software registration, please contact Carl
Zeiss Meditec. In the United States please call Carl Zeiss Meditec at 1-800-341-6968
or by email at z.customersupport@meditec.zeiss.com. Outside the United States,
please contact your local Carl Zeiss Meditec distributor.

6. Go to the bottom of the page, where it says: “When ready use the form to create your
License Key” and click on the word “form” (See Figure I-6 below).

Figure I-6: Carl Zeiss Meditec Software License Registration Page on the Internet

7. Enter your Certificate Serial Number and click the Submit button. 

Click “form”

http://www.meditec.zeiss.com/register
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8. Enter your Node ID and personal information and click the Submit button to generate
your License Key and Security Code.

9. Write down your License Key and Security Code, or print out and save the entire web
page for reference. 

☞ Note: If you are unable to complete the license registration process, click Cancel to
quit the license registration utility. Double-click the ATLAS Review Software desktop
icon to restart the software and return to Step 1 of license registration above. 

10.Returning to the CZM License Registration Utility, enter the License Key and Security
Code in the appropriate fields. The Save button will become active only when the
correct information is entered. When the Save button becomes active, click Save. 

11.If the license registration is successful, a dialog will be displayed confirming
successful registration (Figure I-7).

Figure I-7 Successful License Registration Dialog

12.Click OK to close the dialog and complete the license registration. 
13.The LICENSE VIEW window (Figure I-8) is displayed with the Full license registered.

Select OK to begin using the software. 

Figure I-8 License View Window with Full Review License Registered
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☞ Note: If you get an error message, verify that you have entered the correct values for
your license information and try again.
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(J) Glossary

2 -Difference Display

A display that shows the currently selected exam, the previous exam for the same eye, and
the power differences between the two.

3-Difference Display

A five-map display providing information on the surgical and healing changes that take
place on the eye after corneal surgery. It is also useful to follow contact lens induced
change over time, to determine the effect that the lens is having on the cornea. 

Archive

1) The process of incrementally saving specific patient data to media or a file server in a
form suitable for later retrieval, or 2) the physical media or volume on the file server used
to store such patient data. Used for freeing hard drive space on the computer and backup.

Astigmatism

Corneal astigmatism occurs when the cornea is not symmetric about its optical axis. It is
calculated as the difference between the Steep and Flat K values displayed as a positive value. 

Axial Curvature View

A graphic in which the corneal surface is represented in two dimensions (x and y) with the
assigned color representing a given measure (e.g., curvature) of the cornea at that
location.

Button

An object displayed on the computer screen that can be selected with the touchpad or
mouse and activated by clicking.

Calibration Bar

Frame with three mounted spheres that is placed in the chin rest assembly in order to
capture images used to calibrate the system.

Calibration Test

Process of checking the ATLAS system to make sure it is providing accurate measurements.

Category

A set of patients. Categories are used to classify patient records in local storage.

Chin Rest

Assembly that cradles the patient’s chin and forehead during an examination.
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CIM

Corneal Irregularity Measurement.

Clear

The deletion of exam data that has been previously archived.

Computer

ATLAS instrument component that contains the central processing unit, random-access
memory, and disk drive.

Corneal Apex

The location on the corneal surface, of a normal cornea, where the mean of the local
principal curvatures is greatest. For a normal eye, the corneal apex shows the center of
symmetry.

Corneal Vertex

The corneal vertex defines the center of all maps and is equal to the point on the cornea
where the instrument optical axis is perpendicular to the corneal surface (the center of the
innermost ring). 

CZM

Carl Zeiss Meditec.

Database

A complete record of all patient and exam information in the instrument. The database is
stored on the instrument’s hard disk.

DICOM

Digital Imaging and Communications in Medicine. DICOM is a standard for handling,
storing, printing, and transmitting information in medical imaging. It includes a file format
definition and a network communications protocol. The communication protocol is an
application protocol that uses TCP/IP to communicate between systems. DICOM files can
be exchanged between two entities that are capable of receiving image and patient data in
DICOM format.

EMR

Electronic Medical Records.

Ethernet

Ethernet is a family of standard computer networking technologies for local area networks
(LANs). Allows you to network your instrument with different computers, printers or office
management systems to share information and exams.
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Export

Process of copying exams from the hard drive to a CD or network location; typically used to
transfer exams from one instrument to another.

Field

A portion of a screen display that contains information such as a patient’s name or date of
examination.

File Server

A computer system provided by the customer or third-party to store Patient Data files.

Fluorescein

An inert organic compound dye that is used to stain the tear film for contact lens fitting
and to assess the integrity of the cornea. It mixes with the tear film and glows in the
presence of ultraviolet light or cobalt blue light.

Geometric center

Point on the cornea corresponding to the center of the limbus contour.

HVID

Horizontal Visible Iris Diameter (mm). This is the same as the Limbus diameter (mm) or
White-to-White (mm).

Import

Process of copying exams from another location (i.e., Network drive) to the hard drive;
typically used to transfer exams from one instrument to another.

Joystick

Device used to focus the image of a patient’s eye and trigger the image capture routine.

Joystick Lock

Control located in the joystick locks the projection head in place while the instrument is 
being moved.

JPEG

A commonly used method of compression for photographic images. The compression
method is usually lossy compression, meaning that some visual quality is lost in the process
and cannot be restored. Image files that employ JPEG compression are commonly called
“JPEG files” and the most common filename extensions are .jpg and .jpeg. The name JPEG
stands for Joint Photographic Experts Group, the name of the committee that created the
standard.
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Keratometry View

Data display that provides information similar to data obtained using a Keratometer;
shows dioptric values for three optical zones: central, intermediate, and peripheral.

LASIK

Laser in situ keratomileusis. A method of surgically correcting refractive errors by using a
microkeratome to create a corneal flap and then ablating tissue in the stromal bed of the
cornea using an excimer laser. Under this precise control, the laser reshapes the curvature
of the cornea to correct for nearsightedness, farsightedness or astigmatism.

LAN

A local area network (LAN) is a computer network covering a small geographic area, like a
home, office, or group of buildings.

Landscape Orientation

An image printed across the wide axis of a sheet of paper, i.e., 11” wide by 8½” long.

Liquid Crystal Display (LCD) Screen

Used for viewing images and exams, similar to a laptop computer screen.

MasterFit II

MasterFit II is an optional software feature for the ATLAS System that incorporates contact
lens fitting capabilities.

Media

Removable media used to store Patient Data files. A CD or DVD used on the ATLAS optical
drive is an example of a media.

Micrometer (μm)

A metric unit of measurement equivalent to one millionth of a meter, or one thousandth of
a millimeter (1000 μm = 1 mm, 1 m = 3.28 ft).

Millimeter (mm)

A Metric unit of measurement equivalent to one thousandth of a meter (1000 mm = 1 m,
10 mm = 1 cm, 1 m = 3.28 ft).

Oblate

Describes corneal eccentricity, where the cornea is more elliptical in the vertical meridian.
An eye following myopic refractive surgery is an example of an oblate cornea, with the
center being flatter than the periphery.
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Orientation

The way that images are printed, either across the narrow axis of a sheet of paper (portrait
orientation) or across the wide axis (landscape orientation).

Overview Display

A Display that shows four separate data views of an exam; the views that appear in this
Display can be by set in a Parameter Set.

PACS

Picture archiving and communication systems used in medical imaging. PACS are
computers or networks dedicated to the storage, retrieval, distribution and presentation of
medical images. The medical images are stored in an independent format. The most
common format for image storage is DICOM (Digital Imaging and Communications in
Medicine).

PathFinder II 

PathFinder II is an optional software feature for the ATLAS System designed to identify
abnormal, pathologic, and normal corneas.

Patient Selection Window

The active screen where the user can select a patient, add a new patient, or view today's
patient list.

PDF

Portable Document Format from Adobe®. PDF is fixed-layout document format used for
representing documents in a manner independent of the application software, hardware,
and operating system. Each PDF file can encapsulate a complete description of the
document that includes the text, fonts, images, and vector graphics that compose the
document.

Photopic

Condition in which the eye is in a “light adapted” state.

Placido disk

Name associated with a group of concentric rings.

PDMS

Patient Data Management System. See PMS below.
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PMS

Patient Management System. PMS is a category of software that deals with the day-to-day
operations of a medical practice. Such software frequently allows users to capture patient
demographics, schedule appointments, maintain lists of insurance payers, perform billing
tasks, and generate reports. PMS is often connected to electronic medical records (EMR)
systems. While some information in a PMS and an EMR overlaps—for example, patient
and provider data—in general the EMR system is used for the assisting the practice with
clinical matters, while PMS is used for administrative and financial matters.

Pop-up/drop down menu

A list of choices that pops up or drops down from an area of the screen when clicked on by
the mouse.

Portrait Orientation

An image printed across the narrow axis of a sheet of paper, i.e., 8½” wide by 11” long.

Prolate

Describes corneal eccentricity, where the cornea is more elliptical in the horizontal
meridian. Normal human corneas are prolate, but a highly prolate cornea usually indicates
corneal pathology.

Projection Head

ATLAS instrument component that projects rings and houses the video cameras used to
capture images of a patient’s eye.

Q Value

Q value is an index of asphericity and is a measure of the shape of the cornea: Q is defined
as the inverse (or negative) of the Shape Factor. The index of asphericity indicates how
much the curvature changes upon movement from the center to the periphery of the
cornea. A normal cornea is prolate (i.e., becomes flatter toward the periphery) and has the
asphericity Q of -0.26. A prolate surface has negative Q values and positive oblate surface
values. Most myopic laser vision corrections change the anterior corneal surface from
prolate to oblate.

OcuLign® Mode

This mode enables capturing an image that is compatible with the Carl Zeiss Meditec
CRS-Master Software. This feature is used when capturing the photopic image so you can
use the exam for corneal guided ablation with the CRS-Master Software. 

Retrieve

The process of reading specific Patient Data from an Archive. Unlike restoring from a
backup, retrieving is a routine part of the data management workflow.
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Rings Image View

Data display that shows the actual image of the eye as captured by the ATLAS system while
Placido rings are projected onto it.

RMS

Root Mean Square (abbreviated RMS or rms), also known as the quadratic mean, is a
statistical measure of the magnitude of a varying quantity. The name comes from the fact
that it is the square root of the mean of the squares of the values.

Scotopic

Condition in which the eye is in a “dark adapted” state.

Selection List

A list of choices, such as patient names or data views, that appear on the screen; choices
can be made by positioning the arrow over a selection and clicking the mouse button.

Synchronize

The process of retrieving new data from an archive and storing it locally. Specifically, this
refers to retrieving index data, rather than image data. 

TIFF

Tagged Image File Format, an image file format for storing images. Unlike standard JPEG,
TIFF files using lossless compression (or no compression at all) can be edited and resaved
without suffering a compression loss or image quality degradation. Storing a sequence of
images in a single TIFF file is also possible.

TKM

Toric Keratometric Mean.

Topographical

A display that graphically represents three-dimensional features.

Touchpad

Pad used to move a pointer around the screen and make selections by “clicking” one of the
control buttons located on the bottom of the touchpad.

Trend Analysis Display

A multi-exam display that shows the currently selected exam and up to three previous
exams for the same eye along with a data analysis table of the exams, including mean and
standard deviation.
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Trend Display

A multi-exam display that shows the currently selected exam and up to three previous
exams for the same eye.

Zernike Polynomial

An orthogonal set of polynomials that are used to describe the aberrations of the cornea or
lens from an ideal spherical shape.

XML

Extensible Markup Language.
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(K) Specifications

ATLAS Model 9000 Instrument

Field of view

• 17 mm X 14.5 mm

Number of Placido Rings

• 22 (18 superiorly)

Display Range

• 15 to 95 D (3.5 to 22.5 mm)

Accuracy/Repeatability

• Complies with ANSI Z80.23-2008, American National Standard for Ophthalmics –
Corneal Topography Systems – Standard Terminology, Requirements, Type A.

• Complies with ISO 19980:2005, International Standard – Ophthalmic instruments –
Corneal Topographers, Type A.

Table K-1 Accuracy Tablea – Test Surfaces (Axial Curvature Difference, D / Elevation Difference, μm)

Zone 1: Center
(3 mm)

Zone 2: Middle
(3 mm  diameter 6 mm)

Zone 3: Outer
(diameter > 6 mm)

Meanb 1 Std. Dev.c 2 Std. Dev.c Meanb 1 Std. Dev.c 2 Std. Dev.c Meanb 1 Std. Dev.c 2 Std. Dev.c

Sphered 0.004/--- 0.050/0.30 0.100/0.60 0.024/--- 0.022/0.37 0.044/0.74 0.001/--- 0.040/0.71 0.080/1.42

Toruse 0.077/--- 0.068/0.33 0.136/0.66 0.124/--- 0.029/0.60 0.058/1.19 0.207/--- 0.059/2.57 0.118/5.14

Aspheref 0.055/--- 0.045/0.30 0.090/1.20 0.064/--- 0.036/0.67 0.072/1.34 0.071/--- 0.064/3.26 0.128/6.52

a. All test surfaces oriented with respect to the CT axis: normal to the optical axis (± 1º) and centered on the optical axis (± 0.1 mm)
b. Mean difference only for Axial power.
c. Mean of standard deviation of difference between paired datasets for each zone.
d. Radius of curvature: r = 8.000 mm; diameter = 12.7 mm; eccentricity = 0.0
e. Toric: Radii of curvature, r1 = 8.000 mm and r2 = 8.4000; diameter = 12.7 mm; eccentricity = 0.0
f. Ellipsoid: Central radius of curvature, r = 7.8 mm; diameter = 12.7 mm; eccentricity = 0.5; prolate (Q = 0.25)

Table K-2 Repeatability Tablea – Human Corneas (Axial Curvature Difference, D / Elevation Difference, μm)

Zone 1: Center
(3 mm)

Zone 2: Middle
(3mm < diameter 6 mm)

Zone 3: Outer
(diameter > 6 mm)

Meanb 1 Std. Dev.c 2 Std. Dev.c Meanb 1 Std. Dev.c 2 Std. Dev.c Meanb 1 Std. Dev.c 2 Std. Dev.c

0.114/--- 0.29/0.63 0.58/1.27 0.103/--- 0.20/1.72 0.41/3.44 0.084/--- 0.21/4.27 0.43/8.55

a. (20 patients) x (1 eye per patient) X (2 exams per eye). Total: 20 paired datasets.
b. Mean of absolute difference between paired datasets for each patient for each zone (Axial power only).
c. Mean of standard deviation of difference between paired datasets for each zone.
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Placido Ring Illumination

• Infrared LED (950 nm)

Optics

• Digital CMOS camera with 1280 x 1024 pixel resolution

Computer

• Windows XP Professional
• Internal storage: Up to 35,000 exams
• Writable Optical Drive
• 3 Ethernet ports, 2 USB 2.0 ports 
• Integrated 12.1" TFT-LCD color flat panel display 

Physical

• Dimensions (instrument only): 52 L x 37 W x 50 H (cm)
• Dimensions (in crate): 77 L x 55 W x 80 H (cm)
• Weight (instrument only): 17.7 kg (39 lbs.)
• Weight (in crate): 31 kg (69 lbs.)

Electrical Requirements

Electrical Rating

• 100-240 V, 50-60 Hz, 2-1 A

Fuse Rating

• T3.15 A 250 V

WARNING: Always replace fuses with the same type and rating. Failure to do
so may create a risk of fire.

Environmental Conditions

Transport and Storage

Temperature:  -40 to +70 deg. C
Relative Humidity:  10% to 100%, including condensation
Atmospheric Pressure:  50 to 106 kPa

Operation

Temperature: +15 to +30 deg. C
Relative Humidity: 30% to 75%, excluding condensation
Atmospheric Pressure: 70 to 106 kPa
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ATLAS Review Software

Operating System

• Microsoft® Windows XP Professional with Service Pack 2 or 3
• Microsoft Windows Vista® Business with Service Pack 1
• 32 Bit systems

System Requirements

The system running ATLAS Review Software must meet the following minimum
requirements:

• Processor: 500 MHz or faster
• 20 GB available hard disk space
• Memory: 1 GB RAM for Windows XP, 2 GB for Windows Vista; when running

additional applications concurrently, more memory may be required.
• Windows file system: NTFS required. FAT16 and FAT32 are not supported.
• CD-ROM drive (required for installation)
• 1024 x 768 pixel screen resolution; 16 bit color
• Microsoft Internet Explorer 4.72 or higher (for license registration)
• TCP/IP is installed

Network File Server System Requirements

Operating System

• Windows 2003 Server
• Windows 2003 Small Business Server

System Requirements

If you plan to use a network file server it must meet the following minimum requirements:

• Processor: 800MHz processor or faster
• Memory: 256 MB RAM
• NTFS drive partition(s) for ATLAS data. ATLAS data is compatible only with NTFS. 
• 100GB available disk space for data storage (should be expandable) 
• Network interface card 100 or 1000 Mbps
• External Hard Drive or Tape backup unit for offsite disaster protection

☞ Note: It is the user's responsibility to protect their exam data from loss by frequent
backup of the network server. Backup media should be of archival quality, and the
media should be stored in a secure, remote location.

WARNING: Failure to backup the network file server may result in the loss of
medical exam data.
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Instrument Table (optional) 

WARNING: Always replace fuses with the same type and rating. Failure to do
so may create a risk of fire.

Warning: Do not reconfigure system components on the table, nor add
non-system devices or components to the table, nor replace original system
components with substitutes not approved by Carl Zeiss Meditec. Such
actions could result in failure of the table height adjustment mechanism,
instability of the table, tipping and damage to the instrument, and injury to
operator and patient.

USB Powered Devices

Electrical Requirements

Power Rating

• 500 mA per USB port

Table K-3 Power Table Specifications

PN 24-41200-301 PN 24-41200-302 PN 24-41400-30

Electrical Rating 100 - 120 V~, 50-60 Hz, 8.0 A 100 - 120 V~, 50-60 Hz, 8.0 
A 

230 V~, 50-60 Hz, 6.3 A

Fuse Rating T8.0 A, 250 V T8.0 A, 250 V T6.3 A, 250 V

Table Top Dimensions 43 D x 79 W (cm) 43 D x 79 W (cm) 43 D x 79 W (cm)

Table Min / Max Height 66 Min, 101 Max (cm) 66 Min, 101 Max (cm) 66 Min, 101 Max (cm)

Table Foot Print 64 D x 86 W (cm) 64 D x 86 W (cm) 64 D x 86 W (cm)

Table Weight 34 kg (75 lbs.) 34 kg (75 lbs.) 34 kg (75 lbs.)
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(L) Legal Notices

ATLAS Instrument Legal Notices

Limited Warranty

This Warranty gives you specific legal rights, and you may have other rights, which vary
from state to state. For one year from the date of delivery (the “Warranty Period”) to the
original purchaser (“You,” “Your,” “Purchaser”), Carl Zeiss Meditec, Inc. (“ZEISS,” “Seller,”
“We,” “Our,” “Us”) warrants its ATLAS Model 9000, excluding components and software as
stated below (the “ATLAS”) to be free from defects in material or workmanship. In the
event of failure, Seller's obligation is limited to repairing or replacing on an exchange basis
the parts that have been promptly reported as defective by Purchaser during the Warranty
Period and are confirmed as defective by Seller upon inspection. This Warranty covers all
parts, labor, travel and expenses for the Warranty Period, except as otherwise stated
herein. This Warranty only applies to the original Purchaser and shall not, in any way, be
transferable or assignable.

The procedure for warranty claims shall be as follows: when You believe the ATLAS is
defective, promptly report the defect to ZEISS. Whenever possible, We will provide “in the
customer's office” service to repair Your ATLAS. However, at Our discretion, repairs may be
made in Our repair department. In this case, We will pay all shipping costs unless Your
ATLAS is found upon inspection not to be eligible for repair under this Warranty, in which
case You will be responsible for one-half the shipping costs. If Your ATLAS is ineligible for
repair under Warranty, We will notify You, and any repairs You authorize will be performed
at Our normal rates. All replaced parts will become the property of ZEISS.

This Warranty specifically covers the ATLAS, including the instrument table. This Warranty
does NOT cover: consumable items such as operating supplies, paper or storage media, or
the servicing of any external printer. Those items will be covered by their manufacturer's
warranty and arrangement for service must be made through that manufacturer. This
Warranty will NOT apply if repair or parts replacement is required because of accident,
neglect, misuse, acts of God, transportation or causes other than ordinary use, or supplies
or accessories that do not meet the proper operating specifications of ZEISS. This Warranty
does NOT apply to any articles that have been repaired or altered except by ZEISS.

All data stored on the hard disk, magneto-optical and/or floppy discs are the Purchaser's
records, and it is Your responsibility to preserve the integrity of these files. ZEISS is not
responsible for the loss of patient files stored on the hard disk, floppy discs, backup
magneto-optical discs or backup floppy discs.

You bear the entire risk as to the quality and performance of the software. ZEISS does not
warrant that the software will meet Your requirements, that the operation of the software
will be uninterrupted or error-free, or that all software errors will be corrected. You assume
the responsibility for the installation, use and results obtained from the ATLAS and
programs.
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The Warranty does NOT extend to any diskette that has been damaged as a result of
accident, misuse, abuse, or as a result of service, or modification by anyone other than
ZEISS. Should such software prove defective following its purchase, You (and not ZEISS)
assume the entire cost of all necessary service, repair, or correction. ZEISS has no liability or
responsibility to any person or entity with respect to any claim, loss, liability, or damage
caused or alleged to be caused directly or indirectly by any software supplied with the
ATLAS or by ZEISS.

Every reasonable effort has been made to ensure that the product manuals and
promotional materials accurately describe the ATLAS specifications and capabilities at the
time of publication. However, because of on-going improvements and product updates,
We cannot guarantee the accuracy of printed materials after the date of publication, and
disclaim liability for changes, errors or omissions. All instrument specifications are subject
to change without notice.

Limitation Of Liability

THE WARRANTIES CONTAINED HEREIN ARE IN LIEU OF AND EXCLUDE ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, BY OPERATION OF LAW OR OTHERWISE,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR PARTICULAR USE. NEITHER ZEISS, MICROSOFT CORPORATION NOR
ANY OTHER PARTY INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS
INSTRUMENT OR SOFTWARE (COLLECTIVELY REFERRED TO AS “CONTRIBUTOR(S)”) SHALL
BE LIABLE FOR ANY DAMAGE, LOSS OF USE OR LOSS OF ANY KIND, ARISING OR
RESULTING FROM ACTS OF GOD, YOUR PURCHASE, POSSESSION, FAILURE TO FULFILL
YOUR RESPONSIBILITIES AS TO PROPER INSTALLATION, MANAGEMENT, SUPERVISION OR
USE OF THE ATLAS SYSTEM OR SOFTWARE WHETHER SUCH LIABILITY IS BASED IN TORT,
CONTRACT OR OTHERWISE. IF THE FOREGOING LIMITATION IS HELD TO BE
UNENFORCEABLE, ZEISS'S (AND CONTRIBUTOR(S)) MAXIMUM LIABILITY TO YOU SHALL
NOT EXCEED THE COST PAID BY YOU FOR THE INSTRUMENT. ZEISS (AND/OR
CONTRIBUTOR(S)) SHALL IN NO EVENT BE LIABLE FOR DIRECT, INDIRECT,
CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGE FOR LOSS OF
BUSINESS OR ANTICIPATORY PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, AND THE LIKE), EVEN IF ZEISS OR ANY CONTRIBUTOR(S) HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES OR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO
YOU. 

Service Contract

In the U.S.A., a Warranty Extension Agreement (Service Contract) is available after the
one-year, new ATLAS warranty expires. For information, call the Customer Service
Department at 800-341-6968.
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Software Copyright

The software program (“Software”) included with your ATLAS is a proprietary product of
ZEISS and in certain instances contains material proprietary to Microsoft Corporation.
These proprietary products are protected by copyright laws and international treaty. You
must treat the software like any other copyrighted material.

Copyright © Carl Zeiss Meditec, Inc. All rights reserved.

Software License Agreement

This Software license agreement (“License”) is a legal contract between the Purchaser
(“You”, “Your” “Licensee”) and ZEISS governing Your use of the Software. Opening the
sealed package indicates Your acceptance of the terms and conditions of this License. If
You have any questions concerning this License, contact Carl Zeiss Meditec, Attention
Customer Service, 5160 Hacienda Drive, Dublin, CA 94568. Telephone 800-341-6968.

License Terms and Conditions

1. In consideration of payment of the License fee which is part of the price You paid for
Your ATLAS, and Your agreement to abide by the terms and conditions of this License
and the Limited Warranty, ZEISS grants to You a non-exclusive, non-transferable and
non-assignable license to use and display this Software on a single ATLAS, under the
terms of this License. If the ATLAS on which You use the Software is a multi-user
system, this License covers all users on that single system. 

2. The license is granted solely for the use of Your own internal computing requirements
and does not grant You any right, title or ownership in the licensed software or its
documentation. You own the physical media, ATLAS, on which the Software is
originally or subsequently recorded or fixed, but You understand and agree that ZEISS
retains title and ownership to the Software recorded on the original disk copies and all
subsequent copies of the Software.

3. This Software is copyrighted. Unauthorized copying of the Software, including
Software that has been modified, merged or included with other software, is expressly
forbidden. You may not, nor may You permit others to (a) disassemble, decompile or
otherwise derive source code from the Software (b) reverse engineer the Software, (c)
modify or prepare derivative works of the Software, (d) provide on-line or similar uses
to third parties, or (e) use the Software in any manner that infringes the intellectual
property or other rights of another party. You may be held legally responsible for any
copyright infringement that is caused or encouraged by Your failure to abide by the
terms of the License. 

4. ZEISS may create updated versions of the Software, which You may purchase
separately.

5. This license does not include the right to make copies of software, nor to transfer the
software or copies from the Product(s) to third parties, nor to extract, modify or
incorporate any part of the software or source code, without prior written consent
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from ZEISS and payment of licensing fees. Further, sales of ATLAS instruments may not
include any software or software licensee transfers. You may not sublicense, rent or
lease the Software.

6. ZEISS warrants the operation of the Software only with the operating system for which
it was designed. Use of the Software with an operating system other than that for
which it was designed will not be supported by ZEISS. ZEISS does not claim that the
software provided is free from defects and shall have no obligation to supply software
upgrades (i.e., new versions, or new, or in-line releases).

Acknowledgment

You acknowledge that you have read all the provisions in this Chapter, including this
License and Limited Warranty, understand them, and agree to be bound by their terms and
conditions.

ATLAS Review Software Legal Notices

IMPORTANT PLEASE READ CAREFULLY BEFORE ACCEPTANCE

Carl Zeiss Meditec, Inc. Electronic End User License Agreement

Notification of Copyright

NOTICE TO USER: THIS IS A CONTRACT BETWEEN YOU AND CARL ZEISS MEDITEC, INC.
(“ZEISS”) BY INSTALLING ANY OR ALL OF THIS APPLICATION COMPONENTS, YOU ARE
ACCEPTING ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. This ZEISS End User
License Agreement accompanies a ATLAS(r) software product (“Software”) and related
explanatory materials (“Documentation”). The term “Software” shall also include any
upgrades, modified versions, updates, additions and copies of the Software licensed to you
by ZEISS. You must read this Agreement carefully before indicating your acceptance at the
end of the text of this Agreement. If you do not agree with the terms and conditions of this
Agreement, decline where instructed, and you will not be able to use the Software. You
should then return this Software, together with all the packaging, to ZEISS or the location
where you obtained it.

This software program is a proprietary product of ZEISS and in certain instances contains
material proprietary to other companies. These proprietary products are protected by
copyright laws, international treaty, and under your purchase agreement with ZEISS
governing your use of the software. Installation of this software indicates your acceptance
of this agreement. If you have any questions concerning this agreement, contact Carl Zeiss
Meditec, Inc., Attention Customer Service, 5160 Hacienda Drive, Dublin, CA 94568.

License Agreement

This is a license agreement and not an agreement for sale. ZEISS continues to own the copy
of the Software and the physical media contained in this package and any other copy that
you are authorized to make pursuant to this Agreement. ZEISS hereby grants to You a
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nonexclusive license to use the Software and Documentation, provided that You agree to
the following:

1. Use of the Software.

1.1. You may install the Software in a single location on a hard disk or other storage device
of up to the number of computer licenses that have been purchased from ZEISS.

1.2. You may make one backup copy of the Software, provided your backup copy is not
installed or used on any computer.

2. Copyright. The Software is owned by ZEISS and its suppliers, and its structure,
organization and code are the valuable trade secrets of ZEISS and/or its suppliers. The
Software is also protected by United States Copyright Law and International Treaty
provisions. You must treat the Software just as You would any other copyrighted material,
such as a book. You may not copy the Software or the Documentation, except as set forth
in the “Use of the Software” section. Any copies that You are permitted to make pursuant
to this Agreement must contain the same copyright and other proprietary notices that
appear on or in the Software. Trademarks shall be used in accordance with accepted
trademark practice, including identification of trademark owner's name. Trademarks can
only be used to identify printed output produced by the Software. Such use of any
trademark does not give You any rights of ownership in that trademark. Except as stated
above, this Agreement does not grant You any intellectual property rights or trademark in
the Software.

3. Transfer. You may not rent, lease, sublicense or lend the Software or Documentation. You
may, however, transfer all Your rights to use the Software and Documentation to another
person or legal entity provided that (i) You transfer this Agreement, the Software, including
all copies, updates and prior versions and all copies of font software converted into other
formats, and the Documentation to such person or entity, (ii) You retain no copies,
including copies stored on a computer, and (iii) that the receiving party agrees to be bound
by the terms and conditions of this Agreement.

4. Limited Warranty. Neither ZEISS nor anyone else who has been involved in the creation,
production or delivery of this Software shall be liable for any direct, indirect, consequential
or incidental damages (including damages for loss of business profits, business
interruption, loss of business information, and the like) arising out of the use or inability to
use such Software even if ZEISS has been advised of the possibility of such damages.   For
further warranty information, please contact the Carl Zeiss Meditec, Inc., Customer Service
Department.

5. Governing Law and General Provisions. This Agreement will be governed by the laws in
force in the State of California excluding the application of its conflicts of law rules. This
Agreement will not be governed by the United Nations Convention on Contracts for the
International Sale of Goods, the application of which is expressly excluded. If any part of
this Agreement or its application becomes illegal, unenforceable, or void, such provision
will be changed and interpreted so as to best accomplish the objectives of that provision to
the extent allowed by law, and the remaining provisions of this Agreement will continue in
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full force and effect. You agree that the Software will not be shipped, transferred or
exported into any country or used in any manner prohibited by the United States Export
Administration Act or any other export laws, restrictions or regulations. This Agreement
shall automatically terminate upon failure by you to comply with its terms. This Agreement
may only be modified in writing signed by an authorized officer of Carl Zeiss Meditec, Inc.

This is the entire agreement between ZEISS and You relating to the Software and the
Documentation and it supersedes any prior representations, discussions, undertakings, end
user license agreements, communications or advertising relating to the Software and the
Documentation.

6. Notice to United States Government End Users. The Software and Documentation are
“Commercial Items,” as that term is defined at 48 C.F.R. §2.101, consisting of “Commercial
Computer Software” and “Commercial Computer Software Documentation,” as such terms
are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48
C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the
“Commercial Computer Software” and “Commercial Computer Software Documentation”
are being licensed to U.S. Government end users (i) only as “Commercial Items” and (ii)
with only those rights as are granted to all other end users pursuant to the terms and
conditions herein.

Unpublished-rights reserved under the copyright laws of the United States.

Carl Zeiss Meditec, Inc., 5160 Hacienda Drive; Dublin, CA, USA.

For Your future reference a copy of this End User License Agreement will be accessible after
You install the Software. If You have any questions regarding this Agreement or if you wish
to request any information from ZEISS, please use the address information enclosed in this
product to contact the local Carl Zeiss Meditec office serving your country or write to
Customer Support Department, Carl Zeiss Meditec, Inc., 5160 Hacienda Drive, Dublin, CA
94568.

ATLAS(r) is a registered trademark of Carl Zeiss Meditec, Inc. Windows is a registered
trademark of Microsoft Corporation.

By use of the Software, You acknowledge that You have read this license agreement and
limited warranty, understand them, and agree to be bound by their terms and conditions.

Carl Zeiss Meditec, Inc., Limited Warranty for Software

Defined Terms: 

“You”, “Your”, or “Licensee”: Buyer 

ZEISS: Carl Zeiss Meditec, Inc., 5160 Hacienda Drive, Dublin, CA 94568 USA

Software: Software made by Carl Zeiss Meditec, Inc. 

3rd Party Products: Products, hardware and software supplied by ZEISS but not made by
ZEISS.
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Outside Elements: Hardware or software that ZEISS has not supplied, authorized or
confirmed for use in Buyer’s Site Survey.

Site Survey: Document filled out by Buyer detailing the local operating environment for the
Software. 

Term of Warranty: This Warranty will be effective for a period of forty-five (45) days from
the date of shipment to You (“Warranty Term”).

Scope of Limited Warranty for Software: ZEISS warrants that (i) it has the right to license or
sublicense the Software to You for the purposes and subject to the terms and conditions set
forth in ZEISS’ standard terms and conditions (ii) the Software will be fit for the purposes
described in ZEISS' user documentation (iii) that the Software will perform in substantial
conformity to published specifications during the Warranty Term. ZEISS DOES NOT
WARRANT THAT THE ZEISS SOFTWARE IS ERROR-FREE OR WILL OPERATE WITHOUT
INTERRUPTION OR WILL MEET YOUR SPECIFIC NEEDS. YOU ARE RESPONSIBLE FOR ALL
DATA BACKUPS, DATA ARCHIVING, AND DATA TRANSFER.

Updates: At no cost to You, ZEISS will provide You with maintenance updates (i.e.: bug
fixes) during the Warranty Term. ZEISS will not be obligated to provide new Software
releases or 3rd Party Product upgrades.

Remedies for Software Failure: During the Warranty Term, ZEISS' obligation under this
Warranty is limited, at ZEISS’ discretion, to repair, adjustment and/or replacement of any
Software which proves to be defective in material or workmanship. You must give ZEISS
notice of any defect within the Warranty Term to make a claim under this Warranty. If the
Software fails to substantially conform to its published specifications, ZEISS shall, at its
own expense, use all commercially reasonable efforts to correct such failure.

Software support to correct failures will be provided as follows: 

• For installation issues, up to two (2) hours of free remote technical support.
• For non-installation issues, unlimited telephone support during the warranty period.

Remote Technical Support will be provided from 6:30 AM to 5:00 PM Pacific Time, except
during ZEISS holidays.

Repair or replacement will be ZEISS' sole obligation and exclusive remedy hereunder.

THESE ARE YOUR EXCLUSIVE REMEDIES AND CONSTITUTE ZEISS' SOLE LIABILITY FOR ANY
WARRANTY CLAIMS. YOU AGREE THAT ZEISS, ITS AFFILIATES AND REPRESENTATIVES,
WILL HAVE NO LIABILITY TO YOU FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES SUCH AS EXCESS COSTS INCURRED, LOSS OF DATA, OR FOR LOST PROFITS OR
REVENUE FROM SOFTWARE FAILURE. This provision does not affect third party claims for
personal injury arising in products liability or from ZEISS’ negligence. Some states do not
allow the exclusion or limitation of consequential or incidental damages, so the above
limitation or exclusion may not apply.

To maintain this Warranty, You must use the Software in accordance with ZEISS’
instructions for use, and maintain Your hardware and software in the same configurations
as You have provided in Your Site Survey. 
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You will void this Warranty if: You install Outside Elements not authorized or confirmed for
use by ZEISS in the Site Survey.

Warranty Exclusions: This Warranty does not apply to Software that has been damaged by
accident, virus or similar program based corruption, negligence, misapplication, alteration
or modification, including a change to the configuration of the system as reported in Your
Site Survey (without submitting a new Site Survey and receiving confirmation from ZEISS).
These warranties are exclusive and in lieu of all other warranties, whether written, oral,
express, implied, or statutory. EXCEPT AS PROVIDED HEREIN, NO EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT, SYSTEM
INTEGRATION AND DATA ACCURACY, WILL APPLY. THERE ARE NO WARRANTIES WHICH
EXTEND BEYOND THOSE DESCRIBED IN THIS DOCUMENT AND THE PRIOR STATEMENTS
BY ANY ZEISS REPRESENTATIVE SHALL NOT MODIFY OR EXPAND THESE WARRANTIES. 

This Warranty May Be Transferred if: before You make the proposed transfer, You provide
ZEISS with a written request and You receive written confirmation from ZEISS that it will
accept the transfer.

Software Support Agreement

In the U.S., a Software Support Agreement is available after the new ATLAS Review
Software warranty expires. For information, call the Customer Service Department at
1-800-341-6968. Outside the U.S., contact your local Carl Zeiss distributor.
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Place Patients in 9-15

Removing 9-9

Categorize Patients 9-13

Category Display Threshold A-6

CE Mark 1-13

Certificate Serial Number I-4

Check fuses H-2

Table fuses H-4

Chin Rest Assembly 1-5

Chord length 5-13

CIM 7-10

Cleaning H-8

Clear Archived Exams 10-3

Clearance 10-3

Automated 10-3

Manual 10-3

Which Exams are Cleared 10-4

Clearing Exam Data 10-3

Coefficients

Zernike 7-15

Color map 7-2

Color Palette 7-5

Standard 4-3

Color Scale 7-5

Colors

Changing 7-5

Comments 3-14

Computer Specifications K-2

Configuration Files

Back Up/Restore 9-20, 9-22

Conic section 7-7

Connectors 1-6

Contour map 7-4

Contours

Editing 3-16

Convexity A-10

Copyright, Software L-3

Corneal Irregularity Measurement 7-10

Corneal shape 7-9

normal 7-7, 7-10

Corneal vertex 7-6

Distance from 4-4

Corneal Wavefront View 6-21

Surface view 6-13, 6-22

Zernike table 6-22

Create New Database 9-16, 9-19

Create, Edit and Delete Patients 9-8

CRS-Master Software 8-9

Current archive, set 10-20

Cursor location 4-4

Cursor table 4-4

Custom Display 5-14

Custom image 6-24

Custom Scale 7-5

CZM DICOM Gateway 11-27, C-1

D
Data

Displaying in Data Table 7-7

Data Archiving

See also Networking 10-12

Data Encryption 9-16, 10-1, 11-1

Data Indices View A-4

Data Maintenance Requirements 10-2

Data Management 9-1, 11-1

Data Storage 1-7

Data tab 7-7
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Database

Creating 9-16, 9-19

Index 10-1

Location of Sample Database 9-16

Patient 10-1

Recovering 10-18, 10-25

Database Recovery Tool 10-18, 10-25

Date Format 2-6

Default display 8-5

Default Doctor’s name 8-11

Default exam settings 8-9

Default operator’s name 8-11

Default parameters 8-7

Default text display on Analysis Screen 8-6

Default Views 8-5

Defragmenting hard drive H-7

Delete Archive Locations 10-17, 10-20

Delete Patient 9-10

Delete Staff 9-4

DICOM C-1

DICOM Data Export 11-25, 11-26

For All Patient Exams 11-28

Report Export 11-27

DICOM Gateway

Configure 11-27, C-2

Disable an Archive Location 10-16, 10-19

Display

2-Difference 5-6

3-Difference 5-8

Custom 5-14

MasterFit II B-1

OD/OS Compare 5-4

Overview 5-2

PathFinder II 5-16

Selecting Exams and Views 5-1

Single View 5-3

Trend Analysis 5-12

Trend with Time 5-10

View Tracking 5-1

Display Options window 4-9

Display pop-up menu 2-19, 4-8, 5-1

Display Text 8-6

Disposal 1-22

Doctor 9-2

Selecting 3-14

Doctor’s name

Default 8-11

E
Eccentricity 7-9

Edit an Archive Location 10-19

Edit Categories 9-14

Edit Menu 2-16

Edit Parameter Sets 4-10

Edit Patient 9-9

Edit Pupil and Limbus 3-16

Edit Staff 9-4

Electrical Requirements K-2, K-4

Electromagnetic Compatibility (EMC) 1-15

Electronic Medical Records (EMR) system 11-25, C-1

Elevation View 6-6

Surface view 6-7

Zernike table 6-7

Ellipsoid 6-11

Embedded Windows License 1-13

EMR System 11-25, C-1

Encryption 9-16, 10-1, 11-1

Environmental Conditions K-2

Equivalent defocus 7-13

Error Messages, Handling H-7

Ethernet ports 1-6

Exam Acquisition Screen 3-6

Exam Data

Clearing 10-3

Storing 1-7

Exam Edit Screen 3-16

Exam Preview Screen 3-9

Exam quality indicator 3-11

Exam time out 3-6

Exams

Accessing Archived Exams 10-22

Analyzing 4-1

Remarks 3-14

Selecting 4-9

Selecting on Analysis Screen 4-6, B-5

Which Exams are Cleared 10-4

Exams dialog on Edit Parameters Screen 8-9
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Exams Pop-Up List 4-6, 4-7, B-5

Expanded Colors 7-6

Export archived data 11-24

Exporting 11-21

Auto 3-15, 8-12

Current Screen 11-27

Data for a All Patient Exams 11-28

DICOM 11-26

For Research 11-29

Report 11-27

To ATLAS 2 media 11-21

Zip Format 11-22

External Fixation K-2

External Monitor 1-9

Extrapolated data 11-20

Eye Chart image 6-24

F
F1 function key, User Manual PDF 1-3

F2 function key 4-5, 5-1, 6-1

F3 function key 4-8, 5-1, B-6

F4 function key 4-8

File Menu 2-16

Exit 2-19

Find Existing Patient 2-5, 3-2, 4-1

Fit Zone 6-8, 6-11

Fitting Rules B-17

Flash Drives 1-9

Fluorescein Map B-6

Focusing the image 3-7

Formatting CD disks G-2

Function key

F1 1-3

F2 4-5, 5-1, 6-1

F3 4-8, B-6

F4 4-8

Fuses

Check and Replace H-2

Replacement H-1

G
General Ellipsoid 6-11

Geometric center 6-15

Geometric center offset 6-15

Graphic Scale 6-26, 6-27, 6-29

H
Handling Requirements 1-20

Hard Disk Defragmentation H-7

Hard Disk Status Indicator 2-14

Hardware elements 1-4

Healing changes over time 5-8

Help Menu 2-17

Hide patient Info 11-30

Horizontal Visible Iris Diameter 3-16, 7-13, B-8

HVID 3-16, 7-13, B-8

Hyperopic LVC Class A-8

I
Image

Overlay 7-6

Image acquisition

Defaults 8-9

Image Parameters Screen 3-5

Image Simulation View 6-24

Image Source 6-24

Images

Acquiring 3-1

Analyzing 4-1

Capturing 3-9

Focusing 3-7

Import log files 11-15

Imported data

Cannot Edit Identifying Information 11-2

Data Integrity 11-2

Patient Privacy 11-1

Updating Imported Data 11-2

Importing

From ATLAS 900 Series database 11-5

From ATLAS 9000 Series Export Media 11-3

Zip Format 11-3

Indicator

Exam quality 3-11

Indicators

Archive Status 2-14

Camera Status 2-14

Hard Disk Status 2-14

Instrument Status 2-14

Synchronize Status 2-15
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Information

Status bar 2-13

Institution Name

Creating 2-12

Logo 2-12

Instrument Disposition 1-22

Instrument Installation 1-11

Instrument Status Indicator 2-14

Internet Connectivity Risks D-1

Irregularity View 6-9

Surface view 6-10

Isolation Transformer 1-8

J
Joystick 1-5

K
KCN Pattern Class A-7

Keratometer

Standard readings 7-12

Keratometry View 6-16

Keyboard 1-4, 1-6

L
Labels 1-21

Month and Year of Manufacture 1-21

Language Settings 2-6

Language, Choose 2-7

Legal Notices L-1

Lens Catalogs B-23

Lens Design Thumbnails B-11

License Agreement, Software L-3, L-4

License Key I-4, I-5

License Terms and Conditions, Software L-3

License View window I-1, I-2, I-5

License, Windows XP license location 1-13

Limbus contour 6-15

Editing 3-16

Limbus diameter 3-16

List of User Replacement Accessories H-9

Location of cursor 4-4

Location point

Tracking 4-9

Log files location 11-15

Log in

Preferences 2-4

Logout 2-5

M
Manage Patients 9-13

Manual

F1 function key 1-3

Organization 1-2

PDF 1-3

Manual Archive 10-21

Manual Clearance 10-3

Manufactured label 1-21

Map diameter 7-2

MasterFit II

Accessing B-2

Adding New Lens Design B-12

Change Lens B-13

Change Rx B-16

Data Table B-8

Delete Lens Design B-12

Display Preferences B-9

Exit B-5

Fitting Rules B-17

Fluorescein Map B-6

Lens Catalogs B-23

Lens Design Thumbnails B-11

Map B-15

MasterFit II Display B-3

Options B-17

Order Forms B-26

Patient Refraction B-2, B-16

Preferred Lenses B-22, B-23

Printing B-4

Profile Meridians B-7

Recommended Lens Design B-11

Rename Lens Design B-12

Tear Film Profile Graph B-7

MasterFit II Display B-1

Mean Curvature View A-4

PathFinder II A-10

Regions A-11

Mean Toric Keratometry 7-12

Mean View 6-19

Menu Bar 2-15
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Menu Options 1-3

Menus 2-15

Merge Patients 9-11

Meridians

Plotting in Profile View 7-3

Profile Meridians in MasterFit II B-7

MFT (Modulation Transfer) View 6-28

Modulation Transfer View 6-28

Monitor, connecting external monitor 1-9

More (F2) button 4-5, 5-1, 6-1

Mouse

Clicking to specify location 4-4

Move Archive Volume 10-20

MTF View

Image 6-28

Surface view 6-28

Myopic LVC Class A-8

N
NAS Device E-1

Installation and Configuration E-3

Navigation in General 1-3

Network

Capabilities D-1

Risks D-1

Storage Device Configuration E-1

Synchronizing Databases 10-11

Network activities

Prohibited D-5

Network Archiving

Advantages 10-5

Registration 10-9

Setting up D-5

Network Broker

Configure C-6

Installation C-3

Launching C-7

Network Cable(s) F-3

Network Configuration F-3

ATLAS Model 993/995 Instruments 11-5

Network File Server D-5

New Archive Location 10-9

New patient 3-3, 9-8

Node ID I-4, I-5

Normal Class A-6

Number Format 2-6

Number map 7-2

O
Obscured Patients 9-9

OD/OS Compare Display 5-4

OD/OS Reports 8-12

Omit Patient Identifiers 11-22

Operational Modes and Windows 2-12

Operator 9-2

Default name 8-11

Selecting 3-14

Optic Zone B-9

Options

Display 4-9

Options Menu 2-17

Order Forms B-26

Other Class A-8

Overlay 7-6

Overview Display 5-2

Overview Reports 8-12

P
Parameter Set

Always Use current Parameter Set for acquisition 3-2

Current 8-3

Default 8-3

Deleting 8-4

Editing 4-10

New 8-4

Renaming 8-4

Saving current 4-9

Selecting at image acquisition 3-5

Parameters

Default 8-7

Editing 7-1

Saving 4-9

Parameters View A-4, A-8

Password

Changing 2-10, 9-4

Forgotten 2-10

Password Change dialog 2-10
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PathFinder II A-1

Accessing A-3

Category Display Threshold A-6

Classes A-6

Convexity A-10

Cursor Tracking A-6

Data Indices View A-4

Diagnosed KCN Example A-13

Diagnosed Suspect KCN Example A-14

Display A-4

Examples A-12

Hyperopic LASIK Example A-17

Hyperopic LVC Class A-8

KCN Pattern Class A-7

Mean Curvature View A-4, A-10

Myopic LASIK Example A-16

Myopic LVC Class A-8

Normal Class A-6

Normal Example A-12

Other Class A-8

Other Class Example A-18

Parameters View A-4, A-8

Probability View A-4, A-6

User-Selectable View A-4, A-5

Using A-4

Patient

Adding new 3-3, 9-8

Categorize 9-13

Database 10-1

Deleting 9-10

Editing 9-9

Find existing 2-5, 3-2

Finding 4-1

ID 3-3

Identifying 3-1

Name 3-3

New 9-8

Obscured 9-9

Positioning during exam 3-6

Preparation 3-1

Searching 9-5, 9-6

View today’s patients 3-4

Patient ID 3-3

Unique 11-22

Patient info

Hiding 11-30

Show/hide 8-6

Showing 4-10

Patient Management System (PMS) 11-20, 11-25, C-1

Patient Refraction

MasterFit II B-2, B-16

Patient Selection Window 2-5, 3-2

Patients

Merging 9-11

Omitting patient identification 11-22

PDF Manual 1-3

Photopic 3-6

Image Capture 8-10

Photopic pupil image 6-14

Pupil 3-12

Pupil diameter 6-15

PMS System 11-25, C-1

Point Spread Function View 6-26

Ports 1-6

Power Fuses H-1

Power Problem H-1

Preferences

Archive 2-11, 10-5, 11-20

Archive/Synchronize 10-5

User Log in 2-4

Preferred Lenses B-22, B-23

Prepare The Patient 3-1

Prepare To Capture Image 2-1

Printer Configuration A-1, F-1

Printer Safety Warnings F-2

Printers, approved F-1

Printing

Auto 3-15, 8-12

Automatic 8-11

Fluorescein Map View B-4

Options 8-11

Reports and Views 4-6

Probability View A-4, A-6

Product Compliance 1-13

Product Labels 1-21

Product Safety 1-13

Profile

PSF View 6-26
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Profile Meridian B-8, B-9

Profile View 7-3

Plotting Meridians 7-3

Prohibited Network Activities D-5

Projection Head Assembly 1-5

Aligning 3-7

Prolate surface 7-10

Protective Packing Symbols 1-20

PSF (Point Spread Function) View 6-26

PSF View

Profile View 6-26

Surface view 6-26

Pupil center 7-6

Pupil contour

Editing 3-16

Pupil diameter 7-13, B-8

Q
Q Value 7-10

Quadric 6-11

R
Recycling 1-22

Refractive Power View 6-17

Regional and Language Settings 2-6

Register 9-2

Archive 10-8

Registering

ATLAS Analysis Software I-5

Staff 2-10, 9-2

Registration mode 3-11

Remarks 3-14

Replace Fuses H-1

Replacement Accessories H-9

Report

Options 8-12

Reports

OD/OS 8-12

Overview 8-12

Printing 4-6

Selecting Views 8-12

Residual Astigmatism B-15

Review Software

Manual 1-2

Rings Image 3-12

Zoom In 6-15

Rings Image View 6-13

Rings overlay 6-15

Risks, Networking D-1

RMS 6-8, 6-11, 7-10, 7-13, J-7

RMS fit 6-8, 6-11

Ro 5-13

Root Mean Square 6-8, 6-11, 7-10, 7-13, J-7

Routine Cleaning H-8

Routine Maintenance H-1

Rx

MasterFit II B-16

S
Safety

Printers F-2

Sagittal height 5-13

Sample database 9-16

Save current parameters 4-9

Scale

Auto 7-5

Custom 7-5

Standard 7-5

Scale graphic 6-24, 6-26, 6-27, 6-29

Scotopic

Image Capture 8-10

Pupil diameter 6-15

Scotopic pupil image 6-14

Scotopic Pupil

Viewing 3-13

Search 9-5, 9-6

Advanced 9-6

Preview 9-7

Security Code I-4, I-5

Security Recommendations D-2

Selecting Exams and Views 5-1

In View Editor 4-9

Serial Number Location 1-21

Server

Setup and use D-5

Service Contract L-2

Set Current Archive 10-20

Set Up Network Archiving D-5
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Shape Factor (SF) 7-9, B-8

Show Rings 3-12

Show/hide patient info 8-6

Shutdown 2-19

Sim K Values 7-12

Displaying 7-7

Single View Display 5-3

SmartCapture technology 3-9

Smooth map 7-4

Snell’s Law 6-17

Software and Storage Media 1-7

Software certificate I-4

Software Copyright L-3

Software License Agreement L-3, L-4

Software Support Agreement L-8

Specifications

CE Mark 1-13

Computer K-2

Electrical Requirements K-2, K-4

Environmental Conditions K-2

External Fixation K-2

Spherical aberration 6-2

Staff 2-10

Creating 2-10, 9-2

Registering 2-10, 9-2

Staff Registration 9-2

Standard Colors 7-6

Standard Scale 7-5

Status bar 2-13

Storage

Exam data 1-7

Summary log files 11-15

Surface Fit 6-11

Surface Fit Type 6-12

Surface view

Corneal Wavefront View 6-13, 6-22

MTF View 6-28

PSF View 6-26

Switch Eye button 4-7

Symbols and Labels Defined 1-19

Synchronization 10-18

Add Network Archives for Synchronization 10-15

Alerts 10-7

Automatic 2-11, 10-7

Defined 10-11

Delete Archive 10-17

Enable/Disable Archives 10-16

Synchronize

Status Indicator 2-15

T
Table 1-22

Specifications K-4

Tangential View 6-4

Tear Film Profile Graph B-7

Tear Film Thickness Profile Graph B-7

Text Convention 1-3

Text Items, Showing 4-10

TFT flat panel 1-4

Third Party Software D-5

Tips to Avoid Damage 1-12

TKM 7-12

Today’s Patients List 3-4

Tools Menu 2-17

Touchpad 1-6

Track views 4-9, 5-1

Transport and Storage Conditions 1-20

Trend Analysis Display 5-12

Trend with Time Display 5-10

Troubleshooting power problems H-1

Turning off the ATLAS System 2-19

U
Uniform Color Scale 7-5

Unique Patient ID 11-22

Updating Windows D-2

USB Flash Drives 1-9

USB Ports 1-6

User Accounts 9-2

Creating 2-9

Privileges 9-2

User Changes to Software or Hardware 1-10

User Identification Require (Log in) 2-4

User Login 2-4
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User Manual, F1 function key 1-3

User-Selectable View A-4

V
Validated Antivirus Software D-5

VGA port 1-9

Video port 1-9

View 2-18

View Editor 7-1

Data 7-7

Default parameters 8-7

General tab 7-1

View pop-up menu 2-18, 4-8

View Today’s Patients 3-4

View Tracking on Displays 5-1

Views 6-1

Axial 6-2

Corneal Wavefront 6-21

Default 8-5

Default parameters 8-7

Elevation 6-6

Image Simulation 6-24

Irregularity 6-9

Keratometry 6-16

Mean 6-19

Menu on Edit Parameters Screen 8-7

MFT (Modulation Transfer View 6-28

Pathfinder II 6-30

Printing 4-6

PSF (Point Spread Function) 6-26

Refractive Power 6-17

Rings Image 6-13

Selecting 4-9, 5-1, 6-1

Tangential View 6-4

Tracking 4-9

W
Warranty

Defined L-1

Limited L-6

Note Regarding H-1

Wavefront 7-14

White-to-white diameter 7-13, B-8

Windows Automatic Update D-2

Windows XP license, location 1-13

Worklist

Enabling Import 11-26

Z
Zernike

Coefficients 7-15

Number of coefficients 7-14

Order number 7-14

Zernike polynomial expansion 6-11

Zernike table

Corneal Wavefront View 6-22

Elevation View 6-7

Zip Format

Exporting from ATLAS 9000 Series Export Media 11-22

Importing from ATLAS 9000 Series Export Media 11-3

Zoom rings image 6-15
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Introduction

Proper image acquisition combined with careful exam review techniques facilitate good
image quality and measurement results on the ATLAS™ Model 9000 instrument.

Certain patient and alignment conditions should be taken under consideration for the best
results. See Acquisition Techniques – Best Practices on page A-1. 

Some artifacts may be difficult to detect during acquisition. Choose the best quality data by
conducting a detailed analysis review. If problems are observed for any of the following
methods, additional exams should be acquired. Acquiring multiple measurements is
relatively easy and increases your analysis success later. See Detailed Analysis Review
on page A-9.

Note that not all of these techniques are applicable to all software versions.

☞ Note: This document is a supplement to the ATLAS User Manual. Please refer to the
ATLAS User Manual for primary information relating to the ATLAS Model 9000
instrument and ATLAS Review Software. 

☞ Note: Due to the number of software versions, this document may contain screen
images and terms that differ from those displayed on your version.

☞ Note: The responsibility is upon the medical practitioner to determine the level of
performance required, the quality of the measurement data, and the appropriate
use of the data for their application. 

☞ Note: The ATLAS Model 9000 instrument and ATLAS Review Software are not
intended to be used as the sole diagnostic for disease.

☞ CAUTION: Decisions involving therapeutic and/or surgical procedures should be
made only after considering total clinical information, and not on the basis of a
single index measurement or analysis.

Acquisition Techniques – Best Practices

Patient and alignment conditions to consider include:

• Excessive Patient Motion (saccade, nystagmus, neuro-motor dysfunction) (see
Excessive Patient Motion on page A-2).

• Patient Anatomy Obscuring Cornea (includes eyelids, eyelashes, nose, and eyebrows)
(see Patient Anatomy Obscuring Cornea on page A-3).

• Tear Film Breakup (includes Dry Eye, insufficient blinking) (see Tear Film Breakup
on page A-5).

• Pupil Contour Artifacts (around iris/pupil boundary) (see Pupil Contour Artifacts
on page A-7).



User Manual Supplement: ATLAS Model 9000

User Manual Supplement: ATLAS Model 9000 2660021136504 A

A-2

Excessive Patient Motion

Excessive patient motion (saccade, nystagmus, neuro-motor dysfunction) may cause image
quality issues. An example of excessive patient motion is shown in Figure A-1 where the
ring image is characterized by an overall blurring effect, and the red ring detection lines are
poorly fitted and broken.

Figure A-1 Excessive Patient Motion Example

If this should occur, make sure the patient is comfortably positioned for the exam and is
aligned properly, and then retake the exam. Ask the patient to blink, look at the orange
fixation light, and remain as still as possible while you align the projection head. When
focusing, achieve the clearest and sharpest image of all the rings.

Patients with neurological dysfunction or with vision loss may have difficulty fixating.
Perform multiple measurements and analyze the ring image discarding acquisitions for
motion blurring, apparent vertex position changes, etc.
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Patient Anatomy Obscuring Cornea 

Patient anatomy may obscure the cornea and cause poor image quality. Anatomy that
affects corneal coverage area and may block the ring mires include eyelids, eyelashes,
nose, and eyebrows. This is illustrated in the rings image example shown in Figure A-2.
Note how the superior zone is shadowed with no rings. 

Figure A-2 Patient Anatomy Example – Rings Image

Check the Axial Curvature View for patient anatomy obscuring the cornea. The
corresponding Axial Curvature View for this image is shown in Figure A-3.
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Figure A-3 Patient Anatomy Example – Axial Curvature View

If this should occur, realign the patient in the chin rest and ask him/her to “open eyes
wide” prior to a repeated acquisition. A speculum, or other method, may be used to
improve corneal coverage.
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Tear Film Breakup

Tear film breakup may be caused by Dry Eye or insufficient blinking. Tear film uniformity
affects ring detection. In this example (Figure A-4, Figure A-5, and Figure A-6), there
is Tear Film Artifact. Notice how the red ring detection lines break up and do not follow the
white ring mires, due to tear film irregularity. This may be caused by Dry Eye. Patients with
Dry Eye may require artificial tears to prevent tear film breakup. 

If tear film breakup should occur, ask the patient to “blink” and “open wide”, and then
retake the exam. Shortly after blinking, but before the tear film breakup starts, is the
optimal time to acquire the measurement.

The Refractive Power View is the most sensitive to viewing these artifacts. For System
Software V3.0 users, it is recommended that Exam Preview and SmartCapture™ be turned
on so that the 4 best quality images are presented for analysis.

Figure A-4 Tear Film Breakup Example
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Figure A-5 Tear Film Affecting White Ring Mires

Figure A-6 Zoomed Image of Tear Film Breakup 

Tear film affects 
white ring mires.

Tear film affects 
red ring 
detection.
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Pupil Contour Artifacts

Pupil contour artifacts may be present around the iris/pupil boundary. In certain cases the
artifact is readily observable. Confirm that the red rings match the white Placido rings and
that color topography maps are not distorted or show artifacts. You can use the pupil
contour as a guideline to reference distortions. An example of distortion artifacts around
the pupil contour are shown on the Axial Curvature View in Figure A-7. 

Figure A-7 Axial Curvature View Showing Distortion Artifacts

If this should occur, you may dilate or darken the room lights to encourage a larger pupil,
and retake the exam. Patients with smaller pupils may be more susceptible to greater
repeatability variations, especially those patients with a light-colored iris. Either use a
darkened room, or cover fellow eye, to facilitate dilated pupils to achieve a pupil size
preferably larger than 4.5 mm.

In certain cases, the effects of the artifact may be subtle. For System Software 3.0 users,
check Sim K values on the EXAM PREVIEW screen (Figure A-8). Typically, the standard
deviation of the Sim K values should be less than 0.25 Diopters. Review all acquisitions on
the EXAM PREVIEW screen. If you are unsure of the quality of your image, the best option is
to repeat the measurement and confirm. Check repeatability carefully. See Detailed
Analysis Review on page A-9.

Distortion 
artifacts 
around 
iris/pupil 
boundary.

Pupil 
contour
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Figure A-8 Exam Preview Screen Showing High Standard Deviation of Sim K Values

Check Sim K 
Standard 
Deviation
values.
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Detailed Analysis Review

Some artifacts may be difficult to detect on the EXAM PREVIEW or EXAM RESULTS screen.
Choose the best data by conducting a detailed analysis review. Analysis can be performed
on the ATLAS Review Software (Software Version 3.0 only). If problems are observed for
any of the following methods, additional exams should be acquired. 

• Check the map Views, in particular, the Axial Curvature and the Refractive Power
Views. Artifacts are usually very localized with sharper defining characters.

• Check the Ring Image View with Zoom rings image turned on. Look for the Cone of
Focus™ ring (ring 8) to be equidistant to adjacent rings, all rings in focus, and good
ring detection following the ring mires image.

• Use the Trend Display (Figure A-9) or Trend Analysis Display (System Software V3.0
only) (Figure A-10) to identify distinctly different exams. The Trend Analysis Display
shows the mean and standard deviation of the Sim K values, useful to determine
repeatability. In these Figures, notice the distortion artifacts on the 10:54:00 exam,
and the higher Sim K values on the 10:54:23 exam—either one of the other exams
should be selected as the best quality image.

Figure A-9 Trend Display Revealing Outlier Exams

Distortion 
artifacts around 
pupil contour.

Significantly different color topography map than the other exams 
on this Display.

Significantly different Sim K values than the 
other exams on this Display.
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Figure A-10 Trend Analysis Display Revealing Outlier Exams

Significantly different color topography map than the other exams on this Display.

Significantly 
different Sim K 
values than the 
other exams on 
this Display.

Distortion 
artifacts around 
pupil contour.
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Release Notes: ATLAS Software 
Version 3.0

• 1. New Features, page A-1
• 2. Maintenance Updates, page A-2
• 3. Corrected Anomalies, page A-3
• 4. Use Notes, page A-3
• 5. Known Anomalies, page A-5

1. New Features

Licensed features described in this section are optional and may not be activated on your
instrument, either because the feature is not currently available in your market, or because
you have not purchased the software license. 

The following new features are included in ATLAS Software Version 3.0:   

1. (Optional Licensed Feature) MasterFit II Software. The MasterFit II Contact Lens
Software enables the user to design gas permeable (GP) contact lenses and to
simulate the resulting fluorescein pattern on the cornea. MasterFit II features both
topographic or keratometric-based lens fitting methods. Based on customizable
fitting preferences, MasterFit II will recommend the most appropriate lens type
(including spherical, aspheric, front toric, back toric, and bi-toric designs) and will
design a custom lens that best achieves the desired fitting preferences. The MasterFit
Software set is an optional feature: it is installed with Version 3.0 software but runs
under license protection and must be purchased. 

2. (Optional Licensed Feature) DICOM Gateway. The DICOM (Digital Imaging and
Communications in Medicine) Gateway allows the user to connect one or more ATLAS
systems to a qualified DICOM 3.0 Ophthalmic Compatible Electronic Medical Records
(EMR) system, Patient Management System (PMS), or DICOM archive, for paperless
workflow. The DICOM Gateway is an optional feature: it must be installed, configured
and purchased. This feature runs under license protection.

3. (Optional Licensed Feature) ATLAS Review Software. ATLAS Review Software running
on a separate computer is functionally identical to the software running on the ATLAS
instrument except for the ability to acquire images. ATLAS Review Software is an
optional feature: it must be installed, configured and purchased. This feature runs
under license protection.
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2. Maintenance Updates

1. (Optional) Use SmartCapture™. Now optional, SmartCapture Image Analysis
technology captures images at a rate of 15 images per second before you actually
press the joystick button or spacebar at image acquisition. If the Use SmartCapture™
option is enabled, SmartCapture analyzes these images and uses the best acceptable
image for image processing on the Exam Results Screen, or the best four images for
the Exam Preview Screen. If the Use SmartCapture™ option is not enabled, only the
last image is displayed on the Exam Results Screen, or the last four images (displayed
in chronological order, left to right) on the Exam Preview Screen.

2. (Optional) Exam Preview Screen. If enabled, the Exam Preview Screen displays the last
four images (displayed in chronological order, left to right) in the image frame buffer
(or best four images if the Use SmartCapture™ option is on). Clicking a Save button
below an image marks it for saving and viewing. A Parameters Table displays values
for Eccentricity, Shape Factor, Flat and Steep Sim K’s, HVID, and Pupil Diameter for
each image. The mean and standard deviation values for these parameters are also
displayed for the images.

3. Trend Analysis Display. The Trend Analysis Display shows up to four exams for the
same eye, along with a table of data analysis parameters. Data Parameters displayed
include Apical radius (Ro) (along meridian), Sagittal height (along meridian),
Eccentricity (along meridian), Flat and Steep Sim K’s, HVID, and Pupil Diameter values
for each image. The mean and standard deviation values for these parameters are
also displayed for the images.

4. Rings Image Zoom. The Rings Image View now has an option to display a zoomed in
rings image to 10mm. Only available for ATLAS 9000 exams.

5. RMS Data. The Corneal Wavefront, Image Simulation, PSF, and MTF Views can now
display RMS data. The Root Mean Square (RMS) value of the Zernike coefficients
determines how much wavefront error the anterior cornea has. The higher the RMS
value, the larger the amount of wavefront error. Low (2nd order aberrations only),
High (3rd order aberrations and greater only), and Total (Low + High) RMS values
(μm), and their “equivalent defocus” values (diopters only) are displayed. Equivalent
defocus is the amount of defocus needed to produce the same RMS wavefront error
produced by one or more higher-order aberrations. Equivalent defocus allows us to
compare the order of magnitude of different kinds of aberrations and judge their
clinical significance.

6. Database Recovery Tool. When logged in as admin user, the Database Recovery Tool
(Tools > Database Recovery Tool) enables you to synchronize from a system’s own
database archive for database recovery. The Database Recovery Tool should only be
used with assistance from a Carl Zeiss Meditec authorized technical support
technician.
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7. Synchronize Status Indicator. The Synchronize indicator reports synchronization status
in terms of connectivity. A red circle with a white “X” indicates that no
synchronization volumes are enabled. A green light indicates all enabled
synchronization volumes are connected. A yellow light indicates at least one enabled
synchronization volume is connected, and at least one enabled synchronization
volume is disconnected. A red light indicates all enabled synchronization volumes are
disconnected. You can mouse over the indicator for details.

8. Export Single Exams. When exporting ATLAS 9000 data, (File > Export > To Atlas
9000 Series Export Media), you can select a single exam or only certain exams for a
patient, rather than all exams, by clicking the Select Exams button and then selecting
the exams you want to export for each patient.

3. Corrected Anomalies

1. Refractive Power View Display Anomalies. In Software Version 2.0, if mm is selected
as the units (global parameter) in a View, the Refractive Power View in Profile view
mode correctly displays diopter values as the unit, but incorrectly mm as the label.
Also the Color view in the circle will not be correct. This anomaly has been corrected
so that diopters and the Color view are correctly displayed. 

4. Use Notes

1. Note: The Review Software requires administrative privileges in order to run. 
Action: User must have administrative privileges to use the Review Software.

2. Note: The Review Software cannot be installed on an ATLAS instrument. 
Action: The user should read the Review Software installation guide before installing
the Review Software.

3. Note: If Print2VisuPaC is chosen as the default printer, it must be configured to
Portrait Mode. Selecting Print2VisuPaC Landscape mode can cause an error.
Action: If using Print2VisuPaC, always use Portrait mode.

4. Note: All named Parameter Sets have revised default settings. 
Action: To update to the revised default settings, select the Defaults button for each
Parameter Set.

5. Note: The rings image is only displayed on the simulated fluorescein map view for
exams created on the ATLAS 9000 in MasterFit II.
Action: Exams created on earlier Atlas models can be viewed in MasterFit II but the
rings image is not displayed.

6. Note: The contact lens can only be moved on the simulated fluorescein map view for
exams created on the ATLAS 9000 in MasterFit II.
Action: Exams created on earlier ATLAS models can be viewed in MasterFit II but the
contact lens cannot be moved.
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7. Note: The MasterFit II software uses the Refraction that has been input by the
operator to help determine the contact lens power. If no refractive data has been
entered, the software assumes a plano refraction and displays a warning to the
operator. 
Action: The operator should enter refractive data in order for the MasterFit II software
to be able to determine appropriate contact lens powers and parameters.

8. Note: In some instances, the MasterFit II software lens design area of the screen is cut
off when the tool bar is being displayed or the window has been resized (Review
Software).
Action: The operator can hide the tool bar to make all the contact lens design items
visible or maximize the window if it has been resized.

9. Note: The initial archive of a database containing thousands of exams will take a long
time. For example, on the ATLAS 9000 instrument it will take about 10 hours to
complete archiving 1000 exams.
Action: Initial archiving of large database should only be started at a time when the
use of the instrument is not required for a long time.

10.Note: The initial synchronization of an archive containing thousands of exams will
take a long time. For example, on a late model computer it will take approximately 10
hours to complete synchronizing 1000 exams.
Action: Initial synchronizing of a large archive should only be started at a time when
the use of the computer is not required for a long time.

11.Note: Exporting all the patients in a large database can be very slow and is not
recommended.
Action: Do not attempt to export all patients at a single time from a large database.

12.Note: Exporting all the patients in a large database to the DICOM Gateway can be
very slow and is not recommended.
Action: Do not attempt to export all patients at a single time to the DICOM Gateway
from a large database.

13.Note: The space needed for export is calculated based upon a single patient, not on
the number of exams to be exported. 
Action: If exporting a large number of exams, check beforehand that there is enough
free space on the destination drive. A single exam takes between 1 and 4 MB of
space.

14.Note: Archiving does not stop when available space on the archive volume drops
below the red Archive Status (200 MB available on archive volume) during the archive
process. 
Action: If Archive Status turns yellow, either free up space on the archive volume or
create a new archive volume before archiving.
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15.Note: If you have Auto print after acquisition checked in the Printing Options dialog,
or Enable Automatic End of Exam Export checked in the DICOM Configuration tab,
the selected reports and Views at the end of exam acquisition are only printed or
exported to DICOM for the last saved OD and OS exam.
Action: Other saved exams taken at exam acquisition can be printed or exported to
DICOM by selecting the exams on the Analysis Screen after acquisition, and then
printed or exported.

16.Note: Larger than expected tear film clearances under the peripheral curve regions
may be observed in the MasterFit II fluorescein simulation. MasterFit II does not blend
between the base, secondary peripheral, and third peripheral curve regions. Blending
effectively lowers the peripheral region and reduces the effective peripheral clearance.
Action: None.

5. Known Anomalies

1. Anomaly: If Print2VisuPac is installed and the printing mode is set to landscape an
unhandled exception will occur.
Work-Around: When using Print2VisuPac, set the printing mode to portrait.
Preventive: None.

2. Anomaly: The Review Software installer will not work on a Windows XP 64 bit system.
It will attempt to install Windows Framework .NET 2.0 for a 32 bit system.
Work-Around: When installing the Review Software on a Windows XP system, use
only a 32 bit Windows XP system.
Preventive: None.

3. Anomaly: The Review Software does not support Large size (120 DPI) display setting
when the screen resolution is set to 1024 x 768. 
Work-Around: Change the DPI setting in the Advanced button under the Settings tab
in the Display Properties dialog to the Normal size setting (96 DPI) or change to a
larger screen resolution than 1024 x 768.
Preventive: None.

4. Anomaly: Pressing the space bar very rapidly during Image Acquisition can cause the
software to save images that include thumbnail images in the upper part of the
image, causing the upper part of the image to not be included in the image
processing.
Work-Around: Re-acquire images since missing data cannot be reconstructed.
Preventive: Be careful to only press the space bar once when acquiring an image or
use the joystick to acquire images.

5. Anomaly: Special characters not in English character set (e.g., Ä) are case sensitive in
Basic and Advanced search.
Work-Around: Type in a special character and then use the vertical scroll bar to locate
the desired patient.
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Preventive: Use the correct case when searching patients with names containing
special characters not in English character set.

6. Anomaly: An unhandled exception error can occur during an Import operation if the
operator types in a path as “e:” rather than “e:\.” The error is caused by omitting to
type in the backslash. 
Work-Around: Type in the backslash if typing the path manually.
Preventive: Use the browse button to select the path.

7. Anomaly: ATLAS export functions do not span media disks. The media disk must have
enough space to accommodate all the export data.
Work-Around: Use a USB hard drive or NAS drive with enough free space to
accommodate the export data.
Preventive: Check beforehand that there is enough free space on the media disk to
accommodate the export data. A single exam takes between 1 and 4 MB of space.

8. Anomaly: When you enter Exam Acquisition, the live video image may be black. This
is more likely to occur if you leave the ATLAS 9000 on for many days.
Work-Around: Exit out of Exam Acquisition and the ATLAS application. Reboot the
ATLAS 9000 computer.
Preventive: Turn off the ATLAS System computer each day.

9. Anomaly: When exporting ATLAS 9000 data, if you select Export to Zip Format and
the export folder already contains patients exported without using the Zip format,
then the created Zip file will contain the currently selected patients and the previously
exported patients. Note: Any existing Zip files in the folder will not be included.
Work-Around: Create a new folder when exporting patients.
Preventive: Create a special folder for exporting Zip files.

10.Anomaly: For 2-Difference and 3-Difference Displays, using the keyboard to change
exams in the Exams/Views window does not work.
Work-Around: Select exams with the touchpad or mouse.
Preventive: None.
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Version 3.0 Installation Instructions

Introduction

This document provides instructions to install the ATLAS™ Model 9000 system software
Version 3.0 upgrade for an existing installation of ATLAS Version 1.0.1.0 or 2.034, and to
license the optional software features. Topics include:

• Important Installation Notes, page 1
• Brief Installation Instructions, page 2
• Detailed Installation Instructions, page 3
• License Registration, page 8

Please read all instructions before performing the installation.

Important Installation Notes

WARNING: Before installing any new software, you should completely archive the

instrument database. For instructions, refer to the Archive Management chapter in

the ATLAS User Manual. Failure to archive the database could result in loss of patient

data or the patient database.

1. Successful installation requires that you be logged on to the system with a user
account that has administrator privileges. The default user account on ATLAS Model
9000 instruments has administrator privileges.

2. Plan and allow sufficient time for installation. It will take about 10 minutes to install
the upgrade and about another 10 minutes to register an optional software feature.

3. If you are upgrading from Version 1.0.1.0, your old database will undergo a
conversion process which is very fast. If you have a very large database, it will only
take a little longer time to complete. If any patients exist without a Patient ID, a
Patient ID will be created for them using the patient’s first and last name (e.g. Patient
ID = johnadams).

4. If you are upgrading from Version 1.0.1.0, some View Editor parameters may change
after upgrade due to their change to a global parameter. These global parameters are
General–Units, General–Rendering, Color–Color Scale, Color–Color Palette, and
Overlay. If you want to keep your old settings for these global parameters, it is
recommended to write down your current settings for these parameters for each
Parameter Set before you upgrade. 

5. If you are upgrading from Version 1.0.1.0, all named Parameter Sets for ATLAS Version
3.0 software have revised default parameter settings. To use the Version 3.0 default
settings, select each Parameter Set and then select the Defaults button. 

6. Carl Zeiss Meditec strongly recommends using Acronis to create a new hard drive
image (called a new “archive” in Acronis) after completion of a successful software
upgrade. See the CZM System Recovery Tool Instructions document on the User
Documentation CD.
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7. The optional software features runs under license protection. To use these software
features you must first register them. For instructions, see License Registration
starting on page 8.

Brief Installation Instructions

These brief installation instructions are not detailed and do not include screenshots. They
are intended for users familiar with the process of installing new software, and users who
do not encounter any difficulties during installation. Use the Detailed Installation
Instructions, starting on page 3, if you are not familiar with installing software in
general, or if you encounter difficulties with installation. The detailed instructions include
screenshots.

Brief Install Steps:

1. If the ATLAS Model 9000 software is running, exit the ATLAS software by selecting
File > Exit, or click the  at upper right, and then select Yes to exit.

2. Install the Version 3.0 installation disk into its drive. Wait for the installation program
to start automatically.

3. Prior to installation, the Microsoft® Report Viewer application must be installed if not
already installed. Click Install to install the Report Viewer application. 

4. When preparatory steps complete, the Welcome dialog appears.
5. Click Next. The License Agreement dialog appears.
6. Read the license agreement and select the radio button next to I accept the terms of the

license agreement. Click Next. The Ready to Install the Program dialog appears.
7. Click Install. The Installation Complete dialog appears when installation is complete.
8. Click Finish to exit the installation program. 
9. You can remove the ATLAS Software Version 3.0 installation CD from the optical drive.
10.To start ATLAS Software, double-click the ATLAS Software shortcut on your computer

desktop.
11.(Optional) Carl Zeiss Meditec strongly recommends using Acronis to create a new

hard drive image (called a new “archive” in Acronis) after completion of a successful
software upgrade so later recovery may be to the most recent software version. See
the CZM System Recovery Tool Instructions document on the User Documentation CD.

12.(Optional) Create a new Version 3.0 backup of Configuration Files (see the ATLAS
User Manual for more information).

13.(Optional) See License Registration on page 8 if you want to register any optional
software feature.
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Detailed Installation Instructions

These detailed installation instructions include screenshots. They are intended for users
unfamiliar with the process of installing new software, and users who encounter difficulties
during installation.

Detailed Install Steps

1. If the ATLAS Model 9000 software is running, exit the ATLAS software by selecting
File > Exit, or click the  at upper right, and then select Yes to exit.

2. Install the ATLAS Software Version 3.0 installation disk into its drive. Close the drive
and wait for the installation program to start automatically. 

☞ Note: If you cancel installation, to restart installation you must either open and
close the CD drive, or if autoplay fails, use Windows Explorer (right-click Start and
select Explore) to find and double-click the file named setup.exe on the ATLAS
Model 9000 system software Version 3.0 installation CD.

3. Prior to installation, the Microsoft Report Viewer application must be installed if not
already installed. The INSTALLSHIELD WIZARD window appears:

Figure 1 InstallShield Wizard for Report Viewer
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4. Click Install to install the Report Viewer application:

Figure 2 Installing Microsoft Report Viewer

☞ Note: Microsoft Report Viewer is required for printing. You will not be able to print
from ATLAS Software if it is not installed. It is shown in your list of currently installed
Windows programs as Microsoft Report Viewer Redistributable 2005. Do not
uninstall.

5. After completing installation of Report Viewer, you will see the installation splash
screen and InstallShield Wizard dialog, as shown below.

Figure 3 Splash Screen and InstallShield Wizard Dialog 
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6. After preparatory steps complete the Welcome dialog appears.

Figure 4 Welcome Dialog

7. Click Next. The License Agreement dialog appears.

Figure 5 License Agreement Dialog
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8. Read the license agreement and select the radio button next to I accept the terms of
the license agreement (You must accept the license agreement to complete
installation). Click Next. The Ready to Install the Program dialog appears.

Figure 6 Ready to Install the Program Dialog

9. Click Install to begin installation. A Setup Status dialog reports installation progress.

Figure 7 Setup Status Dialog During Installation
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10.The InstallShield Wizard Complete dialog appears when installation is
complete.

Figure 8 InstallShield Wizard Complete Dialog

11.Click Finish to exit the installation program. You can remove the ATLAS Software
Version 3.0 installation CD from the optical drive.

12.To start ATLAS Software, double-click the ATLAS Software shortcut on your computer
desktop. Alternatively, you can select Start > All Programs > Carl Zeiss Meditec >
ATLAS Software.

13.If you are upgrading from Version 1.0.1.0, upon first time launch of ATLAS Software
Version 3.0, your ATLAS Version 1.0 data will undergo a conversion to the new
Version 3.0 format. This should only take a few seconds.

14.(Optional) Carl Zeiss Meditec strongly recommends using Acronis to create a new
hard drive image (called a new “archive” in Acronis) after completion of a successful
software upgrade so later recovery may be to the most recent software version. See
the CZM System Recovery Tool Instructions document.

15.(Optional) If you are upgrading from Version 1.0.1.0, Configuration Files are all
converted to a new format and are active after upgrade. However, previous version
1.0 Configuration Files backups cannot be used to restore your Configuration Files in
Version 3.0 or later. To create a new Version 3.0 backup of the Configuration Files, see
Back Up/Restore Configuration Files (admin only) in the Data Management Chapter of
the ATLAS User Manual.

16.(Optional) See License Registration on page 8 if you want to register any optional
software feature. 
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License Registration

ATLAS’s optional software features run under license protection. They will not run until you
register their corresponding license. PathFinder™ II and MasterFit™ II have the option of
registering a Trial (30-Day) or Full license. Follow the instructions below to register a
software license.

☞ Note: The ATLAS Model 9000 Version 3.0 upgrade kit may include one or more
license certificates. If not, a license may be obtained by contacting Carl Zeiss
Meditec by email at z.customersupport@meditec.zeiss.com. To reach us by phone, in
the United States please call Carl Zeiss Meditec at 1-800-341-6968. Outside the
United States, please contact your local Carl Zeiss Meditec distributor. Each
certificate you receive must be registered separately.

To start license registration:

1. Make sure the ATLAS Software is running and the PATIENT SELECTION window is
displayed. If not, start the ATLAS Software by double-clicking the ATLAS Software icon
on the desktop.

2. You may need to logon with a User Name and Password.
3. Select View Licenses... on the Help menu to display the LICENSE VIEW window 

(Figure 9).

Figure 9 License View Window
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Registering Optional Software Features

The following licensed features are pre-installed in ATLAS Software Version 3.0, but will not
be active until registered, unless they have been registered previously.

• PathFinder II (30-day Trial available)

• MasterFit II (30-day Trial available)

• DICOM Gateway

If you have purchased these features, the corresponding software certificates will be
included in the software kit. 

You can register the optional software features at any time ATLAS Software is running by
selecting View Licenses... on the Help menu. The LICENSE VIEW window will be displayed
(Figure 9). If ATLAS is not running, start ATLAS by double-clicking the ATLAS Software
icon on the desktop. You may need to logon with a User Name and Password.

Registering a Trial License

1. Click Register under the Trial heading for the license you want to register. A dialog
will be displayed similar to the one shown below (Figure 10).

Figure 10 Trial License Dialog

2. Click Yes to start your 30-Day Trial license. 
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3. The LICENSE VIEW window will be displayed with Trial license registered (Figure 11).

Figure 11 License View Window – PathFinder II 30-Day Trial License Registered

4. Select OK to close the LICENSE VIEW window and begin using the software.
5. You have 30 days from the date of registering to continue using the software. The

number of days left in your Trial license is shown on the LICENSE VIEW window (Figure
11). When the number of days left is seven or less, you will be notified at application
startup with a dialog such as shown in Figure 12 below:

Figure 12 License Notification Dialog

6. Click OK to continue using the software for your remaining trial days. At the end of
your Trial license, the license will expire and you will need to purchase a Full license to
continue using the software.
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Registering a Full License

1. Click Register for the license(s) you want to register.
2. The CZM License Registration Utility dialog (Figure 13) appears. 

Figure 13 CZM License Registration Utility Dialog For DICOM Gateway

3. Under FEATURE TO BE REGISTERED, confirm that the name of the feature you selected
matches the license certificate you are about to register.

4. Make a note of the unique Node ID of your system. Enter the Certificate Serial Number
provided on the software certificate, obtained from Carl Zeiss Meditec customer, or
found on a sticker affixed to the back of the CD case, including the alphabetic prefix
and the intervening dash before the number.

5. To obtain a License Key and Security Code, go to the Carl Zeiss Meditec website:
www.meditec.zeiss.com/register. If your language is other than English, select your
language under the “Other Languages:” area of the website.

☞ Note: If you have questions regarding software registration, please contact Carl
Zeiss Meditec by email at z.customersupport@meditec.zeiss.com. To reach us by
phone, in the United States please call Carl Zeiss Meditec at 1-800-341-6968.
Outside the United States, please contact your local Carl Zeiss Meditec distributor.
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6. Go to the bottom of the page, where it says: “When ready use the form to create your
License Key” and click on the word “form” (see Figure 14 below).

Figure 14: Carl Zeiss Meditec Software License Registration Page on the Internet

7. Enter your Certificate Serial Number and click the Submit button. 
8. Enter your Node ID and personal information and click the Submit button to generate

your License Key and Security Code.
9. Write down your License Key and Security Code, or print out and save the entire web

page for reference. 

☞ Note: If you are unable to complete the license registration process, click Close to
quit the license registration utility. Double-click the ATLAS Software desktop icon to
restart the software and return to Step 1 of license registration above. 

10.Returning to the CZM License Registration Utility, enter the License Key and Security
Code in the appropriate fields. The Save button will become active only when the
correct information is entered. When the Save button becomes active, click Save. 

Click “form”
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11.If the license registration is successful, a dialog will be displayed confirming
successful registration (Figure 15).

Figure 15 Successful License Registration Dialog

12.Click OK to close the dialog and complete the license registration. 
13.The LICENSE VIEW window (Figure 16) is displayed with the Full license registered.

Select OK to begin using the software. 

Figure 16 License View Window with Full Review License Registered

☞ Note: If you get an error message, verify that you have entered the correct values for
your license information and try again.

14.After registering a Full license for a software feature, you can register additional
software licenses now by selecting the Register button for the software you want to
license, or later by selecting View Licenses... on the Help menu.

☞ Note: To purchase additional licensed features, contact Carl Zeiss Meditec at
1-800-341-6968 or by email at z.customersupport@meditec.zeiss.com. Outside the
United States, please contact your local Carl Zeiss Meditec distributor.
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Introduction

This document provides instructions to install and license ATLAS® Review Software, and to
license any optional software features you have purchased. 

Topics include:

• Important Installation Notes, page 1
• Review Software System Requirements, page 1
• Network File Server Minimum Requirements, page 2
• Brief Installation Instructions, page 4
• Detailed Installation Instructions, page 5
• License Registration, page 14
• Set Up and Configure the Review Software, page 20
• Connect Review Station to your ATLAS Instrument, page 20

Please read all instructions before performing the installation.

Important Installation Notes

1. Plan and allow sufficient time for installation.
2. Administrator Account Required. To install, to license or to use this software, you

must be logged in to Windows® as an Administrator (Microsoft Windows® XP and
Windows 7).

3. ATLAS Review Software installs InterBase 2007 SP3. For applications using Interbase
2007 SP3 prior to the installation of ATLAS Review Software, see Possible
Interbase Login when starting ATLAS Review on page 3.

4. Microsoft Report Viewer is installed and required for printing. It is shown in your list
of currently installed Windows programs as Visual J #2.0 Redistributable Package. Do
not uninstall.

5. One Computer Per License. ATLAS Review Software runs under license protection: To
use the software, you must register one license for each computer on which you
install it. See License Registration on page 14.

6. License registration is required. ATLAS Review Software and its optional software
features run under license protection. To use the system software and any optional
software features, you must register each license shipped with the software. See
License Registration starting on page 14.

Review Software System Requirements

Operating System

• Microsoft Windows XP Professional with Service Pack 3 or higher, 32-bit
• Microsoft Windows 7 Home Premium and Professional (32-bit and 64-bit versions)
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System Requirements

The system running ATLAS Review Software (Review Station) must meet the following
minimum requirements:

• Processor: 500 MHz or faster
• 20 GB available hard disk space
• Memory: 1 GB RAM for Windows XP, 2 GB for Windows 7; when running additional

applications concurrently, more memory may be required.
• Windows file system: NTFS required. FAT16 and FAT32 are not supported.

WARNING: Many older and a few newer computers use the FAT16 or FAT32 file

system. Before installing, you must confirm that the hard drive where you will install

ATLAS Review Software uses NTFS. To check the file system, right-click on the hard

drive in Windows Explorer and select Properties. If it uses FAT16 or FAT32, it is

possible to convert the drive to NTFS; however, conversion to NTFS entails risk that

current applications or data may be lost due to error or may be incompatible with

NTFS. The user, and not Carl Zeiss Meditec, assumes all risks associated with

converting the file system to NTFS. Before you convert to NTFS, we recommend you

consult an information technology (IT) expert. Instructions can be found in the

Windows Explorer help system.

• CD-ROM drive (required for installation)
• 1024 x 768 pixel screen resolution; 16 bit color

☞ Note: ATLAS Review does not support a display resolution of 1024 x 768 with Large
size (120 DPI) DPI setting.

• Microsoft Internet Explorer® 4.72 or higher (for license registration)
• TCP/IP is installed 

Network File Server Minimum Requirements

Operating System

• Windows 2003 Server
• Windows 2003 Small Business Server

System Requirements

If you plan to use a network file server it must meet the following minimum requirements:
• Processor: 800MHz processor or faster
• Memory: 256 MB RAM
• NTFS drive partition(s) for ATLAS data. ATLAS data is compatible only with NTFS. 
• 100GB available disk space for data storage (should be expandable)
• Network interface card 100 Mbps
• Tape backup unit
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☞ Note: It is the user’s responsibility to protect their exam data from loss by frequent
backup of the network server. Backup media should be of archival quality, and the
media should be stored in a secure, remote location.

WARNING: Failure to backup the network file server may result in the loss of medical

exam data.

Network File Server Recommendations

In addition to the minimum requirements listed above, we recommend the following for
the network file server:

• A mirrored RAID array for data storage—strongly recommended.
• An uninterruptible power supply (UPS)—strongly recommended.
• The file server must be started prior to networked ATLAS instruments and Review

Stations, and shut down after ATLAS instruments and Review Stations.

☞ Note: It is strongly recommended that the file server not be used for interactive
programs, such as web browsing or word processing.

Possible Interbase Login when starting ATLAS Review

When starting ATLAS Review Software, it is possible a Database Login dialog (Figure
1) will be displayed during system check if you have installed another application using
Interbase 2007 SP3 prior to installing ATLAS Review Software. 

Figure 1 Interbase Database Login

ATLAS uses the default Interbase User Name (sysdba) and Password (masterkey), but a
previously installed application using Interbase 2007 SP3 may be using a different user
name and password. If ATLAS Review Software is installed after the other application, it
will not change the Interbase user name and password of the other application. If this is
the case and a Database Login dialog is displayed, you will need to enter the user name
and password from the other previously installed application. Please contact your IT
administrator for the user name and password if you do not know it. After entering in the
other application’s user name and password, ATLAS Review Software will run, and you will
not need to enter this information again.
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Brief Installation Instructions

These brief installation instructions are not detailed and do not include screenshots. They
are intended for users familiar with the process of installing new software, and users who
do not encounter any difficulties during installation. Use the Detailed Installation
Instructions, starting on page 5, if you are not familiar with installing software in
general, or if you encounter difficulties with installation. The detailed instructions include
screenshots.

1. Install the ATLAS Review Software installation disk into its drive. 
2. When preparatory steps complete, the WELCOME window appears.
3. Click Next. The LICENSE AGREEMENT window appears.
4. Read the license agreement and select the radio button next to I accept the terms of

the license agreement, then click Next. The CHOOSE DESTINATION LOCATION window
appears.

5. Click Next to install into the default folder location. The READY TO INSTALL THE PROGRAM

window is displayed.
6. Click Install to begin installation. A SETUP STATUS window tracks progress of the

installation. The INSTALLSHIELD WIZARD COMPLETE window appears when installation is
complete.

7. Click Finish to exit the installation program. You can remove the ATLAS Review
Software installation CD from your drive.

8. To start ATLAS Review Software, double-click the ATLAS Review Software shortcut on
your computer desktop.

☞ Note: On Windows 7 computers, you may need to right-click on the ATLAS Review
Software shortcut, and select Run as Administrator.

9. See License Registration on page 14 to register the ATLAS Review Software and
any other optional software features.

10.See Set Up and Configure the Review Software on page 20 to configure
ATLAS Review Software to your practice preferences.

11.See Connect Review Station to your ATLAS Instrument on page 20 to
connect your ATLAS instrument to the ATLAS Review Station. 
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Detailed Installation Instructions

These detailed installation instructions include screenshots. They are intended for users
unfamiliar with the process of installing new software, and users who encounter difficulties
during installation.

1. Install the ATLAS Review Software installation disk into its drive. Close the drive and
wait for the installation program to start automatically. 

☞ Note: If you cancel installation, to restart installation you must either open and
close the CD drive, or if autoplay fails, in Windows XP use Windows Explorer
(right-click Start and select Explore) to find and double-click the file named
setup.exe on the ATLAS Review Software 3.0.1 installation CD; in Windows 7, select
Run setup.exe in the pop-up dialog.

☞ Note: In Windows 7, if you have User Account Control (UAC) enabled you will see a
User Account Control – Windows needs your permission to continue dialog.
Click Yes to proceed.

☞ Note: Microsoft Report Viewer application will be installed if not already installed.
Microsoft Report Viewer is required for printing. You will not be able to print from
ATLAS Review if it is not installed. It is shown in your list of currently installed
Windows programs as Visual J #2.0 Redistributable Package. Do not uninstall.

2. For successful installation, the Microsoft .NET Framework 2.0 must be installed if not
already installed. The installation program checks for Microsoft .Net Framework 2.0,
and installs it if necessary. Some systems already have .NET Framework 2.0, in which
case this section is not applicable. If Microsoft .NET Framework 2.0 needs to be
installed, you will see “Configuring Microsoft(R) .NET Framework” in the InstallShield
Wizard dialog. Microsoft .NET Framework can take many minutes to install,
depending on the speed of your computer processor and hard drive.
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3. After completing installation of required software, you will see the installation splash
screen and InstallShield Wizard dialog, as shown below.

Figure 2 Splash Screen and InstallShield Wizard Dialog 
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4. When preparatory steps complete, the INSTALLSHIELD WELCOME window appears:

Figure 3 InstallShield Welcome Window

5. Click Next to begin installation.
6. After preparatory steps, the License Agreement window appears.

Figure 4 License Agreement Window
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7. Read the license agreement and select the radio button next to I accept the terms of
the license agreement. (You must accept the license agreement to complete
installation.) 

8. Click Next to continue. The CHOOSE DESTINATION LOCATION window is displayed:

Figure 5 Choose Destination Location Window

To install into the default folder, C:\Program Files\CZM\ATLAS Review, click Next. 
To install into a different folder, click the Browse button to select another folder, and
then click Next to continue installation.
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9. The READY TO INSTALL THE PROGRAM window is displayed:

Figure 6 Ready to Install the Program Window

Click Install to begin the installation. If you want to review or change any of your
installation settings, click Back. Click Cancel to exit the wizard and cancel the
installation.

Possible Adobe Reader Installation

10.If you don’t have Adobe® Reader® version 5 or above, then Adobe Reader 8 will be
installed. 

11.A security message may appear behind the ATLAS Review Software Installation
screen. Click the Adobe Reader icon on the Windows taskbar to see the security
message, and then click Run to continue the installation.
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12.The ADOBE READER 8 - SETUP window will be displayed:

Figure 7 Adobe Reader Setup Window

13.Click Next to install Adobe Reader in the default folder:

Figure 8 Adobe Reader Destination Folder Window
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14.Click Install to begin the installation:

Figure 9 Adobe Reader Ready to Install the Program Window

15.A window tracks progress of the installation:

Figure 10 Adobe Reader Installing Adobe Reader 8 Window
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16.Uncheck Launch Adobe Reader 8. Click Finish to complete the installation of Adobe
Reader 8:

Figure 11 Adobe Reader Setup Completed Window

Continuing Installation

17.The SETUP STATUS window tracks progress of the installation:

Figure 12 Setup Status Window
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When complete, the INSTALLSHIELD WIZARD COMPLETE window (Figure 13) appears:

Figure 13 InstallShield Wizard Complete Window

18.Click Finish to close the window. Installation is now complete and you can remove the
ATLAS Review Software installation CD from your drive.

19.To start ATLAS Review Software, double-click the ATLAS Review Software shortcut
(shown on the left) on your computer desktop. Alternatively, you can select Start > All
Programs > Carl Zeiss Meditec > ATLAS Review Software.

☞ Note: On Windows 7 computers, you may need to right-click on the ATLAS Review
Software shortcut, and select Run as Administrator.

20.See License Registration on page 14 to register the ATLAS Review Software and
any other optional software features.

21.See Set Up and Configure the Review Software on page 20 to configure
ATLAS Review Software to your practice preferences.

22.See Connect Review Station to your ATLAS Instrument on page 20 to
connect your ATLAS instrument to the ATLAS Review Station.
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License Registration

ATLAS Review Software and its optional software features run under license protection.
PathFinder™ II and MasterFit™ II have the option of registering a Trial (30-Day) or Full
license. They will not run until you register their corresponding license. Follow the
instructions below to register a software license.

☞ Note: ATLAS Review Software includes one or more Certificate serial numbers for
your license or licenses. Each Certificate serial number you receive must be
registered separately. Additional licenses may be obtained from Carl Zeiss Meditec.
To activate, go to www.meditec.zeiss.com/register. You may also contact Carl Zeiss
Meditec:
In the U.S.: Call Carl Zeiss Meditec at 1-800-341-6968.
Outside the U.S.: Contact your local Carl Zeiss Meditec distributor.
E-mail: z.customersupport@meditec.zeiss.com.

☞ Important: A license is valid only for the computer you register it to—it cannot be
transferred to another computer without purchasing another license. Be certain of
your network configuration before licensing ATLAS Review to a computer.

☞ Note: If the computer has multiple network cards you may need to register the
license again.

☞ Note: Trial Licenses are not available on Windows 7 computers.

Registering ATLAS Review Software

When you first run the ATLAS Review Software without registering a license, the LICENSE

VIEW window (Figure 14) will be displayed.

Figure 14 License View Window
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Registering Optional Software Features

The following licensed features are pre-installed in ATLAS Review Software 3.0.1, but will
not be active until registered, unless they have been registered previously.

• PathFinder II (30-day Trial available, Windows XP only)

• MasterFit II (30-day Trial available, Windows XP only)

• DICOM Gateway

If you have purchased these features, the corresponding software certificates will be
included in the software kit. 

You can register the optional software features at any time ATLAS Review Software is
running by selecting View Licenses... on the Help menu. The LICENSE VIEW window will be
displayed (Figure 14). If ATLAS Review Software is not running, start ATLAS Review
Software by double-clicking the ATLAS Review Software icon on the desktop. You may need
to logon with a User Name and Password.

☞ Note: On Windows 7 computers, you may need to right-click on the ATLAS Review
Software shortcut, and select Run as Administrator.

Registering a Trial License

☞ Note: Trial Licenses are not available on Windows 7 computers.

1. Click Register under the Trial heading for the license you want to register. A dialog
will be displayed similar to the one shown below (Figure 15).

Figure 15 Trial License Dialog
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2. Click Yes to start your 30-Day Trial license. The LICENSE VIEW window will be displayed
with Trial license registered (Figure 16).

Figure 16 License View Window – PathFinder II 30-Day Trial License Registered

3. Select OK to close the LICENSE VIEW window and begin using the software.
4. You have 30 days from the date of registering to continue using the software. The

number of days left in your Trial license is shown on the LICENSE VIEW window (Figure
16). When the number of days left is seven or less, you will be notified at application
startup with a dialog such as shown in Figure 17 below:

Figure 17 License Notification Dialog

5. Click OK to continue using the software for your remaining trial days. At the end of
your Trial license, the license will expire and you will need to purchase a Full license to
continue using the software.

Registering a Full License

1. Click Register for the license(s) you want to register.
2. The CZM License Registration Utility dialog (Figure 18) appears. 
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Figure 18 CZM License Registration Utility Dialog For Review Software

3. Under FEATURE TO BE REGISTERED, confirm that the name of the feature you selected
matches the license certificate you are about to register.

4. Make a note of the unique Node ID of your system. Enter the Certificate Serial Number
provided on the software certificate, obtained from Carl Zeiss Meditec customer, or
found on a sticker affixed to the back of the CD case, including the alphabetic prefix
and the intervening dash before the number.

5. To obtain a License Key and Security Code, go to the Carl Zeiss Meditec website:
www.meditec.zeiss.com/register. If your language is other than English, select your
language under the “Other Languages:” area of the website.

http://www.meditec.zeiss.com/register
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☞ Note: If you have questions regarding software registration, please contact Carl
Zeiss Meditec at z.customersupport@meditec.zeiss.com. To reach us by phone, in the
United States please call Carl Zeiss Meditec at 1-800-341-6968. Outside the United
States, please contact your local Carl Zeiss Meditec distributor.

6. Go to the bottom of the page, where it says: “When ready use the form to create your
License Key” and click on the word “form” (See Figure 19 below).

Figure 19 Carl Zeiss Meditec Software License Registration Page on the Internet

7. Enter your Certificate Serial Number and click the Submit button. 
8. Enter your Node ID and personal information and click the Submit button to generate

your License Key and Security Code.
9. Write down your License Key and Security Code, or print out and save the entire web

page for reference. 

☞ Note: If you are unable to complete the license registration process, click Close to
quit the license registration utility. Double-click the ATLAS Review Software desktop
icon to restart the software and return to Step 1 of license registration above. 

10.Returning to the CZM License Registration Utility, enter the License Key and Security
Code in the appropriate fields. The Save button will become active only when the
correct information is entered. When the Save button becomes active, click Save. 

Click “form”
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11.If the license registration is successful, a dialog will be displayed confirming
successful registration (Figure 20).

Figure 20 Successful License Registration Dialog

12.Click OK to close the dialog and complete the license registration. 
13.The LICENSE VIEW window (Figure 21) is displayed with the Full license registered.

Select OK to begin using the software. 

Figure 21 License View Window with Full Review License Registered

☞ Note: If you get an error message, verify that you have entered the correct values for
your license information and try again.

14.After registering a Full license on ATLAS Review Software, you can register additional
software licenses now by selecting the Register button for the software you want to
license, or later by selecting View Licenses... on the Help menu.

☞ Note: To purchase additional licensed features, contact Carl Zeiss Meditec Software
Licensing at 1-800-341-6968 or by email at z.customersupport@meditec.zeiss.com.
Outside the United States, please contact your local Carl Zeiss Meditec distributor.
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Set Up and Configure the Review Software

ATLAS Review Software needs to be configured to your practice preferences. Refer to the
following checklist to customize ATLAS Review Software. See the ATLAS User Manual for
more information.

❏ change language see Language in Operational Overview)

❏ name institution (see Create Institution Name in Data Management)

❏ create staff user accounts (see Staff Registration in Data Management)

❏ set user login preference (see User Login in Operational Overview)

Connect Review Station to your ATLAS Instrument

You can connect an ATLAS Review Station to an ATLAS Model 9000 or ATLAS Model 900
Series instrument for data review and analysis. The setup steps described below are brief
and generic and are designed to be performed by an information technology specialist. For
details, refer to the Network Configuration Guide, Archive Management, Export and Import
chapters in the ATLAS User Manual for assistance.

Connect to ATLAS Model 9000 Instrument

The recommended1 method to connect to the ATLAS Model 9000 instrument is done by
synchronization from an ATLAS Model 9000 archive through a networked connection (see
Figure 22). 

1.  An alternate method is to manually import from ATLAS 9000 Series Export Media. This can be used in 
a non-networked environment.
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Figure 22 Synchronization Diagram

1. You must connect the ATLAS 9000 instrument and Review Station to a network.

Configure ATLAS Instrument
2. Configure the ATLAS instrument and a network file server/NAS drive to communicate.
3. If no current archive exists on the ATLAS instrument, click Archive > Archive

Management and create a new archive location on the network file server and make
it the current archive.

4. Perform a manual archive from the ATLAS instrument, which will archive the entire
ATLAS database to the current archive volume. This could take some time depending
on the size of the database. Once archiving is complete, the ATLAS instrument data
will be available for synchronization with a properly configured Review Station.

☞ Note: For an existing large ATLAS database, it is recommended to repeat Step 3
above to create a new archive volume that will be used by the ATLAS Review Station
to synchronize new ATLAS instrument exam data only.

Configure ATLAS Review Station
5. Configure the ATLAS Review Station and the same network file server to

communicate. You will have to map a network drive on the Review Station to the
network file server.

6. From the Review Station, click Archive > Synchronize Volumes. The Archive
Locations to Synchronize dialog opens.
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7. Click Add and then use the Open dialog that appears to navigate through the drive
mapped in Step 5 to locate the ATLAS archive file named Archive.xml in the ATLAS
instrument current archive location. Click Open to add the archive location to the list
of archives to be synchronized on the Review Station. Select Yes to the confirmation
message.

8. To make the ATLAS instrument data available on the Review Station, click Archive >
Synchronize. Depending on the size of the ATLAS archive, synchronization can take
minutes to hours to complete. Once complete, the ATLAS instrument data will be
available for viewing and analysis on the ATLAS Review Station.

9. Select View Today’s Patients to select the imported patients.

Configure Automatic ATLAS 9000/ATLAS Review Station Connection
10.On the ATLAS 9000 select Auto in the Options > Preferences > Archive/Synchronize >

Archive section to have the ATLAS instrument automatically archive new and imported
exams. 

11.On the ATLAS Review Station, select Auto in the Options > Preferences >
Archive/Synchronize > Synchronize section to have ATLAS Review automatically
synchronize networked archive databases.

Connect to ATLAS Model 900 Series Instrument

The recommended1 method to connect to an ATLAS Model 900 Series instrument is done
by importing from an ATLAS Model 900 Series instrument database through a network
connection (see Figure 23). 

Figure 23 ATLAS 900 Series Database Import Diagram

WARNING/CAUTION: Initial import of ATLAS 900 series databases could take several

hours depending on the size of the database. Do not use the ATLAS 9000/Review

Station during that time.

1. You must connect the ATLAS 993/995 instrument and Review Station to a network.

1.  An alternate method is to manually import from ATLAS 900 Series Export Media. This can be used in a 
non-networked environment.
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2. Configure your ATLAS instrument for networking and ATLAS file sharing. You must
share the folder where the ATLAS 993/995 database is located. The default exams
database resides in the C:\EXAMS folder. On the ATLAS Review Station, you can map
a drive letter to the ATLAS 993/995 database folder.

Configure ATLAS Review Station
3. On the ATLAS Review Station, configure Import Settings with ATLAS 900 Series

Importer. While in patient selection mode, click Tools > Run Atlas Importer to display
the ATLAS 900 Series Importer dialog. 

4. Click the Database button to display the Select ATLAS 900 Series Database
dialog.

5. To add an ATLAS 900 Series Instrument database, click an Add button to display the
Add / Edit ATLAS 900 Series Database dialog.

6. In the Name field, type in a name for the ATLAS 900 Series Instrument.
7. In the Location field, you can type in the exact path to the database folder, if you

know it, or click the browse (...) button to find and select the folder. A Choose file
with name Corneal.mdb dialog appears, enabling you to browse anywhere in a
local or network path that is accessible. If you mapped an ATLAS 993/995 database
folder to a drive letter, you can enter it here. You must choose a file with the name
Corneal.mdb, since all ATLAS 900 Series databases have this name.

8. In the Import Option field, select All (for all exams).
9. Click the Add button to add the database. The Select ATLAS 900 Series

Database dialog will be displayed showing the database you have just added.
10.To import the exams from the ATLAS 900 Series Instrument database now, click Start

Import. The exam import process begins and the Import Exam Status dialog will
be displayed.

11.When complete, click the Exit Importer button to return to the PATIENT SELECTION

window.
12.Select View Today’s Patients to select imported patients.

Configure Automatic ATLAS 900/ATLAS Review Station Connection
13.ATLAS Review can be set to automatically import exams from ATLAS 900 Series

Instrument databases. To turn on automatic importing, while in patient selection
mode, click Options > Auto ATLAS 900 Series Importer Setting. The Auto ATLAS 900
Series Importer Setting dialog appears.

14.Check Turn on Auto ATLAS 900 Series Importer to turn on automatic importing. Click
the OK button to save your changes.

15.When new exams are found they will be automatically imported into your current
database.
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• 6. Known Anomalies, page 6

1. New Features

Licensed features described in this section are optional and may not be activated, either
because the feature is not currently available in your market, or because you have not
purchased the software license.

The following new feature is included in ATLAS Software Version 3.0.x:   

1. (Optional Licensed Feature) MasterFit™ II Software. The MasterFit II Contact Lens
Software enables the user to design gas permeable (GP) contact lenses and to
simulate the resulting fluorescein pattern on the cornea. MasterFit II features both
topographic or keratometric-based lens fitting methods. Based on customizable
fitting preferences, MasterFit II will recommend the most appropriate lens type
(including spherical, aspheric, front toric, back toric, and bi-toric designs) and will
design a custom lens that best achieves the desired fitting preferences. The MasterFit
Software set is an optional feature: it is installed with Version 3.0 software but runs
under license protection and must be purchased. 

2. Maintenance Updates

Licensed features described in this section are optional and may not be activated, either
because the feature is not currently available in your market, or because you have not
purchased the software license.

1. (Optional) DICOM Gateway. The DICOM (Digital Imaging and Communications in
Medicine) Gateway allows the user to connect one or more ATLAS Review Stations to
a qualified DICOM 3.0 Ophthalmic Compatible Electronic Medical Records (EMR)
system, Patient Management System (PMS), or DICOM archive, for paperless
workflow. The DICOM Gateway must be installed, configured, and licensed to
operate.

2. Beginning with ATLAS Review Software 3.0.1, Microsoft® Windows® 7 operating
system is supported. ATLAS Review Software 3.0.1 now supports Microsoft Windows
7 Home Premium and Professional (32-bit and 64-bit versions). Notes about
Windows Vista in the user manual apply to Windows 7 with the following exceptions:

• The note to disable “Fast User Switching” in (2) Operational Overview  System
Start and Login > Starting ATLAS Review Software Running on a PC should be
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read as follows for Windows 7: Click Start, type gpedit.msc in the Search
programs and files field, and then press Enter on the keyboard. Select
Administrative Templates > Computer Configuration > System > Logon > 
Hide entry points for Fast User Switching. Then follow the remaining instructions.

• Steps 4, 8, 9 in (D) Network Configuration Guide > Configuration for Export via
Preexisting Office Network > Create a shared folder on a Windows Vista Review
Station should be read as follows for Windows 7. Step 4 is “Select Share this
folder. Select the Permissions button. The Permissions for Netshare dialog opens.”
Step 8 is “Click Close to close the Netshare Properties dialog.” In Step 9, the
shared folder icon will not change.

• The note in (I) License Registration, “Note: On Windows Vista computers, each
user (User Account) will need to register a license using the same Certificate Serial
Number, License Key and Security Code.”, is no longer valid. With Windows 7, you
only need to register one license per computer.

• The path to start the Network Broker service from the Windows desktop in 
(C) DICOM Gateway (Optional) > DICOM Gateway Configuration Steps should be
read as follows for Windows 7: Start > All Programs > Carl Zeiss Meditec >
Network Broker > Network Broker.

• The path to launch the Network Broker Configuration Tool from the Windows
desktop in (C) DICOM Gateway (Optional) > Launching the Configuration Tool
should be read as follows for Windows 7: Start > All Programs > Carl Zeiss
Meditec > Network Broker > Configuration Tool.

3. Beginning with ATLAS Review Software 3.0.1, Microsoft Windows Vista® is no longer
supported. Notes about Windows Vista in the user manual apply to Windows 7 with
the exceptions described in Maintenance Update number 2 above.

4. The path to start the Network Broker service from the Windows desktop in (C) DICOM
Gateway (Optional) > DICOM Gateway Configuration Steps  should be read as follows
for Windows XP: Start > All Programs > Carl Zeiss Meditec > Network Broker > 
Start Network Broker service. The path to launch the Network Broker Configuration
Tool from the Windows desktop in (C) DICOM Gateway (Optional) > Launching the
Configuration Tool should be read as follows for Windows 7 and Windows XP: 
Start > All Programs > Carl Zeiss Meditec > Network Broker > Configuration Tool.

5. Trend Analysis Display. The Trend Analysis Display shows up to four exams for the
same eye, along with a table of data analysis parameters. Data Parameters displayed
include Apical radius (Ro) (along meridian), Sagittal height (along meridian),
Eccentricity (along meridian), Flat and Steep Sim K’s, HVID, and Pupil Diameter values
for each image. The mean and standard deviation values for these parameters are
also displayed for the images.

6. Rings Image Zoom. The Rings Image View now has an option to display a zoomed in
rings image to 10mm. Only available for ATLAS 9000 exams.
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7. RMS Data. The Corneal Wavefront, Image Simulation, PSF, and MTF Views can now
display RMS data. The Root Mean Square (RMS) value of the Zernike coefficients
determines how much wavefront error the anterior cornea has. The higher the RMS
value, the larger the amount of wavefront error. Low (2nd order aberrations only),
High (3rd order aberrations and greater only), and Total (Low + High) RMS values
(μm), and their “equivalent defocus” values (diopters only) are displayed. Equivalent
defocus is the amount of defocus needed to produce the same RMS wavefront error
produced by one or more higher-order aberrations. Equivalent defocus allows us to
compare the order of magnitude of different kinds of aberrations and judge their
clinical significance.

8. Synchronize Status Indicator. The Synchronize indicator reports synchronization status
in terms of connectivity. A red circle with a white “X” indicates that no
synchronization volumes are enabled. A green light indicates all enabled
synchronization volumes are connected. A yellow light indicates at least one enabled
synchronization volume is connected, and at least one enabled synchronization
volume is disconnected. A red light indicates all enabled synchronization volumes are
disconnected. You can mouse over the indicator for details.

9. Export Single Exams. When exporting ATLAS 9000 data, (File > Export > To Atlas
9000 Series Export Media), you can select a single exam or only certain exams for a
patient, rather than all exams, by clicking the Select Exams button and then selecting
the exams you want to export for each patient.

3. User Profile

Specific assumptions regarding the profiles of individuals performing software operation or
data interpretation are given below. The user manual contains information that will aid in
the proper software operation and interpretation of the resultant data.

Review Software Operation

Demographic

• The user should be adult, and at least one of the following:

• Ophthalmologist or other Medical Doctor

• Optometrist or equivalent

• Nurse

• Certified Medical Technician

• Ophthalmic Photographer

• Non-certified Assistant

Occupational Skills

The user should be able to perform all of the following tasks:

• Power on the computer
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• Find and modify patient identifying data

• Select exams and generate an analysis report

• Review the analysis report for completeness

• Print or export an analysis report

• Power off the computer

Data Interpretation

Demographic

The user should be one of the following:

• Ophthalmologist or other Medical Doctor

• Optometrist or equivalent

Occupational Skills

The user should have the following skills:

• See Review Software Operation above

Job Requirements

The user should have training and certification in the analysis and treatment of ophthalmic
diseases or other eye-related medical issues as required by governing bodies.

4. Use Notes

1. Use Note: Health care providers have responsibility for the protection of patient
health information (PHI), both hardcopy and electronic. 
Action: To protect patient confidentiality of your exported electronic data, the use of
encryption is recommended and is the responsibility of the user.

2. Use Note: When there is a large amount of data to be synchronized, Auto Synchronize
will automatically be turned off (if currently on) to prevent the software from
becoming unresponsive.
Action: Manually synchronize (Archive > Synchronize) to complete the
synchronization. When manual synchronize is complete, Auto Synchronize can be
turned back on (Options > Preferences > Archive/Synchronize). Note that Auto
Synchronize will not be automatically turned on.

3. Use Note: When launching an optional third-party software module from within
ATLAS Review Software 3.0.1, a disclaimer dialog box displays as shown below:

Action: Read the disclaimer message and select OK to use the third-party software
module.
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4. Use Note: The Review Software requires administrative privileges in order to run. 
Action: User must have administrative privileges to use the Review Software.

5. Use Note: The Review Software cannot be installed on an ATLAS instrument. 
Action: The user should read the Review Software installation guide before installing
the Review Software.

6. Use Note: If Print2VisuPaC is chosen as the default printer, it must be configured to
Portrait Mode. Selecting Print2VisuPaC Landscape mode can cause an error.
Action: If using Print2VisuPaC, always use Portrait mode.

7. Use Note: All named Parameter Sets have revised default settings. 
Action: To update to the revised default settings, select the Defaults button for each
Parameter Set.

8. Use Note: The rings image is only displayed on the simulated fluorescein map view for
exams created on the ATLAS 9000 in MasterFit II.
Action: Exams created on earlier Atlas models can be viewed in MasterFit II but the
rings image is not displayed.

9. Use Note: The contact lens can only be moved on the simulated fluorescein map view
for exams created on the ATLAS 9000 in MasterFit II.
Action: Exams created on earlier ATLAS models can be viewed in MasterFit II but the
contact lens cannot be moved.

10.Use Note: The MasterFit II software uses the Refraction that has been input by the
operator to help determine the contact lens power. If no refractive data has been
entered, the software assumes a plano refraction and displays a warning to the
operator. 
Action: The operator should enter refractive data in order for the MasterFit II software
to be able to determine appropriate contact lens powers and parameters.

11.Use Note: In some instances, the MasterFit II software lens design area of the screen
is cut off when the tool bar is being displayed or the window has been resized
(Review Software).
Action: The operator can hide the tool bar to make all the contact lens design items
visible or maximize the window if it has been resized.

12.Use Note: The initial synchronization of an archive containing thousands of exams
will take a long time. For example, on a late model computer it will take
approximately 10 hours to complete synchronizing 1000 exams.
Action: Initial synchronizing of a large archive should only be started at a time when
the use of the computer is not required for a long time.

13.Use Note: Exporting all the patients in a large database can be very slow and is not
recommended.
Action: Do not attempt to export all patients at a single time from a large database.
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14.Use Note: Exporting all the patients in a large database to the DICOM Gateway can
be very slow and is not recommended.
Action: Do not attempt to export all patients at a single time to the DICOM Gateway
from a large database.

15.Use Note: The space needed for export is calculated based upon a single patient, not
on the number of exams to be exported. 
Action: If exporting a large number of exams, check beforehand that there is enough
free space on the destination drive. A single exam takes between 1 and 4 MB of
space.

16.Use Note: Archiving does not stop when available space on the archive volume drops
below the red Archive Status (200 MB available on archive volume) during the archive
process. 
Action: If Archive Status turns yellow, either free up space on the archive volume or
create a new archive volume before archiving.

17.Use Note: Larger than expected tear film clearances under the peripheral curve
regions may be observed in the MasterFit II fluorescein simulation. MasterFit II does
not blend between the base, secondary peripheral, and third peripheral curve regions.
Blending effectively lowers the peripheral region and reduces the effective peripheral
clearance.
Action: None.

5. Corrected Anomalies

1. Refractive Power View Display Anomalies. In Software Version 2.0, if mm is selected
as the units (global parameter) in a View, the Refractive Power View in Profile view
mode correctly displays diopter values as the unit, but incorrectly mm as the label.
Also the Color view in the circle will not be correct. This anomaly has been corrected
so that diopters and the Color view are correctly displayed.

6. Known Anomalies

1. Anomaly: If Print2VisuPac is installed and the printing mode is set to landscape an
unhandled exception will occur.
Work-Around: When using Print2VisuPac, set the printing mode to portrait.
Preventive: None.

2. Anomaly: The Review Software installer will not work on a Windows XP 64 bit system.
It will attempt to install Windows Framework .NET 2.0 for a 32 bit system.
Work-Around: When installing the Review Software on a Windows XP system, use
only a 32 bit Windows XP system.
Preventive: None.
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3. Anomaly: The Review Software does not support Large size (120 DPI) display setting
when the screen resolution is set to 1024 x 768. 
Work-Around: Change the DPI setting in the Advanced button under the Settings tab
in the Display Properties dialog to the Normal size setting (96 DPI) or change to a
larger screen resolution than 1024 x 768.
Preventive: None.

4. Anomaly: Special characters not in English character set (e.g., Ä) are case sensitive in
Basic and Advanced search.
Work-Around: Type in a special character and then use the vertical scroll bar to locate
the desired patient.
Preventive: Use the correct case when searching patients with names containing
special characters not in English character set.

5. Anomaly: An unhandled exception error can occur during an Import operation if the
operator types in a path as “e:” rather than “e:\.” The error is caused by omitting the
backslash. 
Work-Around: Type in the backslash if typing the path manually.
Preventive: Use the browse button to select the path.

6. Anomaly: ATLAS export functions do not span media disks. The media disk must have
enough space to accommodate all the export data.
Work-Around: Use a USB hard drive or NAS drive with enough free space to
accommodate the export data.
Preventive: Check beforehand that there is enough free space on the media disk to
accommodate the export data. A single exam takes between 1 and 4 MB of space.

7. Anomaly: When exporting ATLAS 9000 data, if you select Export to Zip Format and
the export folder already contains patients exported without using the Zip format,
then the created Zip file will contain the currently selected patients and the previously
exported patients. Note: Any existing Zip files in the folder will not be included.
Work-Around: Create a new folder when exporting patients.
Preventive: Create a special folder for exporting Zip files.

8. Anomaly: For 2-Difference and 3-Difference Displays, using the keyboard to change
exams in the Exams/Views window does not work.
Work-Around: Select exams with the touchpad or mouse.
Preventive: None.

9. Anomaly: When selecting a different View from the Views tab on an Analysis Screen
with the More (F2) button enabled, and then selecting Export > Export current screen
to DICOM, the screen exported to your DICOM system is incorrectly titled to the
previously selected View.
Work-Around: Do not use Export > Export current Screen to DICOM from the More
(F2) screen.
Preventive: None.
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10.Anomaly: In Windows 7, the color map portion of the display in Trend Analysis is not
fully refreshed when the operator removes one or more of the currently selected
exams. The exam statistics are updated and all printouts and exports are correct.
Work-Around: After removing one or more of the currently selected exams, click on
either the exam statistics area or the color map area of the display to refresh the
display.
Preventive: None
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ATLAS – HP 6988 Printer Configuration

Introduction

This document instructs you how to configure the HP® 6988 printer for use with the
ATLAS™ instrument. You can install the HP 6988 in two configurations for communication
between instrument and printer:

1.  USB Configuration (page 2), via direct USB connection between instrument and
printer. 

2. Network Configuration (page 2), either via direct connection between instrument
and printer, or via connection of instrument and printer to a local area network. 

Printer Safety Warnings

WARNING: To maintain patient safety, an isolation transformer is required
when connecting externally powered peripheral devices (i.e., printer, USB
drive, etc.) within 1.5 meters (4.9 feet) from the patient. In addition, an
isolation transformer is required for all externally powered peripheral devices
outside this distance unless these devices are (1) connected to the ATLAS
using an Unshielded Twisted Pair (UTP) network cable (CZMI recommends
using a least a CAT 5 UTP network cable), (2) plugged into a different power
outlet than the ATLAS, and (3) qualified by CZM for use with an ATLAS
instrument. Failure to observe this warning could result in electrical shock to
the patient and/or examiner.

WARNING: To directly connect a printer to the ATLAS only use a UTP network
cable. Use of a shielded network cable will ground the printer through the
ATLAS, which could result in electrical shock to the patient and/or examiner. It
could also invalidate the system safety approval.

WARNING: Do not use the printer or the instrument with an extension cord or
a power strip (multiple portable socket outlet). For additional safety, do not
plug the printer and the instrument into the same wall outlet. Failure to
observe this warning could result in electrical shock to the patient and/or
examiner.

WARNING: If you connect the printer incorrectly—for example, by plugging
the printer and instrument into the same wall outlet, or by using a shielded
network cable—you could invalidate the system safety approval.
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Installation Overview

Before configuring the printer to communicate with the ATLAS, the following three general
steps are required for both USB and Network configurations. These steps are explained
further in the specific sections.

1. Printer hardware setup: Refer to the instructions provided with the printer to unpack
and set up the printer hardware.

2. Connect hardware. The hardware used depends on the type of configuration you
select: either a network cable or a USB cable. 

3. Configure the Hostname. Network connection only.

USB Configuration

For the USB configuration:

• You must connect the printer with the existing USB interface cable.
• The HP 6988 Printer driver is already installed on the ATLAS.
• No printer software configuration is required for the USB configuration.

This concludes the procedure to configure the ATLAS and a HP 6988 printer with a USB
connection. The printer is now ready for normal use.

Network Configuration

A network connection can be established either (1) directly between the ATLAS and the
printer, or (2) by connecting both the ATLAS and the printer to the local area network or to
a network switch or hub connected to the ATLAS. One network patch cord (or network
cable) is supplied with the printer and is a standard part commonly available at electronics
stores. Follow the instruction steps below.

1. Connect the Hardware

For the direct connection between ATLAS and printer, use one UTP network cable to
connect the network ports on both devices.

For the connection to a local area network, use two shielded or unshielded network cables.
Connect the network ports on each device to the corresponding ports on the local area
network.

Connect the power supply output to the printer. Connect a UTP network cable to the
printer and to a network port on the right side of the ATLAS (Figure 1). (Use one cable to
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connect the printer and computer directly, or two network cables to connect printer and
computer separately to a network, switch or hub.)

Figure 1 ATLAS Network Ports on Right Side of Instrument

Network Ports
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2. Configure the Host Name

☞ Important Note Regarding the IP Address: These instructions assume that the
ATLAS and the printer are configured to obtain an IP address automatically. The
ATLAS ships this way from Carl Zeiss Meditec, so this will be the case unless
someone has intervened to configure the ATLAS with a static IP address. If the
ATLAS has a static IP address, then use the printer manufacturer’s instructions,
rather than these instructions, to configure the printer. Observe that the IP address
for the ATLAS and the printer must be in the same range. In most cases, it is
sufficient to change the number in the last field of the IP address. If the IP address
or other networking parameters of your ATLAS have been adjusted since delivery
from Carl Zeiss Meditec, or if your particular office network configuration is not
compatible with these instructions, consult your network administrator or
information technology (IT) professional to make sure you install and configure the
print driver correctly. This is because the specific characteristics of individual
network configurations can vary greatly.

The HP 6988 printer driver is already installed on the ATLAS instrument. Follow these steps
to complete the configuration by updating the printer Hostname as follows:

1. To determine the printer Hostname, press the ‘✓’ button on the printer to print out a
report page. The printer Hostname appears on line 6 of the report page in the
Hostname field.

2. Select the Windows key on the keyboard to see the Windows Start menu.
3. Select Start > Printers and Faxes to access the Printers and Faxes dialog as shown

in Figure 2.

Figure 2 Printer and Faxes Dialog
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4. To update the Hostname on the ATLAS, right-click on the HP Deskjet 6988 Network
printer icon, and then select Properties. Click on the Ports tab as shown in Figure 3.

Figure 3 HP Deskjet 6988 Network Properties – Ports Tab

5. Verify that Network – Standard TCP/IP Port is selected (Figure 3), and then select
Configure Port (Figure 4).

Figure 4 Configure Standard TCP/IP Port Dialog – Old Hostname
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6. Type in exactly the new printer Hostname from line 6 of the report page in the Printer
Name or IP Address field (Figure 5), and then select OK twice to close the
configuration and printer properties windows.

Figure 5 Configure Standard TCP/IP Port Dialog – New Hostname

This concludes the procedure to configure the ATLAS and HP 6988 printer in a network
configuration. The printer is now ready for normal use.
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Entsorgung des Produktes innerhalb des EU-Raumes 
 
Das auf dem Lieferschein spezifizierte Produkt darf entsprechend 
den zum Zeitpunkt der Inverkehrbringung geltenden EU-Richtlinien 
und nationalen Vorschriften nicht über den Hausmüll oder 
kommunale Entsorgungsunternehmen entsorgt werden.  
 
Für nähere Informationen zur Entsorgung des Produktes wenden Sie 
sich bitte an ihren lokalen Händler oder den Hersteller bzw. deren 
Rechtsnachfolger. Beachten Sie bitte auch die aktuellen 
Internetinformationen des Herstellers. 
 
Bei Wiederverkauf des Produktes oder dessen Bestandteilen hat der 
Verkäufer den Käufer davon in Kenntnis zu setzen, dass das Produkt 
entsprechend den aktuell gültigen nationalen Vorschriften entsorgt 
werden muss.   
 
 

Disposal of the product within the EU 
 
EU directives and national regulations currently in force at the time of marketing prohibit the 
disposal of the product specified on the delivery note in domestic waste or by municipal waste 
disposal companies.  
 
For more information on disposal of the product, please contact your local dealer, the 
manufacturer or their legal successors. Please also take note of the manufacturer’s current 
online information. 
 
If the product or its components are resold, the seller has the duty to notify the buyer that the 
product must be disposed of in accordance with currently valid national regulations.   
 

Élimination du produit dans la zone UE 
 
Conformément aux directives UE et aux dispositions nationales en vigueur au moment de la 
mise en circulation, le produit spécifié sur le bon de livraison ne doit pas être éliminé en tant 
qu’ordure ménagère ou par l’intermédiaire des entreprises municipales d’élimination des 
déchets.  
 
Pour de plus amples informations relatives à l’élimination du produit, veuillez vous adresser 
au commerçant local ou au fabricant, ou bien à leurs successeurs. Veuillez respecter 
également les informations actuelles du fabricant disponibles sur Internet. 
 
En cas de revente du produit ou de parties du produit, le vendeur est tenu d’informer 
l’acquéreur que le produit doit être éliminé selon les dispositions nationales en vigueur.   
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Cómo desechar el producto dentro de la Comunidad Europea 
 
De acuerdo a las directivas comunitarias vigentes y a las 
reglamentaciones nacionales, el producto especificado en la boleta de 
entrega no deberá ser desechado a través de la basura doméstica o del 
sistema municipal de recojo de desperdicios.  
 
Su representante de ventas local, el fabricante y sus sucesores legales le 
proporcionarán mayores informaciones acerca de cómo desechar el 
producto. Tenga también en cuenta las informaciones publicadas 
actualmente en Internet por el fabricante. 
 
Al revender el producto o sus componentes, el vendedor deberá hacer 
de conocimiento del comprador que el producto deberá desecharse 
respetando la reglamentación vigente al respecto. 
 
 
 
 
 

Smaltimento del prodotto nell’ambito della Comunità Europea 
 
In accordo alle normative UE e alle direttive nazionali vigenti al momento della messa in 
circolazione, il prodotto specificato sulla bolla di fornitura non va smaltito assieme ai rifiuti 
domestici o tramite l’azienda comunale di smaltimento rifiuti.  
 
Per informazioni dettagliate sullo smaltimento del prodotto, si prega di rivolgersi al proprio 
rivenditore di zona, al produttore o ai loro successori legali. Si prega di fare riferimento anche 
alle informazioni attuali del produttore disponibili su Internet. 
 
In caso di rivendita del prodotto o di componenti dello stesso, il venditore è tenuto ad 
informare l’acquirente del fatto che il prodotto va smaltito in accordo alle direttive nazionali 
attualmente vigenti. 
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